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Description 
The DWS consists of the workstation (computer), application software, video display monitors, and medical grade isolation transformer. 

Figure 1.  EnSite™ X EP System 

 

 

System Components 
The EnSite™ X EP System is comprised of two primary components: the EnSite™ X Amplifier with associated modules, and the Display Workstation 
(DWS) as described below. 

NOTE: 

 Cleaning is recommended after each use. All surfaces should be cleaned with a dry, lint free cloth, gently applied. Where necessary, 
alcohol can be applied on such a cloth to remove grease and stains. The monitor screens can be cleaned with an appropriate solution. 

 Cleaning is recommended after each use. All surfaces should be cleaned with a lint free cloth, using one of the following cleaning 
solutions: 

 Isopropyl Alcohol 
 Cidex‡ Solution 
 Cidex OPA‡ Solution 
 Sani-Cloth‡ AF Germicidal Disposable Wipes 

EnSite™ X Amplifier 
 The EnSite™ X Amplifier accepts signals from SurfaceLink Module, 20 pin Catheter Input Modules, the EnSite™ X Field Frame, and four (4) 

Patient Reference Sensors. The devices accept signals from catheters and electrodes attached to the patient and pass these signals to the 
EnSite™ X Amplifier. The EnSite™ X Amplifier converts these signals to a digital format and sends them to the DWS for processing and display. 

 EnSite™ X Field Frame Generator. The Field Frame generates the magnetic tracking field necessary for the VoXel catheter tracking and navigation 
mode of the EnSite™ X EP System.  

 SurfaceLink™ Module. Connects the EnSite™ X surface electrodes, system reference surface electrode, and RL ECG electrode to the EnSite™ X 
Amplifier. 

 Catheter Input Modules. 20 pin module allows for connection of standard diagnostic catheters to the EnSite™ X Amplifier. 

 Four (4) Patient Reference Sensors, one anterior (PRS-A) and three posterior (PRS-P) sensors with cables. 

 EnSite™ X ECG cable. Connects standard ECG electrodes to the EnSite™ X Amplifier. 

 Medical Grade Isolation Transformer. When using the Amplifier Cart, the system components connected to line power through the isolation 
transformer. Only components on the Amplifier Cart should be connected to this isolation transformer. 

EnSite™ X Display Workstation (DWS) 
The DWS consists of the workstation (computer), monitors, medical grade isolation transformer, and optional printer. 
 Workstation. The workstation contains the system software displaying data from the EnSite™ X Amplifier. Attached to the workstation are a 

keyboard and mouse for user input. 

 Monitors. Monitors are used to display patient information. One monitor is placed near the workstation and keyboard for system operation. 
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 Medical Grade Isolation Transformer. All system components on the DWS cart are connected to line power through the isolation transformer. Only 
components of the DWS should be connected to this isolation transformer. 

Required Components Not Included 
The following components are required for EP studies but are not included with the EnSite™ X EP System: 
 Standard and Sensor Enabled™ EP Catheters - These catheters are introduced into the cardiac chamber of interest and used in electrophysiology 

procedures. 

 EnSite™ Surface Electrodes - Six surface electrodes are used for the EnSite™ X EP System. 

 Patient Reference Sensor (PRS) Patches - Four patches used to place the four Patient Reference Sensors (PRS) used with the 
EnSite™ X EP System. 

 ECG Electrodes - These industry-standard surface electrodes are placed in a standard 12-lead configuration. 

 System Reference Electrode - The EnSite™ NavX System Reference. 

 Right Leg ECG Electrode - Placed as right leg ECG electrode during EnSite™ X EP System procedure. 

Optional Components Not Included 
The following components are optional for EP studies and are not included with the EnSite™ X EP System: 
 Ampere™ RF Generator - Radio Frequency Ablation Generator. 

 CoolPoint™ Irrigation Pump - Provides irrigation to an Ablation catheter tip when used with Ampere™ RF generator. 

 Workmate™ Claris™ Recording System Amplifier - ECG amplifier for the WorkMate™ Claris™ electrophysiology signal recording system. 

 TactiSys™ Quartz Force Sensing Module - Calculates and displays force data for Force Sensing Catheters.  

 Printer - An optional printer is available for printing images from the system. 

 Video Extender - This device splits the video signal so that the same information appears on the local and remote EnSite™ X EP System monitors. 

 Remote Monitor - A remote monitor can be placed near the patient table for use by the physician. The monitors display identical information from 
the same source. 

 Display Workstation Cart - Optional cart to mount DWS, Monitor, isolation transformer, and printer. 

 Amplifier Cart - Optional cart to mount, EnSite™ X Amplifier, Workmate™ Claris™ Recording System, Ampere™ RF Generator, TactiSys™ Quartz 
Force Sensing Module, and CoolPoint™ Irrigation Pump. The cart incorporates integrated locations for cable and EnSite™ X Field Frame storage 
and option for remote monitor. 

 Remote Monitor Stand - Optional stand that supports from 1 to 3 video displays. 

EnSite™ X EP System Layout 
Figure 2.  Typical Lab Setup 

 

1. Remote Monitor Stand. 

2. Monitor Boom (Patient Monitors). 

3. EnSite™ X Amplifier. 

4. Fiber Optic Cables. 

5. C Arm. 

6. EnSite™ X EP System Field Frame and bracket. 

7. EnSite™ X SurfaceLink, Catheter Input Module (CIM) 20 pin. 

8. EnSite™ Field Frame cable to the EnSite™ X Amplifier routed 
under the patient table. 

9. Patient Table. 

10. Display Workstation (DWS). 

11. Monitor. 

12. Keyboard and Mouse. 

 



 

3 
 
 

System Diagram 
Figure 3.  DWS Component Layout 

 

 

Indications for Use 
The EnSite™ X EP System is a suggested diagnostic tool in patients for whom electrophysiology studies have been indicated. 

The EnSite™ X EP System provides information about the electrical activity of the heart and displays catheter location during conventional 
electrophysiological (EP) procedures. 

Clinical Benefit 
The intended clinical benefit is to provide diagnostic information to the physician to aid in the treatment of arrhythmias. 

Contraindications 
There are no known contraindications. 

Warnings 
 AutoMarks are placed based on EnGuide location. Sudden impedance changes of the body or catheter electrodes caused by the connection of 

other devices (e.g., stimulator, defibrillator, and other devices), poor patch adhesion or patient movement may create a location shift. Use 
conventional EP techniques, such as fluoroscopy or inspection of intracardiac electrogram signals, to confirm catheter location. 

 Use ONLY the EnSite™ X field frame cable (with ferrites) ENSITE-FF-3MC-01 or ENSITE-FF-4.5C-01. Other cables do not provide adequate 
protection against electromagnetic events 

 Sudden impedance changes of the body or catheter electrodes caused by the connection of other devices (e.g., stimulator, defibrillator, and other 
devices) may create a location shift. 

 Do not modify or make any additional connections to the EnSite™ X EP System, other than those described in this manual. Do not connect the 
system to multiple portable socket outlets or extension cords. 

 The EnSite™ X EP System should not be used adjacent to or stacked with other equipment. If adjacent or stacked use is necessary, this product 
should be observed to verify normal operation in the configuration in which it will be used. 

 If the workstation is powered off by the user, rather than shutdown by the operating system, data on the hard drive may become corrupted and 
the EnSite™ X EP System may cease to be operational. 

 The EnSite™ X EP System model display should be used in conjunction with conventional EP techniques to confirm catheter location. 

 Do not rely solely on the stability indicator information during ablation. 

 Baseline drift of the force output may occur during the procedure. Operator should verify baseline integrity periodically during use. To check for 
baseline drift, position the catheter tip in a free-floating position away from the heart wall. In case of significant baseline drift (e.g. >5 g), a reset to 
zero should be applied by clicking the Reset Force button on the EnSite™ Contact Force Module screen (when not ablating). 

 Make sure that the catheter is in a free-floating (non-contact) position before manually resetting the baseline. Contact can be identified by 
periodic changes (“bumps”) on the force graph or generally an uneven force graph. 

 When the catheter is in a free-floating position, the force value will not be around zero if baseline drift has occurred. Resetting to zero while the 
catheter is in contact may cause differences between the value shown on the screen and the actual force applied to the tissue. 
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 When ablating on the posterior wall, all information available in the electrophysiology laboratory should be taken into consideration by the operator 
to determine the amount of RF energy delivered in order to avoid esophageal damage. The operator should not rely solely on LSI or FTI 
parameters during ablation on the posterior wall. 

 The default display for AutoMarks is 4mm gray spheres. Adjustment to display thresholds is recommended to distinguish individual AutoMarks. 

 The AutoMark feature does not indicate lesion effectiveness. AutoMarks are placed based on user-defined parameters for catheter stability and 
RF metrics only. 

 Do not touch accessible connectors and the patient simultaneously. 

 The ablation metrics display is not to be used as the primary/sole display of ablation information during an Electrophysiology study. Reference the 
ablation generator for ablation information. 

 In the event of a suspected cybersecurity issue, discontinue use of the EnSite™ X System and contact Abbott Technical Support. 

 To protect the privacy and security of sensitive information, including protected health information (PHI), the system should be located in a 
secured environment. 

 Manage security settings, individual user logins, and passwords per the Administrators Guide for the EnSite™ X EP System. 

 The site controlling the device should have policies in place prescribing the physical safety and security of the devices in the electrophysiology 
laboratory. For example, physically securing devices and information should include policies that limit physical access, securing equipment in 
locked rooms, managing access to secured rooms, and restricting the ability to remove devices from a secure area. 

 The ECG display is not to be used as the primary/sole patient monitor during an Electrophysiology study. The EnSite™ X EP System contains no 
alarms for indicating inoperative conditions. 

 Non-SE catheters cannot collect location data and should not be used for navigation in VoXel Mode because they do not have a magnetic sensor. 
However, they can be visualized and display intracardiac signals. 

 Changing the distortion threshold over Level II allows 3D point collection with more metal distortion error in VoXel Mode. 

 For patient safety, any connections that directly connect the patient to the EnSite™ X EP System must be routed through the appropriate 
modules: SurfaceLink Module, 20 pin Catheter Input Module, and Direct Connect Ports on the EnSite™ X Amplifier. 

 When using the EnSite™ X full protection against the effects of cardiac defibrillator discharge and other leakage currents is dependent upon the 
use of appropriate cables. 

 Only connect items that have been specified as part of the EnSite™ X EP System or compatible with the EnSite™ X EP System to the multiple 
socket-outlets. 

 The use of this device in conjunction with radio frequency ablation, as a part of the diagnosis and treatment of cardiac arrhythmias, may pose an 
increased risk of adverse events such as cardiac perforation, myocardial infarction, air embolism, and hematoma requiring surgical repair and/or 
blood transfusion. 

Precautions 
 Make all connections between systems before validating the EnSite™ X EP System. Adding or removing connections after validation may affect 

navigation quality. Additionally, all patient connections to ancillary equipment (e.g. external defibrillators) should be made prior to validation. 
Connections between systems refers only to Abbott-supplied or approved devices. 

 When the EnSite™ X Amplifier is turned off, it can affect ECG signals viewed on the recording system. When the EnSite™ X Amplifier is turned off 
and a recording system is in use, it is recommended that the cables to the EnSite™ X EP System be disconnected from the EnSite™ X Amplifier. 

 EnSite™ X Nav X™ Navigation and Visualization Technology studies intending to use Field Scaling must not have electrodes in a sheath during 
point collection. 

 For studies where Field Scaling is used, be sure that appropriate interelectrode spacing and size are specified for any catheter that is used for 
collecting points. Model points collected with catheters that are inappropriately described may yield unexpected Field Scaling results. This cannot 
be corrected by re-entering correct information after the fact. However, Field Scaling is an option which can be unapplied if unexpected results 
occur. 

 When baselining the sheath filter, the catheter must be in the blood pool. 

 Do not use Stabilize ABL in situations where electrodes 2, 3, or 4 on the ablation catheter are covered by a sheath. 

 Do not immerse system components in liquid. 

 Do not place the EnSite™ X EP Field Frame cable inside the measurement volume or wrap it around the Field Frame, as it may create a magnetic 
interference. 

 Do not coil the EnSite™ X EP Field Frame cable. The cable carries enough electric current that a magnetic field will be created when the cable is 
placed in a circular formation. This magnetic field may disturb the Field Frame's magnetic field. 

 Metallic equipment used in close proximity to the magnetic field during the procedure, such as a sterile drape holder, may cause metal distortion. 

 Do not use the EnSite™ X EP System in the presence of other magnetic fields. 

 Do not expose or immerse the EnSite™ X system to liquids or allow fluid to enter the equipment in any way. Exposing the EnSite™ X system to 
liquids may result in equipment damage, produce a fire or shock hazard, and result in possible personal injury. 

 Snugly hand-tighten the screws with the hex wrench. Do not over-tighten, as the screw may break off inside the Frame. 

 Discard Changes will delete all surfaces if the model has not been finished at least once. 

 Patients with any implantable device might undergo the procedure provided that the implantable device complies with ANSI/AAMI PC69 and the 
implantable device manufacturer’s recommendations regarding the type of invasive procedure and exposure to electromagnetic interference 
(EMI) are strictly followed. In addition, it is recommended to turn off the magnetic field generated by the EnSite™ X Field Frame during telemetry 
or communication between an external programmer and the implanted device. 

 In any case of abnormal behavior of the implanted device, turn the system’s magnetic field off. Whenever device programming has been 
performed before or during the procedure, it is recommended, following the procedure, to: 

- Program the device back to its original pre-procedure settings or other settings according to the patient’s clinical indications. 
- Perform a routine device evaluation. 
- In any case of uncertainty regarding device programming, please consult with a relevant device expert. 

 Do not place multiple socket-outlets on the floor. 
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 The multiple socket outlets provided with the EnSite™ X EP System should only be used for supplying power to EnSite™ X EP System 
components. Failure to do so may result in excessive leakage current. The maximum permitted loads for the multiple socket outlets are: 

System Component Input Current Output Current 

Power strip on carts 12A N/A 

 

System Component  Power (Max) Output Current (Max) 

Amplifier or DWS Isolation Transformer US: 1000VA 

EU: 1000VA 

JPN: 840VA 

US: 8.4A 

EU: 4.17A 

JPN: 8.4A 

Remote Monitor Isolation Transformer US/JPN: 720VA 

EU: 750VA 

US/JPN: 6A 

EU: 3.12A 

 
 EnSite™ X EP System components should be connected to power through an isolation transformer or the multiple socket outlet supplied with the 

system carts. Connecting equipment directly to a wall outlet may result in excessive leakage current. 

 Always respond to warning messages as soon as possible. Failure to do so may cause an inability to record data or to communicate properly with 
the EnSite™ X Amplifier. 

 Model points, mapping points, and map tags (labels, lesions, shadows, etc.) placed at EnGuide within approximately 15 seconds prior to 
notification of dislodgement may not be based on the previous location of the positional reference catheter. The user should confirm whether 
these points are valid. After a dislodgement has been detected, the Positional Reference Tool gives users the option to take immediate action 
(click Adjust Now) or to take action later (click Adjust Later). 

 If the Adjust Later button is selected, the user must be aware that any tasks that rely on the positional reference catheter’s location may be 
affected. These tasks include collecting model points, collecting mapping points, placing labels, placing lesions, etc. 

 The Positional Reference Tool will not monitor positional reference catheter dislodgements if Adjust Later is selected. To re-enable the Positional 
Reference Tool and accept the new location of the positional reference electrode after a dislodgement has been detected, click on Accept. 

 In the event that the system notifies the user of both an EnSite™ X electrode error and a Positional Reference Tool dislodgement message, the 
EnSite™ X electrode error should be addressed first. 

 In the event that the system notifies the user of both an EnSite™ X electrode error and a Positional Reference Tool dislodgement message, the 
user should verify that the positional reference catheter has physically moved. 

 Periodic Inspection: The system components should be inspected by the customer monthly: Check the Torx security screws and discontinue use 
if there is visible evidence of tampering. 

 EnSite™ X Amplifier is not intended to be used as a networked device. All remote network access protocols into the amplifier are disabled/not 
installed. 

 Only a qualified service representative can perform maintenance or service the system. 

 After moving the system, inspect all connections for damage, reconnect the system per instructions in this IFU as well as the EnSite™ X EP 
System IFU. Damaged cables or components must be replaced. 

 This system contains the following security features: Whitelisting - Whitelisting technology prevents the execution of unauthorized software on this 
system to protect against malware. An indicator shows that the security software is running in the background. To check if the security software is 
running, observe the Cybersecurity software status icon in the bottom left corner of the Login Manager or Launcher screens. If the Cybersecurity 
status icon shows the security software is not running, discontinue use of the device and contact the local administrator of the facility the system 
is located in or Abbott Technical Services. 

 Do not drop the EnSite™ X Field Frame or subject it to impact. Physical damage to the Field Frame may alter the Field Frame's factory 
calibration. 

 Do not disconnect the EnSite™ X Field Frame from the system while tracking. Disconnecting the Field Frame while in tracking mode may result in 
sparks being generated. 

 Non-Patient environment system components are not suitable for use within the patient environment where intentional or unintentional contact 
can occur between a patient and these components or between a patient and other person touching parts of these components. 

 Federal (USA) law restricts this device to sale by or on the order of a physician. 

 Do not operate the EnSite™ X EP Field Frame within 10 m of another operating Field Frame. 

 Do not place tool cables within 30 mm of the EnSite™ X Field Frame cable. If placed this close-particularly if the cables are parallel to each other-
the tool cable may become subject to electromagnetic interference. 

 Keep the EnSite™ X Field Frame approximately 75cm away from any exposed ground planes to prevent interference which may affect 
Sensor Enabled™ points and Sensor Enabled™ field scaling accuracy. 3D point collection stops when metal distortion is detected. 

 Do not clean the system components with disinfectants that contain surfactants. 

 Do not clean system components with bleach. 

 Do not apply cleaners while the system is warm to the touch. 

 Do not sterilize system components. 

 Disconnect power to the EnSite™ X system before cleaning it. 

 Do not use aerosol sprays near the equipment as these sprays can damage circuitry. 

 Do not autoclave any EnSite™ X system component. Autoclaving may damage the system. 

 Do not sterilize EnSite™ X interconnect cables. 

 Do not leave cable connectors where they can be damaged, particularly on the floor, where they can easily be stepped on and damaged. 

 Pull connections apart by gripping the connector. Do not pull them apart by tugging on the cable as this can damage the connecting cable. Never 
force a connection or a disconnection. 

Limitations 
Device(s) should connect directly to the EnSite™ X EP System, not through a third device. 
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Adverse Events 
 Cardiac Perforation 

- Cardiac effusion/ tamponade 

 Cardiovascular Injury, which might include but are not limited to: 

- Vascular injury 
- Damage to the coronary vasculature 
- Valvular damage 
- Cardiac effusion/ tamponade 

 Organ Injury, which might include but are not limited to: 

- Esophageal lesion 
- AE fistula 
- Puncture of surrounding organs 
- Hemothorax 
- Pneumothorax 

 Arrhythmias, which might include but are not limited to: 

- Recurrent arrhythmia 
- Non-sustained ventricular tachycardia 
- Recurrence of atrial fibrillation 

 Peripheral Nerve Damage 

- Phrenic nerve (PN) palsy 

 Superficial Tissue Injury 

 Electric Shock 

 Thermal Injury 

EnSite™ X Display Workstation Connections 

EnSite™ X Display Workstation (DWS) Front and Back Panels 
Figure 4.  DWS Front Panel 

 

1. Power On button 

2. USB Drive Connections 

3. CD/DVD Read/Write Drive 

 

Figure 5.  DWS Back Panel 

 

1. Power Connection 

2. Secondary Power On/Off Switch 

3. USB Ports for Keyboard, Mouse and Printer 

4. WorkMate™ Claris™ Recording System 
Connection 

5. Ethernet Connection for Hospital Network 

6. Remote Monitor Connection 

7. Local Monitor Connection 

8. EnSite™ X Amplifier Connection 

 

Connecting the EnSite™ X Amplifier to the EnSite™ X Display Workstation (DWS) 
Connect a "LC to LC OM1, 1 Gb Fiber Optic Cable" from 1 Gb Data Port on the EnSite™ X Amplifier back panel to the AMP Port on the 
EnSite™ X Display Workstation (DWS) back panel. 
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Figure 6.  Local Monitor Display Connection 

 

 
EnSite™ X DWS Back Panel, AMP (amplifier) port. EnSite™ X Amplifier Back Panel. 

 

Connecting to the Local Monitor 
Connect a local monitor to the [LOC] display port connector as shown. 

Figure 7.  Local Monitor Display Connection. 

 

 
EnSite™ X DWS Back Panel, LOC (local monitor display) port. 

 

Connecting to the Remote Monitor 
Connect a remote monitor to the [REM] display port connector as shown. 

Figure 8.  Remote Monitor Display Connection 

 

 
EnSite™ X DWS Back Panel, REM (remote monitor display) port. 
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Connecting to the Hospital Network 
Connect a standard copper ethernet cable to the ethernet connection labeled [HOSP] as shown below. 

Figure 9.  Hospital Network Connection 

 

 
EnSite™ X DWS Back Panel, HOSP (hospital network) port. 

 

Connecting the Keyboard, Mouse and Printer 
Connect the USB mouse, keyboard, and optional printer to any of the USB ports on the rear panel as shown below. 

Figure 10.  Mouse, Keyboard and Printer Connections 

 

 
EnSite™ X DWS Back Panel; Keyboard, Mouse and Printer USB ports. 

 

Connecting the Power Cable 
Connect an IEC power cable to the DWS as shown below. Connect the power cable to the isolation transformer. 

Figure 11.  Power Connection 

 

 
EnSite™ X DWS Back Panel, Power Connection. 
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EnSite™ X EP System Setup 

Starting the System 
Before starting the system, verify the following: 
 All cable connections to the EnSite™ X Amplifier are secure. 

 The fiber-optic cable connection between the DWS and the EnSite™ X Amplifier is secure. Use the following procedure to start the system: 

NOTE: If the system will only be used to review previously recorded data in Offline Review Mode, the EnSite™ X Amplifier does not need to 
be powered on. 
NOTE: If the EnSite™ X Amplifier is already powered on when setting up the system for a new study, power cycle the EnSite™ X Amplifier 
before starting a new study. The EnSite™ X Amplifier self-test provides important information about the status of the EnSite™ X Amplifier 
components that may not be available unless the EnSite™ X Amplifier is power cycled. 

1. Power on the isolation transformer. 

2. Press and release the workstation power switch (located on the front of the workstation) to power on the workstation. When powered on, the 
workstation begins automated self-testing. When self-testing is complete, the system login screen appears on the monitor. 

3. Press the EnSite™ X Amplifier power button in to the ON position. 

4. When the system is powered on, the status lights may change state for approximately two minutes while the system performs self-testing. After 
two minutes, check the EnSite™ X Amplifier status lights. The green light should illuminate and remain lit. If the amber light flashes or is steadily 
illuminated, there is a problem. 

Login to System 
Login to the system with username and password. 

NOTE: Refer to the EnSite™ X System Admin Guide for initial login and setup instructions. The instructions below are for the configured system. 

Figure 12.  Login Screen 

 

1. Hostname The hostname of the system. 

2. Change Keyboard Language Select to access available languages. 

3. Power dropdown menu Open to Power Off or Restart system. 

4. Username Enter username to log into system. 

5. Password Enter password to log into system. 

6. Logon Button Select this button to logon. 

7. Change Language Select to access available languages. 

8. SJM™ Connect icon Select to access SJM™ Connect. 

 

Launcher Main Screen 
Upon successful login, the Launcher screen will be displayed. 
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Figure 13.  Launcher Main Screen 

 

1. Clinical Select to start or review a study. 

2. Services Select to access System Log files, Licenses, and additional functions. 

3. Exit icon Exit application. 

4. Change Password icon Select to access change password screens. 

5. About the System Select to access the About system dialog box. 

6. SJM™ Connect icon Select to access SJM™ Connect. 

 

NOTE: The options seen on the Launcher Main Screen will be displayed based on the assigned User Role(s). User Roles include: 
Administrator, Clinical, Service, and Training and are described in the EnSite™ X System Administration Guide. 

Clinical Menu 

 

After selecting the Clinical icon, the Clinical Menu screen will be shown. Select an action from the Clinical Menu Screen. 
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Figure 14.  Clinical Menu Screen 

 

1. Back icon Go back one screen. 

2. New Study Starts a new study. 

3. Past Study Open a previously recorded study (Opens in Review Mode). 

4. Last Study Open the last study (Opens in Review Mode). 

5. Import Import files onto the system hard drive from a storage device. 

6. Archive Archive files on the system hard drive to another storage source. 

7. Verismo Opens the EnSite Verismo™ Segmentation Tool. 

8. User Clinical user. 

9. Exit icon Exit application. 

10. Change Password icon Select to access change password screens. 

11. About the System Select to access the About system dialog box. 

12. SJM™ Connect icon Select to access SJM™ Connect. 

 

Start a New Study/New Patient 

 

After selecting the "New Study" icon, The Study Setup screen will be shown. Perform the following steps for a New Patient. 
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Figure 15.  New Study/New Patient Screen 

 

 

1. Select New Patient button. (selected by default) 

2. Enter patient information into the fields, required information is noted. 

NOTE: Patient ID and weight cannot be changed after leaving this screen. 

3. Select the Navigation Mode. 

NOTE: Navigation mode cannot be changed after leaving this screen. 

4. Select the Lab. 

NOTE: Lab cannot be changed after leaving this screen. 

5. Select Begin Study button once all patient and system information has been entered. The EnSite™ X Setup Screen will appear. 

6. Select the Exit button to leave the Study without saving. 

NOTE: Use the mouse to hover the pointer over the to show informational text about a selection for entry field. 

Navigation Mode Description 
The EnSite™ X EP System provides users with two distinct navigation modes; EnSite NavX™ mode and EnSite™ VoXel mode. Selection of a navigation 
mode is required before beginning a study and cannot be changed after leaving the setup screen. 

The EnSite™ VoXel model should be selected when only Sensor Enabled™ catheters will be used for location data collection. In this mode, catheter 
locations are mainly based on the magnetic signals generated by Sensor Enabled™ catheters in conjunction with the Field Frame. Standard catheters 
(that is, without a sensor) can only be visualized in this mode and only after enough magnetic information has been collected near the catheter location. 

The EnSite NavX™ mode should be selected when the use of standard electrophysiological (EP) (that is, without a sensor) catheters to collect location 
data is desired. In this mode, catheter locations are calculated based on impedance signals generated using the EnSite™ Surface Electrodes attached 
to the patient. Optionally, a Sensor Enabled™ catheter(s) in conjunction with the EnSite™ X Field Frame can be used in this mode to collect magnetic 
information. The system will use the collected magnetic information for EnGuide Stability Monitor, and during the optional EnSite NavX™ SE field 
scaling calculation. 

Lab Description 
During installation, service personnel will perform a Lab characterization procedure in each room the system is planned to be used. This procedure will 
measure the magnetic field of the room. Selection of a lab is required before beginning a study and cannot be changed after leaving the setup screen. A 
"Non-Characterized Lab" is an option, but not the default. Selecting a non-characterized lab may limit C-Arm movement and may cause false detections 
of metal distortion. 

The Lab characterization information for the selected lab will be used to correct magnetic positions due to metal distortion and prevent inaccurate data 
collection. If the metal environment in the lab changes (e.g. new fluoroscopy system) the lab must be re-characterized as the original data may no 
longer be accurate. 
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Start a New Study/Existing Patient 

 

To begin a new study with an existing patient, select the "Existing Patient" icon. Perform the following steps for a new study with an 
existing patient. 

Figure 16.  New Study/Existing Patient Screen 

 

 

1. Select the Existing Patient button. 

2. Select a patient from the list. 

3. Review patient information. 

4. If changes to the patient information are desired, select Edit button. The Edit dialog box will open. Make changes to the patient information as 
needed and select the Save button to save changes or the Cancel button to discard changes to the patient information. 

Figure 17.  Edit dialog box 

 

 

5. Select the Navigation Mode. 

NOTE: Navigation mode cannot be changed after leaving this screen. 

6. Select the Lab. 

NOTE: Lab cannot be changed after leaving this screen. 

7. Select Begin Study once all patient and system information has been entered. The EnSite™ X EP System - Setup screen will appear. 

8. Select the Exit button to leave the Study without saving. 

NOTE: Use the mouse to hover the pointer over the Help icon to show informational text about a selection or entry field. 
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Past Studies 

 

After selecting thePast studies icon, the Study Review screen will be shown. Perform the following steps for a past study. 

NOTE: To open the last study, select Last Study on the Study Launchpad Screen. 

Figure 18.  Past Studies Screen 

 

 

1. Select a study from the list. 

2. Review study information on the right side of screen. 

3. If changes to the study information are desired, select Edit button. The Edit Studies dialog box below will open. Make changes to the study 
information as needed and select the Save button to save changes or the Cancel button to discard changes to the study information. 

Figure 19.  Edit Studies dialog box 

 

 

4. If changes to the patient information are desired, select Edit Patient button. The Edit Patient dialog box below will open. Make changes to the 
patient information as needed and select the Save button to save changes or the Cancel button to discard changes to the patient information. 
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Figure 20.  Edit Patient dialog box 

 

 

5. Select the Delete button to delete the study. 

6. Select the "Apply changes to the selected study only" checkbox to apply the changes to only this study. 

7. Select OK button to accept changes. Select the Cancel button to discard changes. The dialog will close. 

8. Select Open Study button in the lower right corner of screen. The Workspace screen will open with the study in Review. 

9. Select the Exit button to leave study without saving. 

Last Study 

 

On the Study Launchpad screen, press the last study icon. The Workspace will open with the Last Study view in Review mode. 

 

EnSite™ X EP System Setup Screen 

EnSite™ X EP System Setup, Study Tab 
The System Setup screens open when the study and patient information has been completed. 

Figure 21.  Setup - Study Tab 

 

 

1. Select patient's Diagnosis. 

2. Select Procedure type. 

3. Select name of Physician. 

NOTE: If items 1 through 3 above are required to save and exit a study. 
NOTE: For each field, select a pre-set value from the drop-down menu or freely type a new value. This new value will be available for future 
studies. Anything typed cannot be deleted. 

4. To exit the study, select the Abbott Menu icon and select End Study. 
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Training Menu 
The Training menu allows the user to access the training mode for the EnSite™ X EP System. When a user enters the Training Menu, the same options 
will appear as the Clinical Menu: New study, Past Study, Last Study, Archive, Import, Verismo. Although the Training Menu looks similar to the Clinical 
Menu the Training Mode is designed for Training Use only; the Training mode is not intended for Human Use studies. The following items are unique 
features of the Training Mode: 
 The Training mode does NOT permanently save any information to the system. Every time a user logs into the system, the Training Menu is 

refreshed and all previous changes are discarded. 

 Selecting "New Study" provides a simulation of a study. The system will NOT connect to the EnSite™ X Amplifier when using the Training Menu. 

 Selecting "Past Study" provides the ability to review studies that are imported or provided by Abbott as a Training Database. 

NOTE: Any study that is imported by the user can only be used during the current log-in session. All changes, including study imports, are 
discarded upon user log-in. 

 When reviewing a "Past Study" the "Edit Model" functionality is available to allow training on the model creation process. 

EnSite™ X EP System Setup, System Tab 
Select the Hardware Sub-tab to configure the system hardware. 

Figure 22.  Setup – System Tab – Hardware Sub-tab 

 

 

1. Select Hardware Sub-tab. 

2. Review necessary connections in hardware diagram. 

3. Configure ablation catheter types in hardware diagram as necessary. The ablation catheter types control the system components displayed on the 
system diagram screen. 

4. Troubleshoot system connections if needed (user may select individual system components in the diagram, these will highlight). Setup and 
troubleshooting instructions will appear in the screen below the diagram. 

5. The window at the bottom of the screen will display: 

- Selected Component. Any component in the hardware diagram can be clicked on, to bring up help content. A selected component is 
highlighted, indicated by a glow around the shape, and help content related to the selection appears in the section below. Clicking on a 
selected component deselects it. The highlighting disappears from around the shape, the help content below disappears, and the default 
instructional statement and legend reappear. 

- Label. Name of the selected component or connection. When a component is selected, its name appears here. 
- Hyperlinks. Clicking on a link (Description, Install, Troubleshoot) jumps/scrolls the help content to that subsection. 

6. Expand/Collapse. Expands and collapses the size of the section where help content appears. 

NOTE: If the help section is expanded, then clicking the Exit buttion collapses the section size back down to the default size. Regardless of 
whether the help section is expanded or collapsed, clicking the Exit button also deselects the component. The highlighting disappears from 
around the shape, the help content below disappears, and the default instructional statement and legend reappear. 

EnSite™ X EP System Setup, System Tab - ECG Sub-tab 
The ECG Sub-tab assumes the following pre-requisites: the ECG surface electrodes are properly positioned on the patient and connected to the 
SurfaceLink™ Module which is in turn connected to the EnSite™ X Amplifier. 



 

17 
 
 

Figure 23.  Setup – System Tab – ECG Sub-tab 

 

 

1. Select ECG Sub-tab. 

2. Visually examine signals to verify ECG signal quality. Signals should be visible for each of the 12 leads, free of high-frequency sine waves and free 
of excessive noise. If traces contain excessive noise, check all electrode and cable connections between the patient and the EnSite™ X Amplifier. 

3. Enable/disable the Noise Filter checkbox. 

4. Enable/disable Display Filter Data checkbox. If signal filtering is desired, verify that the Display Filter Data checkbox has the High Pass and Low 
Pass filters set accordingly. Refer to Filters and Settings Options Table below for a description of the filters and setting options. Use dropdown 
menus to set the low pass and high pass filters to desired values. 

5. Use Amplitude slider to adjust size of the ECG signals. 

The ECG Sub-tab assumes the following pre-requisites: the ECG surface electrodes are properly positioned on the patient and connected to the 
SurfaceLink™ Module which is in turn connected to the EnSite™ X Amplifier. 

Table 1. Filters and Settings Options Table 

Filter Descriptions Settings 

Default Setting 

ECG 
EP Catheter 

Bipolar Unipolar 

Noise Noise filters are 50-60 Hz notch filters that reduce 
powerline noise. Available settings are ON/OFF. To 
adjust the powerline frequency and filter. 

OFF, ON OFF OFF OFF 

High pass High pass filters reduce low-frequency signals (i.e., 
repolarization signals) and baseline drift. 

0.05, 0.5, 1, 2, 5, 
10, 20, 30, 40 Hz 

0.5 Hz 30 Hz 2 Hz 

Low pass Low pass filters reduce high-frequency signals 
commonly caused by electronic interference. 

500, 400, 300, 
200,100,60, 50, 
40, 30, 20, 10 Hz 

50 Hz 300 Hz 300 Hz 

 

EnSite™ X EP System Setup, System Tab - Validate Sub-tab 
The Validate Sub-tab assumes the following pre-requisites: System Reference Electrode and the EnSite™ X Surface Electrodes are properly positioned 
on the patient and connected to the SurfaceLink™ Module which in turn is connected to the EnSite™ X Amplifier. 

The EnSite™ X Surface Electrodes are single-use components. The surface electrodes must be validated before catheters can be visualized. Validation 
sets an 18-hour time-period during which the electrodes may be used during a study. 

NOTE: Re-validation will delete all 3D objects, manually placed lesions, AutoMarks, shadows, and labels from the study. Validation or re-
validation should be performed as close as possible to creating the first model, map or 3D point. 
NOTE: All controls for 3D operations are unavailable until the EnSite™ X Surface Electrodes are validated. 

CAUTION: EnSite™ X Surface Electrodes are intended for single-use only. Device integrity will be compromised by any reuse, which 
may compromise patient safety and system performance. 
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Figure 24.  Setup – System Tab – Validate Sub-tab 

 

 

1. Select Validate Sub-tab. 

2. Select Validate button. 

NOTE: Validation lasts for 18-hours. 
NOTE: The screen image does not necessarily represent surface electrode placement on the patient. It is not an indicator of actual surface 
electrode placement. 

3. Message in the bottom right corner of display will confirm validation outcome. 

4. If validation fails, troubleshoot surface electrode placement and/or EnSite™ X Amplifier connections. 

5. To troubleshoot EnSite™ X Surface Electrodes placement refer to the EnSite™ X Surface Electrodes Kit Instructions for Use for preparation and 
placement. Other troubleshooting sources are the EnSite™ X Amplifier Instructions for Use and the online help under the System Setup tab. 

EnSite™ X EP System Setup, System Tab - PRS Sub-tab 
The Patient Reference Sensors (PRS) are used in the EnSite™ VoXel™ and EnSite NavX™ modes when using sensor enabled catheters. A total of four 
(4) PRS sensors are applied when using Sensor Enabled catheters; one (1) PRS-A (anterior) sensor and three (3) PRS-P (posterior) sensors. The PRS-
A sensor is used to detect and compensate metal distortion. The three PRS-P sensors are used to establish the magnetic system reference. The PRS 
Sensors are positioned on the patient and are connected to the Amplifier using two PRS cables, PRS-A cable and PRS-P cable. Position the Field 
Frame generator and PRS patches as needed to facilitate getting all PRS sensors to a valid state. Refer to EnSite™ X Electrode Kit Instructions for Use 
for more information on how to place PRS patches and sensors. 
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Figure 25.  Setup – System Tab – PRS Sub-tab 

 

 

1. Select PRS Sub-tab. 

2. Confirm that all PRS placement conditions are satisfied. 

EnSite™ VoXel Mode and EnSite NavX™ Mode 
If the field frame is not connected these messages will appear. 

NOTE: In EnSite NavX™ mode, the user may ignore this message if they do not intend to use EnSite NavX™ SE field scaling with a Sensor 
Enabled™ catheter. 

EnSite™ X EP System will detect and notify the user if the incorrect field frame model is connected. The only compatible model is ENSITE-FF-01. Verify 
the correct field frame is connected by reviewing the label on the field frame generator. 

Figure 26.  Field Frame Detection Errors 

 

EnSite™ VoXel Mode 

Indicates that no Field Frame has been detected. 

 

EnSite NavX™ Mode 
Indicates that no Field Frame has been detected. 

 

Confirm PRS Placement 
Refer to EnSite™ X Surface Electrode Kit Instructions for Use for more information on how to place PRS patches and sensors. 

1. Confirm that PRS-P1, -P2, and -P3 are within motion field. 

2. Confirm that PRS-P1, -P2, and -P3 spacing is at least 8 cm. 

NOTE: The center of the PRS-P triangle determines the magnetic positional reference of the magnetic coordinate system. This is used to 
compensate for patient movement within the magnetic field. The system will monitor that the distances between PRS-P sensors do not 
change to ensure that the system is able to compensate for patient movement. 

3. In EnSite NavX™ mode, the distance between PRS-P pairs must not change after the first EnSite™ NavX SE point is collected. 

4. In EnSite™ VoXel mode, the distance between PRS-P pairs must not change after the first Sensor Enabled™ catheter enters the motion box. 

5. Confirm that PRS-A is within the PRS-A detection box. 
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6. Confirm that PRS-A green side is up. 

7. Confirm that PRS-A is anterior to PRS-P1, -P2, and -P3. 

Confirm that PRS-A is not inclined more than 45° relative to the patient table. 

1. Confirm that PRS-A is pointing 30° from the midline towards the left shoulder. 

2. Troubleshoot PRS placement issues as needed. 

Figure 27.  Patient Reference Sensors (PRS) Placement Examples 

 

Field Frame connected, and all conditions satisfied. 
Before the magnetic positional reference has been established 
or the first EnSite™ NavX SE point is collected in EnSite 
NavX™ mode or the first Sensor Enabled™ catheter enters 
the motion box in VoXel mode. 
After the magnetic positional reference has been established 
or the first EnSite™ NavX SE point is collected in 
EnSite NavX™ mode or the first Sensor Enabled™ catheter 
enters the motion box in VoXel mode. 

 

 

Two PRS-P (posterior) are out of the motion field. 

Any PRS outside the motion field will not be shown. To resolve 
this condition, move the PRS into the motion field or adjust the 
field frame. 
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PRS-A (anterior) is out of the PRS-A 
detection box. 
When PRS-A is out of the PRS-A detection 
box but inside the motion field, it will 
appear red. To resolve this condition, 
move the PRS-A or the field frame so that 
PRS-A is inside the PRS-A detection box 
while keeping PRS-A on top of the heart. 

 

Distance between 
two PRS-P 
(posterior) is below 
8 cm before the 
magnetic positional 
reference has been 
established. 
To resolve this 
condition, move the 
PRS sensors further 
apart (8 cm 
minimum). 

 

PRS-A (anterior) is out of the motion field. 

Any PRS outside the motion field will not 
be shown. To resolve this condition, make 
sure PRS-A is connected and move the 
PRS-A into the PRS-A detection box or 
adjust the field frame while keeping PRS-
A on top of the heart. 

 

PRS-A (anterior) is 
upside down. 
To resolve this 
condition, flip PRS-A 
so that the green 
side is up. 
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PRS-A (anterior) is not anterior to PRS-P1, 
-P2, and -P3. 
To resolve this condition, place PRS-A on 
top of the heart and all PRS-P1, -P2, and 
-P3 on the back. 

 

PRS-A (anterior) is 
inclined more than 
45°. 
To resolve this 
condition, place 
PRS-A on a flatter 
surface on top of the 
heart. 

 

PRS-A is not pointing 30° from the 
midline towards the left shoulder. 
To resolve this condition, rotate PRS-A so 
that it points as shown in the dotted line. 

 

One PRS-P has 
moved after the 
magnetic positional 
reference has been 
established. The 
distance between 
pairs of PRS-P has 
changed. 
To resolve this 
condition, adjust 
PRS-P position so 
that it returns to the 
dotted circle position. 
Alternatively, if you 
cannot return the 
PRS-P to its valid 
position you may 
reset magnetic 
positional reference 
by resetting the 
metal baseline or 
revalidating. 
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Two or more PRS-P have moved after the 
magnetic positional reference has been 
established. The distance between pairs 
of PRS-P has changed. 
To resolve this condition, adjust PRS-P 
position so that sensors return to the 
dotted circle position. 
Alternatively, if you cannot return the 
PRS-P to its valid position you may reset 
magnetic positional reference by resetting 
the metal baseline or revalidating. 

 

Two PRS-P are not 
detected in the 
motion field. Field 
Frame may have 
moved. 

To resolve this 
condition, adjust 
Feld Frame position 
so that sensors 
return the motion 
Field. 

 

EnSite™ X EP System Setup, System Tab - Metal Sub-tab 
The Check Metal Field and Set Metal Baseline must be performed to initiate the algorithm that corrects magnetic positions and simultaneously 
estimates the error due to metal distortion. Check Metal Field verifies that the metal field values match those collected during characterization when the 
C-arm was in AP on its highest position. Set Metal Baseline verifies that that the metal distortion error is less than the threshold and optimizes detection 
algorithm for the preferred C-arm height in AP. Both Check Metal Field and Set Metal Baseline must succeed prior to EnSite™ NavX SE point collection 
in EnSite NavX™ mode, or any 3D point collection in EnSite™ VoXel mode. 

1. Check Metal Field 

a. Confirm the PRS-A location is valid. 

b. Confirm that the selected lab matches the current room. 

c. Confirm that the C-arm is placed in AP on its highest position. 

d. Click "Check Metal Field" button. 

2. Set Metal Baseline 

a. Confirm that the C-arm is placed in AP on the preferred height. 

b. (Optional) Adjust metal distortion threshold level. 

c. Click "Set Metal Baseline" button. 
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Figure 28.  Setup – System Tab – Metal Sub-tab 

 

1. Indicates that the PRS-A location is valid. If the PRS-A 
location is not valid, return to PRS sub-tab to 
diagnose and fix the error. Check Metal Field and Set 
Metal Baseline will fail if the PRS-A location is not 
valid. 

2. Reminds to verify lab selection. 

3. Indicates the selected lab. 

4. Reminds to confirm that the C-arm position is in AP on 
its highest position. 

5. Check Metal Field button. 

6. Indicates the time at which the last "Check Metal Field" 
succeeded. 

7. Reminds to confirm that the C-arm position is in AP at 
its preferred distance from chest. 

8. Distortion Threshold slider. Click and drag on the slider 
to adjust the metal distortion threshold. 

NOTE: The metal distortion threshold can also be 
adjusted from the metal distortion meter. 

9. Set Metal Baseline button. 

10. Indicates the time at which the last "Set Metal 
Baseline" succeeded. 

NOTE: The metal distortion meter will automatically 
show up in the modeling and map display after "Set 
Metal Baseline" succeeds. 

 

Distortion Threshold Level 
When the distortion threshold level is exceeded, the collection of EnSite™ NavX SE points in EnSite NavX™ mode or any 3D points in EnSite™ VoXel 
mode will be suspended. In EnSite NavX™ mode, the default is Level III. In EnSite™ Voxel mode, the default and recommended threshold is Level II. 

EnSite™ X EP System Setup, Catheter Tab 
The figure below shows the full catheter setup screen. The following sections will describe the function of each area of the interface. 
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Figure 29.  Setup - Catheters Tab 

 

 

EnSite™ X EP System Setup, Catheter Tab - Amplifier Catheter Ports 
Figure 30.  Setup - Catheters Tab - Amplifier Catheter Ports 

 

 

The following icons indicate the state of a port on the amplifier. They can be active (when a catheter extension cable or CIM is plugged in), inactive 
when nothing plugged in, highlighted when a row on the Catheter List associated with that port is selected, and red (with a triangle) which indicates that 
the catheter isn’t fully defined. 

 
Grey Inactive when there no is connection detected at the port. 

 

Green Active when there is a catheter extension cable or CIM connected to the port that is fully set up. 
NOTE: only active ports are selectable. Selecting results in highlighting the associated row on the Catheter List (which 
also then causes the port to be highlighted with a halo). If a selected port has a CIM connected, and the CIM has more 
than one catheter connected to it, the first catheter on the list is highlighted. 

 
Haloed Indicates the port associated with the row that is currently selected on the Catheter List. 

 

Red The red outline and triangle indicate that a CIM or catheter is connected, but the catheter is not fully defined. 

NOTE: this can appear on both active ports (shown) and haloed ports (not shown). 

 

Green/Grey Indicates the recording system channels that are connected to the port. This can be green or grey depending if the 
recording system is connected or not. 
The numbers do not change colors. The numbers appear if the recording cable is connected and blank when not 
connected. If the image in the last row is there, then all the ports in that section should have numbers, regardless of if 
catheters are active or not. 

 

 Indicates which block of ports are connected to the recording system on the amplifier’s rear panel (catheter bank 1, 2A 
or 2B). Image shows connections at bank 1 (AmpereConnect and ports 1-4) and 2A (port 9). Bank 2B is the box 
containing port 9 for future use. 

 

EnSite™ X EP System Setup, Catheter Tab - Catheter Input Module (CIM) Display 
A graphic representation of the Catheter Input Module (CIM) will appear on the display when the CIM is connected to the Amplifier. 

WARNING: Do not connect ablation catheters to CIM modules. The CIMs are low voltage components and ablation catheters are 
high voltage. Equipment damage may occur. 



 

26 
 
 

Figure 31.  Setup - Catheters Tab - Catheter Input Modules (CIM) Display 

 

1. Catheter – Red, Green, and Blue (represents the catheter color selected by user). 

2. Catheter is selected – White fill and solid lines between pins. 

3. Not used (available) ports. 

 

Catheter Input Settings 
Right click an electrode input channel in the CIM to display the options for the catheter representation. 

Figure 32.  Catheter Input Modules Settings 

 

1. Visible checkbox 

2. Connected checkbox 

3. Set Positional Reference 
checkbox 

4. Set Distal checkbox 

 

1. Visible checkbox - Shows/hides the selected electrode. 

NOTE: 

 Making an electrode not visible will cause the system to not use the electrode’s location information for EnGuide related functions such 
as collecting model points, making map tags, or 3D mapping information. Electrograms from the electrode will be available for viewing 
and measurement with calipers, but the electrograms will have “No Location” if displayed in Mapping Acquisition Waveforms. Mapping 
points will not be taken from electrodes with “No Location.” 

 The visibility of non-functional electrodes on any catheter should be turned off. 

2. Connected checkbox - Connects/disconnects the selected electrode. When an electrode is disconnected, its channel becomes available. To 
reconnect a disconnected electrode, select the electrode on the catheter image below the CIM representation. 

3. Set Positional Reference checkbox - Allows the user to select an electrode that will remain stable during the study to be the positional reference. 
The displayed position of all electrodes is relative to the location of the positional reference. 

NOTE: Set positional reference is only available in EnSite NavX™ mode. 

4. Set Distal checkbox - Moves all electrodes on a selected catheter to new input channels. To move the electrodes, select the catheter in the 
Catheter List, position the mouse over the new distal input channel of choice, right- click and select Set Distal. The input channel positions can 
also be manually moved by selecting and dragging the displayed electrodes. 
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Assign or Reassign CIM Pins 
System automatically assigns the distal electrode to the first available channel and other electrodes in sequence. Connection to Ampere Generator using 
the AmpereConnect port is permanently pinned out to recording channels 53-56. 

1. Select a row in the catheter list. 

2. Right-click on the desired pin channel on the CIM diagram and select Set Distal. 

or 

1. Select and drag a catheter electrode to a pin channel. 

EnSite™ X EP System Setup, Catheter Tab - Catheter List 
Figure 33.  Setup - Catheters Tab - Catheter List 

 

The following describes the Catheter List Table: 

1. Individual Catheter Recording Channels 
The catheter name defaults to a number and the user can then 
define the name of the catheter. 

The List displays with expandable/collapsible tree for each catheter. 
User may scroll up and down the list. Double clicking allows the user to 
change the name. 

2. CIM (Catheter Input Module) Displays the CIM type, 20 pins. When the tree is expanded for a 
catheter connected to a CIM the CIM column displays the CIM port. 

3. Port (Amplifier Port) Displays the amplifier port in which the catheter is plugged into. 
The port drop-downs lists: ports 1-9. Once a Sensor Enabled™ catheter 
is connected to the port, the dropdown feature is removed and if a 
Sensor Enabled™ catheter is on the list but not yet plugged in, the "-" 
option is inactive. Red text is used to indicate (1) ports that are 
specified but do not have anything connected (for example after a 
preset is applied but before a catheter is connected), and (2) indicating 
that a port has something connected but it is unidentified. 

4. Recording Channels This column indicates which recording channels are being used by the 
recording system. In the case of a CIM where the ports are not pinned 
sequentially, the field lists the lowest number channel being used 
followed by an ellipsis point (that is, "…"). 

5. Connected Allows the user to connect or disconnect individual electrodes on the 
catheter. 

6. Visible Show or hide a catheter in the navigation area. 

7. Sheath Filter Turn on or off sheath filter for the selected catheter.  

8. Show Electrode Numbers Show or hide the electrode numbers on the catheter being displayed. 
Requires Show Electrode Numbers to also be selected from the Display 
Settings panel. 

9. Color Select the color the catheter is displayed as. 

10. Add/Remove a catheter from the Catheter List Select + (plus) button to add a catheter to list.  

Select – (minus) button to remove a catheter from the list: Select and 
press OK to confirm. 
Unplug catheter cable from the Amplifier port. 
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Adding and Deleting Catheters to a Study 
Catheters may be added to a study using four methods: 

1. Auto-recognition when using magnetic catheters (Sensor Enabled™ tools). 

2. Utilizing the Catheter Catalog. 

3. Manually defining Catheter parameters. 

4. Selecting a catheter preset. 

Auto-recognition of Sensor Enabled™ Catheters 
When a Sensor Enabled™ catheter is connected, the system automatically adds its attributes. 

Catheter Catalog 
The catheter catalog contains many pre-defined Abbott catheters typically used in electrophysiological (EP) studies. Users may also define their own 
catheters and add them to the catalog for future use. 

Figure 34.  Setup - Catheters Tab - Catheter Catalog 

 

 

To add a catheter to the Catheter List from the Catheter Catalog: 

1. Select the Catheter Catalog button. The catalog screen opens. 

2. Choose the desired catheter from the catalog list. 

3. Select the Add New at the lower right of the catalog screen. 

4. Choose more catheters or close the catalog screen with the Close button at the lower right corner of the catalog screen. 

To redefine a catheter already in the Catheter List using the Catheter Catalog: 

1. Highlight the catheter to be redefined in the Catheter List. 

2. Select the Catheter Catalog button. The catalog screen opens. 

3. Select the desired catheter in the catalog list. 

4. Select Apply to Current at the lower right corner of the catalog screen. "Apply to Current" takes the currently selected catheter in the Catheter 
Catalog and copies its settings to the currently selected catheter in the Catheter List. 

5. Choose more catheters or close the catalog screen with the Close button at the lower right corner of the catalog screen. 

The selected catheter’s attributes will populate the applicable property setting fields, and the catheter’s distal electrode will be automatically assigned to 
the first available input. Subsequent electrodes will be placed in consecutive inputs, if available. 
 The catheter name can be modified by double selecting on the name in the Catheter List or in the Name field (four-character limit). The name 

can also be modified by selecting a system default name from the drop-down list in the Name field. 

 Modify any editable properties, if necessary. 

NOTE: Only diagnostic catheters added using the catalog can be modified. 

Reassign any input channels, if necessary. 

Filtering and Sorting the Catheter Catalog List 
Users may scroll up and down the catheter list and select the appropriate catheter for the procedure. The catalog may contain many catheters. Several 
tools have been provided to aid in the selection of a catheter. 
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 Filter by Type: Select the pull-down menu to choose catheters by Type. 

 To sort the catalog by a column heading alphabetically/numerically, select the column heading. 

 To search for specific catheter, select the column heading type from Add Filter drop-down menu then type the desired search text in the text box. 

When the desired catheter is located, select the Add New button and it will be added to the Catheter List and the catheter parameters will be 
automatically populated. 

Manually adding a Catheter to the Catheter Catalog 
Figure 35.  Setup - Catheters Tab - Manually Adding a Catheter to the Catalog 

 

 

1. Select the + button beneath the Catheter List. 

2. Enter a catheter name (up to four alphanumeric characters) or choose a system default from the drop-down menu. 

3. Select a color for the catheter body. The color of the waveforms for the catheter defaults to the color selected for the catheter body. 

4. Select the Type. 

5. Specify the number of electrodes. When specifying the number of electrodes, the electrodes will be assigned to consecutive input channels 
starting with the distal electrode assigned to the first available channel. 

6. Specify the Diameter. 

7. Specify the Distal Length. 

8. Specify the Electrode Length. 

9. Specify the Electrode Spacing. 

10. Specify the Manufacturer. 

11. Specify the Model. 

12. Specify the Brand Name. 

13. From the Signal Order drop down menu, specify the order. 

14. From the Polarity drop-down menu, specify whether signals should be collected from paired bipoles, all possible bipoles, or all possible unipoles. 

NOTE: 

 Electrode spacing is calculated from the edges of the electrodes. 
 If a catheter is to be used to collect Model points, and Field Scaling is to be applied, the electrode size and spacing information entered 

the catheter description must match the information provided by the catheter manufacturer. 
 Model points collected with catheters that are inappropriately described may yield unexpected EnSite™ NavX™ Field Scaling results. 

This cannot be corrected by re-entering correct information after the fact. However, EnSite™ NavX™ Field Scaling is an option which 
can be unapplied if unexpected results occur. 

Catheter Signal Settings 
Signals from the selected catheters in the Catheter List appear in the waveform display. Next to each trace are the electrodes that comprise the signal. 
In the instance of a bipolar signal, two numbers will appear. The number in the left column is the negative pole, and the right column is the positive 
pole. A trace can be configured as unipolar by setting the left electrode to the dash. The unipolar reference is the System Reference by default, but can 
be set to the Auxiliary Reference in the System Menu [References] Menu. 

One or more waveforms can be selected for trace height adjustment. Traces should be smooth lines that are free of excessive noise. If traces contain 
excessive noise, check all electrode and cable connections between the patient and the EnSite™ X Amplifier. 
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Figure 36.  Setup - Catheters Tab - Catheter Waveforms Display 

 

 

Add/Remove a Trace to a Catheter 
1. Select a catheter in the Catheter List. 

2. Select "+" (plus) button (on the lower left) will add a trace. By default, it will be a unipolar electrogram configured with the distal electrode set as 
positive (right column), with the reference set as the System Reference (or Aux Ref, if chosen) (left column). 

3. You can also configure this trace as a bipole by changing the electrode configuration to any combination of electrodes on the same catheter. 

4. To remove a trace, left-click a trace and drag it out of the screen to the left, to remove it. 

Set Catheter Polarity 
1. Select a catheter in the catheter list. 

2. Select polarity from the "Polarity" drop-down menu (on the lower left) (Paired Bipole, All Bipole, Unipole). 

3. Select the "Negative Pole" icon and set it to "---" to change signal to unipolar. 

4. Select the "Negative Pole" icon and select the electrode to assign as the negative pole. 

5. Select the "Positive Pole" icon and select the electrode to assign as the positive pole. 

Manually Setting up a Bipolar and Unipolar Filters 
1. Select a catheter in the catheter list. 

2. Enable/Disable noise filter (checkbox) (on the lower left). 

3. Set High Pass filter (drop-down list). 

4. Set Low Pass Filter (drop -down list). 

Configure Miscellaneous Signal Settings 
1. Enable/Disable display of filtered data (checkbox). 

2. Select signal order (distal-proximal or primal-distal) (radio buttons). 

3. Select signal trace and adjusting height/amplitude by clicking the middle mouse button and drag up/down to adjust trace height. A regular click 
and drag will just move the signal (change the order). 

Deleting a Catheter from the Catheter Catalog 
Choose the catheter to delete from the Catheter Catalog, select the [ - ] button. 

NOTE: Only user-defined catheters can be deleted. The user cannot delete pre-populated Abbott catheters. 

EnSite™ X EP System Setup, Catheter Tab - Catheter Presets 

 

 

To Save a Preset: To save the current catheter setup as a preset, open the Preset menu in the upper- left corner of 
the control panel and select Save Preset. In the Save Preset window, type a name for the preset, and then select 
OK. 

 

To Load a Preset: To load a preset for the current physician, open the Preset menu in the upper-right corner of the 
control panel and select a preset from the list. The menu lists the presets for the current physician followed by 
presets from other physicians. Select the desired preset and then select OK. 
NOTE: Loading a preset is equivalent to: 

- Deleting all the current catheters. 

- Defining the catheters in the preset, and then updating that list with connection status from the amplifier. 
- Loading a catheter preset will clear the intracardiac system reference and then set it to the value in the 

preset. 
To Use Default or Factory Settings Presets: Select Nominal from the Preset drop-down menu. 
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To Manage Presets: Select "Manage Presets" from Preset drop-down menu. 

Rename a Preset: To rename the preset, double-click on the name then enter the new name, or select the preset to 
be renamed then select Rename. 
Delete a Preset: To delete a preset for the current physician, select a preset from the list in the Manage Presets 
window. To delete the preset, select Delete. 
Add a Note to a Preset: To add a note for the preset, type in the Note text area. When the note is complete, select 
Close. 

 

EnSite™ X EP System Setup, Navigation Tab 
The navigation tab contains Setup controls that effect catheter navigation. 

Figure 37.  Setup - Navigation Tab - EnSite™ VoXel Mode 

 

 

1. Validate button – Select to validate the surface electrodes and set the baseline for impedance measurements. 

2. Velocity Filter checkbox – Turn on/off the velocity filter. 

3. Threshold slider – Set the threshold of the velocity filter in mm/sec. 

4. Filter lockout slider. Set the time (sec) when the system will collect model points after the Velocity filter returns to below threshold.  

5. RespComp X checkbox – Select to enable respiration compensation. 

6. Collect Respiration Data – Collect RespComp X data. 

7. Update RespComp X checkbox – Select to continuously update respiration compensation. 

8. Irregular Respiration rejection checkbox – Select to suspend data collection during irregular respiration events. 

System Validation 
The EnSite™ X Surface Electrodes are a single use device. The surface electrodes must be validated before system usage. Validation sets an 18-hour 
time period the electrodes may be used during a study. Validation also sets the baseline for impedance measurements. 

A Validation should be performed as close as possible to creating the first model, map or 3D point. 
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NOTE: Validation may be performed earlier to verify electrode connections; in which case it is recommended to perform a second Validation 
just prior to creating the first model, map or 3D point. 

Velocity Meter and Velocity Filter 
The Velocity Meter shows the relative velocity of the fastest unsheathed enabled electrode of the Active EnGuide (white bar) and the velocity threshold 
(the transition between the black and grey backgrounds). The meter’s border, normally white, flashes red if the velocity exceeds the velocity threshold. 
Enable the Velocity Meter from the Meters and Display Options Setting Panel. The Velocity meter can be moved within the Model/Map display area. 

The Velocity Filter prevents model point collection during rapid catheter movements. When the velocity of any electrode used to collect model points 
exceeds a user-specified rate (threshold), the meter will highlight with a red border, the catheter electrodes will turn yellow, and model point collection is 
suspended only for those electrodes exceeding the threshold for a user-specified period of time (Filter Lockout). 

Model point collection resumes after the lockout period only if the velocity of all electrodes has returned to a value below the velocity threshold. Velocity 
Filter settings are active only during model creation. 

To display the Velocity Filter controls: 

1. Select Navigation Settings Panel or through the Navigation Tab of the Setup Panel. 

2. Select Velocity Filter checkbox to turn it on, uncheck to turn the filter off. 

3. The Velocity threshold can be set by moving the slider. 

4. Use the Filter Lockout in Seconds slider to set the collection lockout period. 

5. The velocity threshold can also be adjusted using the meter display. 

6. When the cursor hovers over the boundary line, a vertical blue line appears and can be used to adjust the threshold with the mouse. 

Figure 38.  Velocity Meter 

 

Velocity Meter - The Velocity Meter shows the relative velocity of the fastest unsheathed enabled electrode of 
the Active EnGuide Active Electrode. 
Velocity Threshold change indicator – The threshold line turns blue when the user hovers close to the 
threshold. When the line is blue a left-mouse click will adjust the Velocity Threshold. If the line is not blue, a 
left-mouse click will move the entire meter. 

 

RespComp X 
The RespComp X feature is used to compensate for catheter movement caused by a patient’s breathing. The Irregular RespComp X feature is used 
enhance 3D point collection by suspending 3D point collection and labeling functions during unstable events. It may facilitate more consistent model 
creation and improve navigation stability while mapping and placing lesion markers. 

Before RespComp X can be used, the system needs to briefly monitor the patient’s respiration to collect respiration data and calculate a respiration 
range. 

During respiration data collection, all catheters must be in stable positions; then, over a period of 12 seconds, the system collects the x-y-z coordinate of 
all located electrodes and the impedance values of all EnSite™ X surface electrodes. The system identifies respiration by a gradual rise in intrathoracic 
impedance of the EnSite™ X surface electrodes. The lowest and highest impedance values sampled during data collection define the respiration range. 
This range is referred to as the RespComp X range. 

When respiration data collection is complete, an automatic segment is recorded, and RespComp X monitors the EnSite™ X surface electrodes for the 
impedance pattern of respiration; when respiration occurs, navigation on each electrode is gradually compensated in correlation with the degree of the 
impedance change. 

When RespComp X is applied, the system will continually monitor the respiration motion of the catheters; the system gradually updates the 
compensation values throughout the study when the individual catheters are in a stable position and compensates to the end phase of respiration. 

NOTE: 

 If a new electrode is defined or catheter is introduced after respiration data collection completes, the user should recollect RespComp X 
data for the system to apply compensation to the newly added components. 

 Visibility of bad electrodes on a catheter should be turned off so RespComp X can successfully be applied to a catheter. 
 RespComp X is not applied to the Positional Reference electrode in EnSite NavX™ Mode. 
 RespComp X data can be collected at any time during a study. 

Collecting Respiration Data 
Be sure the patient is in a stable respiration pattern and that all catheters are in stable positions. 

1. Select Collect Respiration Data. Data collection takes approximately 12 seconds. During this time, a progress box is displayed. When data 
collection is complete, RespComp X is applied, and Update RespComp X and Irregular Respiration Rejection are turned on. 

2. To disable RespComp X turn off the RespComp X checkbox. The most recent compensation values are saved and can be re-applied at any time. 

Figure 39.  RespComp X Progress Bar 

 

To cancel RespComp X Data collection. select the Cancel button on the 
progress box. When RespComp X Data collection is canceled, Update 
RespComp X and Irregular Respiration Rejection are turned off. 

NOTE: If desired, a respiratory waveform computed from 
surface electrode impedances can be displayed in the 
Waveform Display and the Respiration Meter. 

 

Respiration data can be re-collected at any time during a study. The re-computed RespComp X values replace all previous RespComp X values. 

Re-collecting respiration data is recommended for any of the following situations: 
 Adding a catheter or electrodes not present during initial Respiration data collection. 

 Significant movement of the catheter within the heart (for example, left atrium to right atrium). 
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 Significant changes in respiration, such as moving the patient onto or off a ventilator. 

 Any time undesired respiratory motion is visible during catheter navigation. 

 After the user resolves any EnSite™ X surface electrode errors. 

Update RespComp X 
Update RespComp X continuously monitors respiration and adapts the compensation applied to any slow changes in the respiratory pattern. When 
Update RespComp X is turned off, the system will use the most recently collected data as the RespComp X baseline. Update RespComp X begins again 
approximately 12 seconds after being turned back on. 

Irregular RespComp X 
The Irregular RespComp X feature is used to suspend model point collection and labeling functions when the patient’s respiration falls outside of a 
percentage of the RespComp X range. 

When Irregular RespComp X is enabled, and irregular respiration is detected, the Respiration Meter outline flashes red, and all displayed electrodes 
flash yellow, and the following functions are suspended. 
 Model point collection. 

 Map labels at the Active Electrode. 

 Lesion markers at the Active Electrode. 

 Shadow at selected EnGuide. 

 Map point collection. 

 VoXels (in EnSite™ VoXel mode). 

Normal system functionality returns approximately 12 seconds after stable respiration returns. 

Uncheck the Irregular Respiration Rejection checkbox to turn off. 

Respiration Meter 
The Respiration Meter displays the respiration waveform and provides visual indication of respiration compensation. The respiration meter controls are 
in the Meter & Display Options Settings Panel. The Respiration Meter will display by default when Respiration Data has been collected. Once the 
Respiration Meter is displayed the user can right select the meter and a right select menu will appear. The options are to turn off or change the time 
length of the respiration meter display. When irregular respiration is detected the meter will highlight in red color and the portion of the waveform that is 
irregular will change to a red dashed line. 

Figure 40.  Respiration Meter and Options 

 

1. Respiration Meter – displays the respiration waveform and 
provides visual indication of respiration compensation.  

2. Right-click Respiration menu – right-click on the respiration 
meter to see the Respiration menu. 

3. 10-sec & 20-sec screen radio buttons – select a radio button to 
set the total viewable area of the Respiration meter. 

 

Respiration Data Indicator 
Figure 41.  Respiration Data Quality Indicator 

 

The Respiration Data Quality Indicator shows respiration compensation status and is in the lower right corner 
of the model display workspace panel. 

 

The table below shows the relationship of the irregular respiration rejection setting to the respiration indicators based on the respiration pattern. 

Irregular 
Respiration 
Rejection 

Respiration Pattern Respiration Meter Respiration Data Indicator 

ON Regular 

 

ON Irregular 

 

OFF Regular 
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OFF Irregular 

 

NOTE: Complete patient apnea will trigger irregular respiration approximately 10 seconds after detection of the respiration change. 

Respiration Waveforms 
Select the waveforms to display from the waveforms list. 

Figure 42.  Respiration Waveforms list 

 

1. The respiration waveforms can be enabled using the waveform 
list. 

 

Figure 43.  Respiration Waveforms Display screen 

 

1. Respiration Amplitude Waveform: the 
same data as displayed in the 
respiration meter.  

2. Irregular Respiration Waveform: "1" high 
state indicates respiration is irregular. 
"0" or low state indicates respiration is 
regular.  

3. End of Expiration Waveform: "1" or high 
state indicates end-phase of 
respiration. "0" or low state indicates 
respiration is all other cases.  

NOTE: Line turns purple if there is no 
data to calculate the respiration 
waveform. 

 

EnSite™ X EP System Setup, Navigation Tab - EnSite NavX™ Mode 
The images below show the options within the Navigation tab when operating in EnSite NavX™ Mode. 

Figure 44.  Setup - Navigation Tab - EnSite NavX™ Mode 

 

1. EnGuide Stability Monitor checkbox – Enable/Disable EnGuide Stability Monitor. 
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2. Distance Threshold slider – Controls the distance at which the EnGuide Stability Monitor triggers an alert to the user. 

3. Electrode drop-down menu – Select the System Reference (default) or intracardiac electrode for the Positional Reference Tool. 

4. Catheter in desired location checkbox – Enable to confirm that the catheter chosen for the Positional Reference Tool is in the desired location. 

5. Enable Positional Reference Tool checkbox – Enable to turn on Positional Reference Tool monitoring. 

 

Figure 45.  EnSite NavX™ Navigation Methods 

EnSite NavX™ Mode, Positional Reference Tool EnSite NavX™ Mode, EnGuide Alignment 

 

 

1. Show: Positional Reference Tool drop-down menu – 
Instructions and options to correct a Positional Reference 
Tool Catheter Dislodgement warning. 

2. Accept button – Select Accept when the positional reference 
catheter is in the desired location. 

1. Show: EnGuide Alignment drop-down menu – Instructions and 
options to use the EnGuide Alignment feature. 

2. Apply checkbox – Enable to apply the desired EnGuide 
Alignment. 

3. Accept button – Select to Accept user changes to EnGuide 
Alignment. 

4. Cancel button – Select to Cancel user changes to EnGuide 
Alignment. 

 

EnGuide Stability Monitor (EnSite NavX™ Mode Only) 
The EnSite™ X EP System can check for unexpected changes in Sensor Enabled™ EnGuide locations. If the system provides a message that instability 
has been detected, check for rate or rhythm changes, respiratory changes, or patient movement. If required, use EnGuide Alignment to adjust the 
alignment of EnGuides relative to the model. Also, check the status of the Metal Distortion Meter. If the distortion threshold is exceeded, there could 
potentially be a shift in the magnetic sensor positions caused by the presence of metal in the EnSite™ X EP System magnetic Field. 

NOTE: The EnGuide Stability Monitor only works when actively tracking Sensor Enabled™ EnGuide locations. A Sensor Enabled™ catheter 
is required to be in the body, with EnSite™ NavX SE Field Scaling applied. 

Show Positional Reference Tool (EnSite NavX™ Mode Only) 
The Positional Reference Tool is a software feature available when operating in EnSite NavX™ mode procedures with an intracardiac positional 
reference selected. This feature alerts the user when there has been acute movement of the positional reference catheter. It is designed to detect 
sudden movement of the positional reference catheter along its long axis that exceeds a preset distance threshold of 4mm. 

This feature requires that the positional reference catheter be in a stable location throughout the procedure. It is recommended that the coronary sinus 
(CS) catheter be used for this purpose. The Positional Reference Tool is intended to be used with a multi- electrode positional reference catheter and 
requires that the positional reference catheter consist of at least 4 electrodes. The Positional Reference Tool detects positional reference catheter 
movement by comparing the current position of the positional reference electrode to its past position. The Positional Reference Tool examines all the 
electrodes on the positional reference catheter to confirm that the detected movement is due to actual physical catheter dislodgement. 

By default, this feature is not enabled; however, the user can enable or disable this feature at any time during the procedure. If positional reference 
catheter movement is detected, the user is provided with several methods to manage the repositioning of the catheter. 

NOTE: The Positional Reference Tool can only be enabled if the positional reference catheter has at least 4 electrodes. If fewer than 4 
visible electrodes are defined, the Positional Reference Tool will not activate, even if the user attempts to set up and enable the feature. 

Setting Up the Positional Reference Tool (EnSite NavX™ Mode Only) 
NOTE: The Positional Reference Tool requires that the positional reference catheter be in a stable location. It is recommended that the 
coronary sinus (CS) catheter be used for this purpose. 

The Positional Reference Tool requires a minimum of 4 visible electrodes on the positional reference catheter. The visibility of bad electrodes on the 
positional reference catheter should be turned off. 

Follow these steps to set up the Positional Reference Tool: 

1. Select the positional reference catheter and positional reference electrode from the Positional Reference drop-down menu. 

2. When the catheter is in the desired position select the Catheter Desired Location checkbox. 

3. Select the Enable Positional Reference Tool checkbox. 

The system will display a progress bar while the Positional Reference Tool is being enabled. The catheter must be kept in a stable position and not 
disturbed for the duration of the Positional Reference Tool’s initialization. 

NOTE: Initializing the Positional Reference Tool takes approximately 10 seconds from the time that the Enable Positional Reference Tool checkbox is 
selected 
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Positional Reference Catheter Dislodgement (EnSite NavX™ Mode Only) 
When the Positional Reference Tool detects that the positional reference catheter has moved at least 4mm from its previous location, a message will be 
displayed. The Positional Reference Tool message gives users the option to take immediate action (select Adjust Now) or to act later (select Adjust 
Later). 

Figure 46.  Positional Reference Catheter Movement Error Message 

 

1. Adjust Now button – select to take immediate 
action  

2. Adjust Later button – select to defer action to 
a later time 

 

CAUTION: 

 Model points, mapping points, and map tags (labels, lesions, shadows, etc.) placed at EnGuide within approximately 15 
seconds prior to notification of dislodgement may not be based on the previous location of the positional reference catheter. The 
user should confirm whether these points are valid. 

 If the Adjust Later button is selected, the user must be aware that any tasks that rely on the positional reference catheter’s 
location may be affected. These tasks include collecting model points, collecting mapping points, placing labels, placing 
lesions, etc. 

 The Positional Reference Tool will not monitor positional reference catheter dislodgements if Adjust Later is selected. 
 If the system notifies the user of both a surface electrode error and a Positional Reference Tool dislodgement message, the 

surface electrode error should be addressed first. 
 If the system notifies the user of both a surface electrode error and a Positional Reference Tool dislodgement message, the user 

should verify that the positional reference catheter has physically moved after addressing the surface electrode error. 
 Sudden impedance changes of the body or catheter electrodes caused by the connection of other devices (for example, 

stimulator, defibrillator, and other devices) may trigger the Positional Reference Tool. The user should verify the movement 
before accepting the adjustment. 

Managing Positional Reference Catheter Dislodgement 
Managing the dislodgement of the positional reference catheter is done in the Navigation Setup Sub-tab or the Navigations Settings Panel. 
 If Adjust Now was selected at the time of dislodgement notification, the system will immediately enter the Navigation Setup Sub-tab. 

 If Adjust Later was selected at the time of dislodgement notification, the user will need to manually enter the Navigation Setup Sub-tab or the 
Navigations Settings Panel. 

When the Navigation Setup is entered (either by selecting Adjust Now or manually selecting the Navigation sub-tab ask in the Setup workflow) the 
display will show the current location of the positional reference catheter as well as a preview of where the other catheters will be located if the 
adjustment is accepted. A yellow sphere will surround the previous location of the selected electrode on the positional reference catheter and a dashed 
line will connect the current location of the selected electrode with the previous location of that same electrode. 

The user should assess the validity of the positional reference catheter dislodgement prior to selecting the Accept button in the Positional Reference 
Tool screen. The steps below discuss how to assess the validity of the dislodgement prior to accepting the new positional reference electrode location. 
With the Positional Reference Tool screen open: 
 Assess the position of all the catheters within the field relative to the created geometry and other known landmarks. 

Validate Against Fluoroscopy (if needed) 
If the user does not think the catheters are shown in the appropriate locations, the user can disable and then re- enable the Positional Reference Tool 
by using the check box. This will disregard the notification and will not update the position of the catheters. 

If the user does think the catheter are shown in the appropriate locations, the user has two options based on the perceived future stability of the 
positional reference catheter: 

1. Manually reposition the catheter until the positional reference electrode is back to the original electrode location. 

OR 

2. Accept the new positional reference catheter location without manually repositioning the positional reference catheter. 

If the user chooses option manually reposition the positional reference catheter, the user can use the yellow sphere and dashed line as a guide 
(catheter movement will appear damped). To return the positional reference electrode to its previous position, move the positional reference catheter 
until the positional reference electrode moves into the yellow sphere and the sphere turns green. The yellow sphere will turn green once the selected 
electrode is within 4mm of the previous location. When satisfied with the readjusted position, select Accept. This will reset the Positional Reference Tool 
with the new coordinates of the selected electrode. When the user selects Accept the new location of the positional reference catheter is set. All other 
catheters will be displayed relative to this new position. 

Figure 47.  Adjusting Positional Reference 
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1. A and B show the previous position of the positional reference catheter and electrode. 

2. C and D show the current position of the positional reference catheter and electrode. 

3. To return the positional reference electrode to its previous position, move catheter C until electrode D is within the yellow sphere, in which 
case the yellow sphere will turn green. 

4. E shows the positional reference electrode properly adjusted. 

 

If the user chooses to accept the new positional reference catheter location without manually repositioning the positional reference catheter the user 
selects Accept and the system will reset the Positional Reference Tool with the new coordinates of the selected electrode. When the user selects Accept 
the new location of the positional reference catheter is set. All other catheters will be displayed relative to this new position. The user should ensure that 
the positional reference catheter is in a clinically appropriate, stable location before selecting Accept. 

A progress bar (beneath the control panel) can be seen while the re- initialization is in progress. When complete, the system will be ready for continued 
operation. During that time, some catheters may temporarily appear to have shifted. 

Re-initializing the Positional Reference Tool takes approximately 10 seconds from the time that the Accept button is selected. 

NOTE: Whenever the user selects Accept, the positional reference must be kept in a stable position and not be disturbed for the duration of 
the Positional Reference Tool’s re-initialization. 

Show EnGuide Alignment (EnSite NavX™ Mode Only) 
In the Navigation Setup Sub-tab, select Show EnGuide Alignment to initiate EnGuide Alignment. If there are changes in catheter location that cannot be 
adapted by navigating the positional reference electrode, EnGuide Alignment allows for visually realigning the catheter to the model along the x-y-z- 
axes. 

EnGuide Alignment is used to visually adjust the alignment of EnGuides relative to the model. To align the EnGuides in the workspace, hold down the 
<Shift> key and the middle mouse button, and drag the mouse. While dragging the mouse, the EnGuides will move, but the model remains stationary. 
Use the middle mouse button to rotate the model. Use the Apply checkbox to switch between the aligned (checkbox on) and unaligned (checkbox off) 
states. When satisfied with the alignment, select Accept. 

Sheath Filter 
The Sheath Filter detects and provides visual feedback when all or part of a catheter is in the sheath. When an electrode is detected to be within the 
sheath, both visibility and data collection from the electrode will suspend. 

A sheath graphic is drawn around the proximal catheter shaft to indicate that the sheath filter is active. The EnSite™ X EP System contains initial 
baseline setting for the Sheath Filter. The user may re-baseline the Sheath Filter to optimize performance. 

NOTE: The Sheath Filter is compatible with the following 8.5F sheaths: 

 Braided Swartz Transseptal Introducer 
 Agilis NXT Introducer 
 Baylis TorFlex 
 BiosenseWebster MOBICATH 

Figure 48.  Sheath Filter States 

Disabled Enabled 

  
Inactive Blue colored sheath graphic. Sheath Filter is active 

 

Sheath Filter for a Sensor Enabled™ Catheter 
Sheath filter is automatically enabled for Sensor Enabled™ catheters. In EnSite™ VoXel mode, sheath filter cannot be disabled for Sensor Enabled 
catheters. 

A Sensor Enabled catheter may be baselined to optimize performance at any time in a procedure. See rebaseline steps below. 

Sheath Filter for a Standard Catheter 
Sheath filter for standard catheters can be enabled or disabled in both EnSite™ VoXel and EnSite NavX™ Modes and is defaulted to "Disabled". When 
enabled, Sheath Filter will use initial system default settings for operation. 

A standard catheter maybe rebaselined to optimize performance at any time in a procedure. See rebaseline steps below. 

Enable/Disable Sheath Filter (not Available for Sensor Enabled™ Catheters in EnSite™ VoXel Mode) 
1. Enabling/disabling the sheath filter for a standard catheter in the catheter list (checkbox). 

OR 

1. Right select the study workspace display. 

2. Select "Sheath Filter". 

3. Select catheter. 

4. Then select Disable/Enable. 



 

38 
 
 

Figure 49.  Set Baseline: from right-select Display menu (left) or Catheter Setup (right) 

 

 

 

NOTE: Sheath Filter set baseline function is different from the Contact Force reset force button. Sheath Filter set baseline does not require a 
contact vs. non-contact position as when using a TactiCath™ ablation catheter, but rather requires that all electrodes be out of the sheath. 
Refer to the EnSite™ Contact Force Module Instructions for Use for additional information. 

Re-Baseline Sheath Filter (Sensor Enabled™ and standard catheters, EnSite™ VoXel and EnSite NavX™ modes) 
1. Perform the baseline procedure by first positioning the catheter with all electrodes out of the sheath when the catheter is not touching tissue or 

placed within the veins. 

2. Begin the baselining procedure by selecting Set Baseline from the right-select Display Menu in the study workspace display. 

OR 

1. Right-selecting on the Sheath Filter icon in the catheter list item and selecting Set Baseline. 

2. During the baselining process, a progress bar display in the lower-right area of the window. 

NOTE: The baselining procedure may fail if the system determines that electrodes are in the sheath. If baseline fails, the system will provide 
the option to revert to the default baseline settings or collect a new baseline. 

Figure 50.  Baseline Fail Message 

 

 

NOTE: If the Sheath Filter is falsely triggering, a new baseline may be required. 

Workspace 

Realtime Mode vs Offline Mode 
The EnSite™ X EP System can display data in two modes: Realtime and Offline Review. The display mode determines which system functions are 
available and are independent from navigation aids. 

Realtime Mode allows data to be gathered, displayed, and recorded simultaneously while a patient is being studied. Patient connections to the 
EnSite™ X Amplifier are required, and the EnSite™ X Amplifier must be powered on. 

Offline Review Mode allows data from a previous study to be viewed and edited. The EnSite™ X Amplifier does not need to be connected or powered 
on. 

The functions available in Offline Review Mode are more limited than those available in Realtime Mode. The table below describes the functions that are 
available in each Mode. 

Table 2. Functions available in Realtime Mode and Offline Review Mode. 

Task Realtime Offline Review 

Setup All Shows a historical view of the study setup which is primarily read-only 

If viewing a segment or bookmark, shows the setup at the time of capture. 
If viewing the static items (Model, Model View, Images, or Animations), shows 
the final state of the setup. 
Review the ECG signals and adjust the controls. 

Shows the catheters and traces used during the study. 
Select which catheters are visible. 

Collect: Model Sub-tab All Change surface colors, names, and visibility. 
Surface editing functions are not available. 

Collect: Mapping Sub-tab Primary & Secondary View: Left Primary 
pane shows the realtime study. Right 
Secondary pane shows either Realtime 
or RealReview. (When Split Screen is 
active.) 

Open maps. 
Review map points. 
Collect points from the recorded catheter signals and locations. 

Switching to Split Screen view allows side-by-side comparison of the Review 
items. 

Lesions All Review therapy data. 

Modify lesion markers 

NOTE: Lesion markers added in offline review will be given a brown 
background in the list. 

Review All All 

Split Screen In Realtime Mode, the Split Screen In Offline Review Mode, the Review task allows recorded data from a past study 
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option allows recorded data from the 
study to be viewed. 
Primary View: Left Primary pane shows 
the realtime study.  
Secondary View: Right Secondary pane 
can show the realtime study or be 
switched to view recorded information 
(RealReview). 

to be viewed and edited. 
Primary View: Left pane shows recorded data from the past study selected in the 
Title screen.  
Secondary View: Right pane shows a different view of the recorded data from the 
same past study. 

Status Bar Blue Brown 

 

System Messages 
System messages appear near the status tray or on the desktop. The appearance and behavior of each message depends on the severity of the 
situation. System messages are logged to the system for troubleshooting purposes. There are four types of messages, as shown below. 

Type of Message Example Description 

Information 
Message 

 

Information messages are non-critical messages that appear 
temporarily in a blue screen above the status tray. They persist for 3 
seconds and then fade away. 

NOTE: Access a list of Information and Advisory 
messages displayed during the study by clicking on the 
Message Log icon in the status tray in the lower right 
portion of the screen of Realtime and live studies only. 

Advisory Message 

 

Advisory messages appear above the status tray and persist until the 
user closes the message. 

NOTE: Access a list of Information and Advisory 
messages displayed during the study by clicking on the 
Message Log icon in the status tray in the lower right 
portion of the screen of Realtime and live studies only. 

System Busy 
Message 

 

System Busy Messages display when the system is collecting data; 
during this time the system will be non-responsive to user actions. 

Warning Message 

 

Warning messages alert the user of an action that is going to occur 
and asks the user to verify the action. The message must be acted 
upon before any other action can be taken on the system. 

NOTE: Some warning messages can be disabled by 
checking the "Do not show this message again" box; 
once this box is checked and the user clicks OK, the 
message will no longer display for the remainder of the 
study session. 

 

Using the Mouse 
EnSite™ X Specific Mouse Actions. 

Right-click – Move the mouse pointer over a specified feature and press the right mouse button once and release to display any context-sensitive 
menus. 

Rotating, Panning, and Zooming 
 Use the mouse to rotate, pan, and zoom a model/map. 

 To rotate the model/map in any direction, use the middle mouse button to click and drag in any direction. 

 To rotate the model/map clockwise or counterclockwise, hold down <Ctrl> or <Alt> and middle-click and drag clockwise or counterclockwise. 

 To pan (move vertically and horizontally) the model/map, hold <Shift>, middle-click, and drag. In Dual View, panning works independently for 
each model/map. 

 To zoom the model/map in and out at the center of the map display, rotate the mouse middle wheel. In Dual View, zooming works independently 
for each model/map, unless synced/F3 is active. 

 To zoom the model/map in and out at the mouse pointer position, hold down <Shift> and rotate the mouse middle wheel. In Dual View, zooming 
works independently for each model/map, unless synced/F3 is active. 

Selecting and Adjusting Waveforms 
Use the mouse to select and adjust waveforms: 
 To add a temporary isoelectric line, left-click and hold on the waveform. 

 To add a permanent isoelectric line to a waveform, select the waveform, hold down <Shift> and left-select the waveform.  

 To move a waveform, left-select the waveform and drag up or down. 

 To remove a waveform from the waveform display, left-select the waveform and drag it off the left edge of the screen. This functionality does not 
work in the Acquisition Waveform Display. To remove a waveform in the Acquisition Waveform Display, unselect the checkbox in the Signals tab 
of the Mapping Settings Panel. 
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 To adjust the amplitude of all waveforms, middle-select the waveform and drag up or down to increase or decrease the amplitude. Waveforms of a 
specific signal type are ganged so the amplitude for all will be adjusted. 

 To adjust the amplitude of a single waveform, hold down <Ctrl> then middle-click and drag the waveform up or down.  

 To pan a waveform in the Acquisition Waveform Display, hold <Shift>, middle-click, and drag left or right. 

 Right click in the black background for waveform options menu: 

- Sweep Speed – Adjusts the number of mm/sec. in the waveform display (time scale). 
- Reset Offsets – Evenly spaces all visible waveforms vertically in the waveform display, without changing the order of the display. 
- Reorder Waveforms – Rearranges the waveforms according to the trace number and types as defined by the order in the Waveforms Tab of the 

Catheters and Waveforms Settings Panel. 
- Font Size – Used to select a font size for the label text in the waveform display. 
- Thickness – Used to adjust the thickness of all waveforms in the waveform display. 
- High/Low Lines – Used to display the peak-to-peak values of the roving signal. Options include displaying the High/Low Lines on all roving in 

signals, only on the distal roving signal, or not displaying the High/Low Lines.  Only available in the Acquisition Waveform Display. 

Adjusting the Torso View Using the Keyboard 
"A" and "D" rotate the view about the torso’s vertical axis. 

"W" and "S" tip the view forward and backward about the torso’s horizontal axis (through its left and right sides). 

Workspace Orientation 
Organization of the application Workspace provides a Model/Map display, Waveform display areas, a Control Panel, Top bar, and Bottom bars. 

Figure 51.  Workspace Orientation 

 

 

1. Top bar The top bar presents the mode type, date/time information, display options, links back to setup screens, and provides 
access to the Settings Panels. 

2. Model/Map Display The area where catheters, three-dimensional models, and/or maps are displayed. 

3. Waveform Display A waveform display area. 

4. Waveform Display A waveform display area. 

5. Bottom bar The bottom bar contains the application menu as well as icons that indicate the status of various system components, 
system information and access to controls for recording segments. 

6. Control Panel The Control Panel provides access to the Work Panels:  

- Collect 
- Map Points 

- Lesions 
- Review 

7. Waveform Display  A waveform display area. 

 

Top Bar 
The top bar presents the Navigation mode type (VoXeL or NavX), date/time information, display options, links back to setup screens, and provides 
access to the Settings Panels. 
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Figure 52.  Top bar 

 

 

1. Study mode Type  Displays the current mode Type (EnSite NavX™ or EnSite™ VoXel). 

2. Date/Time Stamp  Displays the current Date and Time. 

3. Display Options  Provides the user with the ability to change the model/map display.  

4. Access to Setup Link  Provides access to setup screens (Patient/Study Details, Hardware Map, etc.) 

5. Settings Panel Access 
Icons 

Provides access to the configuration settings/options for each panel.  

- Meter & Display Options  

- Catheter & Waveforms  
- Model, DIF & Fusion Options  

- Map Settings  
- AutoMark & Contact Force  

- Navigation 

Figure 53.  Display Options 

 

 

1. Auto Correct Model Visibility - Centers the model back into view, and resets display settings. 

2. Clean Up Display - Temporarily hides meters, metrics, and orientation options. When in Full-screen mode also hides the Points and Tools panel. 

3. Mobile Work Panel - Shows or hides the Mobile Work Panel. 

4. Single View / Split View Toggle - Switches between single and split screen views. 

5. Full Screen Toggle - Hides the Work Panel and displays the Model/Map area in full screen mode. 

Model and Map Display Window 
The area where catheters, three-dimensional models, and/or maps are displayed. The following sections will review each item displayed within the 
Model/Map display screen. 

Figure 54.  Map and Model Display Window 

 

 

Mapping and Model Window Control: Single, Dual, and Stacked Views. 

Dual View & Stacked View allow the user to display two views of the same map. 
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Figure 55.  Mapping and Model Window Dropdown Menu 

 

 

In Dual or Stacked View, the active view is highlighted by green corners, Dual View shown below. To make the other view active, click once on the black 
background of the non-highlighted view. 

The following functions are available only for the highlighted, active view: 
 Using the mouse to rotate the model. 

 Adjusting the clipping plane. 

 Adjusting the view scale. 

 Saving or loading a model/map View. 

NOTE: Using the mouse to delete surface points or place map labels, lesion markers, anatomic markers, or tape measures can only be 
done in the highlighted view; however, the result of these actions appears in both model/map display areas. 

Figure 56.  Map and Model Dual View 

 

1. Primary model/map display area The left side of the model/map display when dual view is selected. 

2. Secondary model/map display area The right side of the model/map display when dual view is selected. 

3. Active model/map display area Framed with green brackets. 

 

 

Views and the Orientation Reference 
The current rotation of the display is indicated by the orientation reference icon in the upper right of the model or map display. A view is a saved 
orientation of a model or map (rotation and panning) that is accessible by clicking a button.  

Four predefined views and up to three custom views are available. The predefined views are AP, LAO, RAO, and PA. The three custom views are user-
named. 

To access the view controls and the orientation reference settings, right-select the orientation reference icon. 
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Figure 57.  Orientation Reference Icon 

 

Right-select the orientation reference icon to open the views and 
orientation reference settings right-click menu 

 

Figure 58.  The Views and Orientation Reference Right-click Menu 

 

1. To save the current view and settings as a custom view, 
select Save Views from the right-click menu.  

2. In the Save View screen, select View1, View2, or View3, 
and then rename the view if desired.  

3. The custom view name will be added to the right-click 
menu.  

4. Up to three custom views can be created.  

5. The custom views are independent and do not 
compute automatically. 

6. Perspective On - Perspective View displays distant 
objects appearing smaller than close objects, thereby 
enabling improved visualization of the 3D image with 
a clearer representation of the catheter positions. 
When Perspective On is selected, zooming in on the 
map view transforms a view of the outside surface to 
that of the inside surface of a chamber. When 
zooming out, the view of the inside surface, likewise, 
changes back to a view of the outside surface of the 
chamber. In Dual View, Perspective On works 
independently for each model/map display. 

7. Show Torso - Shows/hides the orientation reference 
icon. 

8. Recenter on View Load – When switching between 
views; AP, PA, LAO, RAO, the image is recentered. 

9. Synchronize Dual-views - When in Dual View, turn this 
checkbox on to synchronize the orientation of the two 
views and allow both models or maps to be rotated at 
the same time. 

 

Creating and Saving Map Views 
NOTE: If a DIF model is highlighted, map views cannot be saved unless registration has been applied using the 
EnSite™ X Fusion Registration Module. 
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Figure 59.  Save View/View Angles screen 

 

To save the current view and set as the AP view, select Save New AP 
View from the right- click menu. Saving the AP view automatically saves 
the LAO, RAO, and PA views. In the default settings, LAO is set at -45 
degrees from AP, and RAO is set at 30 degrees from AP. These angles 
can be adjusted using the LAO Angle Setting and RAO Angle Setting 
slider bars under the "View Angles" tab, or the up and down arrows on 
the keyboard or by manual text entry. 
For EnSite™ X studies, the orientation reference and AP view are 
automatically established at the time of system validation. If a model is 
created, and LAO and RAO are undefined, the LAO and RAO views are 
automatically established when the model is completed. Saving AP, LAO, 
RAO, or PA views also adjusts the orientation reference. The system does 
not overwrite custom views. 

 

Orientation Toolbar 
The Orientation Toolbar provides one-click access to several model/map views. 

Figure 60.  Orientation Toolbar 

 

1. Zoom Level – Adjust the zoom level of the surfaces. 

2. Surface Translucency – Adjust the translucency of the image for optimal visualization of objects behind other 
surfaces. 

3. Edge Enhancement – When enabled, provides a rendering of the model where the body can be translucent, but the 
edge remains distinctly defined. 

4. Clipping Plane – Clipping planes allow for a view of the interior and rear of the closed model by cutting a plane away 
from the viewing space. The slider provides a smooth, controlled way of adjusting the clipping plane. Unlocking 
the Clipping Plane deletes it. 

5. Lock Clipping Plane – Clipping planes can be locked in the model/map display window. When locked, the 
orientation remains fixed relative to the model. When unlocked, the orientation is parallel to the screen. To change 
the orientation of a locked clipping plane, unlock it, rotate, and lock it again. 

6. Center of Surface – Select to center the model/map display at the center of the surfaces being displayed. 

7. Center on Active Electrode – Select to center the model/map display on the active electrode. 

8. AP View – Anterior Posterior view shortcut.  

9. LAO View – Left Anterior Oblique view shortcut. 

10. RAO View – Right Anterior Oblique view shortcut. 

11. PA View – Posterior Anterior view shortcut. 
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Right-click Menus for Mapping/Model Window 
Figure 61.  Center Model At Sub-menu. 

 

1. Center of Surface(s) – Centers the model 
within the view. In Dual View, it works 
independently for each model. 

2. Surface Point – Centers the model at a 
selected point. When Surface Point is 
selected, the cursor changes to a red box 
with a dot in the center. With a left 
mouse click, select the point of interest 
on the model. The view is re-centered to 
this point, and a small marker appears at 
this point. Exit this mode by selecting off 
the model surface. 

3. Active Electrode – Centers the map display 
to the active electrode. 

4. Catheter Tip – Centers the model on the 
desired EnGuide. 

 

The translucence sub-menu supports the image integration of co-located models, surface translucency can be applied independently to each surface or 
group. Translucency is applied to All Surfaces (both EnSite and DIF) as the default setting. 

Select the Translucence menu item, then select one or more options. 

Figure 62.  Translucence Sub-menu. 

 

1. All Surfaces – Enable to apply 
translucence to all surfaces (EnSite and 
DIF) equally. 

2. Per EnSite Surface – Enable to apply 
translucence to each EnSite surface 
independently. 

3. Per EnSite Group – Enable to apply 
translucence to each EnSite Group 
(Right, Left, Other) independently. 

4. All EnSite Surfaces – Enable to apply 
translucence to all EnSite surfaces 
equally. 

5. Per DIF Surface – Enable to apply 
translucence to each DIF surface 
independently. 

6. All DIF Surfaces – Enable to apply 
translucence to all DIF surfaces equally. 

 

NOTE: When one of these modes is selected, adjustment of the translucency slider in the map display will apply to the surface, DIF, or 
Group currently selected within the Model or DIF list. 

Map Point Count Display 
Figure 63.  Map Point Count Display 

 

1. Displays in the Map and Model Window showing the 
points used and total points in the current map 
creation. 

2. Name of the Map, drop-down menu. 

3. Screen change drop-down: dual view, single view, 
stacked view. 

 

Display Meters 
The following meters display in the Model/Map area. Visibility controls are located in the Meters and Display Options Settings Panel. Refer to the Meters 
and Display Options Settings panel for more information. 

Figure 64.  Velocity, Respiration and Distortion Meters 

 

Velocity (mm/s) meter – A meter that shows the relative velocity of the Active Electrode and the 
velocity threshold.  
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Respiration meter – A meter that shows the current respiration pattern.  

 

Distortion (mm) meter – Indicates the level of possible interference of the magnetic field due to the 
proximity of a metal object.  

 

Display Views 
Figure 65.  Split and Full Screen Views. 

 

 

The Split View toggle allows the user to display combinations of Realtime and Review maps, generated with the same or different mapping points. The 
user can: 
 Display the same map side-by-side in Realtime and Review workflows. 

 Display two different maps, each generated with the same or different mapping points. 

 Display one Realtime map (primary display) and one Realtime or Review map (secondary display). 

NOTE: To visualize different screen arrangements, try a different screen layout preset. 

Figure 66.  Split Screen View 

 

1. Primary Display: Click in this display to make it active. 

2. Secondary Display: Click in this display to make it active. 

3. Adjustment Bar: Click and drag to resize the display areas. 

4. Yellow highlight around the active display. The Control Panel works with the active display. 

5. Mapping waveform display. 

6. Realtime/Review: Switch between Realtime or Review Mode. 

 

Mobile Panel 
Provides access to Detection Sources and AutoMap Thresholds to support simultaneous workflow of mapping, therapy tasks, and full screen view. 

To display the panel, the user selects the Mobile Work Panel button in the Display Options. 

The Mobile Panel can be displayed on the screen in either Standard, Split-screen or Full Screen mode and can be positioned within the model space as 
desired. It is dismissed from view using the close icon in the top right corner of the panel or re-clicking the mobile work panel button within the Display 
Options area. 
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Figure 67.  Mobile Panel – Detection Sources Tab 

Cardiac Triggered Reference Non Cardiac Triggered Reference 

  
Reference the Collect Tab Mapping Sub-tab for description of functionality. 

 

Figure 68.  Mobile Panel - AutoMap Thresholds Tab 

Cardiac Triggered Reference Non Cardiac Triggered Reference 

  
Reference the Collect Tab Mapping Sub-tab for description of functionality. 

 

Waveform Displays Window Control 
Only one waveform type can be displayed in any given screen at a time.  

Example: If Acquisition Waveforms are displayed in the top right screen, then waveforms and generator waveforms can only be shown in the other open 
screens.  

A different right-click sub menu opens for each of the waveform types. 

NOTE: Only one Realtime Waveforms display can be shown at a time, even when in Split Screen mode. The second Waveforms display will 
revert to a blank screen showing that the Waveforms content has been selected, and it will fill the screen when it can (if the display group is 
changed to show review data, or the Waveforms display from the other realtime display group is closed). 

Figure 69.  Waveform Display Controls 
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1 

 

Generator Waveforms: Displays Force and Ablation Generator waveforms  

2 

 

Waveforms: Displays the active electrode signals and respiration waveforms 

3 

 

Acquisition Waveforms: Displays the acquisition waveform 

4 

 

The two Split Screen buttons open a second horizontal or vertical display group to the right of the original displays. 
The layout and content choices will be copied from original displays into the second display group. 

5 

 

Select the "X" at the upper-right corner of the screen to close the screen. 

 

Bottom Bar 
The bottom bar contains icons that indicate the status of various system components, system information and access to controls for recording 
segments. 

Figure 70.  Bottom bar 

 

 

1. Application Menu  Provides access to system level controls. 

2. Segment Recording Enables Segment Recording start/stop toggle, AutoMap and AutoMark Sessions 
checkboxes, and segment naming. 

3. REF ECG info Display of REF ECG info. 

4. System Components Displays the active system components. 

 

Component Status 
Figure 71.  Component Status icons 

 

1. Messages icon – Accesses messages in the system. 

2. EnSite Derexi icon – Software features that uniquely 
integrate the WorkMate™ Claris™ Recording System 
with the EnSite™ X EP System. 

3. Ampere icon – Ampere Generator. 

4. TactiSys Quartz icon – Shows the measurements of the 
contact force sensor. 

5. SJM™ Connect icon – Provides access to the 
SJM™ Connect configuration dialogue. 

 

EnSite™ X Application Menu 

 
The menu bar provides access to system-level controls. All active menu bar and menu options for the current operating environment 
(Realtime/Offline) are displayed in white lettering. Options not available for the current operating mode are shown in gray lettering. 
Selecting a menu will display a column of additional options. Menu options followed by three periods "..." will display a window when 
selected. 

 

Menu Option Sub-menu Option Function 

Study and Patient 
Information 

 Displays the Study and Patient Information Screen 

Save Bookmark ...  Create and save a bookmark to the notebook 

Save Image …  Capture and save still images 

Save Event ...  Create and save a timestamped comment to the notebook 

Load DIF …  Import a three-dimensional model created from digital images sources such as CT or MRI for display in 
the EnSite™ X EP System 

Eject External Media  Eject a CD/DVD from the DWS 
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Menu Option Sub-menu Option Function 

Amplifier  Access EnSite™ X Amplifier controls 

 Power Line Power line frequency; 50 or 60 Hz 

 Log Access the EnSite™ X Amplifier log 

 Reconnect Initiate communication between DWS and EnSite™ X Amplifier 

 Reset Amplifier Reset and self-test the EnSite™ X Amplifier 

 Magnetic Field 
Enabled 

Turn on or off the EnSite™ X Field Frame 

Validate  Validate the EnSite™ X surface electrodes for use 

Reference    

 Unipolar Reference Select the unipolar reference for a study 

Hotkeys   

 Synchronize Split 
Screen 

Synchronizes the two screens so that both models pan, zoom, rotate, spin, and change perspective 
together. 

 Record Record/Stop recording. 

 Collect Respiration 
Data 

Collect RespComp X 

 Add Lesion at 
EnGuide 

Add a lesion at the Active Electrode. 

 Add 3d Lesion at 
EnGuide 

Add a 3D lesion at the Active Electrode. 

 Stop All Collection Stop all data collection 

 AutoMap Start/Stop Start/Stop AutoMap feature 

 Freeze Freeze and save a mapping point 

 Cancel Discard the collect point 

 Step Forward Moves the cursor to the right (forward) 

 Step Backward Moves the cursor to the left (backward) 

Help   

 Quick Help Display a list of quick actions and shortcuts. 

 About Display hardware and software version information, copyright information. 

End Study  End the current study and Logout. 

 

Control Panel 
The Control Panel provides access to the Work Panels, Point Collection functions, the Active EnGuide options and the Points and Tools Panel. 

The controls most often used during the work flow of a study are in the "Work Panel". Tasks are arranged from left to right in the order of typical work 
flow. Panel content displays below each workpanel. 

The controls and settings less often modified during a case, (typically those configured with presets,) are grouped into the Settings Panels. The contents 
of a Settings Panel temporarily replaces the Work Panel when an individual control is accessed. Panels are minimized using the ‘Close’ icon, or when 
another panel icon is selected. Once Settings Panels are closed, the Work Panel returns to view. 

Work Panels Description/Navigation 
Figure 72.  Work Panels Tabs 

 

 

1. Collect Work Panel The Collect Work Panel provides access to the features and activities associated with creating 
geometry models and maps. 

2. Map Points Work Panel The Map Points Work Panel provides access to the features and activities associated with the 
Points list and point display options. 

3. Lesions Work Panel The Lesions Work Panel provides access to the features and activities associated Lesion lists, 
lesion properties, and AutoMark metrics options. 

4. Review Work Panel The Review Work Panel provides access to the features and activities associated Recorded 
notebook entries. 

 

Settings Panels Description/Navigation 
The Settings Panels contain controls and settings less often modified during a case. Presets can be managed from the settings panels and are context 
sensitive. When the user is within any specific Settings Panel, the user may manage the presets for that Settings Panel only. 

Figure 73.  Settings Panel Icons 
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Panel Sub-Menus or Controls 

1. Meters and 
Display Options 

Layout options - size, location and content of waveforms and map display. 

Display options for meters, filters, model and map display settings, Contact Force display, EnGuide display options, 
zoom and color contour. 

2. Catheter and 
Waveforms 

- Specifications 
- Attributes 

- Setup 

- Signal Settings 
- Waveform Attributes 

3. Model Surface 
Properties, DIF 
and Fusion 
options. 

- Model 
- DIF 

- Fusion 

4. Mapping and 
Signals 

- Settings 

- Map Appearance 
- Map Display 

- Points/Labels 

- Detection Settings 
- AutoMap Thresholds 

- Signals 

5. AutoMark & 
Contact Force 

- Metrics 

- Placement Settings 
- Visible Thresholds 

- CF Display 

- CF Stability 

6. Navigation Setup 
options 

- Metal Distortion 

- Velocity Filter 
- Respiration Compensation 

 

Points and Tools Panel 
The Points and Tools Panel provides access to the Point Collection buttons; the Active EnGuide option menu; a link to the Tools Tag list; the Tool 
selection menu and options. 
 Points and Tools Panel is available in Full-screen mode, it can be located by dragging to desired position but cannot be dismissed. 

 The Cursor display is mapped to the selected Tool. 

Figure 74.  Points and Tools Panel 

 

1. Start/Stop Model button – Select to begin 
anatomic model point collection – select again 
to stop anatomic model point collection. 

2. Start/Stop AutoMap button – Select to begin 
automatic mapping point collection — select 
again to stop automatic mapping point 
collection. The user can also start/stop the 
AutoMap feature by using <shift> + <F11>. 

3. Stop All button – Select to stop automatic 
mapping point collection AND stop anatomic 
model point collection. 

4. Active EnGuide Option – Select the drop-down 
list to choose the Active EnGuide and 
Electrode. 

5. Tools Menu – Displays the currently selected tool 
and tool options. Select the drop-down list to 
select a different tool or use the following 
keyboard shortcuts for Tool selection: 

a. <P> - Pointer 

b. <R> - Rotate/Pan 

c. <H> - Shadow 

d. <M> - Marker 

e. <T> - Tape Measure  

f. <C> - Caliper 

g. <B> - Label  

h. <L> - Lesion  

6. Tools Tag list – Displays a list of items associated 
with the currently selected tool. The Tools Tag 
list can also be accessed by the hotkey <O>. 
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Tools Description 
Tools Menu 
The Tools menu displays the currently selected tool and tool options. Select the drop-down list to select a different tool or use keyboard shortcuts for 
Tool selection. For each tool the menu will show the relevant tool options as summarized in the Tool descriptions below. 

Tools Tag List 
The Tools Tag List are independent of the current Work Panel and is accessed by clicking the Tools Tag List icon in the Points and Tools Panel or by 
using the hotkey <O>. By default, the list displays above the palette but can be repositioned within the Model and Waveform space. Lists are associated 
and displayed based on the currently selected tool. When a different tool is selected with the option menu, or with a keyboard shortcut, the list responds 
to the new selection and displays the related list. 

Helpful tips for the Tools Tag List include: 
 Lists can be relocated and dismissed in either standard mode or full screen mode. 

 Right-click options are provided and accessed from the lists. 

 Row selection is not retained when Tool is changed, or list is dismissed from view. 

 List permits name changes for individual rows. 

Tools Description 
This section will review the Tool function, Tools List, and Tools Menu for each of the Tools within the Points and Tools Panel. The tools are split into two 
categories: 

1. Tools that have an associated Tools List. 

2. Tools that do not have an associated Tools List. 

Tools that do not have an associated Tools List will be described first. 

Pointer, Rotate/Pan, and Caliper Tools Overview 
The Pointer, Rotate/Pan, and Caliper Tools do not have associated lists; the list box displays instructional text related to the tool use. 

Tool Name Pointer Tool Rotate/Pan Tool Caliper Tool 

Hotkey <P> <R> <C> 

Tool Cursor 
display 

   

Tools List and 
Tool Menu 

   

Tools List 
Instructional 
Text 

Zoom 
Scroll the middle mouse wheel/button to 
zoom in or out. 
Rotate 

Select the middle mouse wheel/button 
and drag the mouse to rotate. 
Pan 
<Shift> + <click> the middle mouse 
button and drag mouse to pan. 

To Rotate Left click and drag mouse in 
desired direction 
For clockwise/counter-clockwise rotation, 
<Ctrl> + <click> and drag mouse in desired 
direction. 
To Pan Horizontally or Vertically 
<Shift> + <click> and drag mouse in 
desired direction. 

To place a caliper, select the pause button 
beneath the waveform, then select the 
beat of interest in the waveform display. 
To move the vertical lines of a caliper, left-
click and drag the line left or right. 
To move the entire caliper, middle-click 
and drag the caliper left or right. 
To move the horizontal line of a caliper, 
left-click and drag the line up or down. 
To remove a caliper, left-click and drag 
the caliper past the top or the bottom of 
the waveform display. 

 

Pointer and Rotate/Pan Tools Details 
The Pointer and Rotate/Pan tools are basic tools that allow the user to rotate, pan, and zoom the surfaces within the Map/Model Display Window. 

Caliper Tool Details 
A caliper is a set of two vertical lines with a horizontal line between them. The time between the vertical lines is displayed above the horizontal line in 
milliseconds (ms). The frequency is displayed beneath the caliper measurement in Hertz (Hz). 
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Ten calipers can be placed in a recorded segment, and ten per mapping point in the Mapping Acquisition Window. The calipers in the Mapping 
Acquisition Window are saved with the points. Calipers placed in a recorded segment are not saved. 

Calipers move with the waveform display. When a vertical line or caliper moves outside of the display area, a small arrow appears at the edge of the 
screen. This arrow can be left-clicked to select the vertical caliper line then dragged to bring the caliper back into the waveform display. The relative 
caliper position also appears in the segment overview. 

Shadow, Marker, Tape Measure, Label, and Lesion Tools (Map Tags) Overview 
Map Tags is a general name to describe 3D annotation types which include EnGuide shadows, anatomic markers, tape measures, labels, and lesion 
markers. The properties of Map Tags are similar therefore the descriptions will be grouped with the unique tool features highlighted below. 

Tool Name Shadow Tool Marker Tool Tape Measure Tool 

Hotkey <H> <M> <T> 

Right-click 
Menu 

To use the right-click menu in the display area, select the tool from the Tools drop-down list on the Points and Tools panel (or use the 
HotKey combination), right-click in the display area to display the tools menu, and then select one of the tool functions. 

Tool Cursor 
display 

   

Tools List and 
Tool Menu 

   

 

Tool Name Label Tool Lesion Tool 

Hotkey <H> <M> 

Right-click Menu To use the right-click menu in the display area, select the tool from the Tools drop-down list on the Points and Tools panel (or 
use the HotKey combination), right-click in the display area to display the tools menu, and then select one of the tool functions. 

Tool Cursor display 

  

Tools List and Tool 
Menu 
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1. Name (list column) – Map Tag 
Name. 

2. Visibility (list column) – Use the 
visibility checkbox to show/hide 
the item. When the checkbox is 
selected, the Map Tag is 
visible. To hide the Map Tag, 
deselect the checkbox. Hiding 
an item does not delete the 
item. 

3. Show/Hide Selected checkbox 
(list column) – Shows/hides the 
selected Map Tag. The Map 
Tags are only hidden, not 
deleted. 

4. Show [Map Tag] Text checkbox 
– Shows/hides the text 
associated with the selected 
Map Tag. 

5. Show All [Map Tags] button – 
shows all instances of the 
selected Map Tag. 

6. Delete button – Deletes the 
selected Map Tag(s) from the 
map and the Tools List. 

7. Shadow at Drop-down selection 
– Use the dropdown to select 
to shadow at a single EnGuide 
from the list or All EnGuides. 

8. Name – Select from dropdown 
list or enter manually. 

9. Add Shadow Button – Select to 
place the Shadow(s) based on 
the user selection. 

10. Area – Calculated Area of the 
Marker Tool. See the Marker 
Details section for additional 
information. 

11. Move [Map Tag] Button – Use 
this button to modify the 
location of the selected Map 
Tag. Only Map Tags placed at 
mouse can be moved. 

1. Color selection – Choose the desired 
color for the selected Map Tag. 

2. Cutout checkbox – Show/hide the center 
of a closed Marker. 

3. Thickness value – Adjust the thickness of 
the Marker line. 

4. Complete Marker Button – Select to 
automatically finish the current Marker 
creation. 

5. Distance (mm) (list column) – Displays 
the measured distance (in mm) 
between points on the model of the 
endocardial surface. See Tape Measure 
Details for additional information. 

6. Type – Select the type of Tape Measure. 
Surface radio button – connects two 
selected points on the map with the 
shortest possible line along the 
endocardial surface. 

7. Straight Line radio button – connects two 
selected points on the map with a 
straight line. 

8. 3D icon (list column) – Use the 3D 
checkbox to show a Map Tag as 3D 
Map Tag or project the Map Tag to the 
model surface. When the checkbox is 
selected, the Map Tag will be shown as 
a 3D Map Tag in space. 

9. Project Selected [Map Tag] checkbox – 
Changes a Map Tag’s Projection. A Map 
Tag placed with the [Map Tag] at 
EnGuide button is already projected. To 
move the Map Tag to the original 3D 
location where the Map Tag was 
placed, deselect Project Selected [Map 
Tag]. A Map Tag placed with the 3D 
[Map Tag] at EnGuide button is placed 
at the Active Electrode. To project the 
Map Tag onto the closest surface, 
select Project Selected [Map Tag]. 

1. Text Shows Through Map checkbox 
– Makes label visible regardless of 
the map/model orientation. 

2. Projection slider – Sets the maximum 
distance for automatic projection to 
surface of a Map Tag placed at 
EnGuide. Map Tags beyond this 
distance from the model surface 
will be shown at the 3D location. 
The projection slider applies to all 
applicable Map Tags. 

3. Add at EnGuide Buttons – Select 
button to add a Map Tag at the 
model surface or 3D Map Tag at 
EnGuide. 

4. [Map Tag] button – Select to add 
Map Tag at EnGuide. This option 
projects the Map Tag based on the 
projection slider value. 

5. [3D Map Tag] button – Select to add 
3D Label at EnGuide. 

6. No. (list column) – Numeric name of 
a Lesion Marker based on order of 
Lesion placement. 

7. Color selection (list column) – 
Choose the desired color for the 
selected Map Tag. 

8. Annotation (list column) – Select 
field to manually enter annotation 
text for individual Lesions. 

9. Diameter value – Adjust the diameter 
of the lesion. 

 

Selecting and Modifying Map Tags 
To select Map Tags in the Model/Map Display: 
 To select a single Map Tag, select the tool from the Points and Tools Panel or via the hotkey, hold down <Shift>, and then select the Map Tag’s 

name. 

 To select multiple Map Tags of the same type, select the tool from the Points and Tools Panel or via the hotkey, hold down <Ctrl>, and then select 
each Map Tag. Alternatively, after selecting the tool, hold down <Shift> or <Ctrl>, hold down the left mouse button, and drag a box around the 
Map Tags. 

To deselect a Map Tag(s) in the Model/Map Display: 
 Hold down <Shift> and click away from the Map Tag’s name. 

NOTE: 

 When a Map Tag is selected, the color of its name changes to white or red in the model/map display area. 
 Multiple Map Tags can only be selected if they are of the same type (such as labels, anatomic markers, tape measures lesion markers, 

and EnGuide shadows). 

To select Map Tags in a Tools list: 
 To select a single Map Tag in the list, select the Map Tag in the list. 

 To select multiple Map Tags in the list, hold down <Ctrl> and select each Map Tag. 

 To select multiple consecutive Map Tags in the list, hold down <Shift>, select a Map Tag, and then select another Map Tag. Alternatively, select a 
Map Tag and drag to select additional consecutive Map Tags. 

NOTE: When a Map Tag is selected, the color of its name changes to white in the model/map display area. 

To modify a Map Tag(s): 
 Select the Tools List icon to open the Tools List. 

 Select a Map Tag(s) using one of the selection methods above. 
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 Use the options in the Tools List screen to modify available options. 

Map Tag Colors 
The color of a Map Tag indicates the type of Map Tag and/or relationship to the surface. 

Figure 75.  Map Tag colors 

 

- Green indicates that the Map Tag is on the nearest surface. 
- Amber indicates that the Map Tag is on the surface, but something is 

obstructing the Map Tag. This could indicate that the Map Tag is on 
the far side of the model or behind an object such as an EnGuide 
electrode. 

- Blue indicates that the Map Tag is not tied to the surface (such as 
3D labels, 3D Lesions and EnGuide Shadows). 

- White indicates that the Map Tag is selected. AutoMark annotations 
are also displayed in White. 

- Yellow indicates a Map point annotation. The Map point annotation 
flashed between yellow and red when the Map point is selected. 

 

EnGuide Shadow Tool Details 
EnGuide Shadows display a three-dimensional historic image of an EnGuide catheter position. EnGuide Shadows can be useful in returning a catheter 
to a previous position or for confirming that a catheter has remained in position. Up to 256 EnGuide Shadows can be placed in the map display. 

NOTE: In EnSite™ VoXel mode, Shadows can only be placed with Sensor Enabled™ catheters that are in a high confidence state. 

Figure 76.  An EnGuide Shadow (at arrow) 

 

 

The stability of diagnostic catheters can be verified using EnGuide Shadows. 

1. Display one or more electrodes on a stable catheter. 

2. Early in the study, place an EnGuide Shadow on the stable catheter electrodes. 

3. If the catheter moves away from the Shadows, suspect catheter movement. 

NOTE: In EnSite NavX™ mode, a shadow placed on an intracardiac positional reference does not move away from the positional reference 
electrode. In the event of a positional reference dislodgement, all other electrodes move from previous shadows. 

Below is a n example of a catheter that has moved in an EnSite NavX™ study. The arrow points to the EnGuide Shadow. 
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Figure 77.  An example of a catheter in an EnSite NavX™ study 

 

 

Placing EnGuide Shadows 

1. Select the EnGuide Shadows tool on the Points and Tools Panel. 

2. Select a catheter from the Shadow at drop-down menu. Or select All EnGuides to place an EnGuide Shadow at the locations of all catheters. 

NOTE: EnGuide Shadow keeps the color of the displayed catheter. 

3. Select Add Shadow to place an EnGuide Shadow(s) at the location of the selected catheter(s). 

4. Type a name for the EnGuide shadow in the Name text area or select a name from the drop-down menu. Names appear at the middle of the 
EnGuide Shadow display. 

NOTE: When a shadow is placed on the map, it also appears in the EnGuide Shadow Tools List. 

Anatomic Marker Tool Details 
Anatomic markers connect points on the surface of the model with lines. Closed anatomic markers are useful for drawing valve or vessel openings on 
the model; these circular markers can be cut out of the map to show these openings. Up to 256 anatomic markers can be placed on the map. 

The Marker value is displayed next to the Marker in the Model/Map Display and in the Tools List. The Marker display value is dependent upon the 
surfaces that it crosses. 
 If a surface that the marker crosses is deleted, the marker is deleted. 

 If a surface that the marker crosses is not included, the marker is hidden. 

NOTE: In EnSite NavX™ Mode, Field Scaling must be applied for values to be displayed. 

The method of calculating the area differs depending on whether the marker is cut out. 
 For markers that have not been cut out, the area is calculated for the entire surface encompassed by the marker. 

 For markers that have been cut out, the area is calculated for an averaged plane across the open marker. 

To place an anatomic marker: 

1. Select the Marker tool on the Points and Tools Panel. 

2. Create the marker by clicking at desired locations on the surface. The marker will be formed by connecting consecutive points. 

3. Complete the marker. 

4. For closed markers, click near the first point in the marker to close and complete the marker. To remove the center of the closed marker, turn on 
the Cutout checkbox. 

NOTE: If the marker encompasses the center of the model, the wrong portion of the model may be cut out. 

5. For open markers, right-click in the display area to display the Marker menu, and then select Complete Open Marker or deselect the Marker tool 
or select Complete Open Marker from the Tools List. 

6. Set the marker’s color and thickness with the Color and Thickness controls on the Points and Tools Panel. 

7. Type a name for the marker in the Name text area or select a name from the drop-down list. 

NOTE: When an anatomic marker is placed on the map, it is also added to the Tools List. 

Tape Measure Tool Details 
Tape measures are used to measure the distance (in mm) between points on the model of the endocardial surface. The Tape Measure feature may be 
used with DIF models. Up to 12 tape measures can be placed on the map. 

NOTE: 

 Tape measure values can only be as accurate as the contoured chamber model that they measure. 
 In EnSite NavX™ Mode, Field Scaling must be applied for values to be displayed. 

The example below shows a map with two tape measure lines, one across the model surface and one straight line between two model surface locations. 
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Figure 78.  An example of the Tape Measure Tool 

 

 

Placing a Tape Measure 

Select the Tape Measure tool on the Points and Tools Panel. 

1. Set the tape measure’s color with the Color control on the Points and Tools Panel. 

2. Select the desired Type button: 

- Surface radio button – connects two selected points on the map with the shortest possible line along the endocardial surface. 
- Straight Line radio button – connects two selected points on the map with a straight line. 

3. Place the tape measure: 

- Select on the map at the point to begin measuring, and then drag the mouse to position the other end of the tape measure. 

The tape measure appears on the map as a colored line. The tape measure’s type and the distance between the points in mm, appear at the beginning 
of the tape measure. Up to 12 tape measures (yellow, green, cyan, orange, red, and magenta) can be used. 

NOTE: In EnSite NavX™ mode, measurements will not be shown if Field Scaling is not enabled (the line will still show through). 

Label Tool Details 
Labels are used to identify points on the model. Up to 1024 labels can be placed during a study.  

NOTE: 

 The labels have no intrinsic meaning to the EnSite™ X EP System. Users can assign their own meaning to labels.  
 In EnSite™ VoXel mode, Label at EnGuide(s) can only be placed with Sensor Enabled™ catheter electrodes that are in a high 

confidence state. 

Figure 79.  A model with a label displayed 
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Placing a Label 
Select the Label tool on the Points and Tools Panel. 

1. Type the label’s name in the Name text area on the Points and Tools Panel or select a name from the drop-down menu. By selecting the drop-
down menu after a name appears in the text area, commonly used names can be added or removed from the drop-down menu.  

NOTE: 

 Once a label name is automatically added to the list, it cannot be manually removed. 
 The list in the drop down is cleared at the end of each study. 

1. Use the Projection slider (text entry box) to set the projection distance if the label is to be projected. 

2. Place the label using one of the following methods: 

- Select on the map or DIF surface to place the label at the pointer location. Clicking repeatedly places multiple labels.  

NOTE: When placing labels with the mouse, labels can be placed on either the DIF model or the created model surface. For multiple-
surface models, the label appears on the surface beneath the pointer. 

- Select [Label] button to place a label at a point on the surface nearest to the Active Electrode. For multiple-surface models, the label appears 
on the nearest included surface. Label location is projected from the 3D center of the Active Electrode to the nearest surface. If the surface is 
edited and the projection distance is exceeded, the label re-projects from the original 3D catheter location, because the original 3D catheter 
location is preserved. 

- Select [3D Label] button to place a 3D label at the Active Electrode location. This label is not connected to the surface of the map but rotates 
with the model. This function is useful for labeling the location of catheters outside of the chamber.  

NOTE: When a label is placed, it is also added to the Tools List. 

Lesion (Manual) Marker Tool Details 
Lesion markers are used to identify ablation lesion marker sites. Up to 1024 lesions can be placed in the map display. Lesion markers are projected 
from the 3D center of the Active Electrode to the nearest surface. The original 3D catheter location is preserved. If the surface is edited, the lesion is re-
projected from the original 3D catheter location. 

When using the Lesion Marker tool, the user can place lesion markers with the mouse or use the tool bar to place surface and 3D lesions at the Active 
Electrode. 

An adjustable distance control allows the user to edit the distance allowed for projection. Lesion markers that are present and do not meet the 3D 
distance requirement are displayed as 3D objects (without being tied to a surface).  

The user has the option to project, or not to project the lesion.  

Each lesion marker has a numeric name that is displayed in a list. This number increments each time a lesion marker is placed on the map. If a lesion 
marker is deleted, the numeric list is updated to keep numbers consecutive. 

NOTE: In EnSite™ VoXel mode, Lesion markers can only be placed with Sensor Enabled™ catheter electrodes that are in a high confidence 
state. 

Figure 80.  A map with lesion markers on the surface 

 

 

Placing Lesion Markers 
Place the lesion marker using one of the following methods: 

1. Click on the map to place the lesion marker at the mouse pointer. For multiple-surface models, the lesion marker appears on the surface beneath 
the pointer. 

2. Click the Lesion button to place the lesion marker on the point on the endocardial surface that is highlighted by the EnGuide proximity indicator. 
For multiple-surface models, the lesion marker appears on the nearest included surface. A lesion marker placed with the Lesion button is already 
projected. To move the lesion marker to the Active Electrode, turn off the Project Selected Lesions checkbox. 

- Hot key: <F6> places a lesion marker at the Active Electrode. 

3. Click the 3D Lesion button to place the lesion marker at the Active Electrode. This lesion marker appears as a sphere and is not connected to the 
surface of the map but rotates with the model. To project the lesion marker onto the closest surface, turn on the Project Selected Lesions 
checkbox. 

- Hot key: <Shift>+<F6> places a 3D lesion marker at the Active Electrode. 
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NOTE: 

 The last lesion marker placed is outlined in yellow. If this lesion marker is deleted, the next to last lesion marker is outlined. 
 When a lesion marker is placed on the map, it is added to the Lesion List. 
 The diameter control also adjusts the maximum diameter of the proximity indicator on the EnGuide electrode. 

Work Panels 
The Work Panels contain the controls most often used during the work flow of a study. Tasks are arranged from left to right in the order of typical work 
flow. Panel content displays below each subtab. Each of the Work Panel Tabs are described in the following section. 

Collect Panel 
The Collect Work Panel provides access to the features and activities associated with creating anatomic models and maps. The Collect Work Panel 
contains two sub-tabs: Model Sub-tab and Mapping Sub-tab. The top portion of the Collect Work Panel contains selections that are independent on the 
sub-tab selection. 

Figure 81.  Collect Work Panel 

 

1. Current Map drop-down list – Use the drop-down menu to 
select the desired map to display in the Model/Map 
display. 

2. Cardiac Triggered checkbox – Select the checkbox to create 
a map using a cardiac triggered reference (ECG or IEGM) 
or deselect to create a map using a non-cardiac triggered 
reference (segment length). 

3. Unipole checkbox – Select the checkbox to view the 
unipolar map for the selected Peak-Peak or Peak-Negative 
Map. Note: Bipolar and unipolar data are simultaneously 
collected for all cardiac triggered maps. 

4. Map drop-down list – Use the drop-down to select the map 
type. Refer to the mapping section for further information 
on Map options. 

5. Project to drop-down list – Use the drop-down to select 
projection location: Closest [surface], Right Group, Left 
Group, Other Group. 

 

Model Sub-tab 
The Model Sub-tab in the Collect Panel displays the settings and options for creating anatomic models. The Model Sub-tab has two different states: 
 Finish Model state. 

 Edit Model state. 

The state seen is controlled by the Finish Model/Edit Model toggle button. If Edit Model is showing, then the user is in the Finish Model state. Both 
states are described in the following section. 

NOTE: Field Scaling and associated controls are not visible in EnSite NavX™ mode. All other Model functionality is the same in 
EnSite NavX™ and EnSite™ VoXel modes. 
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Figure 82.  Collect Work Panel – Model Sub-tab – Edit Model state 

 

1. Surfaces list (list column) – After creating a model the name of 
each available surface appears in the surfaces list. The list 
can contain one model with up to 16 created surfaces; 
surfaces may be edited and adjusted independently from one 
another. 

2. Included icon (list column) – This checkbox controls whether a 
surface is displayed in the model. When the checkbox is 
checked, the surface is displayed for labeling, intersecting, 
and overlapping surfaces. When the checkbox is unchecked, 
the entire surface is excluded from view. See the Field Scaling 
section for more information on how surface 
inclusion/exclusion impacts the Field Scaling algorithm. 

3. Visibility icon (list column) – Use the visibility checkbox to 
show/hide the item. When the checkbox is selected, the 
surface is visible. To hide the surface, click on the checkbox. 
Hiding a surface does not delete the surface and the surface 
is still available for intersecting and overlapping other 
surfaces. 

4. Grid Control icon (list column) – The number of selects (1, 2, or 
3) on cylinder will determine where a surface grid is placed on 
the model. Selecting once, places the grid on the interior of 
the model, selecting twice, places the grid on the exterior of 
the surface. Selecting a third time turns the grid off. 

5. Color icon (list column) – Use the color chart to select a color 
for the item. Select on the colored square to open the color 
chart, and then select on the desired color. The color can be 
changed for entire group of surfaces together or for each 
individual surface. 

6. Edit Model – Select Edit Model button to bring up the modeling 
controls (the display in this area will change to the Edit Model 
state and the Edit Model button becomes the Finish Model 
button). 

7. Add/remove Surface buttons – Selecting the "+" Add Surface 
button will bring up the modeling controls (the display in this 
area will change to the Edit Model state and the Edit Model 
button becomes the Finish Model button). The Remove 
Surface button "-" becomes active when a surface is selected 
on the list. 
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Figure 83.  Collect Work Panel – Model Sub-tab – Finish Model state 

 

1. Collection Source drop-down list – Model points can be 
collected using the Roving Electrode, all electrodes on the 
Roving EnGuide, or all electrodes on all EnGuides. Default 
is all electrodes on the Roving EnGuide. 

2. Edit Surface - When highlighted, the currently selected 
surface can be edited. 

3. Select Points – When selected, point editing is active. 

4. Name drop-down list – The name of the surface. Select a 
name from the drop-down menu or type a name. 

5. Group drop-down list – Allows surfaces to be associated to 
one another typically in terms of blood pool. Selections are 
Left, Right and Other. Overlapping surfaces from the same 
group are automatically cut away. Overlapping surfaces 
from different groups are not cut away. 

6. Color – Use the color chart to select a color for the item. 
Select on the colored square to open the color chart, and 
then select on the desired color. 

7. Type drop-down list – Drop down list controls the level of 
surface detail. Selections are OneModel, High and Low. 
Default is OneModel. 

8. Fill slider – Controls the level of surface detail. Surface detail 
smooths as the slider is moved to the right. 

9. Force checkbox/slider – Controls the high and low force 
values that can be used in model point collection when 
using a force sensing catheter. These controls are grayed 
out if Contact Force Software license and/or Force Sensing 
catheter are not present. 

10. Points drop-down list – Use the drop-down list to select 
which points are shown: None, Used (based on Force 
criteria), or All. Hiding points is useful if the point cloud 
begins to obscure navigation. Showing points is useful for 
evaluating areas requiring further collection. 

11. NavX SE checkbox (EnSite NavX™ mode only) – Allows 
visualization of EnSite™ NavX SE points collected from 
Sensor Enabled™ catheters in EnSite NavX™ mode.  

12. Delete Points button – Enabled when Edit Surface button is 
highlighted. This function allows the user to erase selected 
points from the model using the mouse. 

13. Undo Delete button – Select this button to undo the delete 
operation. 

14. Discard Changes button – Discards model point editing on 
the selected surface except for reassigned or copied 
points. 

CAUTION: Discard Changes will delete all surfaces if the model has 
not been finished at least once. 

Field Scaling (EnSite NavX™ mode only) 

15. Auto checkbox – Enables automatic Field Scaling updates. 
When sufficient new EnSite™ NavX or EnSite™ NavX SE 
points are collected, the navigation field is automatically 
updated. 

16. Apply checkbox – Applies Field Scaling to the surfaces that 
are included in the surface list. 

17. NavX radio button – Field scaling is computed based upon 
defined catheter electrode size and spacing. 

18. NavX SE radio button – Field scaling is computed based on 
known offsets between position and orientation of the 
magnetic sensor(s) and electrodes. 

19. Compute button – Select to begin field scaling operation. 
Select at any time to update the field scaling computation. 
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Figure 84.  Collect Tab – Model Sub-tab – Edit Model/Select Points mode 

 

Select Points Mode 

When the Select Points button is selected, point editing is active. To 
select points in the selected surface, sequentially click to create a 
closed loop around the desired points. Once the loop is closed the 
selected points will be highlighted. These points can then be deleted, 
assigned to another surface, or copied to another surface. 

1. Reset button – Select to reset the point selection in the 
Model/Map Display.  

2. Delete Points button – Enabled once the point selection loop 
is closed. When enabled, select the Delete Points button to 
delete the selected points. 

3. Undo Delete button – Select this button to undo the delete 
operation. 

4. Copy to drop-down list & Copy Button – Use the drop-down 
list to choose the desired existing or new surface to copy 
the selected points. Then select the Copy Button to Copy 
the selected points to the selected surface. The selected 
points now appear in the original surface and the newly 
selected surface. 

5. Assign to drop-down list & Assign Button – Use the drop-
down list to choose the desired existing or new surface to 
assign the selected points. Then select the Assign Button 
to move the selected points from the current surface to the 
selected surface. 

 

The EnSite™ X EP System Navigation Modes 
The EnGuide navigation system is used to display catheters and electrodes. The EnSite™ X EP System provides two primary ways to locate and navigate 
catheters. The EnSite™ VoXel Mode and the EnSite NavX™ mode. 

In both navigation modes the maximum number of catheters that can be used simultaneously is 8. The maximum number of electrodes that can be 
located is 200, and the maximum number of electrodes per catheter is 80. Catheter setup is typically done as a part of the Setup task at the beginning 
of a study. 

EnSite™ VoXel Mode 
The EnSite™ VoXel mode can be used to locate, navigate, and collect data from one or more Sensor Enabled™ catheters; standard catheters will be 
visualized but cannot be used to collect 3D data. In EnSite™ VoXel mode the locations of the catheters are primarily based on the signals generated by 
Sensor Enabled™ catheters in conjunction with the Field Frame. EnSite™ X Surface Electrode data is used to aid in catheter visualization. Only 
Sensor Enabled™ catheters may be selected as the Active EnGuide or Roving Source in EnSite™ VoXel mode. 

NOTE: The maximum catheter navigation accuracy error is 2.0 mm in EnSite™ VoXel mode. 

Figure 85.  VoXel Cloud Display 

 

EnSite™ VoXel Mode 
VoXels are not limited to the model creation process, rather VoXels are 
collected at all times. The user may turn visualization of the VoXel cloud on 
or off at any time. Visualization of the point cloud can aide in showing areas 
that may require more attention to obtain high confidence catheter 
visualization. 
To enable display of the VoXel cloud, enable the checkbox located in the 
Map and Display Settings Panel. 
If RespComp X is enabled, VoXels are collected continuously. 

If RespComp X is not enabled, or turned off, collection of VoXels is gated to 
the end expiration phase. 
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Sensor Enabled™ Catheter Visualization 
VoXels are links between the magnetic and impedance data which allow non-rigid portions of Sensor Enabled™ tools to be visualized and used for data 
collection. VoXels are automatically created by moving a Sensor Enabled™ catheter within the cardiac anatomy and appear as blue squares in 3D 
space when turned on by the user. The catheter visualization changes depending on the density of VoXels surrounding each catheter. When the density 
of VoXels is low, the catheter will show in a low confidence state. When the density of VoXels is high, the catheter will show in a high confidence state. 
3D data can be collected from any electrode that is shown which changes based on the confidence state. 

NOTE: VoXels are collected at all times as long as the magnetic and impedance data of the catheter shaft is valid and RespComp X is 
enabled. VoXel collection is not tied to the Edit Model state or a specific model surface. 

Figure 86.  Sensor Enabled™ visualization for confidence states 

 
High confidence example: Ablation catheter 

Sensor Enabled™ Ablation catheters are always high confidence and will be 
visualized showing all electrodes and color as selected by the user. 

 
LOW Confidence Example: 
Advisor™ HD Grid Catheter, 
Sensor Enabled™ 

 
LOW Confidence example: 
Advisor™ FL and 
Advisor™ VL Catheters, 
Sensor Enabled™ 

Sensor Enabled™ diagnostic catheters have low and high confidence states. If the 
density of VoXels surrounding a Sensor Enabled™ diagnostic catheter is too low, the 
Sensor Enabled™ diagnostic catheter will display in the low confidence state. In the 
low confidence state the electrodes near the magnetic sensor location (on the shaft) 
will appear as well as the proximal row of electrodes on the Advisor HD Grid 
catheter. The rest of the electrode will be replaced by a ghost-like shape as seen 
here. In the low confidence state, 3D data can only be collected from the visible 
silver electrodes. 

 
HIGH Confidence example: 
Advisor™ HD Grid Catheter, 
Sensor Enabled™ 

 
HIGH Confidence example: 
Advisor™ FL and 
Advisor™ VL Catheters, 
Sensor Enabled™ 

Once the density of VoXels surrounding a Sensor Enabled™ diagnostic catheter is 
sufficient, the Sensor Enabled™ diagnostic catheter will display in the high 
confidence state. In the high confidence state ALL electrodes on the catheter are 
visible and 3D data can be collected from all electrodes. 

NOTE: If a catheter confidence is low in a region, move the catheter to 
that area until enough VoXels are collected to obtain high confidence. 

 

Standard Catheter Visualization 
Standard Catheters are any catheters that are not Sensor Enabled™. Standard catheters will be visualized but cannot be used to collect 3D data. IEGM 
data can always be visualized for Standard Catheters. Standard catheters will not be displayed in a region without VoXels. When the density of VoXels is 
low, the catheter will show in low confidence. When the density of VoXels is high, the catheter will show in high confidence. 

NOTE: 3D locations of low confidence Standard catheters are shown for information purposes only. 3D locations should be visualized with 
an alternate 3D imaging technique. 

Figure 87.  Standard Catheter visualization for confidence states 

 
No catheter shown. 

Standard catheters will not be displayed if VoXels have not been collected. 

 
LOW Confidence example: 
Standard Catheter 

Standard catheters have low and high confidence states once VoXels have been collected. If the density of VoXels 
surrounding a Standard catheter is too low, the catheter will display in the low confidence state. In the low confidence 
state, Standard catheter electrodes will be replaced by a ghost-like shape as seen here.  

 
HIGH Confidence example: 
Standard Catheter 

Once the density of VoXels surrounding Standard catheter is sufficient, the Standard catheter will display in the high 
confidence state. In the high confidence state ALL electrodes on the catheter are visible. Although the electrodes are 
visible, Standard catheters will be visualized but cannot be used to collect 3D data. 
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Impedance Shift 
When an impedance shift is detected in VoXel mode the VoXel collection is suspended. Catheters go into low confidence (shaft electrodes are still in 
high confidence). A message appears stating that a shift has been detected and VoXel collection will be stopped with the option to ‘Close" or "Delete 
VoXels". 

If the user presses "Close" the message will be dismissed for 5 seconds. 

If the user presses "Delete VoXels" a new message appears asking: Are you sure you want to delete all VoXels? Model Map Lesions and AutoMarks will 
not be deleted. 

Press the Delete VoXels button for VoXel collection to resume, the catheters go into low/high confidence according to the available VoXels. A message 
will appear stating that the impedance shift has resolved and VoXel collection has resumed. 

EnSite NavX™ Mode 
The EnSite NavX™ mode can be used to locate one or more standard EP catheters; Sensor Enabled™ catheters may also be used. In EnSite NavX™ 
mode the locations of the catheters are primarily based on the signals generated from the impedance measurements of NavX surface electrodes. When 
using Sensor Enabled™ catheters in EnSite NavX™ Mode, the EnSite™ X EP System collects both impedance-based (NavX) points and magnetic-
based (NavX SE) points. Field Scaling can then be applied using either data set to optimize the model. 

When using EnSite NavX™ Mode, accurate distance measurements are dependent on application of NavX Sensor Enabled™ Field Scaling. Prior to 
EnSite™ NavX™ SE Field Scaling being applied, distance measurements are either not shown or are estimated based on the impedance measurements 
and the user-supplied patient weight. Measurements that become dimensionally accurate with the application of EnSite™ NavX™ SE Field Scaling 
include: 
 Interior Projection 

 Exterior Projection 

 Interpolation 

 Speed Limit 

 Distance (AutoMap Threshold) 

 Lesion Marker & AutoMark - Diameter 

 Lesion Marker & AutoMark - Project on Surface 

 Label Tool & Lesion Tool – Projection 

 Marker Tools List – Area (Area measurement will not be displayed until Field Scaling is applied) 

 Tape Measure – Name (Tape Measure measurement will not be displayed until Field Scaling is applied) 

NOTE: The maximum catheter navigation accuracy error is 2 mm in an EnSite NavX™ mode in a Sensor Enabled™ field scaled model. 
NOTE: The maximum allowable Tracking Accuracy error in an EnSite NavX™ SE field scaled model is 10%. 

Figure 88.  Points Display 

 
Example of Edge Enhancement and EnSite NavX™ SE points 

1. EnSite NavX™ Mode 

2. In EnSite™ NavX™ Sensor Enabled™ points, orange points, are 
collected from Sensor Enabled™ catheters during model creation. 
EnSite NavX™ SE points represent the magnetic data within the 
impedance field. Select the NavX Sensor Enabled™ checkbox to 
display these points in addition to the green model points. 

3. Collect EnSite NavX™ SE points globally throughout the model to 
ensure an accurate distribution of sensor data within the field. 

Looking closely at the EnSite NavX™ SE point pairs, the points are made up of 
two components: 

- The orange sphere, which corresponds to the location of the electrode 
located within the EnSite™ NavX™ impedance field. 

- The tail of the point pair, which points toward the corresponding sensor 
location. 

NOTE: EnSite NavX™ SE points are always gated to end expiration of 
the respiratory cycle. 

 

Setting the Active EnGuide and Active Electrodes 
The display of an EP catheter in the model screen display is called an EnGuide. The Active EnGuide and Active Electrode are the catheter and electrode 
that are used for creating surfaces, placing labels, placing lesions, and collecting points for maps. Only Sensor Enabled™ catheters may be used as the 
Active EnGuide or Roving Source in EnSite™ VoXel mode. Any catheter may be the Active EnGuide in EnSite NavX™ mode. 

The controls for selecting the Active EnGuide and Active Electrode are in the Points and Tools Panel. Use the drop-down menus to change these values. 
The Active Electrode is green; all other electrodes are silver. 
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NOTE: When in the Edit Model state, the Active EnGuide cannot be changed in the Points and Tools Panel. Change the Active EnGuide by 
changing the Roving source in the Mapping sub-tab or Mobile panel. 

Figure 89.  The Active EnGuide and Active Electrode selection in the Points and Tools Panel 

 

Active EnGuide and Active Electrode selection in the Points and Tools 
Panel. 

 

This is an example of an active electrode. The active electrode is green. 

 

EnGuide Navigation Indicators 
During 3D point collection, the EnGuide electrodes change color to indicate various conditions. For conditions that can impact individual electrodes, 
only the problematic electrode(s) will change color. 
 Green – Active Electrode, Conditions are normal. 

 Silver – Non-active electrode, Conditions are normal. 

 Yellow – Irregular Respiration detected, Velocity Filter threshold has been exceeded, Electrode Issue (broken, disconnected, or out of the body), 
Metal Distortion threshold exceeded (EnSite™ VoXel Mode), PRS-P data invalid (EnSite™ VoXel Mode), Low Confidence Electrode (EnSite™ 
VoXel mode). 

 Blinking red – There is a significant error. The location may be unreliable and 3D graphics (labels, lesions) cannot be placed at the Active 
EnGuide. 

If the EnGuide electrodes turn red and point upward, there is a problem with one of the following: A surface electrode, the Active Electrode, a Non-
Active EnGuide at the distal electrode. A warning appears indicating which electrode is causing the problem. 

Modeling 
The EnSite™ X EP System displays contoured, three-dimensional surface models of the patient’s cardiac anatomy. The purpose of creating a model is 
to collect and label the anatomic locations within the chamber. The software does not assume a specific chamber shape; therefore, it is important to 
collect enough points to provide sufficient chamber definition. A single model may consist of multiple surfaces. 

A surface is created by navigating a selected catheter to locations within a cardiac structure. As the catheter moves, green model points are collected at 
and between all electrodes on the catheter. A surface is wrapped around the outermost points. This process can be repeated to create multiple 
surfaces. If surfaces in the same group overlap, the surfaces combine, and the overlapping section is clipped away. 

WARNING: The EnSite™ X EP System model display should be used in conjunction with conventional EP techniques to confirm 
catheter location. 

NOTE: A model is not required for EnSite™ X EP System studies but a model is required to use the Field Scaling algorithm. 

Figure 90.  Points Display 

 

 

Green model points, available in both modes, track the locations of the 
selected catheter(s) which are then used to form the anatomic model 
surface. The method of wrapping a surface around the green points is 
dependent on the model type (OneModel, High detail, Low detail). 
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Sensor Enabled™ Catheter 
Begin model creation using an Abbott Sensor Enabled™ tool. After model creation begins, initiate and compute EnSite NavX™ SE Field Scaling. As 
more model data is collected, the Field Scaling algorithm will automatically update. The user may display the orange EnSite NavX™ SE points to verify 
areas of the model that require further attention. 

Standard Catheter 
Begin model creation using any standard catheter. After model creation begins, initiate and compute EnSite NavX™ Field Scaling. As more model data 
is collected, the user can manually re-compute field scaling or choose to automatically update field scaling. 

Collecting Surface Points 
As the catheter moves, green model points are collected at and between all electrodes on the catheter. A surface is wrapped around the outermost 
points. Green model points are collected in both EnSite™ VoXel mode and EnSite NavX™ mode. 

To Collect Points. 

1. Set the Active EnGuide that is to be used to collect points from the Points and Tools Panel. 

2. Select the [+] button in the work panel to create a new surface. 

3. Use the Name drop-down to select an existing surface name or type the name of the new surface. 

4. Use the Group drop-down to associate the surface with a group: Left, Right, or Other. 

5. In EnSite NavX™ Mode, select an appropriate Field Scaling if desired. 

6. Select [Collect Points] to begin collecting points on and between electrodes of the Active EnGuide. Navigate the catheter along the chamber walls 
and throughout the interior to create a surface. 

7. Select [Stop Collecting Points] to stop collecting points. 

8. Repeat steps 1-7 for all additional surfaces. 

9. Select [Finish Model] when model creation is complete. 

To Select and Edit Points. 

As the model is created, the user may inspect and adjust the model to increase anatomical representation. Use the editing tools provided in the work 
panel. 

NOTE: User may edit EnSite NavX™ SE points the same as geometry points. 

Use the Edit Points tool to move or copy points from the current surface to another surface, or to delete a large group of points. Click the Edit Points 
icon, and then click on the map display to form a closed shape around the group of points to be reassigned. The points on the interior of the closed 
shape turn red. The map can then be rotated to confirm appropriate selection. Use the Assign to drop-down menu to move the points, or the Copy to 
drop-down menu to copy the points, to one of the available options: 
 New assigns the points to a new surface. 

 Delete removes the points. 

 Existing surface. Selecting the name of an existing surface assigns the points to that surface. 

NOTE: Reassigned and copied points cannot be undone by the [Discard Changes] function. 

Point Collection, EnSite™ VoXel Mode 
Only Abbott Sensor Enabled™ catheters can be used to collect green model points. Standard catheters may be visualized in this mode but cannot be 
used to collect 3D data. Standard catheters will be visualized when enough VoXel data has been collected with a Sensor Enabled™ catheter. VoXel 
mode allows user to collect modeling data using magnetic coordinates to provide accurate and linear visualization. 

Point Collection, EnSite NavX™ Mode 
In EnSite NavX™ mode, the user can collect green model points with Standard catheters (without a sensor) as well as Abbott Sensor Enabled™ 
catheters. 

Field Scaling (EnSite™ NavX Mode Only) 
Field Scaling uses known fixed characteristics of the catheter to adjust the dimensions of the navigation field. As the catheter is moved during model 
creation, the system records the location and spacing of characteristics on the active catheter. Field Scaling is only applied in the EnSite NavX™ mode 
of operation and is not applicable to the EnSite™ VoXel mode of operation where magnetics is the primary method of catheter location. There are two 
field scaling options: EnSite™ NavX™ SE Field Scaling (Sensor Enabled™ Catheters) and EnSite™ NavX™ Field Scaling (Standard Catheters). Field 
scaling is calculated based on the surfaces that are "included" at the time Field Scaling is computed. 

NavX™ SE Field Scaling (Sensor Enabled™ Catheters) 
EnSite NavX™ SE uses known offsets between the position and orientation of magnetic sensor(s) and electrodes on Abbott Sensor Enabled™ catheters 
to adjust the dimensions of the navigation field. Once initiated and Auto checkbox is selected, EnSite NavX™ SE Field Scaling continuously computes 
when sufficient points have been collected during model creation. 

Showing EnSite NavX™ SE points will help ensure good coverage of the chamber, resulting in better EnSite NavX™ SE Field Scaling results. EnSite 
NavX™ SE points appear in the orange color. 

NavX Field Scaling (Standard Catheters) 
EnSite™ NavX™ Field Scaling uses known interelectrode spacing to adjust the dimensions of the navigation field when using standard catheters. Once 
initiated, the user may re-compute field scaling or select automatic field scaling updates. 

Applying Field Scaling 
Select the type of Field Scaling to be computed by checking either the EnSite™ NavX or the NavX™ SE checkbox radio buttons. 

1. Select [Compute] to compute field scaling. 

2. The Apply checkbox is automatically checked. 

When using EnSite NavX™ SE Field Scaling, the [Auto] checkbox is automatically selected. When sufficient new EnSite NavX™ SE points are collected, 
Field Scaling is automatically updated. 
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When using EnSite NavX™ Field Scaling the user must manually select the [Auto] checkbox to enable automatic Field Scaling updates. When sufficient 
new EnSite NavX™ points are collected, Field Scaling is automatically updated. 

To un-apply Field Scaling, uncheck the Apply box. 

Field Scaling Notes 

NOTE: 

 EnSite NavX™ SE points are not collected under the following conditions: 

 When EnSite NavX™ SE locations are invalid. 
 When the Active EnGuide is not a Sensor Enabled™ catheter. 
 When the EnGuide has Stabilize ABL enabled. 
 When the Sheath Filter feature has detected that the catheter has been retracted into the catheter sheath. 
 When the Metal Distortion is out of range. 

 When using EnSite NavX™ Field Scaling, Model points are not used for Field Scaling under the following conditions: 

 Electrodes having greater than 11.25 mm (center to center) spacing. 
 Collecting with a single electrode. 
 Catheters without defined interelectrode spacing or electrode length. 
 The distal electrode and at least one of electrodes 2, 3, or 4 must be enabled to collect EnSite NavX™ SE points for an ablation catheter. 
 For studies where Field Scaling is used, be sure that appropriate interelectrode spacing and size are specified for any catheter that is used 

for collecting points. Model points collected with catheters that are inappropriately described may yield unexpected Field Scaling results. 
This cannot be corrected by re-entering correct information after the fact. However, Field Scaling is an option which can be unapplied if 
unexpected results occur. 

 For optimal use of the Field Scaling feature, the points collected should represent all 3 axes (x-y-z) in all areas of the model. 
 Checking a Field Scaling type different from the one currently applied will automatically un-apply Field Scaling. Select the Compute button 

to recompute Field Scaling. 
 Model adjustments using Field Scaling are reversible, to un-apply Field Scaling, uncheck the [Apply] checkbox. 

Collect Workpanel - Mapping Sub-tab 
Figure 91.  Collect Workpanel – Mapping Sub-tab 
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1. Low-V ID slider – (Applies to the map that has focus when in Split Screen mode.) Identifies low-voltage zones in LAT or CFE maps. If a 
collected point’s P-P value is lower than the specified Low-V ID value, then that point will display a gray area instead of the color- coded 
scale for the current map type. Grey points do not interpolate with color points. 

2. Fractionation Threshold checkbox/slider – Renders points that are fractionated as larger spheres. Default value=3 (renders points with a 
fractionation value of >= 3. 

3. Map Display – (LAT maps only) The type of LAT map: Standard LAT, Reentrant Map, Full-Color Propagation or Propagation Map. 

4. Sparkle Map button – Displayed the activation sequence overlaid on top of another map. The SparkleMap shows the propagation sequence 
using a series of circular flashes. The button changes to "Stop" while Sparkle Map is playing and will stop Sparkle Map when selected. The 
speed that the Sparkle Map is played is controlled by the drop-down next to the button. Sparkle Map button is unavailable when the Map 
Display control is set to either type of propagation map. 

5. Interior Projection slider – (Applies to both maps when Split Screen mode is active.) This slider controls the maximum distance that an 
interior 3D Point (represented as a triangle) can project to a location on the surface (represented by a square). For multiple-surface 
models, points will project to the nearest surface. 

6. Interpolation slider – (Applies to the map that has focus when in Split Screen mode.) This slider controls the minimum distance between 
surface points necessary for the system to interpolate color. For multiple surface models, points will interpolate between surfaces in the 
same group. 

7. Surface Points checkbox – (Applies to the map that has focus when in Split Screen mode.) Enables/disables the display of small square 
points on the surface. These squares represent the point on the surface closest to a collected 3D point. 

8. All roving Waves checkbox – Select to display all roving waves. When deselected, only one roving wave is displayed in the Acquisition 
Waveform Display. 

9. 3D Points checkbox – (Applies to the map that has focus when in Split Screen mode.) Enables/disables the display of collected points as 
triangular markers. The triangular markers are placed on the negative electrode of the roving signal channel. 

10. Unipole waves checkbox – Select to display unipolar waves of the roving signals in the Acquisition Waveform Display. 

11. REF and ROV tabs – this area will be described in later sections. 

12. Score checkbox/slider – Score Threshold: Full or any combination of the 12 Surface Leads. Only collect mapping points if the 12-Lead 
Surface Morphology is XX% similar or higher compared to the original template beat 12-Lead Surface Morphology. The user can set the 
Score Threshold from 0 to 100%. By default, the Score Threshold is enabled and is set to 90%. 

13. CL Tolerance checkbox/slider - Cycle Length Tolerance: Only collect mapping points if the intracardiac measured (CS, HIS, other) Cycle 
Length is within +/- XX ms of original template beat Cycle Length. User can set the Cycle Length Tolerance from +/- 0 to 150 ms. Default 
the Cycle Length Tolerance is enabled and is set to +/- 20 ms. 

14. Activation Seq checkbox/slider – Activation Sequence is defined as the timing between the primary reference (REF) detection and the 
secondary reference (REF 2) detection when both the REF and the REF 2 are set to intracardiac signals. Mapping points when the 
Activation Sequence of the current beat is within +/- XX ms of the template beat Activation Sequence. The user can set the Activation 
Sequence tolerance slider from +/-0 to 25 ms with a default of +/- 5 ms. 

15. Speed Limit checkbox/slider – Speed Limit: Only collect mapping points if the mapping catheter is moving less than XX.X mm/s. User can 
set the Speed Limit from 0.1 to 75 mm/s. Default the Speed Limit is enabled and is set to 10.0 mm/s. 

16. Distance checkbox/slider – Distance Threshold: Only collect mapping points if the 3D position of the roving catheter electrode is X.X mm or 
more from the previously collected mapping point from that electrode. User can set the Distance Threshold from 0.1 to 10 mm. Default 
Distance Threshold is enabled but the default value is set to 1.0 mm. 

17. Signal to Noise checkbox/slider – SNR Threshold: Only collect mapping points if the Signal-To- Noise Ratio on the roving catheter signal is 
X.X or higher. User can set the SNR Threshold from 1 to 50. Default the SNR Threshold is enabled and is set at 5.0. 

18. Force checkbox/slider – Force (Contact Force Range): This criteria can only be used if the EnSite™ X Contact Force Module is installed and 
the physician is mapping with a TactiCath™ catheter. Only collect mapping points if the Average Contact Force (as measured by a 
TactiCath™ Contact Force Catheter) is at least X grams and less than Y grams. User can set the Lower Threshold from 0 to 30 grams. 
User can set the Upper Threshold from 30 grams to 150 grams. Default the Contact Force Threshold is not enabled but the default lower 
threshold is 10 grams and the default upper threshold is 50 grams. 

19. Enhanced Noise Rejection checkbox – Enhanced Noise Rejection: Only collect mapping points if the roving catheter signal does not have 
certain types of noise (Signals with saturations, electrode-to-electrode contact, open electrode noise, signals with degraded conditions 
such as no location or dropped data). Only uncheck for pace mapping. User can set the Enhanced Noise Reduction on or off. Default the 
Enhanced Noise Reduction is enabled. 
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Figure 92.  Collect Workpanel – Mapping Sub-tab - Automap 

 

1. Stable Distance checkbox/slider – Area in which the user must keep the catheter for the algorithm to consider it the same collection. 

2. Distance checkbox/slider – Distance Threshold: Only collect mapping points if the 3D position of the roving catheter electrode is X.X mm or 
more from the previously collected mapping point from that electrode. User can set the Distance Threshold from 0.1 to 10 mm. Default 
Distance Threshold is enabled but the default value is set to 1.0 mm. 

3. Signal to Noise checkbox/slider – SNR Threshold: Only collect mapping points if the Signal-To- Noise Ratio on the roving catheter signal is 
X.X or higher. User can set the SNR Threshold from 1 to 50. Default the SNR Threshold is enabled and is set at 5.0. 

4. Force checkbox/slider – Force (Contact Force Range): These criteria can only be used if the EnSite™ X Contact Force Module is installed 
and the physician is mapping with a TactiCath™ catheter. Only collect mapping points if the Average Contact Force (as measured by a 
TactiCath™ Contact Force Catheter) is at least X grams and less than Y grams. User can set the Lower Threshold from 0 to 30 grams. 
User can set the Upper Threshold from 30 grams to 150 grams. The Lower Threshold cannot be set higher than the Upper Threshold. 
Default the Contact Force Threshold is not enabled. The default lower threshold is 10 grams and the default upper threshold is 50 grams. 
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Collect Workpanel - Mapping REF, REF2 and ROV Sub-tabs 
Figure 93.  Collect Workpanel – Mapping Sub-tab 

 

 

 

 

1. REF Source – Cardiac Triggered Maps Only. Sets the primary reference signal for mapping which can be either a surface electrocardiogram 
or an intra-cardiac electrogram. Multiple ECGs can be selected. Default is set to ECG I. 

2. REF Tick Mark Color - The user can assign a color to the primary reference tick mark on the waveform display using the color control. 

3. REF Detection – Cardiac Triggered Maps Only. Sets the detection algorithm for the Primary Reference Source. 

4. REF Sensitivity – Cardiac Triggered Maps Only. Sets the P-P Sensitivity for the Primary Reference Source. The default sensitivity setting is 
Automatic, but Fixed sensitivity is an option unless Multiple ECGs is selected as the reference source. 

5. REF 2 Source – Cardiac Triggered Maps Only when the Primary Source is set to an intracardiac electrogram. Sets the secondary reference 
signal used for calculating the Acquisition Sequence. The secondary reference can be set to an intracardiac electrogram. 

6. REF2 Tick Mark Color - The user can assign a color to the secondary reference tick mark on the waveform display using the color control. 

7. REF 2 Detection –Cardiac Triggered Maps Only. Sets the detection algorithm for the secondary reference source. First deflection and last 
deflection are not available for the secondary reference detection. 

8. ROV Source – Defines the signal used for sampling local activation times and voltages from various locations in the heart. The roving signal 
can be set to one specific intracardiac signal, all intracardiac signals on a catheter, or all intracardiac signals on all catheters. 

9. ROV Tick Mark Color - The user can assign a color to the roving tick mark on the waveform display using the color control. 

10. ROV Detection – Cardiac Triggered Maps Only. Sets the detection algorithm for the Roving Source. 

11. ROV Sensitivity – Sets the P-P Sensitivity for the Roving Source. In cardiac triggered mapping, this is only available when using First 
Deflection or Last Deflection. 
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Figure 94.  The contact mapping screen 

 

 

Surface Type 
The system can use several methods to create a model with the collected points: OneModel, High, and Low. 

The OneModel tool is a cardiac model creation tool that wraps the model surface tightly around collected points without tying it back to a center point. It 
provides enhanced anatomic detail of the cardiac model when creating a single surface model, and reduces the time required to create a finished 
model without requiring the user to change the point collection techniques. 

High (detail): Cardiac model creation tool that less extensively fills the space between model points. 

Low (detail): Cardiac model creation tool that more extensively fills the space between model points. 

NOTE: 

 When creating the model, the user can switch back and forth between definition Types: High, Low, and OneModel. Items projected onto 
the surface may adjust their positions based on the surface generated by each type. 

 Moving surfaces to separate surface groups can help in situations where visible separation between surfaces is desired. 

Types of Contact Maps 
The mapping tool organizes data collected during conventional electrophysiology procedures and displays the data in three- dimensional maps. During 
mapping, the clinician samples various heart locations (points) in a stable rhythm. The 3D location of each sampled location (point) is saved along with 
voltage and activation data, which can be displayed on the nearest surface as color. A single set of collected data can be used to display several types of 
maps. 

Cardiac Triggered Maps 
Cardiac triggered maps use a surface electrocardiogram or an intra-cardiac electrogram as the reference to which collected points are measured. There 
are several types of cardiac triggered maps: 
 Local Activation Time (LAT) isochronal maps display color-coded activation times for each collected location (or nearest surface). The local 

activation time is the difference in milliseconds between detected activation on the roving waveform and the primary reference waveform. Colors 
range from white (early) to purple (late). 

 Peak-to-Peak (P-P) voltage maps display color-coded voltage values for each collected location (or nearest surface). The P-P voltage is the 
difference in millivolts between the peak positive and Peak-Negative components of the detected activation complex on the roving waveform. 
Colors range from gray (low voltage) to purple (high voltage). 

 Peak Negative (P-Neg) voltage maps display color-coded voltage values for each collected location (or nearest surface). The P- Neg voltage is the 
difference in millivolts between baseline and the Peak-Negative component of the detected activation complex on the roving waveform. Colors 
range from gray (low voltage) to purple (high voltage). 

 CFE Mean maps provide a fractionation index based on the cycle length between multiple, discrete, local activations in an electrogram. Collected 
points with a lower value are mapped toward the white end of the color spectrum. 

 CFE Standard Deviation maps provide a fractionation index based on the cycle length between multiple, discrete, local activations in an 
electrogram. The CFE standard deviation calculates the standard deviation between activations. Collected points with a lower value are mapped 
toward the white end of the color spectrum. 

 Fractionation maps indicate the number of CFE detections. 

 Score maps compare the surface lead morphology of each mapping point collected to the originally collected template beat surface lead 
morphology. Points collected with a higher score are mapped toward the purple end of the color spectrum. 
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 Point Count maps indicate the number of points co-located with that point on the map. 

NOTE: 

 For Peak-to-Peak and Peak Negative, the user can select the Unipole box to display unipole maps. Unipole waveforms display on the 
right. Deselect the Unipole box to display bipole maps. 

 At least one LAT point must be mapped and saved in order for other map types to become available. Prior to this action, these options 
are grayed out. 

 When the remove white checkbox is selected the color ranges defined above will change from red to purple. 

Non-Cardiac Triggered Maps 
Non-cardiac triggered maps collect points at user defined period of time, the default is at a one second interval. 
 CFE Mean maps provide a fractionation index based on the cycle length between multiple, discrete, local activations in an electrogram. Collected 

points with a lower value are mapped toward the white end of the color spectrum. 

 CFE Standard Deviation maps provide a fractionation index based on the cycle length between multiple, discrete, local activations in an 
electrogram. The CFE standard deviation calculates the standard deviation between activations. Collected points with a lower value are mapped 
toward the white end of the color spectrum. 

 Fractionation maps indicate the number of CFE detections. 

 Point Count maps indicate the number of points co-located with that point on the map. 

Signals Collection - Setting the Reference 
Primary Reference Signal Source 
Cardiac triggered maps require a primary reference signal. The primary reference signal is provided by a surface electrocardiogram or an intra-cardiac 
electrogram. Multiple ECGs can be selected. The electrodes that provide the primary reference signal must remain in a stable position throughout the 
mapping procedure. The primary reference signal is set once before beginning a mapping procedure and is used for timing of the roving signals. 

Non-cardiac triggered maps do not use any part of the cardiac signal as a reference. Instead, the waveform window refreshes once each second. 

The color of the primary reference signal tick mark can be changed by selecting a different color from the color picker. The primary reference signal is 
highlighted with a box around the waveform’s label in the Acquisition Waveform Display. 

Figure 95.  Boxed label of reference signal 

 

 

Figure 96.  Collect Workpanel – Mapping Sub-tab - Primary Reference tab 

 

1. REF Source – Cardiac Triggered Maps Only. Sets the primary reference signal for mapping which can be either a surface electrocardiogram 
or an intra-cardiac electrogram. Multiple ECGs can be selected. Default is set to ECG I. 

2. REF Tick Mark Color – The user can assign a color to the primary reference tick mark on the waveform display using the color control. 

3. REF Detection – Cardiac Triggered Maps Only. Sets the detection algorithm for the Primary Reference Source. 

4. REF Sensitivity – Cardiac Triggered Maps Only. Sets the P-P Sensitivity for the Primary Reference Source. The default sensitivity setting is 
Automatic, but Fixed sensitivity is an option unless Multiple ECGs is selected as the reference source. 

 

Secondary Reference Signal Source 
The secondary reference signal is a method to monitor intracardiac activation sequence patterns to ensure the current map point has the same rhythm 
as the rest of the map. The secondary reference signal is used to calculate the Activation Sequence. The Activation Sequence is the time difference in 
milliseconds between the detected activation on the secondary reference signal and the primary reference signal. The Activation Sequence of the 
current map point can be compared against the Activation Sequence of the template beat to ensure the rhythms are consistent. The secondary 
reference source detection tick mark can be adjusted by clicking and dragging on the tick mark. 
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Figure 97.  Collect Workpanel – Mapping Sub-tab - Secondary Reference tab 

 

 

The secondary reference source can be set to an intra-cardiac electrogram. The ability to set the secondary reference signal source is only available in 
cardiac-triggered maps when the primary reference signal is set to an intra-cardiac electrogram. 

The color of the secondary reference signal tick mark can be changed by selecting a different color from the color picker. The secondary reference 
signal is highlighted with a box around the waveform’s label in the Acquisition Waveform Display. 

Roving Signal Source 
Both cardiac triggered and non-cardiac triggered maps require a roving signal. The roving signal is used for sampling local activation times and voltages 
from various locations in the heart. The roving signal source can be any intracardiac electrode; it can be changed during a procedure, and data can be 
sampled from one or from multiple electrodes. The color of the roving signal tick mark can be changed by selecting a different color from the color 
picker. 

Figure 98.  Collect Workpanel – Mapping Sub-tab - Cardiac Triggered Roving tab 

 

 

Detection Algorithm 
The reference signals and roving signals require a detection algorithm. Detection algorithms locate the best point on the waveform signal to use to 
identify activation. The detection algorithm first uses a P-P sensitivity to identify activation complexes in the signal. A detection marker is then placed on 
the activation complex according to the selected Detection Algorithm. 

Figure 99.  Collect Workpanel – Mapping Sub-tab - Non-Cardiac Triggered Roving tab 

 

 

Sensitivity – (Applies to the map that has focus when in Split Screen mode.) The minimum peak-to-peak voltage required for the detection algorithm to 
operate. Incoming signal complexes must be larger in amplitude than the Sensitivity in order to be considered activations by the system. While changing 
the Sensitivity, red amplitude lines will appear on the related signal in the acquisition panel to indicate the current setting. Set this sensitivity to just 
above the noise floor. If 1.5 seconds has elapsed since the last reference signal detection, the algorithm will identify an optimal activation complex, even 
if it does not meet the Sensitivity setting. 

NOTE: For the primary reference signal, the default sensitivity setting is Automatic, but Fixed sensitivity is an option unless Multiple ECGs is 
selected as the reference source. For Roving for Cardiac Triggered maps, the Fixed Sensitivity is available when using First Deflection or 
Last Deflection. 

Detection Algorithm – The available selections are: 
 -dVdt – Sharpest negative slope 

 +dV/dt – Sharpest positive slope 

 abs dVdt – Sharpest slope, regardless of positive or negative 

 Max – Peak positive amplitude 

 Min – Peak negative amplitude 

 abs Peak – Largest peak amplitude (difference from baseline) regardless of positive or negative 

 First Deflection – First deflection from baseline 

 Last Deflection – Last deflection from baseline 

Setting up the Detection Algorithm 
1. Select a primary reference signal. 

2. If applicable, set the sensitivity slightly above the noise floor. 
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3. Select the appropriate detection algorithm. 

4. Repeat for the roving signal. 

5. If using a secondary reference signal, repeat steps 1 and 3. 

NOTE: 

 The user can drag the green Reference Offset line to the desired position, and the system calculates the timing automatically from that 
position. The aqua-colored line is the reference line placed by the detection algorithm and cannot be moved. 

 Do not change the reference offset after saving the first beat when using Score Map. Changing of the reference offset after the first beat 
may lead to an incorrect mapping display. 

 Cardiac triggered CFE maps use the same detection algorithm as LAT, P-P, and P-Neg. Non-cardiac CFE maps use the one second 
screen refresh signal as a trigger. The detection algorithm is not selectable. 

 Detection on the roving waveform takes place within the Roving Activation Interval. 

Additional Signals (see Mapping Settings Panel for more information) 
Additional ECG or intracardiac signals can be selected to facilitate confirmation of rhythm stability. These signals are only for visualization and are not 
involved in detection. 

Mapping Considerations 
CFE Maps 
 Multiple detections are possible in a single sample. 

 Tick marks in CFE maps are not individually adjustable. 

 In CFE maps, some detection settings can be adjusted retrospectively and affect all points in the current map, including Sensitivity, Width, 
Refractory, the RAI, and Segment Length. 

 The Width slider controls the minimum complex width to consider for activation. 

 The Refractory slider controls the minimum amount of time between detections. 

 The Segment Length slider controls the number of seconds per sample. This control is only available for non-cardiac triggered maps. 

Reentrant Maps 
 Reentrant maps present the mapping of reentrant arrhythmias and are displayed in a manner similar to LAT maps. The color displayed within the 

map is linked to the cardiac cycle length (CL) and allows the adjacent display of "early" (white) and "late" (purple) activation times. 

 The CL of a Reentrant LAT map is determined by the spacing between the curtains. Adjustment of the CL can be made by clicking and dragging 
the edge of the curtains to the desired location. The CL will not take effect until the Reentrant checkbox is turned on. 

NOTE: Adjusting the CL and then collecting points may invalidate the map. 

Propagation Maps 
 Propagation maps display areas of activations times that fall within a specific time interval. The interval can be moved forward through one heart 

cycle either automatically or by user control. 

 Propagation maps can be played in Realtime or RealReview but recordings can only be exported in Offline Review. 

 A button beneath the Propagation dropdown controls automatic motion of the activation interval with [Play] and [Freeze] options. [Play] loops over 
the user-selected cycle length. 

 There are two type of Propagation maps available. A mono-color propagation map and a full-color propagation map. 

 The speed that the Propagation Maps are played is controlled by the drop-down next to the Play/Sparkle Map button. The speed is related to the 
amount of time it takes to play through one RAI cycle. 

Propagation 
 When Propagation is selected, the colors of the map change to purple and white only. The leading edge of the white stripe is brighter than the 

trailing edge of the stripe to indicate the direction of travel activation. 

 Using the side color bar, the stripe can be widened (increasing the interval in milliseconds [ms]), by clicking and dragging above the white stripe. 
This action can also be accomplished by clicking to the right of the stripe in the color bar at the top of the screen. 

Full-Color Propagation 
 When Full-Color Propagation is selected, all the colors of the map are used to show the cardiac activation wavefront. The color of the spectrum 

move through the heart cycle and the map is updated accordingly. 

SparkleMap 
 The SparkleMap feature allows you to view the activation sequence on top of another map (ex. Voltage map) which allows the physician to 

simultaneously view multiple datasets on the same anatomic model. The SparkleMap shows the propagation sequence via a series of circular 
flashes. 

 Select the SparkleMap button in the Mapping Tab of the Collect Work Panel to activate. 
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Collect Workpanel – Mapping Sub-tab 
Figure 100.  Collect Workpanel – Mapping Sub-tab 

 

1. Low-V ID slider – (Applies to the map that has focus 
when in Split Screen mode.) Identifies low-voltage 
zones in LAT or CFE maps. If a collected point’s P-
P value is lower than the specified Low-V ID value, 
then that point will display a gray area instead of 
the color- coded scale for the current map type. 
Grey points do not interpolate with color points. 

2. Fractionation Threshold checkbox/slider – Renders 
points that are fractionated as larger spheres. 
Default value=3 (renders points with a fractionation 
value of >= 3. 

3. Map Display – (LAT maps only) The type of LAT 
map: Standard LAT, Reentrant Map, Full-Color 
Propagation or Propagation Map. 

4. Sparkle Map button – Displayed the activation 
sequence overlaid on top of another map. The 
SparkleMap shows the propagation sequence using 
a series of circular flashes. The button changes to 
"Stop" while Sparkle Map is playing and will stop 
Sparkle Map when selected. The speed that the 
Sparkle Map is played is controlled by the drop-
down next to the button. Sparkle Map button is 
unavailable when the Map Display control is set to 
either type of propagation map. 

5. Interior Projection slider – (Applies to both maps 
when Split Screen mode is active.) This slider 
controls the maximum distance that an interior 3D 
Point (represented as a triangle) can project to a 
location on the surface (represented by a square). 
For multiple-surface models, points will project to 
the nearest surface. 

6. Interpolation slider – (Applies to the map that has 
focus when in Split Screen mode.) This slider 
controls the minimum distance between surface 
points necessary for the system to interpolate color. 
For multiple surface models, points will interpolate 
between surfaces in the same group. 

7. Surface Points checkbox – (Applies to the map that 
has focus when in Split Screen mode.) 
Enables/disables the display of small square points 
on the surface. These squares represent the point 
on the surface closest to a collected 3D point. 

8. All roving Waves checkbox – Select to display all 
roving waves. When deselected, only one roving 
wave is displayed in the Acquisition Waveform 
Display. 

9. 3D Points checkbox – (Applies to the map that has 
focus when in Split Screen mode.) Enables/disables 
the display of collected points as triangular 
markers. The triangular markers are placed on the 
negative electrode of the roving signal channel. 

10. Unipole waves checkbox – Select to display unipolar 
waves of the roving signals in the Acquisition 
Waveform Display. 

11. REF and ROV tabs – this area will be described in 
later sections. 

12. Score checkbox/slider – Score Threshold: Full or any 
combination of the 12 Surface Leads. Only collect 
mapping points if the 12-Lead Surface Morphology 
is XX% similar or higher compared to the original 
template beat 12-Lead Surface Morphology. The 
user can set the Score Threshold from 0 to 100%. 
By default, the Score Threshold is enabled and is 
set to 90%. 

13. CL Tolerance checkbox/slider - Cycle Length 
Tolerance: Only collect mapping points if the 
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intracardiac measured (CS, HIS, other) Cycle 
Length is within +/- XX ms of original template beat 
Cycle Length. User can set the Cycle Length 
Tolerance from +/- 0 to 150 ms. Default the Cycle 
Length Tolerance is enabled and is set to +/- 
20 ms. 

14. Activation Seq checkbox/slider – Activation 
Sequence is defined as the timing between the 
primary reference (REF) detection and the 
secondary reference (REF 2) detection when both 
the REF and the REF 2 are set to intracardiac 
signals. When activated, this controls only collects 
mapping points when the Activation Sequence of 
the current beat is within +/- XX ms of the template 
beat Activation Sequence. The user can set the 
Activation Sequence tolerance slider from +/-0 to 
25 ms with a default of +/- 5 ms. 

15. Speed Limit checkbox/slider – Speed Limit: Only 
collect mapping points if the mapping catheter is 
moving less than XX.X mms/s. User can set the 
Speed Limit from 0.1 to 75 mm/s. Default the 
Speed Limit is enabled and is set to 10.0 mm/s. 

16. Distance checkbox/slider – Distance Threshold: Only 
collect mapping points if the 3D position of the 
roving catheter electrode is X.X mm or more from 
the previously collected mapping point from that 
electrode. User can set the Distance Threshold 
from 0.1 to 10 mm. Default Distance Threshold is 
enabled but the default value is set to 1.0 mm. 

17. Signal to Noise checkbox/slider – SNR Threshold: 
Only collect mapping points if the Signal-To- Noise 
Ratio on the roving catheter signal is X.X or higher. 
User can set the SNR Threshold from 1 to 50. 
Default the SNR Threshold is enabled and is set at 
5.0. 

18. Force checkbox/slider – Force (Contact Force 
Range): These criteria can only be used if the 
EnSite™ X Contact Force Module is installed and 
the physician is mapping with a TactiCath™ 
catheter. Only collect mapping points if the Average 
Contact Force (as measured by a 
TactiCath™ Contact Force Catheter) is at least X 
grams and less than Y grams. User can set the 
Lower Threshold from 0 to 30 grams. User can set 
the Upper Threshold from 30 grams to 150 grams. 
Default the Contact Force Threshold is not enabled 
but the default lower threshold is 10 grams and the 
default upper threshold is 50 grams. 

19. Enhanced Noise Rejection checkbox – Enhanced 
Noise Rejection: Only collect mapping points if the 
roving catheter signal does not have certain types 
of noise (Signals with saturations, electrode-to-
electrode contact, open electrode noise, signals 
with degraded conditions such as no location or 
dropped data). Only uncheck for pace mapping. 
User can set the Enhanced Noise Reduction on or 
off. Default the Enhanced Noise Reduction is 
enabled. 
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Figure 101.  Collect Workpanel – Mapping Sub-tab - Automap 

 

1. Stable Distance checkbox/slider – Area in which the user must 
keep the catheter for the algorithm for it to consider it the 
same collection. 

2. Distance checkbox/slider – Distance Threshold: Only collect 
mapping points if the 3D position of the roving catheter 
electrode is X.X mm or more from the previously collected 
mapping point from that electrode. User can set the Distance 
Threshold from 0.1 to 10 mm. Default Distance Threshold is 
enabled but the default value is set to 1.0 mm. 

3. Signal to Noise checkbox/slider – SNR Threshold: Only collect 
mapping points if the Signal-To- Noise Ratio on the roving 
catheter signal is X.X or higher. User can set the SNR 
Threshold from 1 to 50. Default the SNR Threshold is enabled 
and is set at 5.0. 

4. Force checkbox/slider – Force (Contact Force Range): These 
criteria can only be used if the EnSite™ X Contact Force 
Module is installed and the physician is mapping with a 
TactiCath™ catheter. Only collect mapping points if the 
Average Contact Force (as measured by a 
TactiCath™ Contact Force Catheter) is at least X grams and 
less than Y grams. User can set the Lower Threshold from 0 
to 30 grams. User can set the Upper Threshold from 
30 grams to 150 grams. The Lower Threshold cannot be set 
higher than the Upper Threshold. Default the Contact Force 
Threshold is not enabled but the default lower threshold is 
10 grams and the default upper threshold is 50 grams. 
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Cardiac Triggered Mapping Settings 
Settings apply to the map that has focus when in Split Screen mode unless noted. 

Figure 102.  Cardiac Triggered Mapping Work Panel 

 

1. Low-V ID - Identifies low-voltage zones for all maps 
except voltage and score maps If a collected point’s P-P 
value is lower than the specified Low-V ID value, then 
that point will display a gray area instead of the color- 
coded scale for the current map type. Grey points do 
not interpolate with color points. 

2. Fractionation Threshold - Renders points that are 
fractionated as larger spheres. Default value=3 (renders 
points with a fractionation value of >= 3. 

3. Map Display (LAT maps only) - The type of LAT map: 
Standard LAT, Reentrant Map, Propagation Map or 
Full-Color Propagation Map. 

4. SparkleMap - Displays the activation sequence overlaid 
on top of another map. The SparkleMap shows the 
propagation sequence using a series of circular flashes. 
The button changes to "Stop" while Sparkle Map is 
playing and will stop Sparkle Map when selected. 
SparkleMap button is unavailable when the Map 
Display control is set to either type of propagation map. 

5. Interior Projection - (Applies to both maps when Split 
Screen mode is active.) This slider controls the 
maximum distance that an interior 3D Point 
(represented as a triangle) can project to a location on 
the surface (represented by a square). For multiple-
surface models, points will project to the nearest 
surface. 

6. Interpolation - (This slider controls the minimum distance 
between surface points necessary for the system to 
interpolate color. For multiple surface models, points 
will interpolate between surfaces in the same group. 

7. 3D Points - Enables/disables the display of collected 
points as triangular markers. The triangular markers are 
placed on the positive electrode of the roving signal 
channel. 

8. Surface Points- Enables/disables the display of small 
square points on the surface. These squares represent 
the point on the surface closest to a collected 3D point. 

9. All roving Waves checkbox - Select to display all roving 
waves. When deselected, only one roving wave is 
displayed in the Acquisition Waveform Display. 

 

Figure 103.  LAT Isochrone with Low-V ID and Collected Points Example 

  

LAT isochrone with Low-V ID Collected points 

 

1. A: surface point 

2. B: 3D point 

3. C: 3D label 
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Non-Cardiac Triggered Mapping Tab 
Notice that in the Mapping Tab of the Collect Work panel the available settings have changed slightly. The Map Display controls have been removed 
and there is no option to select a primary or secondary reference. 

Figure 104.  Non Cardiac Triggered Mapping control panel 

 

Cardiac Triggered Reference checkbox is unchecked. 
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AutoMap Description 
The AutoMap feature automates the point collection process, based on the user-defined settings. As the catheter is moved, points are collected when 
the user-defined settings are met. 

Figure 105.  Mapping Screen 

 

 

Figure 106.  Start/Stop Automap 

 

 

Start AutoMap/Stop AutoMap button: Select to begin automatic mapping point collection — select again to stop automatic mapping point collection. 

Stop All button: Stops automatic mapping point collection AND stops anatomic model point collection. 

The user can also start/stop the AutoMap feature by using shift+F11 key. 

AutoMap Settings 
AutoMap Settings define the minimum criteria that must be met for a mapping point to be automatically collected. Select the box next to each criterion 
to be used for automatic point collection. The settings for AutoMap differ between cardiac and non-cardiac triggered references. 

Point Collection Status Meter 
The point collection status meter provides feedback on whether the AutoMap threshold criteria are being met during point collection. To view this meter 
in the model/map display, select the Point Collection Status checkbox in the Meter & Display Options settings panel. 
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Figure 107.  Points collection status icons 

 

Icons correspond to AutoMap thresholds: 

Cardiac triggered map-only 

1. Score icon (Score threshold) 

2. Activation Sequence icon (Activation Sequence threshold) 

3. Cycle Length icon (CL Tolerance threshold) 

4. Speed Limit icon (Speed Limit threshold) 
Non-cardiac triggered and cardiac triggered maps 

1. Distance icon (Distance threshold) 

2. Noise icon (Signal to Noise and Enhanced Noise Rejection 
thresholds) 

3. Force icon (Force threshold) 
Non-cardiac triggered maps-only 

1. Stable Distance icon (Stable Distance threshold) 

NOTE: The entire circle must turn green before a point will be 
collected. The circle will increasingly fill with green as the 
catheter electrodes remain stable (i.e. within the distance 
specified in the Stable Distance threshold). The entire circle 
will become green if the catheter electrodes remain stable for 
the duration of time defined by the Segment Length setting. 

 

The color of an icon corresponds to the following states: 
 Black with white graphic - AutoMap threshold is enabled. 

 Black with grayed-out graphic - AutoMap threshold is not enabled. 

 Flashing red - Points are not being collected because they do not meet AutoMap threshold criteria associated with icon. 

NOTE: The Speed Limit icon will turn red if the AutoMap threshold criteria is unmet for all roving electrodes collecting points, e.g. the signal 
to noise ratio would have to be beneath the threshold for every roving electrode collecting points, for the icon to turn red. 

 Magenta - The following icons will be magenta when the setup requirements described below have not been met:  

- Score icon - At least one ECG signal must be selected in the acquisition waveform display. 
- Activation Sequence icon - Primary and secondary reference signal source must be set to intra-cardiac electrograms. 
- Force icon - Roving signal source must be set to an EnSite™ Contact Force-compatible catheter and TactiSys™ Quartz Equipment must be 

connected. 

NOTE: The entire point collection status meter flashes white when any point is collected. 

Points Display 
Figure 108.  Points Display Examples 

 

 

Mapping points are collected, and a brief flash occurs at the active mapping electrodes that meet all the user defined point collection criteria. 

The flash at electrodes indicators may be disabled by unchecking the Flash New Points box on the Meters and Display Options Setting Panel. 

Figure 109.  Mapping metrics display – example for LAT map 

 

1. Score - Score value 

NOTE: Score is display when there is at least one ECG signal 
selected in the acquisition waveform display. 

2. CL - Reference cycle length 

3. Seq - Activation sequence timing value 

NOTE: Seq is displayed when the primary and secondary 
reference sources are set as intra-cardiac signals. 

4. Map type-dependent metric - A metric relevant to the type of 
map selected will be displayed, e.g. LAT will be displayed 
when the current map type is LAT. 

 

The color in which data values are displayed indicates the following: 
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 White when viewing data in real time. 

 Gold when viewing data in review mode. 

 Brown when mapping point is frozen or selected. 

 Red when AutoMap threshold criteria associated with metric are not being met. 

 Purple when a frozen or selected mapping point contains unreliable data. 

 Purple dash when: 

- the reference detection is degraded for the current beat or previous beat or 
- the previous detection beat does not exist due to clearing the beat buffer. 

Score Map 
A Score Map is a map type that plots the surface lead morphology match score associated with each mapping point collected compared to the originally 
collected template beat surface lead morphology. The physician may want to use this feature during pace mapping where it may be useful to plot the 
90%-100% morphology match scores in the area of interest. 

The user may also sort the points list by score from highest score surface lead morphology match compared to the template beat to lowest score surface 
lead morphology match compared to the template beat. When the user clicks on the mapping point, they will be able to view the current mapping point 
surface lead morphology on top of the template beat surface lead morphology trace. This may be useful to determine which surface lead(s) are different 
from the template beat. 

It is possible to adjust the map scale to only display the 90-100% matches on the map. 

The Score Map can also be used during automated mapping to allow users to automatically collect only those points with morphology match scores that 
are XX% similar or higher compared to the template beat and automatically reject those points that are not XX% similar or higher compared to the 
original template beat. 

Figure 110.  Score Map Example 

 

 

When Start AutoMap is activated, the software automatically records the data from 10 seconds before the EnSite™ X AutoMap feature was activated 
and continues recording as long as the EnSite™ X AutoMap feature is active. 

TurboMap 
Once original mapping has occurred, the user may change mapping criteria and play back through the original dataset at Max speed to generate a new 
map at 10x’s real-time speed. This is called the TurboMap feature. As an example, if the original mapping time was 10 minutes, the user can generate 
a second map in only 1 additional minute. This same concept can be employed for multiple maps. This may be useful if the physician is mapping Sinus 
Rhythm and intermittent, multiple PVC or VT morphology beats are occurring. This may also be useful if the physician is trying to map multiple, distinct 
Cycle Length atrial tachycardias. 

Figure 111.  Playback Speed Selection Menu 
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There is no limit to the number of mapping points that may be collected per map. The number of mapping points in the map is listed on the screen. 

There is no limit to the number of maps that may be collected per study. 

Catheters for Use with Automated Mapping with the EnSite X™ AutoMap Feature 
The Navigation mode determines the catheters available for mapping. In EnSite NavX™ mode physicians may take advantage of automated mapping 
with the EnSite™ X AutoMap Feature with standard EP catheters with any number of electrodes. In EnSite™ VoXel mode mapping data can only be 
collected from Sensor Enabled™ catheters. Physicians may take advantage of automatically including/excluding mapping points based on average 
contact force when the EnSite™ X Contact Force Module is installed and when the physician is using a TactiCath™ Contact Force Catheter to map. 

Example 1 (atrial mapping with multiple distinct cycle length atrial tachycardias) 
In the atrial chambers, physicians may want to automatically collect mapping points as long as the intracardiac (CS, HIS, etc) measured Cycle Length is 
within +/- XX ms of the original template beat (first point saved into the map). In the example below the physician simultaneously and automatically built 
the right atrial anatomy and atrial tachycardia LAT timing and voltage maps in the right atrium by: 

1. Saving the first atrial tachycardia (Cycle Length 1) beat into the map, ensuring that the Roving Activation Interval does not include a ventricular 
complex. 

2. Checking the "Cycle Length Tolerance" box and setting it to +/- 20 ms. 

3. Checking the "Score Threshold" box and setting it to 50 (this may eliminate roving catheter points polluted with far field ventricular activity). 

4. Select "Start AutoMap". 

Figure 112.  Atrial mapping with multiple distinct cycle length atrial tachycardias example 

 

 

 

5. If a secondary atrial tachycardia (Cycle Length 2) was intermittently occurring during original mapping, the user can save one of those points into 
a new map, pulling up the primary AutoMap mapping segment, setting the AutoMap Settings for the secondary map, and clicking Max speed to 
generate this new map with the TurboMap feature. 

Example 2 (ventricular mapping with multiple distinct surface lead morphologies) 
In the ventricular chambers physicians may want to automatically collect mapping points as long as the surface lead morphology is XX% similar to the 
template beat (first point saved into the map). For example the physician can simultaneously and automatically build the left ventricle anatomy and 
Sinus Rhythm voltage/timing maps in the left ventricle by: 

1. Saving the first Sinus Rhythm beat into the map. 

2. Checking the "Score Threshold" box and setting it to 90. 

3. Select "Start AutoMap". 

NOTE: When the surface lead morphology is not 90% similar to the template Sinus Rhythm 12-lead Surface Morphology, the red box turns 
red indicating that mapping points were not collected because the Surface Lead Morphology Match Score was outside the morphology of 
interest. This feature can be used to automatically reject ectopy as the ectopy would not be 90% similar to the template beat. 

Figure 113.  Ventricular mapping with multiple distinct surface lead morphologies example 
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In some instances secondary arrhythmias may intermittently occur during primary map collection. If this occurs, the physician could use the TurboMap 
feature to create a map with points only associated with that secondary intermittent arrhythmia by: 

1. Placing a bookmark when the secondary arrhythmia occurred during primary map collection. 

2. Saving a mapping point of the secondary arrhythmia into a new map. 

3. Pulling up the AutoMap Mapping Segment of the original map. 

4. Select Start AutoMap. 

5. Selecting Max speed to play back through the original dataset at 10x’s real-time speed. 

6. Selecting Play on the segment. 

NOTE: When the surface lead morphology is not 90% similar to the secondary arrhythmia template beat morphology, the red box turns red 
indicating that mapping points were not collected because the Surface Lead Morphology Match Score was outside the morphology of 
interest. 

This same concept could be applied to other secondary arrhythmias that occurred during the original map creation. 

Automatic Non-Cardiac Triggered Maps 
1. Setup a non-cardiac triggered map as usual. 

2. Setup the AutoMap Settings as shown in the image below. 

3. Select Start AutoMap. 

Figure 114.  Automatic Non-cardiac Triggered Map Controls 

 
 

 

Collecting Points 
The waveform display is used to evaluate waveforms and collect points. 

Figure 115.  The waveform display for contact maps 

 

 

Table 3. Horizontal Split Screen mode Elements 

Callout Item Description 

1 Time scale The time scale (in milliseconds) at the top edge of the waveform display. The detected timing reference 
appears at 0 ms. Right-click on the Time Scale to display a menu to set the sweep speed, font size, and 
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waveform thickness. 

2 Color bar (LAT maps only) When collecting or displaying LAT isochronal data, the color bar displays above the 
waveform display. The function of the color bar duplicates the color bar in the map display. Dragging the 
pointers on the color bar will adjust the range. 

3 Roving Activation Interval 
(RAI) 

The Roving Activation Interval is a timing parameter that is used in the detection of roving catheter 
activation. The RAI is defined by the black area between the curtains. The curtains appear as shaded 
areas on either side of the RAI. Roving catheter activation will not be reliably detected unless the beat falls 
within the black-background portion of the waveform display. To adjust the RAI, click and drag the edge of 
the shaded background.  

4 RAI Curtain Select and drag the curtain to adjust the RAI. 

5 Reference Activation Tick 
Mark 

Reference catheter activation as defined by the selected reference detection algorithm. The reference tick 
mark will always appear at (0) ms on the time scale. 

NOTE: If the current rhythm does not meet the reference detection settings, this tick mark will 
be magenta. 

Points can still be collected and adjusted. 

6 Reference Offset Caliper 
(Green) 

Drag to place the Reference Offset Caliper to the desired point in the waveform. Waveform timing 
calculations will be based upon the offset location. 

7 Roving Activation Tick Mark Roving catheter activation as defined by the selected roving detection algorithm, within the Roving 
Activation Interval. When adjusting this tick mark, the associated location in the map display will move to 
reflect the roving position at the time of the tick mark measurement. 

NOTE: 

 If the current rhythm does not meet the roving detection settings, this tick mark will be 
magenta. Points can still be collected and adjusted. If a time is adjusted and there are 
error conditions in the signal and the reference caliper is not purple, the caliper will turn 
yellow. 

 For CFE maps, multiple tick marks may appear on the roving waveform. Activation tick 
marks for CFE maps are not adjustable. 

8 Voltage Low Caliper Roving catheter low voltage. This voltage caliper is set to the lowest voltage within 100 ms of detected 
roving activation, within the RAI. This caliper is used in determining peak-to-peak (P-P) voltage and peak-
negative voltage. 

9 Voltage High Caliper Roving catheter high voltage. This voltage caliper is set to the highest voltage within 100 ms of detected 
roving activation, within the RAI. This caliper is used in determining peak-to-peak (P-P) voltage. 

10 RAI Values The current RAI values appear at the lower corner on each side of the curtains. These combined values 
equal the amount of time occupied by the curtains. For non-cardiac CFE maps, the RAI is equivalent to 
the segment length, and appears at the lower left and right. Only the left value changes for non-cardiac 
triggered CFE maps. For cardiac triggered CFE maps, the RAI is set independently for CFE maps and 
other contact map types. 

11 [Freeze]/[Save] When data is being collected (gated to detection of the timing reference), click the [Freeze] button to stop 
the display and review data. 
After pressing [Freeze], the label on the button changes to [Save]. Clicking [Save] allows you to save the 
current point and point display to the current map, a different map, or a new map using the pulldown 
menu. 
The following data is saved with each collected beat: electrode position, current waveforms (reference, 
roving, signal1, signal2, signal3), buffered waveforms and related roving electrode locations, timing, and 
voltage. Performance may begin to slow after 1000 points. 
When mapping is used in Review mode, [Freeze] will also freeze the waveform display and [Save] will 
cause the waveform display to play. 
Hot key: <F11> duplicates the function of the [Freeze] and [Save] buttons. 

12 [Cancel]/[Resume] When the waveform display is frozen, [Cancel] will remove the currently displayed beat and resume gated 
data collection without adding information to the map. [Resume] will resume gated data collection. 
Hot key: <F12> duplicates the function of the [Cancel] button. 

13 Collected point buffer As data is collected, each detected beat is temporarily saved in a buffer. When the waveform display is 
frozen, buffered data can be accessed using the buffer controls below the waveform display. The beat that 
was present at the time that [Freeze] was selected is represented by [0]. Previous beats can be accessed 
by selecting the buttons for [-1], [-2], etc. When reviewing beats in the buffer, the associated location in 
the map display will change to reflect the roving location at each selected beat. 
Hot key: The left and right arrow buttons in the beat buffer are duplicated by the left and right arrow keys 
on the keyboard. 

 

Mapping Settings Panel – Settings Tab 
NOTE: Controls are disabled in the Mapping Settings Panel when that control is not applicable to the current map. 

Map Points Workpanel 
Select the Map Points workpanel to display the collected points. The display is a combined waveform segment, synchronized in time, of every roving 
catheter waveform incorporated into the map. Each waveform includes a tick mark indicating the activation point and a numeric metric that is 
determined by the current map type. 

Selecting a waveform in the Map Points display shows the original data for that heartbeat in the waveform display including all saved waveforms, up to 
ten timing calipers per point (timing calipers can be adjusted), voltage calipers, and all buffered data. The beat of interest and voltage caliper settings 
can be adjusted. All changes are saved automatically. The point in the map display that is related to the highlighted waveform will flash red. 

NOTE: The first point(s) in the map are highlighted green to indicate that they are the template beat for the map. These points, while first 
chronologically, may appear at different places in the list with other sort orders. These template beats are colored green so they are not 
inadvertently deleted, as doing so would change the map. 



 

85 
 
 

Figure 116.  Map Points Workpanel (Points list and point display options) 

 

1. Scroll to Selected icon – Scrolls the list to the selected point. 

2. Locate Point icon – Locates the selected point in 3D space. 

3. Show Duplicate of Selected icon – Show duplicates of the 
selected point. 

4. Show/Hide Unused Points icon – Show all points or only the 
used points. 

5. Sort drop-down list – Sort waveforms by order of collection, 
current map type, and cycle length. (After making timing 
adjustments, the user must select sort by LAT again.) 

6. Map Points list – Displays the list of points saved to the 
current map. 

7. Timescale: The time scale, in milliseconds (ms), displays at 
the top edge of the waveform display. The timing reference 
of all waveforms is synchronized to 0 msec. Adjust the 
Sweep Speed by right-clicking in the black background 
and selecting Sweep Speed. The available options are 40, 
50, 100, 200, and 400 mm/sec. 

8. Waveform Number - Indicates the order of waveform 
collection. When multiple points are acquired 
simultaneously, all the related points have the same 
waveform number. 

9. Electrode Polarity - Polarity of the electrodes on the 
catheter. Unipolar is indicated with the single electrode 
preceded by a "+" sign. 

10. Hide Point Checkbox - When checked, this checkbox 
indicates that this point on the map may show. Clear the 
check mark to hide this point. When unchecked, the point 
is hidden, and a red circle displays. 

11. Duplicate Points - A star above the check box indicates a 
duplicate point. There are 3 types of duplicate points: 

- Blue outline star - duplicate point, but not used 

- Solid blue star - point has duplicates, but this point is used by 
the system 

- Solid gold start - point has duplicates, but the user chose to 
use this point 

1. Dashed Waveform Line - A dashed waveform line indicates 
that a point is not used to color the map (not shown). The 
following types of points are drawn as dashed: hidden 
points, duplicate points, points outside the projection 
distances, and points with no locations. 

2. Solid Waveform Line - Indicates a point that is used in the 
map. 

3. Blue background - Indicates the selected waveform. The 
data for the waveform is shown in the waveform display. If 
the corresponding point is used in the map, the 3D point, 
its projection on the map surface, and its text, flash red. 

4. Map point measurement - The Timing (in ms) or Voltage (in 
mV) of the map point. 

5. Number of points - The number of points that have been 
selected/used/collected. The list may have to be scrolled to 
see all the waveforms. 

6. Delete button – To delete a waveform from the Points 
display and its corresponding point from the map, select 
the waveform and select [Delete]. 

7. Delete Group button – Removes the selected group of 
points. 

8. Delete Last button – Removes the selected group of point(s) 
last saved. 

 

Amplitude – Waveform amplitude can be adjusted by middle-clicking the waveform and dragging up or down. For the Points display, amplitudes are 
ganged for all waveforms. 

Panning – The Points display will default to centering on the timing reference. The display can be panned by <Shift> + middle- clicking in the 
background and dragging left or right. 

Waveform indicators – The type of line used in the waveform indicates the effect of the waveform on the map. 
 Solid, bold with blue background – The waveform is selected. The original data for this waveform is currently displayed in the waveform display. If 

displayed in the map display, the 3D point, 3D text, and surface point for this waveform flashes red. 
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 Solid – The waveform is used by the map. 

 Dashed – The point is a duplicate or is degraded. 

Delete Hidden Points – To delete points that were hidden using the Show checkbox, right-click in the waveform display or Points display and select 
Delete Hidden Points. 

Delete Unused Points – To delete all points that are not displayed due to the current projection settings, right-click in the waveform display or Points 
display and select Delete Unused Points. 

NOTE: Due to the potential collection of duplicate points, the action to "Delete Unused Points" may cause more unused points to appear. To 
delete duplicates, sort by point status, then select and delete all of the unused duplicates. 

Scroll bar – Use this control to scroll through all activation points. 

Hot key: When the Points display is open, the up and down arrow keys select the previous or next point, respectively. When the Points display is open, 
[Delete] will remove the current beat in the waveform display.  The left and right arrow keys select a point backward and forward in time respectively in 
the beat buffer. 

Creating a Map 
Setting Up a New Map 
1. From the Collect Workpanel, select New Map from the Current Map drop-down menu, or choose No Map Selected from the drop-down menu in 

the Model/Map Display Window. 

2. The user may choose to name the map. 

3. From the Mapping sub tab, select the primary reference timing signal. 

a. Select a primary reference source from the drop-down menu. 

b. Select a detection algorithm from the Detection drop-down menu. 

c. Sensitivity defaults to auto, if using fixed Sensitivity, adjust the Sensitivity to a level just outside of baseline noise. 

4. Select a secondary reference source and algorithm if using a secondary intracardiac reference. 

a. Select a secondary reference source from the drop-down menu. 

b. Select a detection algorithm from the Detection drop-down menu. 

NOTE: A secondary reference can only be used if the primary reference is an intracardiac signal. 

5. Select an initial roving catheter signal. The roving catheter can be any intracardiac electrogram that is actively being located (hidden electrodes 
cannot be used as Roving).  

a. Select a roving source from the drop-down menu. The roving signal can be changed during mapping, allowing any intracardiac electrode to be 
used as part of the mapping process. 

b. Select a detection algorithm from the Detection drop-down menu. 

c. Adjust the Sensitivity to a level just outside of baseline noise. Sensitivity is adjustable only for First Deflection and Last Deflection detection 
algorithms in cardiac triggered reference maps. Sensitivity is always adjustable for non-cardiac triggered reference maps. 

After the references and detection algorithms have been selected, waveforms will begin to refresh in the waveform display, gated to detected activation 
on the primary reference. 

6. Adjust the Roving Activation Interval by clicking and dragging the edge of the shaded boundary. Generally, the Roving Activation Interval should 
be set to encompass one activation sequence on the roving catheter. 

Collecting Points (Select template beat) 
If in Edit Model on the Model subtab, the Active EnGuide is automatically changed to be the same as the Roving catheter and the Active EnGuide 
control is not selectable. 

1. With the patient in the clinical rhythm, place the roving catheter to collect data. When a beat of interest appears in the RAI, select [Freeze]. 

NOTE: Selecting [Freeze] will automatically enable [Collect Points] when model type is set to OneModel. 

2. In the frozen mapping screen, review the morphology of the beat and placement of the caliper lines. If necessary, select an optimal beat from the 
collected point buffer and/or adjust calipers. 

3. Select [Save] or select a New Map or an existing map from the pulldown menu to save the point; otherwise, select [Cancel]. The waveform display 
will return to acquisition mode. 
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Figure 117.  Map from Segment Example 

 

 

To Map from a Segment 
1. Click the Split Screen mode button in the upper right corner of the Mapping screen. 

NOTE: You will need to switch the secondary screen from Live to Review mode. 

2. Select the appropriate segment from the drop-down list at the bottom of the right display. 

3. If necessary, use the Waveform control panel in the right display to set the roving catheter and electrode. 

4. Reference 11 through 13 under the Horizontal Split Screen Mode Elements table in the section titled Collecting Points. 

NOTE: Points can be added to either the left or right display and will be applied to both displays. Offline Review only. 

Managing Maps 
New Map – New Map can be selected from the drop-down menu in the upper right corner of the Collect Work Panel. Select New Map; the Map Name 
screen comes up with a prompt to name the map. Type a name in the Name field and click [OK]. 

Copy Open Map - Copy Open Map can be selected from the drop-down menu in the upper right corner of the Collect Work Panel. Select Copy Open 
Map; the Map Name screen comes up with a prompt to name the map. Type a name in the Name field and click [OK]. 

NOTE: You can rename a map by double-clicking in the Map Name field at the top of the Collect Work Panel and typing in the new name.  

Lesions Work Panel 
The Lesions Work Panel provides controls to allow the user to place lesion marker manually or to automatically place lesion markers using AutoMark. 
Lesion markers are primarily used to identify ablation therapy locations. When placed, Lesion Markers are projected from the 3D center of the Active 
EnGuide electrode to the nearest model surface. If the model surface is edited, lesions projections are recalculated using the original 3D location of the 
electrode used to create the lesion marker. 

Lesions Work Panel - Manual Sub-tab 
Allows the user to manually place lesion markers on the 3D model. The Manual sub-tab contains a list of lesion markers and controls for modifying their 
appearance. When using the Lesion Marker tool, you can place lesion markers with the mouse or use the tool bar to place surface and 3D lesions at the 
Active Electrode. 

Lesion markers are used to identify ablation lesion marker sites. Up to 1024 manual lesions can be placed in the map display. 

An adjustable distance control allows you to edit the distance allowed for projection. Lesion markers that are present and do not meet the 3D distance 
requirement are displayed as 3D objects (without being tied to a surface). You have the option to project, or not to project the lesion. 

Each lesion marker has a numeric name that is displayed in a list. This number increments each time a lesion marker is placed on the map. If a lesion 
marker is deleted, the numeric list is updated to keep numbers consecutive. 
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Figure 118.  Map with Lesion Markers on the Surface 

 

 

Figure 119.  Lesions Tab – Manual Sub-tab 

 

1. No. (list column) – Lesion ID number based on order of 
Lesion placement. 

2. Time (list column) – Time when the lesion was created. 

3. Lesion Visibility (list column) – Use the Lesion Visibility 
checkbox to show or hide a lesion. 

- Checked: Lesion is visible 

- Unchecked: Lesion is hidden 

4. 3D Lesion (list column)– Use the 3D Lesion checkbox to 
control how a lesion is displayed. 

- Checked: Lesion is displayed as a 3D Lesion 

- Unchecked: Lesion is projected on to the model surface 

5. Color (list column) – Use the color chart to select the color 
of a lesion. Select the colored square to open the color 
selector, and then select the desired color. 

6. Annotation (list column) – Select field to manually enter 
annotation text for individual Lesions.  

7. Delete button – Use the delete button to delete a selected 
lesion. 

8. Visible checkbox – Use the checkbox to show/hide 
selected lesions.  

- Checked: Lesion is displayed as a 3D Lesion 

- Unchecked: Lesion is projected on to the model surface 

9. 3D Lesion checkbox – Use the 3D Lesion checkbox to 
control how a selected lesion is displayed. 

- Checked: Lesion is displayed as a 3D Lesion 

- Unchecked: Lesion is projected on to the model surface 

10. Color – Use the color chart to select the color of selected 
lesions. Select the colored square to open the color 
selector, and then select the desired color. 

11. Diameter slider – Adjust the diameter of selected lesions. 

12. Lesion Text checkbox – controls the visibility of Annotation 
text within the map screen. 

- Checked: Annotation text is visible in the map screen. 

- Unchecked: Annotation text is not visible in the map screen. 
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Lesions Work Panel - AutoMark Sub-tab 
AutoMark will color and size lesion markers on the 3D model based on physician defined RF metrics and ablation catheter stability requirements. 
AutoMark provides the following functions: 
 Automatic coloring and sizing of AutoMarks based on user-defined ablation criteria. 

 Automatic placement of AutoMarks based on user-defined catheter stability criteria. 

 Automatic segment recording during RF ablation. 

 Display of live RF generator information. 

 Export of AutoMark data. 

 Cataloging of data for retrospective review. 

AutoMark Parameters 
The color and size of the AutoMarks can be configured based on the following criteria: 
 Energy (Joules). 

 Time (Seconds). 

 Impedance Drop (Ohms). 

 Impedance Drop (%). 

 Average Power (Watts). 

 Maximum Power (Watts). 

 Average Temperature (Degrees Celsius). 

 Max Temperature (Degrees Celsius). 

 FTI (OUS only). 

 LSI (OUS only). 

Average Force (grams). 

Max force (grams). 
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Figure 120.  Lesions Tab – AutoMark Sub-tab 

 

1. Color Metric – Metric used to define the color of 
AutoMarks. 

2. Size Metric – Metric used to define the size of 
AutoMarks. This may be set to "Same as Color". 

3. ID (list column) – RF Session ID and AutoMark ID 
automatically assigned by the system and increases 
sequentially. An RF Session is defined by one complete 
cycle of RF on/off. If AutoMark placement criteria are 
met, an RF Session will contain one or more 
AutoMarks. 

4. Duration (list column) – Denotes duration of the RF 
Session, individual AutoMark or transition in seconds. 

5. Metric Column (list column) [example displayed: Time] – 
Displays metric data for each AutoMark. Column 
displays metric selected for Color Metric (#1). 

6. Visibility (list column) – Use the visibility checkbox to 
show or hide the item. When the checkbox is selected, 
the item is visible. To hide the item, select the 
checkbox. 

7. Annotation (list column) – Double-click on an AutoMark 
to add a text annotation. 

8. RF Statistics icon – Choose this to open the RF Session 
Statistics dialog box. 

9. Show Transitions checkbox – Displays the transient RF 
data that is not associated with an individual AutoMark 
(that is, when the catheter is moving to a new location 
while RF is still on). Transition items in the AutoMark 
list are grayed out and do not have an ID or a 3D 
sphere in the Map Display. 

10. Delete button – Deletes selected AutoMarks. RF Sessions 
cannot be deleted. 

11. Selected ID checkbox – Displays the AutoMark ID in the 
map screen for selected AutoMarks. 

12. AutoTracks checkbox – Displays catheter location data in 
the form of a line in 3D space tracking the path taken 
by the tip of the ablation catheter during RF.  

13. Selected Value checkbox – Displays the metric value for 
selected AutoMarks in the map screen. Metric value 
displayed is the metric selected for Color Metric (#1). 

14. AutoMarks checkbox – controls the display of all 
AutoMarks. 

15. 3D Annotations checkbox – Displays the AutoMark 
annotations on the 3D map. The user can add or edit 
an annotation by double-clicking in the annotation 
column for the desired AutoMark from the AutoMark 
list. 

16. Project on Surface checkbox/slider – Projects AutoMarks 
to the closest model surface if they are within the user 
defined distance threshold. 

17. Show/Hide AutoMark Feature button – Controls the 
display of all AutoMark data including AutoTracks. 
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RF Session Statistics dialog box 
The RF Session Statistics dialog box displays RF Session data from the Ampere™ generator. 

Figure 121.  RF Session Statistics dialog box 

 

1. RF Session drop-down list. 

2. Session Time (in Seconds). 

3. Average [Power (W), Temperature (°C), Impedance (Ω)]. 

4. Maximum [Power (W), Temperature (°C), Impedance (Ω)]. 

 

Configure AutoMark Thresholds 
The user must first define the AutoMark color and size thresholds. These can be saved in a preset for use in subsequent procedures if desired. 

NOTE: If using less than 4 thresholds, start from the top row. 

The default Color Metric and Size Metric is Time, the user may set as below: 
 Color: Gray. 

 Diameter: 4. 

 Value (seconds): 0. 

To configure the AutoMark thresholds: 

1. From the Lesions Workpanel, select the AutoMark sub-tab. 

2. Select the desired Color Metric and Size Metric from the respective drop-down lists. 

NOTE: 

 AutoMark collection is disabled until the user accesses the AutoMark tab for the first time in each study. When the user has accessed 
the tab for the first time, AutoMark collection can be enabled/disabled as desired using the button in the Metrics Setup dialogue box. 

 If AutoMark Collection is disabled, AutoMarks, RF Session AutoSegments, and RF On/Off events (in the Notebook) will not be recorded. 

3. From the Metrics Setup dialog box drop menu, select the desired Metric to configure. 

Figure 122.  AutoMap Threshold Configuration 

 

 

Table 4. Available Metrics 

Energy Avgerage Power Average Force 

Time Maximum Power Maximum Force 

Impedance Drop (Ohms) Average Temperature FTI (OUS only) 

Impedance Drop (%) Maximum Temperature LSI (OUS only) 

For Contact Force related parameters refer to the EnSite™ X Contact Force IFU. 
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Figure 123.  AutoMap Threshold Values 

 

1. Define the Value for each threshold. This is the value 
at which the Color and Diameter of the AutoMark will 
be set. 

2. Select the color box and choose a Color to associate 
with each value. 

3. Define the Diameter to associate with each value. 

NOTE: The Diameter, or Size, of the AutoMark is 
relative to one another: e.g., "1" is smaller than "2." 

4. Repeat steps 1 through 3 for all desired metrics from 
the pulldown menu. 

NOTE: Threshold values for the currently selected 
color metric can be changed by dragging on the 
transition values in the color bar shown on the map 
display. 

 

Figure 124.  Threshold values on the map display 

 

 

AutoMark Placement 
AutoMark placement is based on three user-defined settings. 

AutoMark Region: 
 The spatial catheter stability requirement for each AutoMark, which defines the AutoMark region. 

 This is also the minimum distance between AutoMarks. 

 Default = 1.5 mm (millimeters). 

Min AutoMark Time: 
 The minimum amount of time the catheter tip must remain within the AutoMark region before a new AutoMark is placed. 

 Default = 3.0 seconds. 

Away Time: 
 The maximum amount of time the catheter can move away from the AutoMark region before that AutoMark is completed. 

- For example, if an AutoMark has been created and the catheter moves away from the AutoMark region for a duration longer than the Away 
Time, the AutoMark will be completed. If the catheter returns to that location at a later point in the procedure, a new AutoMark will be created, 
and the data will not be combined. If the catheter returns to the AutoMark region within the Away Time, the data will continue to be collected 
in to the current AutoMark. 

 Default = 8.0 seconds. 

NOTE: 

 It is recommended to set the Away Time to a duration that is greater than the respiration cycle of the patient. 
 The accuracy of the AutoMark placement is dependent on the catheter Navigation Accuracy. 

AutoMark Placement Overview 
Ablation catheters will move in three-dimensional space due to heart beat and respiration. The AutoMark placement algorithm must take these motions 
into account when determining placement of AutoMarks. 

AutoMarks are placed at the average three-dimensional location of the data included for each AutoMark. AutoMarks can be visualized either as three-
dimensional spheres whose center point is this location or projected to the closest surface. If projected to the surface, a representation of the AutoMark 
is shown on the geometry using the same projection algorithm as for manual lesion markers. 

AutoMarks serve as a record of therapy delivered and are not intended to be definitive as to whether or not a lesion has or has not been formed. 

As shown in the figure below, the AutoTrack represents the string of data points collected. The x,y,z points are based on a cluster of data points that are 
determined by the marker time interval, which is calculated using the placement parameters. The placement algorithm breaks up the data points along 
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squiggly path according to the thresholds that the user sets. The average location calculation is the sum of all the x,y,z values divided by the number of 
x,y,z values based on the set of data locations along each path: 

x = (1/n) * sum(x(1), ..., x(n)). 

y = (1/n) * sum(y(1), ..., y(n)). 

z = (1/n) * sum(z(1), ..., z(n)). 

Figure 125.  Average Location Calculation 

 

 

The system automatically places an AutoMark at the center of the tip electrode when the catheter remains within the AutoMark region (1.5 mm) for at 
least the Min AutoMark Time (3 seconds). 

When the catheter moves greater than the AutoMark region, the AutoMark metrics display will blink to indicate that a new AutoMark is preparing to be 
created. While blinking, data values will continue to accumulate. Once the Min AutoMark Time at the new location is met, an AutoMark is created and 
the blinking stops. Values for the previous AutoMark will be finalized and the metrics display will switch to displaying the metrics values for the new 
AutoMark. If, due to cardiac motion, respiration, or other catheter movement, the ablation catheter is away from the AutoMark region for less than the 
Away Time, once the catheter returns the data will be added to the current AutoMark. If the catheter does not return within the Away Time, the 
AutoMark will end. If the catheter returns at a later time, a new AutoMark will be placed, and the data will not be cumulative. 

Transition Data 
Transient RF data that is not associated with an individual AutoMark (i.e. when the catheter is moving to a new location while RF is still on). Transitions 
in the AutoMark list are grayed out and do not have an ID or a 3-D sphere in the Map Display. Transitions can be shown by checking the "Show 
Transitions" checkbox. 

Figure 126.  Transition Data Rows 

 

1. Arrows indicate transition data rows. 

 

Placement Example 
In the example below, a new AutoMark was created because the ablation catheter moved more than 1.5 mm (AutoMark region) from the active 
AutoMark and stayed within a new 1.5 mm location for a duration longer than 3 seconds (Min AutoMark time). 
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Figure 127.  AutoMark Placement Example 

 

1. Ablation Catheter 

2. Active AutoMark 

3. AutoMark Region (1.5 mm) 

4. New AutoMark 

5. AutoTrack 

 

AutoMark Placement Examples 
The following images provide examples of the same study displayed with different AutoMark placement options, including AutoMark region, Min 
AutoMark Time, and Away Time. 

For all examples below, the AutoMark Color is defined as: Time (0-5s, White; 5-10s, Gray; 10-20s, Light Red; 20+s, Dark Red). 

Table 5. AutoMark Placement Examples 

Example 1 (default) 

Away Time: 8 s 
Min AutoMark Time: 3 s  
AutoMark Region: 1.5 mm 

Example 2 

Away Time: 8 s 
Min AutoMark Time: 10 s  
AutoMark Region: 1.5 mm 

 
 

 Fewer AutoMarks are created because the ablation catheter must remain 
within the AutoMark region for 10 seconds (instead of 3 seconds). 
Additionally, no White or Gray AutoMarks are shown because all placed 
AutoMarks have a value of greater than 10 seconds. 
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Table 5. AutoMark Placement Examples 

Example 3 

Away Time: 8 s 
Min AutoMark Time: 3 s 

AutoMark Region: 5.0 mm 

Example 4 

Away Time: 8 s 
Min AutoMark Time: 3 s 

AutoMark Region: 2.5 mm 

  
More AutoMarks are created because the spacing between AutoMarks is 
only 0.5 mm (instead of 1.5 mm). Additionally, the AutoMarks tend to 
have a lower corresponding time as only data within the 0.5 mm region is 
collected. 

Fewer AutoMarks are created because the spacing between AutoMarks is 
2.5 mm (instead of 1.5 mm). Additionally, the AutoMarks tend to have a 
higher corresponding time as data within the 2.5 mm region is collected. 

Example 5 

Away Time: 8 s 
Min AutoMark Time: 3 s 

AutoMark Region: 1.5 mm 

Example 6 

Away Time: 2 s 
Min AutoMark Time: 3 s 

AutoMark Region: 1.5 mm 

 

 

AutoTrack shows larger catheter movement for each AutoMark because 
all catheter movement resulting from respiration motion is included in the 
AutoMark data. 

AutoTrack shows smaller catheter movement for each AutoMark because 
less catheter movement resulting from respiration motion is included in the 
AutoMark data due to the shorter Away time. 
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Configure AutoMark Placement Settings 
Configure the Placement Settings as described above. The user can click and drag the slider or type a value directly into the field. 

NOTE: Placement Settings can be updated at any time. When Placement Settings are updated, all existing AutoMarks will be updated to 
reflect the new settings. It is recommended to set the Away Time to a duration that is greater than the respiration cycle of the patient. 

Figure 128.  AutoMark Display Settings 

 

 

Figure 129.  AutoMark Placement Settings 

 

 

AutoMark Display Settings 
These controls configure how the AutoMarks are displayed on the 3D map. 
 Show Transitions - Displays the transient RF data that is not associated with an individual AutoMark (i.e. when the catheter is moving to a new 

location while RF is still on). Transition items in the AutoMark list are grayed out and do not have an ID or a 3D sphere in the Map Display. 

 Selected ID - Displays the AutoMark ID on the 3D model when selected. 

 AutoTracks - Displays the raw catheter location for each AutoMark. 

 Selected Value - Displays the metric value for selected AutoMarks in the map window. Metric value displayed is the metric selected for Color 
Metric. 

 3D Annotations - Displays the AutoMark annotations on the 3-D map. The user can add or edit an annotation by clicking in the annotation column 
for the desired AutoMark from the AutoMark list. 

 Project on surface - Projects the AutoMarks to the closest surface on the 3D model if they are within the user defined distance, as defined by the 
slider bar. 

 AutoMarks - controls the display of all AutoMarks. 

 Show/Hide AutoMark Feature - Controls the display of all AutoMark data including AutoTracks. 

Configure AutoMark Visible Thresholds 
When used, an AutoMark will not display until the value exceeds the defined visible threshold. Visible Thresholds can be defined based on one or more 
of the AutoMark Parameters. 

Default: No Visible Thresholds are configured. 

Table 6. AutoMark Parameter. 

Energy Average Power Avgerage Force 

Time Maximum Power Maximum Force 

Impedance Drop (Ohms) Avgerage Temperature FTI (OUS only) 

Impedance Drop (%) Maximum Temperature LSI (OUS only) 

Figure 130.  AutoMark Visibility Thresholds 

 

 

AutoTrack 
AutoTracks provide the ability to see and review the raw ablation catheter location during RF and may be useful when assessing lesion continuity or 
ablation catheter stability for each particular lesion. There are two types of AutoTracks: 
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 Live AutoTrack is the white line that displays for a current RF session or the most recent RF session. Live AutoTrack always displays when the 
AutoTracks checkbox is enabled. 

 Selected AutoTrack is the blue line that may be displayed for RF sessions prior to the most recent one. To display a Selected AutoTrack, highlight 
the desired AutoMarks and transitions. 

 When reviewing AutoMarks via the Generator Waveforms window, the exact location of the ablation catheter can be pinpointed on the AutoTrack 
via a color change to the line, as the user moves the time cursor throughout the RF event. The portion of the AutoTrack behind the catheter 
location is red, while the portion in front of the catheter location may be either white or blue, depending on if the AutoTrack being reviewed is Live 
or Selected. 

Generator Metrics Display 
The Generator Metrics Display provides a configurable numeric display of generator information. The Generator Metrics Display window can be 
positioned anywhere in the Model/Map workspace and can be positioned anywhere on the map display. 

1. Select the Generator Metrics checkbox from the Meter and Display Options Settings Panel. The meter will display in the Model/Map Display. 

2. To Add/Remove Metrics to the Generator Metrics Display. 

- Right-click on the metric display and clicking the "+" or "-" button. 
- Configure the display of each box by right-clicking on the box and selecting the metric for display. 

Figure 131.  The Meter Displays Menu 
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Figure 132.  Metric Display 

 

 

Table 7. Available Generator Metrics. 

Avg. Force Max Force 

Energy Time 

Impedance Drop Impedance Drop (%) 

Avg. Power Max Power 

Avg. Temperature Max Temperature 

RF Session Time Power 

Temperature Impedance 

NOTE: 

 The user can change the shape of the Generator Metrics Display by selecting and dragging the small, gray circle at the lower right corner 
when two or more metrics are displayed. 

 The user can change the shape of the Metric Display by selecting and dragging the small, gray circle in the lower right corner when two 
or more metrics are displayed. 

Generator Waveform Displays 
This display allows for live and review visualization of the RF generator and Contact Force information. 

Figure 133.  Generator Waveform Display 

 

 

1. Enable the display of generator and contact force information by clicking the box next to each parameter. 
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Table 8. Available Parameters. 

Power Temperature 

Impedance Total Force 

Current  

2. Define the screen range by clicking on the range and editing the maximum and minimum values. The range for each trace in the Generator 
Waveform Display can be modified in a number of ways: 

- Select a trace by clicking the wave, scale, or name in the title bar. Select the maximum/minimum value that appears at the top or bottom of the 
vertical scale and type the new desired value. 

- Move the trace up or down with a left-click and drag on the wave, scale, or name. 
- Scale the trace up or down with a middle-click and drag on the wave, scale, or name. 
- When zoomed in on review data, the user can move the time range using a shift + middle click combination and dragging in an empty area on 

the Generator Display. 

3. Adjust the time scale by right-clicking on the time display or by zooming on the display using middle mouse. 

Export AutoMark Data 
Summary and raw AutoMark data can be exported to a USB device, CD/DVD, or network drive. Refer to the Data Export section in the 
EnSite™ X EP System Instructions for Use. 

Review AutoMark Data 
Double click on an AutoMark from the AutoMark list to open a review panel that will allow the user to review all the information associated with the 
selected AutoMark, including catheter location and stability, ablation electrograms, and RF generator information. The user can use the cursor to scroll 
through the information and assess the various parameters at any given timepoint. 

Manually Editing AutoMarks 
If the user would like to edit the placement of specific AutoMarks, it is possible to manually combine or split them. Only AutoMarks within the same RF 
session can be manually edited, and only in review after the RF session has completed. 

NOTE: Changing the AutoMark Placement settings, Field Scaling, and Fusion will re-apply the Auto Placement algorithm and all manual 
AutoMark edits will be lost. 

Combining AutoMarks 
Manually combining two or more consecutive AutoMarks within the same RF session will combine their respective data into a single AutoMark. When 
AutoMarks are combined, the new AutoMark will be placed at the average three-dimensional location of the combined AutoMark. 

NOTE: There is no distance limitation for combining AutoMarks; however, only consecutive AutoMarks (i.e. sequential in time) within a 
single RF session may be combined. 

To combine AutoMarks: 

Figure 134.  Combining AutoMarks: Before, Left; After, Right 

 

 

1. Select two or more consecutive AutoMarks from the AutoMark list. 

NOTE: Ensure that Transitions are shown when combining. 

2. Right click on the AutoMark list and select Combine AutoMarks. 

Splitting AutoMarks 
Splitting an AutoMark at a specific point in time will create two AutoMarks with the data being split at the exact point in time defined by the user. A split 
AutoMark will remain in the same RF Session in the AutoMark List. 

When the AutoMark is split, two AutoMarks will be placed at the average three-dimensional location of their respective data. 

To manually split AutoMarks: 

1. Select an AutoMark from the AutoMark list. 
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Figure 135.  Splitting AutoMarks: Before, Left; After, Right 

 

 

2. Drag the time cursor in the Generator display to the time that the new AutoMark should start. 

3. Right click the Generator Display and select Split AutoMark. 

Re-splitting 
Re-splitting re-applies the Auto Placement algorithm to the selected AutoMark and will undo any manual editing of the selected AutoMarks. 

To re-split AutoMarks: 

1. Select an AutoMark from the AutoMark list. 

2. Right-click in the Generator display and select Re-split AutoMarks. 

Review Work Panel 
The Review Work Panel allows the user to review the study notebook recorded in the current study. 
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Notebook 
The Notebook allows recorded data and study information to be filed and annotated for future review. Events (realtime) and Bookmarks (offline review) 
can be added to the Notebook to mark specific times in a study which allow the system to return to a specific time in review environment. 

The Notebook is accessible in the Review Work panel. 

Figure 136.  Review Work Panel - Notebook 

 

1. Order by Time/Order by Type – Text changes based on view. Select 
this text to change the format of the Notebook organization. 

2. Order by Type – Shows a list of the items in the notebook that fit the 
criteria of each item type. Item types include: 

- Animation 

- Bookmark 

- Mapping 

- Image Sequence 

- Segment 

- Stop Time 

- Auto Segment (System automatically adds) 

- Comment 

- Image 

- Model 

- Start Time 

- Events 

3. Order by Time - Shows a list of all items in the notebook in order of 
time the item was created. Items that were created in review are 
ordered based on the original time stamp in the study and are 
highlighted in brown to distinguish from items created during the live 
study. 

4. Load button – Loads the selected item from the Notebook list. Items 
can also be loaded by double-clicking the item in the Notebook list. 

5. Edit button – Allows the text of the selected item from the Notebook 
list to be edited. 

6. Delete button – Deletes the selected item from the Notebook list. 

 

Table 9. Feature descriptions for Review functions. 

Feature Name Realtime Realtime Split Screen Review Offline review 

Saving an Event X X  

Saving a Bookmark   X 

Recording Manual Segments X   

Recording Automatic Segments X   

Playing Recorded Segments  X X 

 

Review Functions Feature Descriptions 

Saving an Event 
An event can be added to the Notebook to mark important activities (e.g. drug administration). An event is always stamped with the current Realtime 
clock (not the time cursor, in RealReview mode). 

NOTE: The key sequence for saving an event is <Ctrl> + <E>. The time is stamped when the key sequence is executed. 

From the menu bar, select File > Save Event. The Save Event window will appear. 

Type the text of the annotation in the text area, and then select Save. 

Saving a Bookmark 
Bookmarks create Notebook entries that allow the system to return to a specific time. 

NOTE: The key sequence for saving a bookmark is <Ctrl> + <B>. The time is stamped when the key sequence is executed. 

If the segment is playing, click the pause button. 

From the menu bar, select File > Save Bookmark. The Save Bookmark window will appear. 

Type the annotation for the bookmark in the text area, and then select Save. 

Recording Manual Segments 
Segment recording is used to save a segment of information to the Notebook for future review. 
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From the bottom bar, select the green Record button to begin recording. The Record button will change to an orange Stop button. The recorded 
segment begins approximately 10 seconds before the Record button was clicked. The length of the segment being recorded and the number of 
segments recorded during the study appear in the Notebook. 

Hotkey: <F4> key can be used in place of Record and Stop. 

Select Stop to stop recording. 

An annotation can be added to the segment by typing in the text area on the bottom bar. Annotations can be added or modified at a later time from the 
Notebook. 

Recording Automatic Segments 
The system automatically records segments. These automatically recorded segments are added to the Notebook where they are identified as Auto 
Segments. Automatic recording occurs under the following circumstances: 
 After validating 

 When the positional reference is changed 

 When positional reference dislodgement is detected 

 When positional reference dislodgement is adjusted and accepted 

 When the user collects Respiration Compensation data 

 Right-click menu in Model/Map Display and select Sheath Filter Baseline 

 When the model is finished 

 Before and after EnGuide Alignment 

 Every 15 minutes 

 At the end of a study 

 When AutoMap is collecting data (unless option is turned off) 

 When an RF session is in progress (unless option is turned off) 

NOTE: Auto segments do not appear in the segment drop down menu. 

Accessing Recorded Segments 
The purpose of the RealReview task and Offline Review mode is to review data recorded during Realtime mode. 

To access a recorded segment (RealReview or Offline Review modes) from the same study, use the notebook: 

1. From the list, select a recorded segment or bookmark. 

2. Select [Load] or double click on the segment or bookmark name, if doing it from the Notebook in Realtime. 

A recorded segment can also be accessed from the Segment drop-down menu in the control bar. 

Playing Recorded Segments 
Recorded segments can be played in the RealReview or Offline review by loading a segment from the Notebook or from the Segment drop-down 
selection in the bottom bar. 

Realtime - By default, when RealReview mode is first entered, the system waits for the user to select a segment in that study. 

Offline Review - Opening a study from the Past Studies screen opens the study in the Model task. The last recorded segment will automatically be 
played. The brown status bars indicate Offline Review environment 

Overview – The segment overview shows the length of the entire recorded segment in black. The portion of the entire recorded segment that is shown in 
the waveform display appears in gray in the Overview. 

Click and drag the gray area of the Overview to display that area in the waveform display. 

The time cursor and any placed calipers also appear in the Overview. 

Time Cursor – The time cursor is a vertical yellow line in the waveform display that indicates the time represented by the map display. The specific time 
represented by the time cursor appears in the lower right corner of the waveform display. 

Clicking in the waveform display background (not on a trace) makes the time cursor appear at the mouse pointer. 

Dragging the time cursor moves the cursor across the waveform display. 

Moving the time cursor in the waveform display also affects the time represented by the map display. 

Segment drop-down menu – Select a manual segment, event, or bookmark from the drop-down list to load the item. 

Play button – starts the time cursor moving to the right. When the cursor reaches the right edge of the waveform display, segment playback starts over 
again. After clicking the play button, the button turns into a pause button (pauses playback). 

Arrow buttons – While the waveform display is frozen, the left and right arrow buttons move the time cursor one sample to the left or right, respectively. 
Holding down an arrow button causes the time cursor to scroll. To set a sample (in 1, 10, or 100ms), right click on the right or left arrow keys and make 
a selection from the windows. Hot key: The arrow keys on the keyboard can be used to scroll the time cursor left or right. 

Review Speed – In Review environments, the Review Speed drop-down menu controls the speed of the time cursor as it moves to the right, which 
controls how fast the waveforms scroll across the screen. To choose a speed, select the drop-down menu button and select a speed from the available 
list: 1:1 (real time speed), 1:2 (half speed), 1:4 (quarter speed), 1:10, 1:25, 1:50, 1:100, 1:200, 1:500, 1:1000, 2:1 (double speed), TurboMap 
(maximum speed). 

Reviewing Segments 
Selecting a segment from the notebook will display it in the right pane. Playback controls become enabled beneath the view. 

Reviewing Bookmarks 
Selecting a bookmark from the control panel list opens the recorded segment with the time cursor frozen at the bookmarked location. This point is 
marked by a yellow line in the waveform display and segment overview. 

Reviewing Images 
Double clicking on an image listed in the control panel causes the image to be displayed in the center of the display window. The image size can be 
adjusted by dragging the lower right corner of the window. 
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Reviewing Annotations 
The annotation list area can be used to view and modify the annotations (labels, anatomic markers, tape measures, lesion markers, and EnGuide 
shadows). Select a type icon from the Tool Palette. Annotations created in Offline Review will have a brown background in the control panel. To modify 
an annotation, select the annotation in the list (it will be selected in the model) then use the controls to show/hide, delete, and change the appearance 
of the annotation. 

Figure 137.  Play Bar. 

 

 

Figure 138.  RealReview screen. A: Notebook listings; B: Annotation lists. 

 

 

Figure 139.  Offline Review screen. Note the brown status bars. 
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Settings Panels 
The Settings Panels contain controls and settings less often modified during a case. Presets can be managed from the settings panels and are context 
sensitive. When the user is within any specific Settings Panel, the user may manage the presets for that Settings Panel only. The contents of a Settings 
Panel temporarily displays in the Work Panel space when an individual control is accessed. Panels are minimized using the ‘Close’ icon, or when 
another panel icon is selected. Once Settings Panels are closed, the Work Panel returns to view. 

NOTE: Areas marked within a box are settings and values saved with a preset. The example below shows the Meter and Display Options 
settings panel. All items within a box will be saved as a preset. These values change in all corresponding areas of the user interface (Work 
Panels, Settings Panels and the Mobile Work Panel.). 

Not all settings captured in a preset are configured or displayed in panels including display size and location of screens and/or meters/metrics, font 
sizes, Waveform amplitude, RAI screen, etc. 

Figure 140.  Settings Panel Preset Options 

 

 

Study Presets 
The use of study presets enables a user to quickly and easily setup a new study with a set of settings that is consistently used for studies. Users can 
enable or manage presets from the Settings Panels in the Workspace (Catheter presets can also be enabled in Setup.). 

Changes made on the Work Panel are reflected on the corresponding Settings Panel. To Save the changes the user must go to the corresponding 
Settings Panel and save. 

Although there are some differences in the use of presets in these three areas, the basic ideas in their use are the same. 

Typically, a user will enable one or more presets at the beginning of a study to save time and avoid manually changing options and settings; rarely are 
presets changes during a study. One exception is the preset for "Meters & Display Options". This preset may be used to setup the workspace for the 
different stages of a study (Mapping vs. Therapy) or to configure the display of screens for split-screen viewing or saving images. 

When a preset is enabled, options and settings update for all corresponding values in the Work Panels, Settings panels and the Mobile Work Panel. 

Preset Dropdown Menu Save Preset Manage Preset 

Preset Button: 
The Presets drop-down menu is used to load a 
preset, save a preset, and manage presets. 
To Use Default or Factory Settings Presets: 

Select Nominal from the Preset drop-down 

To Save a Preset: 
To save the current setup as a preset, open the 
Preset menu in the upper- left corner of the 
control panel and select Save Preset. In the Save 
Preset screen, type a name for the preset, and 

To Rename a Preset: 
To rename the preset, double-select the name 
then enter the new name or select the preset to 
be renamed then select Rename. 
To Delete a Preset: 
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Preset Dropdown Menu Save Preset Manage Preset 

menu. 
To Load a Preset: 
To load a preset for the current physician, open 
the Preset menu in the upper-right corner of the 
control panel and select a preset from the list. 
The menu lists the presets for the current 
physician followed by presets from other 
physicians. Select the desired preset and then 
select OK. 

then select OK. To delete a preset for the current physician, 
open the Preset menu in the upper-right corner 
of the control panel and select Manage Presets. 
In the Manage Presets screen, select a preset 
from the list. To delete the preset, select Delete. 
To Add a Note to a Preset: 

To add a note for the preset, type in the Note text 
area. When renaming is complete, select Close. 

 

 

 

 

Meter & Display Options Settings Panel 
The Meter and Display Options Settings Panel enables a user to make changes to the layout and display options: 
 Layout options – size, location and content of waveforms and map display. 

 Display options – meters, filters, model and map display settings, Contact Force display, EnGuide display options, and zoom. 

NOTE: 

 Although Contact Force, Point Collection Status and Mapping Metrics content is setup elsewhere, the display of the related 
Waves/Meters/Metrics is controlled in the Meters & Display Options panel. 

 Areas marked with a yellow border are values saved with a preset. These values change in all corresponding areas of the user interface. 
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Figure 141.  Meter & Display Options Settings Panel 

 

1. Layout Options icons – Allows the user to select several overall Workspace screen layout options. 

2. Velocity Meter checkbox – The Velocity Filter prevents model point collection during rapid catheter movements. 

3. Generator Metrics checkbox – Shows the numeric values of the Ampere Generator on the screen. 

4. Respiration Meter checkbox – The Respiration Meter shows the current level of respiration, as computed by the relative impedance on the 
EnSite™ X surface electrodes. The data in this display is identical to the respiration waveform available in the Waveform Display. 

5. Contact Force Display checkbox – Displays Contact Force for Force enabled ablation catheter. Numeric value is displayed near the tip. Does not 
display if the Content Force module is not installed. Displays disabled when no TactiSys™ Quartz equipment connection is detected or if the 
Metrics, Wave, Tip Indicator, and Tip Force Number features are all disabled in the Contact Force settings panel. When enabled, mouse-over tool 
tip provides instructional text. Default is checked. 

6. Distortion Meter checkbox – A Distortion Meter is available that displays the current level of relative magnetic field distortion. 

7. Voltage Caliper checkbox – Turn on/off display of the Voltage Caliper which displays the measured potential at the selected signal of the Active 
Electrode. To select the signal displayed, right select the Voltage Caliper and Select Signal. Select Auto Adjust and the caliper automatically 
adjusts to the peak to peak value of the waveform. 

8. Point Collection Status checkbox – Select to show the AutoMap point collection criteria status panel. 

9. Electrode Spacing checkbox – Turn on/off display of electrode spacing for the selected catheter. Electrode spacing is calculated form the edges of 
the electrodes. Not center to center. 

10. Mapping Metrics checkbox – (Applies to the map that has focus when in Split Screen view.) Enables/disables the display of the reference cycle 
length in mm (CL), and the measurement of the current roving point (LAT). The reference rate and cycle length are computed from detections on 
the reference catheter. CL and LAT display in yellow when points are frozen. The live heart rate (HR) displays in the lower-left bottom bar and is 
calculated on the reference the user is using. 

11. Proximity to Surface checkbox – The surface proximity distance is the distance from the Active Electrode to the model or DIF surface (Fusion 
must be applied). To display this measurement on an EnSite™ X NavX model, field scaling must be applied. 

In EnSite™ VoXel mode Proximity to Surface may be displayed at any time when enabled. The proximity distance is displayed (in millimeters) at 
the bottom of the map display in the following fasion: the current value, followed by the average calculated value over 12 seconds, shown in 
parentheses. A negative value indicates that the electrode is inside the model surface, while a positive value indicates the electrode is outside the 
model surface. 
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12. Map Point Count checkbox – Displays the Map Point Count totals (those currently displayed at the bottom of the Map Points list) in the Model 
Space. Only displays when a map is displayed and reflects current Map point counts. Option checkbox defaults to "Off". 

13. Flash New Points checkbox – New map points flash as collected. 

14. EnGuides checkbox – Select to show/hide EnGuides. 

15. Electrode Numbers checkbox/drop-down filter list – Select this checkbox to show catheter electrode numbers on the map display to facilitate 
navigating the ablation catheter to specific electrodes. The user can show electrode numbers on all or none. In Dual View, Split Screen, and 
RealReview, this checkbox affects each view independently. 

16. Active EnGuide Silhouette checkbox/drop-down list – Select this checkbox to produce an outline of the Active EnGuide, which displays over the 
model, showing where it resides inside the chamber. The silhouette is displayed in the color selected for the Active EnGuide. Select "Off", 
"Normal", or "Enhanced". 

17. Stabilize ABL – (EnSite™ NavX™ Model) Select this checkbox to enable Stabilize ABL; default setting is off, or unselected. Stabilize ABL is 
applied to Ablation catheters connected to the Ampere™ RF Generator. Stabilize ABL corrects the location of the distal electrode based on the 
properties of the catheter. ABL electrodes 2, 3, and 4 need to be displayed for Stabilize ABL to be enabled. 

NOTE: If Stabilize ABL is enabled for the catheter, EnSite NavX™ points cannot be collected. 

WARNING: Do not use Stabilize ABL in situations where electrodes 2, 3, or 4, on the ablation catheter, are covered by a sheath. 

• If Stabilize ABL is enabled and the display of electrodes 2, 3, or 4 is turned off, Stabilize ABL is disabled and a message displays 
to alert the user. 

• If multiple ablation catheters are setup, Stabilize ABL is applied to each catheter independently and only when appropriate. 

18. EnGuide Responsiveness slider – This slider controls the response speed between catheter motion and EnGuide navigation. 

19. Tools Text checkbox – Shows/hides the label text for all map labels, anatomic markers, tape measures, lesions, and EnGuide Shadows. 

20. Map Color checkbox – Causes surface to be colored using the current map color. 

21. Text Shows Through checkbox – Allows or prevents label text for all map labels, anatomic markers, tape measures, lesion markers, and EnGuide 
Shadows from showing through other objects. 

22. Non-map Surface Groups checkbox – Hide surfaces that have no maps projected on them. 

23. EnSite Model checkbox – Enables/disables the display of the contoured, three-dimensional surface model(s) of a patient’s cardiac anatomy. 

24. Map Transparency checkbox – Display map colors with values greater than Color High as transparent instead of purple. Areas of the contact map 
that are not colored will be hidden. 

NOTE: Do not select the Map Transparency On box unless a map is displayed. 

25. DIF Model checkbox – Allows the DIF model (that is, CT scan or MRI) to either be hidden or displayed. 

26. Project on DIF checkbox – (After registration has been performed using the EnSite™ X Fusion™ Registration Module) Enabling this checkbox 
allows the user to project or un-project 3D Labels and/or Lesions (referred to as 3DP), and map data onto the DIF surface rather than onto the 
EnSite model surface. 

27. Fixed Proximity checkbox – The EnGuide proximity indicator represents the position of the Active Electrode. The position of the indicator is size 
scaled based upon the distance from the Active Electrode to the closest model surface. The proximity indicator is drawn on the surface as a 
colored translucent spot, matching the color of the Active Electrode. The maximum diameter of the proximity indicator can be displayed based on 
either the current lesion size or by checking the Fixed Proximity Indicator box, located under the drop-down menu in the map display under the 
eyeball.  

NOTE: The Proximity Indicator only displays on finished surfaces. 

28. Zoom slider – Increases/decreases the size of the model in the display screen. The middle mouse / scroll wheel can also be used to zoom. 

29. VoXel Cloud checkbox – Select to display the VoXel point cloud in EnSite™VoXel Mode. 

 

Catheters & Waveforms Settings Panel 
Catheters and Waveforms are located together in the Settings Panel and separated by sub-tabs. 

Catheters & Waveforms Settings Panel - Catheters Sub-tab 
The Catheter lists and details are available from within the workspace allowing the user to access and modify elements without the need to return to 
setup. Functionality to expand the electrodes is like the behavior available for waveforms. A user may include or exclude (disconnect) an electrode in 
addition to controlling its visibility. If an electrode is excluded, its visibility is also removed, and the appearance of the electrode and the corresponding 
waveform is removed from view. If the electrode remains included but its visibility is removed, the display of the waveform is unaffected. 

Refer to Catheter Setup for a full description of the controls. 

NOTE: Areas marked with a yellow border are values saved with a preset. These values change in all corresponding areas of the user 
interface. 
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Figure 142.  Catheters & Waveforms Settings Panel – Catheters Sub-tab 

 

1. Name – Catheter name 

2. Connected icon – Allows the user to connect or disconnect 
individual electrodes on the catheter. 

3. Visibility icon – Show or hide a catheter in the Model/Map 
display area. 

4. Sheath Filter icon – Turn Sheath Filter on/off for applicable 
catheter. 

5. Show Electrode Numbers icon – Shows the electrode numbers 
on the catheter being displayed. Requires Show Electrode 
Numbers to also be selected from the Display Settings panel. 

6. Color icon – Select the color the catheter is displayed. 

For more infomation on currently selected catheter panel, refer to: 
"EnSite™ X EP System Setup, Catheter Tab - Catheter List" (page 27). 

 

Catheters & Waveforms Settings Panel - Waveforms Sub-tab 
Use the Waveforms tab to select the signals to display and the ECG Filters panel to select the filtering options for the displayed traces. Signals are listed 
in a tree-like structure and can be checked to be visible or hidden in the Waveform display. The settings for each signal, including the color, d/dt, and 
filtering can be adjusted. Filters can be turned on or off for individual signals. If the filter settings are changed, the filter settings for all signals in that 
group are changed. By default, ECG signals and EP catheters are included in the signals list. 

NOTE: Areas marked with a yellow border are values saved with a preset. These values change in all corresponding areas of the user 
interface. 
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Figure 143.  Catheters & Waveforms Panel – Waveforms Sub-tab 

 

1. Signal – Name of displayed signal source 

2. Filtered icon – Show filtered signals and waveforms 

3. Unfiltered icon – Show unfiltered signals and waveforms 

4. dv/dt icon – Show the dv/dt of signals waveforms 

5. Color icon – Use the color chart to select a color for the 
item. Select the colored square to open the color chart, 
and then select the desired color. Changing the color of a 
waveform changes the color in the Waveform Display and 
in the Acquisition Waveform Display. 

6. ECG Filters High Pass drop-down list – Use to set the High 
Pass filter for ECG waveforms. 

7. ECG Filters Low Pass drop-down list – Use to set the Low 
Pass filter for ECG waveforms. 

8. ECG Filters Noise Filter checkbox – Use to turn on/off the 
Noise Filter for ECG waveforms. 

9. Catheter Bipolar Filters High Pass drop-down list – Use to 
set High Pass filter for Bipolar waveforms. 

10. Catheter Bipolar Filters Low Pass drop-down list – Use to 
set Low Pass filter for Bipolar waveforms. 

11. Catheter Bipolar Filters Noise Filter checkbox – Use to turn 
on/off the Noise Filter for Bipolar waveforms. 

12. Catheter Unipolar Filters High Pass drop-down list – Use 
to set High Pass filter for Unipolar waveforms. 

13. Catheter Unipolar Filters Low Pass drop-down list – Use to 
set Low Pass filter for Unipolar waveforms. 

14. Catheter Unipolar Filters Noise Filter checkbox– Use to 
turn on/off the Noise Filter for Unipolar waveforms. 

 

Model, DIF & Fusion Settings Panel 
The Model, DIF and Fusion Panel provide access to Model Surface presets and DIF & Fusion functionality. 

Model, DIF & Fusion Panel - Model Sub-tab 
The Model tab allows provides the ability to define or change a Surface preset or surface details. The addition or deletion of surfaces is available on the 
Collect Panel - Model Sub-tab. 

Model presets are used to initialize a model using a predefined list of surfaces. When a model preset is loaded, the surfaces do not exist, but they have 
properties such as names and colors. This list can serve as a starting point for which surfaces to collect points. Refer to the Model, Diff & Fusion 
Settings Panel to load and manage Model presets. 

NOTE: Areas marked with a yellow border are values saved with a preset. These values change in all corresponding areas of the user 
interface. 
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Figure 144.  Model, DIF& Fusion Panel – Model Sub-tab 

 

1. Surfaces – List of model surfaces 

2. Included icon – Select a checkbox to include a surface. Deselect a 
checkbox to not include a surface. A surface that is not included is 
not displayed, used for labeling, or intersecting overlapping 
surfaces. 

NOTE: Excluding unnecessary surfaces optimizes performance. This 
checkbox controls whether a surface is displayed in the model. 
When the check mark is visible, the surface is displayed for labeling, 
intersecting, and overlapping surfaces. When the checkbox is 
unchecked, the entire surface is excluded from view. 

3. Visibility icon – Use the visibility icon to show or hide the item. When 
the checkbox is selected, the item is visible. To hide the item, 
select the checkbox. Hiding an item does not delete the item. 

4. Grid Control icon – The number of clicks (1, 2, or 3) on cylinder will 
determine where a surface grid is placed on the model. Clicking 
once, places the grid on the interior of the model, clicking twice, 
places the grid on the exterior of the surface. Clicking a third time 
turns the grid off. 

5. Color icon – Use the color chart to select a color for the item. Select 
the colored square to open the color chart, and then select the 
desired color. 

 



 

111 
 
 

Model, DIF & Fusion Settings Panel - DIF Sub-tab 
The DIF list shows both surfaces and associated maps as defined in the EnSite™ Verismo™ Segmentation Tool or the third-party application. 

NOTE: There are no Presets for the DIF sub-tab. 

Figure 145.  Model, DIF& Fusion Panel – DIF Sub-tab 

 

1. Surfaces – List of surfaces 

2. Load DIF – Select to load a DIF file. 

3. Visibility icon – Use the visibility icon to show or hide the item. 
When the checkbox is selected, the item is visible. To hide 
the item, select the checkbox. Hiding an item does not 
delete the item. 

4. Map icon – Use the Map icon to show or hide the DEMRI 
map if one is imported. 

5. Color icon – Use the color chart to select a color for the item. 
Select the colored square to open the color chart, and then 
select the desired color. 

 

Digital Image Fusion (DIF) 
 Three-dimensional models created from digital images collected from Spiral CT, MRI, and DEMRI (Delayed Enhancement MRI) can be imported 

into the EnSite™ X EP System for display. 

Creating a Model to Import 
Models for import into the EnSite™ X EP System can be created using segmentation tools such as the EnSite™ Verismo™ Segmentation Tool. When 
using the EnSite™ Verismo™ Segmentation Tool, the creation of a model involves the following steps. 
 The patient is scanned. See the EnSite™ X Verismo™ Segmentation Tool section (page 152) for the optimal 

EnSite™ X Verismo™ Segmentation Tool scan file characteristics. 

 The scanned image is exported to a CD/DVD in DICOM3 format. 

 The CD/DVD is imported into an EnSite™ X Display Workstation (DWS) with the EnSite™ Verismo™ Segmentation Tool, and the segmentation 
process is used to create a DIF file according to the EnSite™ Verismo™ Segmentation Tool Instructions for Use. 

Figure 146.  An imported DIF left atrium 
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If the DIF file is created on the same EnSite™ X EP System DWS that will be used during the clinical study, the DIF file can be accessed from the hard 
drive. If the DIF file will be used on a separate EnSite™ X EP System, the DIF file can be exported to a USB device, network, or CD/DVD for import into 
the clinical EnSite™ X EP System. 
 In addition to the DIF file format, the EnSite™ X EP System also supports CardEP file format for digital images, as well as Siemens, Phillips, 

Toshiba (Vital Images), and Terra Recon formats; however, formats other than DIF may not be able to use all DIF-related functions, such as the 
ability to show or hide individual chamber surfaces. 

Importing a Digital Image 
1. Click the DIF icon at the top of the Model control panel. 

2. From the DIF control panel, select Load DIF. 

The Import DIF window appears. 

3. From the Load DIF window, select a DIF file for import: select a source, either hard drive or DVD/CD, for import from the drop-down menu at the 
top right corner of the window. 

- HardDrive – DIF files created by the EnSite™ Verismo™ Segmentation Tool on the same EnSite™ X EP System DWS are stored on the 
workstation’s hard drive. As additional models are added, the oldest models are deleted first. Models can also be manually deleted by selecting 
a model from the list and selecting Delete. 

- DVD/CD – Digital image models can be imported using DVD and CD. Models can be formatted as Digital Image Fusion (.xml), or GE DICOM3 
models processed using CardEP software. For GE CardEP models, the original CD/DVD from the GE workstation is required for import, not just 
the file of the model itself. Select an image type to display the appropriate models. 

Select Load to load the model. 

NOTE: The colors applied to the DIF model are the EnSite™ X EP System software model colors, not the colors that were used during 
segmentation. 

Additional Options for DIF Files 
Models created by the EnSite™ Verismo™ Segmentation Tool have additional features: 

Patient information – In the Import Digital Image window, models are displayed with information from the patient, scan, and saved model name. 
Clicking on the category name at the top of a column sorts the data by that column. 

DIF viewer – A viewer is available for previewing DIF models. Select View to display the selected DIF model. The following controls are available in the 
viewer: 
 Rotate – Hold down the middle mouse button and drag. 

 Zoom – Use the roller wheel on the mouse. 

 Wireframe – Options > Wireframe. 

 Bounding box display – Options > Bounding Box. 

 Default views – Views > AP/PA/LL/RL/CRA/CAU. 

Viewing a DIF Image for Reference 
DIF models can be shown by selecting the DIF Model checkbox in the Meters and Display Options Settings Panel. Deselect to hide the DIF Model. 
 The digital image appears in the map display. 

 To compare the two models, select Dual View. The EnSite™ X EP System model appears on the left side of the screen, and the DIF model 
appears on the right side of the screen. 

Digital images are saved with rotational information included. The orientation reference will automatically appear for the digital image. 

In an EnSite™ X System study, the EnSite™ model and DIF model rotate together when the system is validated. 

NOTE: Clipping, Map Scale, rotation, spin, Edge Enhancement, and panning can be used to change the appearance of the model. 

DEMRI (Delayed Enhancement MRI) Image Integration 
The use of delayed enhancement MRI is sometimes used to analyze areas of electrically nonviable tissues such as areas of fibrosis, scar, or ischemia. 
The import of this model type into the EnSite™ X EP System may provide a faster, higher resolution of substrate over traditional voltage mapping. The 
system can now accept Visualization Tool Kit files, or VTK files, and Visualization Toolkit Polygons, or VTP files. These files are created from a third-party 
application rather than through the EnSite™ Verismo™ Segmentation Tool. 

Once imported, interaction is like a DIF file, with options to view or use with the EnSite™ Fusion™ Registration Module. The DIF list shows both 
surfaces and associated maps as defined in the third-party application. The color spectrum bar on the left is displayed just as it is for timing and voltage 
maps within the system. One map tool data set can be displayed on the surface at a time. 

NOTE: If using this model in the EnSite™ Fusion™ Module’s registration process in single map display, the user will be able to either 
visualize the associated imported map or project a contact map on the surface, but not both. 

Figure 147.  DEMRI Image 
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In Split Screen view, the user can display an EnSite model in one screen and the DEMRI in the other.  

Figure 148.  Imported DEMRI Image 

 

 

File limitations for VTK or VTP files include: 
 Total number of vertices cannot exceed 1,000,000. 

 Total number of polygons cannot exceed 2,000,000. 

 Polygons are limited to only containing three points (triangles). 

 Only one occurrence of the <Piece> tag is supported. 

Selecting and Adjusting the Waveforms 
Waveforms can be selected and adjusted by clicking on the waveform in the waveform display. 
 Selecting waveforms: Shift-left-clicking on a waveform makes the selected trace bold and displays a dotted white line at 0 mV. The color calipers 

are rail lines indicating the current Color High and Color Low values. Shift-left-click on a waveform again to remove the rail lines and color calipers. 

 Moving waveforms: To move a waveform, left-click on the waveform and drag up or down. 

 Adding waveforms: To add a waveform to the waveform display, turn on the waveform’s checkbox in the Catheters & Waveforms Settings Panel - 
Waveforms Sub-tab. 

 Removing waveforms: To remove a waveform from the waveform display, turn off the waveform’s checkbox in the Catheters & Waveforms Settings 
Panel - Waveforms Sub-tab, or left-click on the waveform and drag it off the left edge of the screen. 

 Adjusting amplitude: To adjust the waveform amplitude, middle-click the waveform and drag up or down to increase or decrease the amplitude 
for all waveforms of that signal type. To adjust the amplitude for a single waveform, hold <Shift> + middle-click and drag up or down. 

 Right click in the black background for waveform options menu: 

- Sweep Speed: Adjusts the number of mm/sec. in the waveform display (time scale). 
- Reset Offsets: Evenly spaces all visible waveforms vertically in the waveform display, without changing the order of the display. 
- Reorder Waveforms: Rearranges the waveforms according to the trace number and types as defined by the order in the Catheters & 

Waveforms Settings Panel - Waveforms Sub-tab. 
- Font Size: Used to select a font size for the label text in the waveform display. 
- Thickness: Used to adjust the thickness of all waveforms in the waveform display. 
- Hi/Lo Lines: Doing a shift-left-click on a selected waveform, causes the waveform to bold and for color calipers to display. The color calipers 

are horizontal rail lines that indicate the current Color High and the current Color Low values of the selected waveform. Doing a shift-left-click 
again will remove them. 

Using the Waveform Displays 
The two types of waveform display windows in the GUI are shown below: 

1. Waveform Display. 

2. Acquisition Waveform Display. 
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Figure 149.  Waveform displays. 

 

1. Waveforms – Signals can be simultaneously displayed as waveforms. Each waveform consists of a label and a trace. The label identifies the 
source of the signal, and includes whether the signal is unfiltered, whether contact catheters are unipolar, the signal label, and the signal 
amplitude. If the traces turn purple, then the data should not be used. 

2. Time cursor – (Waveform Display only) The time cursor is a vertical yellow line in the waveform display that indicates the time represented 
by the map display. The specific time represented by the time cursor appears in the lower right corner of the waveform display. The 
following controls are available for the time cursor in review mode: 

- Left-clicking in the waveform display background (not on a trace) makes the time cursor appear at the mouse pointer. 
- Dragging the time cursor moves the cursor across the waveform display. 

NOTE: In Realtime, the cursor is not shown when one or more waves are visible. 

3. Time scale – The time scale (in milliseconds) appears at the top edge of the waveform display. Right-click between waveforms in the 
window to display a menu for setting the sweep speed, font size, and waveform thickness. 

4. Calipers – Calipers are used to measure timing between signal features in the waveform display during review mode. See “Using Calipers” 
for information about using calipers. 

 

Model, DIF & Fusion Settings Panel - Fusion Sub-tab 
The EnSite™ Fusion™ sub-tab is used to place and edit fiducial point pairs. 

NOTE: There are no Presets for the Fusion sub-tab. 

The EnSite™ X Fusion™ Registration Module is a software expansion module for the EnSite™ X EP System that provides non-fluoroscopic navigation 
registered to a model of patient anatomy generated by CT or MR scanners. The EnSite™ Fusion™ Registration Module is intended for use with the 
EnSite™ X EP System Surface Electrode Kit and cardiac models from CT or MR scans segmented into a compatible file format. 

Once the registration is applied, mapping and labeling functions can be applied to the Digital Image Fusion (DIF) surface, including Contact Mapping, 
Map Labels, Lesion Markers, and Anatomic Markers. 
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Figure 150.  Model, DIF& Fusion Panel – Fusion Sub-tab 

 

1. Fiducials – The name of the fiducial. 

2. Used checkbox – A check mark in this column 
indicates that the fiducial is being used. No check 
mark indicates that the fiducial is not being used. 

3. Add at Surface radio button – Select to place a fiducial 
point at the mouse location on the EnSite™ model 
and DIF model. 

4. Move radio button – Select to move one end of a 
fiducial point pair. 

5. Add at EnGuide radio button – Select to place a 
fiducial point at the Active EnGuide on the 
EnSite™ model and mouse location on the DIF 
model. 

6. Select radio button – Select to select individual fiducial 
points. 

7. Compute button – Compute the registration between 
the EnSite™ Model and the DIF Model. 

8. Apply checkbox – Select to show the registration. 
Deselect to remove the registration. 

9. Delete Fiducials button – Click to delete the selected 
fiducial point. 

10. Use Fiducials checkbox – Select to use the selected 
fiducial point. Deselect to not use the selected 
fiducial point. 

11. Show Points checkbox – Select to show the EnSite™ 
model point cloud; deselect to hide. 

12. Show Fiducials checkbox – Select to show all fiducial 
points; deselect to hide all fiducial points. 

 

Performing Registration 
The EnSite™ X Fusion™ Registration Module provides non-fluoroscopic navigation, mapping, and labeling on a DIF model. The dynamic registration 
process involves the following steps: 
 Importing a DIF model. Refer to Model, DIF & Fusion Settings Panel - DIF Sub-tab for instructions (page 111). 

 Scaling the EnSite NavX™ navigation field (only applicable to EnSite NavX™ mode). 

 Placing fiducial point pairs. 

Importing a DIF Model 
When used for registration, a DIF model is a surface rendering segmented from slice-based CT or MR data using the 
EnSite™ Verismo™ Segmentation Tool. A DIF model is imported in the Model task. For information on importing DIF models and compatible formats, 
see the Importing a Digital Image (page 112). 

NOTE: Registration should be performed for one cardiac chamber at a time. A high-quality scan is necessary for the creation of an accurate 
registration. The quality of the scan is fundamental to the user’s ability to create a highly detailed model during the segmentation process. In 
turn, a detailed segmentation is essential to the user’s ability to identify precise fiducial points during the registration process. 

Scaling the EnSite NavX™ Navigation Field  (EnSite NavX™) Mode only) 
Field Scaling, available in EnSite NavX™ Mode, compensates for local changes in impedance fields. For further information on Field Scaling, see the 
Field Scaling (EnSite NavX™ Mode Only) (page 65). 

NOTE: Field Scaling the EnSite NavX™ field is optional but recommended. 
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Figure 151.  An EnSite NavX™ model before (left) and after field scaling 

 

 

Placing Fiducial Point Pairs 
Fiducial point pairs are markers that link matching locations between an EnSite™ X EP System model and a DIF model. The points are connected by a 
spring-shaped icon. 

Figure 152.  Fiducial point pairs linked by a spring-shaped icon 

 

 

Placing Fiducial Points 
NOTE: The buttons referred to in the following instructions are located on the EnSite™ X Fusion™ Registration Module control panel. 

1. Display the models in Dual Views display. 

2. Click the EnSite™ Fusion™ Registration Module icon in the Model control panel. 

3. Place fiducial points to link common locations between the EnSite™ model and DIF model. 

- To place a fiducial point at the mouse: 

Select the Add at Surface button. While this button is selected, the left mouse button is used to place fiducial points on both the 
EnSite™ model, and DIF surfaces. When the cursor is over the EnSite™ map display, it will be cross-hair shaped. 

On the EnSite™ model surface, left-select a model location that is also recognizable on the DIF surface. After placing a fiducial point 
on the EnSite™ model side of the screen, the cursor will change to a cross-hair inside a square. 

NOTE: When a fiducial point is placed on the EnSite™ model surface, the fiducial point will link to the nearest model point, not the model 
surface. This ensures that the location is tied to a previous catheter position. 

Left-select the matching anatomic location on the DIF model. A spring-shaped icon will appear to connect the paired fiducial points. 

- To place a fiducial point at the Active EnGuide: 

Manipulate the Active EnGuide catheter so that the Active Electrode is at an anatomic location on the EnSite NavX™ model that can 
also be easily recognized on the DIF side of the screen. 

Select the Add at EnGuide button. 
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Left-select the matching anatomic location on the DIF model. A spring-shaped icon displays to connect the paired fiducial points. 

NOTE: A point is created at the active EnGuide position when the mouse is clicked on the DIF model. 

4. Click Compute to compute an initial registration. The model surfaces, point cloud, and DIF model will be superimposed. 

In EnSite™ VoXel™ Mode: Regardless of the number of fiducial point pairs that are used, the registration will be a rigid overlapping registration. 
Spring-shaped icons connecting fiducial points will not necessarily collapse to a common location. 
In EnSite NavX™ Mode: If three or fewer fiducial point pairs are in use, the registration will be a rigid overlapping registration. Spring-shaped 
icons connecting fiducial points will not necessarily collapse to a common location. However, if four or more fiducial point pairs are in use the 
system will use a non-rigid dynamic registration to fuse the linked fiducial locations together. In this scenario, registered points will appear as dots 
instead of springs. 

Figure 153.  The overlapping point cloud, DIF model, and EnSite NavX™ model 

   

 

5. Evaluate the registration and continue placing fiducial points if necessary. When defining fiducials in the overlapping view, the first point will be 
placed on the EnSite™ model, and the second point will be placed on the DIF model. 

NOTE 

 After any change to fiducial point pairs, select Compute to apply the change. 
 Select the Apply button to see the results of any changes. 

Editing Fiducial Points 
Several options are available for editing placed fiducial points. The controls for editing fiducial points are located on the EnSite™ X Fusion™ control 
panel. 

To move one end of a fiducial point pair: 

1. Select the Move button and select one end of the fiducial. If the points are registered and overlapping, the end of the point that is connected to 
the EnSite™ model will be selected. 

2. Drag the point to a new location. 

Disabling/enabling individual points 

To disable or enable an individual fiducial point pair: 

1. Select the Select button and select either the fiducial in the map display or select it in the fiducial list. The selected fiducial will turn red in the 
map display. 

2. Select or deselect the Use Fiducial button to enable or disable the selected fiducial. In the fiducials list, all fiducials in use will have a check mark 
in the Used column. 

3. Select Compute to recompute the registration. 

4. Confirm the catheter position relative to the anatomy using conventional means (for example, fluoroscopy, intracardiac echocardiography).  

Deleting a point - To delete a fiducial point, select the point in the fiducial list, and then select Delete Fiducials. 

Removing a registration - De-select the Apply button to remove a registration. When registration is removed, navigation and labeling at EnGuide will 
apply to the EnSite™ model. 

The Map Settings panel groups Map Settings, Detection Settings sources and Signals. 

Mapping Settings Panel - Settings Sub-tab 
Mapping Settings Options associated with maps types that do not apply for the selected map type display are disabled. 

NOTE: 

 Areas marked with a yellow border are values saved with a preset. These values change in all corresponding areas of the user interface. 
 All settings options below apply to the map that has focus when in Split Screen view. 
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Figure 154.  Mapping Settings Panel – Settings Sub-tab 

 

1. Cardiac Triggered Reference checkbox – Determines 
which map types (Cardiac Triggered or Non-
Cardiac Triggered) are available for use. 

2. Unipole checkbox – Toggle on or off unipolar map. 
Available only for Peak to Peak and Peak-Negative 
maps. 

3. Map drop-down list – 
- LAT: Local Activation Time isochrone 
- Peak-to-Peak: Peak-to-Peak voltage 

- Peak-Negative: Peak-Negative voltage 
- CFE Mean: Complex Fractionated Electrogram Mean 

activation time between complexes 

- CFE Std Dev: Complex Fractionated Electrogram 
Standard Deviation between complexes 

- Fractionation: Number of CFE detections 
- Score: Morphology match of the correct ECG signals to 

the template beat. 

- Point Count: Number of co-located points. 

4. Low-V ID slider – Identifies low-voltage zones in LAT 
or CFE maps. If a collected point’s P-P value is 
lower than the specified Low-V ID value, then that 
point will display a gray area instead of the color- 
coded scale for the current map type. Grey points 
do not interpolate with color points. 

1. Fractionation Threshold checkbox/slider – Renders 
points that are fractionated as larger spheres. 
Default value=3 (renders points with a fractionation 
value of >= 3. 

2. Width slider – The Width slider (CFE maps only) 
determines the minimum complex width to 
consider for activation. Applies to the map that has 
focus when in Split Screen view. 

3. Refractory slider – The Refractory slider (CFE maps 
only) determines the minimum amount of time 
between detections. Applies to the map that has 
focus when in Split Screen view. 

4. Segment Length slider – The Segment Length slider 
(CFE maps only) determines the duration of the 
selected segment length. Applies to the map that 
has focus when in Split Screen view. 

5. Map Display drop-down list – (LAT maps only) The 
type of LAT map: Standard LAT, Reentrant Map, or 
Propagation Map. Sparkle Map: When any map 
type other than Propagation Map is selected, the 
Play button is marked SparkleMap and activates 
the SparkleMap feature. 

6. Interior Projection slider – This slider controls the 
maximum distance that an interior 3D Point 
(represented as a triangle) can project to a location 
on the surface (represented by a square). For 
multiple-surface models, points will project to the 
nearest surface. 

7. Exterior Projection slider – This slider controls the 
maximum distance that an exterior 3D Point 
(represented as a triangle) can project to a location 
on the surface (represented by a square). For 
multiple-surface models, points will project to the 
nearest surface. 

8. Interpolation slider – This slider controls the 
minimum distance between surface points 
necessary for the system to interpolate color. For 
multiple surface models, points will interpolate 
between surfaces in the same group. 

9. Color Contour slider – Adjusts the gradation between 
colors on the map. At low Color Contour values, 
colors appear as distinct bands. At high Color 
Contour values, there is a smooth transition 
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between colors. 

10. Last Duplicate radio button – Uses the most recent 
duplicate. 

11. Best Duplicate radio button – Uses duplicate with the 
best combined timing and voltage. Favors points 
with large voltages that are close to the average 
timing. 

12. Surface Points checkbox – Enables/disables the 
display of small, yellow square points on the 
surface. These squares represent the point on the 
surface closest to a collected 3D point. 

13. All Roving Waves checkbox – Select to display all 
roving waves in the Acquisition Waveform Display. 
When deselected, only one roving wave is displayed 
in the Acquisition Waveform Display. 

14. 3D Points checkbox – Enables/disables the display of 
collected points as triangular markers. The 
triangular markers are placed on the negative 
electrode of the roving signal channel. 

15. Unipole Waves checkbox – Select to display unipolar 
waves of the roving signals in the Acquisition 
Waveform Display. 

16. 3D Values checkbox – Allows data to be numerically 
displayed adjacent to the triangular 3D points. 3D 
points must be enabled to show 3D labels. 

17. Reference Shadows checkbox – Displays or hides 
the Reference Shadows. The first point saved in a 
map will store the displayed Reference and "extra" 
waveforms as gray shadows and will be displayed 
in the RAI behind subsequent detected beats. If 
the first saved point is deleted, the next point saved 
will generate the shadows. 

NOTE: 

 Changing the reference signal of the waveform 
will remove the shadow. 

 Shadows will be stored for all 12 surface ECG 
leads even if not displayed when the first point is 
collected. 

1. 3D Annotations checkbox – Displays or hides the 
user-defined annotations associated with 3D points. 

2. Roving Shadows checkbox – Displays or hides the 
Roving Shadow which is a dark red shadow that 
appears behind the current waveform for the roving 
catheter. This waveform indicates the morphology 
of the previous beat for this catheter. This shadow 
is used to confirm beat-to-beat stability. 

NOTE: If data does not exist for the previous beat 
(earliest beat in the buffer, etc.), then the dark red 
shadow will not appear. 

3. Selected Points Only checkbox- When selected, the 
system draws only the selected points in the 3D 
display. 

4. Auto Color checkbox – Controls whether the system 
automatically controls the pointers on the color bar 
during mapping. If Auto Color is enabled, the 
pointers will adjust to the minimum and maximum 
data values for all points in the current map. Auto 
Color applies separately for each display type. Auto 
Color will be disabled if any color is manually 
adjusted. 

5. Independent Scoring Interval checkbox – The 
Independent Scoring Interval defines the portion of 
the template mapping point’s 12-lead surface 
morphology that is used to compare with the 
current beat’s 12-lead surface morphology to 
determine the Score of correlation between the two. 
If the independent scoring interval is not enabled 
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(the checkbox is not selected), then the 12-lead 
surface morphology match score will be 
determined using the entire portion of the roving 
activation interval. 

6. Scoring Interval Lines checkbox – Select the 
checkbox for Show Scoring Interval Lines so that 
the two, red Independent Scoring Interval lines are 
displayed and can be adjusted to contain the 
relevant portion of the signal. 

 

Mapping Settings Panel – Source and Thresholds Sub-tab 
Figure 155.  Mapping Settings Panel – Source & Thresholds Sub-tab (AutoMap Thresholds) 

 

1. Score checkbox/slider – Mapping points will be collected if the 
morphology match between the 12-lead surface morphology 
and the original template best’s 12-lead surface morphology is 
equal to or greater than the specified threshold (measured as a 
percentage). Note at least one ECG signal must be selected in 
the Acquisition waveform display to enable the Score threshold. 
Change the Score percentage slider as needed. 

2. CL Tolerance checkbox/slider – Cycle Length Tolerance: Only 
collect mapping points if the intracardiac measured (CS, HIS, 
other) Cycle Length is within +/- XX ms of original template beat 
Cycle Length. User can set the Cycle Length Tolerance from +/- 
0 to 150 ms. Default the Cycle Length Tolerance is enabled and 
is set to +/- 20 mm/s. 

3. Activation Seq checkbox/slider – Only collect mapping points if 
the timing between REF and REF 2 is less XX ms as compared 
to the template beat. Note Activation sequence requires 
intracardiac signals to be defined for REF and REF 2. 

4. Speed Limit checkbox/slider – Only collect mapping points if the 
mapping catheter is moving less than XX.X mm/s. User can set 
the Speed Limit from 0.1 to 75 mm/s. Default the Speed Limit is 
enabled and is set to 10.0 mm/s. 

5. Stable Distance checkbox/slider – Non-cardiac triggered, area in 
which the user must keep the catheter for the algorithm for it to 
consider it the same collection. 

6. Distance checkbox/slider – Only collect mapping points if the 3D 
position of the roving catheter electrode is X.X mm or more from 
the previously collected mapping point from that electrode. User 
can set the Distance Threshold from 0.1 to 10 mm. Default 
Distance Threshold is enabled but the default value is set to 
1.0 mm. 

7. Signal to Noise checkbox/slider – Only collect mapping points if 
the Signal-To- Noise Ratio on the roving catheter signal is X.X or 
higher. User can set the SNR Threshold from 1 to 50. Default 
the SNR Threshold is enabled and is set at 5.0. 

8. Force checkbox/slider – (Contact Force Range): This criterion can 
only be used if the EnSite™ X Contact Force Module is installed 
and the physician is mapping with a TactiCath™ catheter. Only 
collect mapping points if the Average Contact Force (as 
measured by a TactiCath™ Contact Force Catheter) is at least X 
grams and less than Y grams. User can set the Lower Threshold 
from 0 to 30 grams. User can set the Upper Threshold from 30 
grams to 150 grams. Default the Contact Force Threshold is not 
enabled but the default lower threshold is 10 grams and the 
default upper threshold is 50 grams. 

9. Enhanced Noise Reduction checkbox – Only collect mapping 
points if the roving catheter signal does not have certain types of 
noise (Signals with saturations, electrode-to-electrode contact, 
open electrode noise, signals with degraded conditions such as 
no location or dropped data). Only uncheck for pace mapping. 
User can set the Enhanced Noise Reduction on or off. Default 
the Enhanced Noise Reduction is enabled. 
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Mapping Settings Panel 

Mapping Settings Panel - Signals Sub-tab 
The Signals list works in the same manner as Waveforms and Catheters from the Setup Panel. 

NOTE: Areas marked with a yellow border are values saved with a preset. These values change in all corresponding areas of the user 
interface. 

Figure 156.  Mapping Settings Panel – Signals Sub-tab 

 

1. Available Signals list – Displays Signals with expandable/collapsible 
tree; colors changed with the color picker control updates color 
selections for Waveforms and Catheters. 

2. Filtered icon – Display filtered signals. 

3. Color icon – Choose the color of the displayed Signal trace. Color 
changes updates color selections for Waveforms and Catheters. 

 

AutoMark and Contact Force Settings Panel 

AutoMark & Contact Force Settings Panel - AutoMark Sub-tab 
The AutoMark and Contact Force Settings Panel provides access to the Metrics, Placement and Criteria settings and controls. 

NOTE: Areas marked with a yellow border are values saved with a preset. These values change in all corresponding areas of the user 
interface. 
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Figure 157.  AutoMark and Contact Force Setting Panel - AutoMark Sub-tab 

 

1. Color Metric drop-down list – Used to define the AutoMark 
metric for color. 

2. Size Metric drop-down list – Used to define the AutoMark 
metric for size. The Size Metric can be set to same as Color 
Metric. 

3. Metrics Setup drop-down list – Used to select the AutoMark 
metric to configure; threshold values, color and size. 

NOTE: The default AutoMark configuration does not have any 
threshold values, colors or diameters configured. Without 
configuration, all AutoMarks will appear as grey spheres with a 
diameter of 4 mm. 

Available Metrics: 

- Avgerage Force 
- Maximum Force 

- Energy 

- Time 
- Impedance Drop 

- Impedance Drop (%) 
- Avgerage Power 

- Maximum Power 
- Avgerage Temperature 

- Maximum Temperature 

- FTI (available only outside the US) 
- LSI (available only outside the US) 

4. Value(s) – User defined thresholds for each AutoMark metric. 

5. Color – User defined color for each threshold value. 

6. Diameter – User defined AutoMark diameter for each threshold 
value. 

7. Disable/Enable AutoMark Collection button – Turn on/off 
AutoMark data collection. When disabled no data from the 
Ampere generator will be stored. 

Placement Settings 

8. AutoMark placement is based on three user defined settings: 
AutoMark Region, Min AutoMark Time, and Away Time. Any 
changes to the placement settings will result in recalculation 
of all AutoMark data. 

9. AutoMark Region (r) slider – The radius of a catheter stability 
considered sufficiently stable to allow formation of an 
AutoMark. This value is also the minimum center-to-center 
distance between AutoMarks. Default = 1.5 mm (millimeters). 

10. Min AutoMark Time slider – The minimum amount of time the 
catheter tip must remain within the AutoMark region before a 
new AutoMark is placed. Default=3 seconds. 

11. Away Time slider – The maximum amount of time the catheter 
can move away from the AutoMark region before that 
AutoMark is completed. – For example, if an AutoMark has 
been created and the catheter moves away from the 
AutoMark region for a duration longer than the Away Time, 
the AutoMark will be completed. If the catheter returns to that 
location at a later point in the procedure, a new AutoMark will 
be created, and the data will not be combined. If the catheter 
returns to the AutoMark region within the Away Time, the data 
will continue to be collected in to the current AutoMark. 
Default = 8.0 (seconds). 

NOTE: It is recommended to set the Away Time to a duration 
that is greater than the respiration cycle of the patient. 

12. Visible Thresholds drop-down list/slider – User defined visibility 
thresholds. AutoMarks will not appear until all visibility 
thresholds have been met or exceeded. Visible Thresholds 
can be defined based on one or more of the AutoMark 
Parameters. 

NOTE: The default is no Visible Thresholds are configured. A 
Visibility Threshold must be selected to make AutoMarks visible 
on the map. 

Available Metrics: 

- Avgerage Force 

- Maximum Force 
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- Energy 

- Time 
- Impedance Drop 

- Impedance Drop (%) 
- Avgerage Power 

- Maximum Power 
- Avgerage Temperature 

- Maximum Temperature 

- FTI (available only outside the US) 
- LSI (available only outside the US) 

13. Add Criteria icon – Select to add additional Visible Thresholds. 

 

AutoMark & Contact Force Settings Panel - Contact Force Sub-tab 
The Contact Force tab provides access to the Metrics, Display and Stability settings.  

This tab is grayed out if there is no Contact Force License installed on the system. If a Contact Force License is present, refer to the EnSite™ X Contact 
Force Instructions for Use for description of the controls. 

NOTE: 

 The display of the related Contact Force Waves, Meters, and Metrics are controlled in the Meters & Display Options panel. 
 Presets for the Contact Force are set and managed from the Meters and Display Options Settings Panel. 

Figure 158.  AutoMark & Contact Force Panel – Contact Force Sub-tab 

 

 

Navigation Settings Panel 
The Navigation Settings Panel provides quick access to setup functions and parameters. It contains functions related to the catheter navigation, 
respiration compensation, PRS setup, and Metal setup. 
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For description of controls and on the Settings sub-tab, refer to the Setup section for detailed descriptions of the controls and settings. 

Figure 159.   

 

Refer to the Setup section for detailed descriptions of the controls and 
settings. 
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Navigation Panel - PRS Sub-tab 
The PRS sub-tab provides quick access to PRS setup functions and parameters. Refer to the Setup section for detailed descriptions of the controls and 
settings. 

Figure 160.   

 

Refer to the Setup section for detailed descriptions of the controls and 
settings. 
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Navigation Settings Panel - Metal Sub-tab 
The Metal sub-tab provides quick access to Metal environment setup functions and procedure. Refer to the Setup section for detailed descriptions of 
the controls and settings. 

Figure 161.  Navigation Settings Panel – Metal Sub-tab. 

 

Refer to the Setup section for detailed descriptions of the controls and 
settings. 

 

Ending a Study 
WARNING: If the DWS is powered off by the user, rather than shutdown by the operating system, data on the hard drive may 
become corrupted and the EnSite™ X EP System may cease to be operational. 

CAUTION: When removing the system reference surface electrode from the patient’s abdomen, disconnect the electrode from the 
patient before disconnecting its connection from the SurfaceLink Module. 

Use the following procedure to end a study: 
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Figure 162.  Study and Patient Information screen. 

 

1. From the top bar, select File > End Study. The 
system will prompt the user with "End the 
current study? Yes/No." Select Yes. If study 
and patient information has already been 
specified, go to step 3. 

2. If study and patient information has not been 
specified, the system will prompt the user with 
"Cannot end study without entering study and 
patient information. Enter study and patient 
information? Yes/No." Select Yes. The system 
will display the Study and Patient Information 
screen. Fill in the required information and 
Select OK. 

3. The system will prompt the user with 
"Remember to backup study information". 

4. Select OK to continue. 

5. The system will return to the Login screen. 

NOTE: To backup, or archive, the study, see 
"Archiving Studies". 

 

Capturing, Exporting, and Importing Information 

Exporting Data to External Devices 
Images and study data can be stored to a USB device, a network drive, or CD/DVD. Compatible CD/DVD formats are: CD-R, CD+R, CD-RW, CD+RW, 
DVD-R, DVD+R, DVD+RW, and DVD-R Dual Layer. 

NOTE: CD/DVDs must be handled with care. Do not allow a CD/DVD to fall on a hard surface. To label a CD/DVD, never use a paper label, 
always write directly onto the CD/DVD using a permanent marker. 
NOTE: Information can only be exported to a CD/DVD from outside of a study. 
NOTE: A CD/DVD may contain multiple images, but only one study. 
NOTE: If export to a USB device fails, try an alternate external storage device, a network location, or CD/DVD. 
NOTE: Network File System (NFS) versions prior to NFSv3 may experience limitations to the addressable file system size to less than 4.2GB. 
(This is a protocol limitation.) 
NOTE: File system access errors may be experienced when using Server Message Block (SMB) versions prior to 2.0. Some files may 
become inaccessible. 
NOTE: USB devices having FAT32 file systems may be unable to store Velocity studies, due to the number of files, file name length, or file 
size limitations of FAT32. NTFS or ext3 file systems are recommended to be used. 

When images are stored to external media, they are listed by their annotation and an index number to differentiate duplicate 

annotations. Images are stored as JPEG files. 

Selecting an Area for Capture 
When capturing images or creating animations, the entire screen or a selected area of the screen can be captured. In addition, the images and 
animations can be captured with a white background. The user specifies what is to be captured in the Capture Image, Record Movie, and Capture 
Images windows. 
 To capture the entire screen, select Full Screen. 

 To define the area of the screen to be captured, select Selected Area. To define the area to be captured, Click and hold down the left mouse 
button and drag a box around the desired area of the screen. Adjust the box if necessary. 

 To capture the entire screen or selected area with a white background, select White Background. A white background is beneficial if the images 
are going to be printed on a printer. 

When the desired area has been selected, click [Capture Image] to capture an individual image, or click [Start] to capture an animation. The captured 
image or animation is stored in the Notebook. 

NOTE: Individual images can be captured at any time during a study. 
NOTE: MPEG and JPEG animations can only be captured in Offline Review. 

Saving and Accessing Individual Images 
Images of entire screens can be saved. These images can also be viewed. 

Saving an Image 
To save an individual image: 

1. Select File > Save Image to display the Capture Image window. 

2. Type a description of the image in the text area. 

3. Indicate the screen area to be captured: 

- Select Full Screen to capture the entire screen. 
- Select Selected Area to manually select the screen area to capture. Refer to “Selecting an Area for Capture” for more information about 

selecting the screen area. 

4. Select White Background if a white background is desired. 

5. Click [Capture Image]. The image is captured and saved as a part of the patient study and is added to the Notebook. 



 

128 
 
 

Accessing an Image 
NOTE: Images are saved with their appropriate study. If a study containing images created in Offline Review mode is removed from the 
workstation hard drive, the images are removed as well. Be sure to backup studies so the images are saved. 

1. Access the Notebook in the Review work panel. 

2. Select an annotation from the list. Use the buttons described below to view or manage image files: 

- [Load] displays the image. 

NOTE: This is the only location where printing can be done. 

- [Delete] erases the selected image. 
- [Edit] allows the user to edit the annotation of the image. 

3. Click [Close] to exit the window. 

Creating Animations 
NOTE: Offline Review Mode only. 

A series of continuous images of the entire screen can be exported from the system as either an mpeg movie file or a sequence of jpeg images. 

Creating an MPEG Movie 
Creating and MPEG Movie 
1. Select the Application menu icon at the bottom left of the screen, then choose Save Animation > Start Capturing MPEG Movie to display the 

Record Movie window. 

2. Indicate the screen area to be captured: 

- Select Full Screen to capture the entire screen. 
- Select Selected Area to manually select the screen area to capture. Refer to “Selecting an Area for Capture” for more information about 

selecting the screen area. 

3. Select White Background if a white background is desired. 

4. Click Start to start recording a movie. 

To stop recording an MPEG movie: 

1. Click the Animation Recording icon located in the bottom right corner of the screen. 

or 

Select the Application menu icon and choose Stop Capturing Animation. 

2. A dialog box will appear in the center of the screen. Enter a description for the movie in Description field. 

3. Click [Create Movie] to create the movie or [Cancel] to cancel the operation. 

Creating a JPEG Image Sequence 
To start recording a JPEG image sequence: 

1. Select the Application menu icon then choose Save Animation > Start Capturing JPEG Images to display the Capture Images window. 

2. Indicate the screen area to be captured: 

- Select Full Screen to capture the entire screen. 
- Select Selected Area to manually select the screen area to capture. Refer to “Selecting an Area for Capture” for more information about 

selecting the screen area. 

3. Select White Background if a white background is desired. 

4. Click Start to start recording a movie. 

To stop recording a JPEG movie: 

1. Click the Animation Recording icon located in the bottom right corner of the screen. 

or 

Select the Application menu icon and choose Stop Capturing Animation. 

2. Enter a description for the movie in Description field. 

3. Click [OK] to save the images or [Discard Images] to discard the captured images. 

Data Export 
NOTE: Offline Review Mode only. 
NOTE: This option exports data only to the DWS hard drive. 

To begin Data Export, select Application menu icon and choose Export to bring up the Data Export window. 

Waveform Data 
Near the top of the window is a list of the types of data that can be exported. Any or all of them can be selected using the check boxes, and each will be 
written to its own file. When the user selects any type of data that changes over time (e.g. Waveforms, or Electrode Locations), the Export Interval 
options become available to choose the time interval for the export. 

The Displayed Waveforms option is a special shortcut selection that exports only those waveforms (of any type) that are currently displayed, over the 
current span of the waveform window. The Export Data and Export Interval options do not apply to this selection. 

In EnSite NavX™ mode, if Use System Reference at the top of the window is checked, the Positional Reference will be set to System Reference before 
the export begins, regardless of its setting during the study. This can standardize the positions of electrodes and labels, but also export them in positions 
different than how they appear on the screen. If this option is checked, the user must revert the Positional Reference manually after the export is 
complete. 
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Directory Name 
A directory prefix is assigned in the Directory Name field of the Data Export window. Each time the Export button is clicked, a folder is created using this 
name and the current date and time of the button click, and the exported data files are saved into this folder. 

Export Interval Options 
NOTE: The caliper and the cursor are only available in the following workflows: Model, Therapy, or RealReview. 

Caliper: Select this option to use the green calipers in the waveform display to capture the time interval desired. 

Displayed Window: Selecting this option captures the visible time interval in the waveform display. 

Cursor Location: Selecting this option exports the segment beginning at the cursor. This option requires that one of two sub-options also be selected: 
 Export until segment end, which will continue exporting data until the segment ends. 

 Duration (in seconds), in which the exact segment interval is determined by the user and is manually entered in the field supplied. 

NOTE: Selecting [Clear Selections], at the top of the Data Export window, will clear all Export Option check marks. Deselecting items can be 
done anytime prior to Export. 

Exporting 
When [Export] is clicked, a progress bar is displayed for each option selected. If Export Data: All is selected, all available data for the selected type(s) will 
be exported from the study (e.g., all EP Catheter Unipole Waveform channels). In contrast, when Export Data: Displayed is selected, only those 
channels currently displayed in the waveform window will be exported. 

Once an Export begins: 
 All graphical user interface objects are disabled, except [Cancel]. 

 A progress bar is displayed for each option selected. 

 Application configuration changes recorded as part of the segment are inhibited. 

 The configuration at the start of the Export will be maintained for the duration of the Export. 

NOTE: When the progress bar(s) is displayed, [Cancel] can be selected to stop the Export. The Export may not stop immediately; a slight 
delay can be expected. 

Export is not available if Segment: None is selected. 

When exporting data from the EnSite™ X EP System, the segment playback speed is automatically set to 1:4. This ratio allows for internal processing 
and the Export of data. 

Presets 
The user can choose to save a Preset for application configurations that will be used in more than one Export. 

Once all the desired parameters are set, click on the Preset icon located in the upper right of the Data Export window. Click on Save Preset to bring up 
the Save Preset window. Type in a name for the preset and click [OK]. 

To reapply a Preset, click on the Preset icon and click on the appropriate Preset name. 

NOTE: Export Presets can be applied to any segment in the study in which they are defined. 

However, Export Presets cannot be applied to a different study. 

Archiving Studies 
This option allows the user to archive entire studies to a USB device, a network drive, CD/DVD, or to the DWS to remove later via SJM™ Connect. 

1. Click Archive from the Clinical Menu. 

2. Select the Archive Study tab. 

3. Highlight the desired study. 

4. Insert the desired media, and select the Archive Destination (USB, CD/DVD, network drive, DICOM Server, or SJM™ Connect). 

5. Select the Identifier (name of the USB device or enter the name of the CD/DVD). 

6. Select one or both options: 

- “Delete the selected studies from the local drive after successful archiving” 
- “Overwrite the previous archive on the selected destinations” (does not apply to CD/DVD media) 

7. Click Archive. 

Archiving Media 
This option allows the user to archive individual images and animations from a study, rather than the entire study. 

1. Click Archive from the Clinical Menu. 

2. Select the Archive Media tab. 

3. Highlight the study that contains the desired images and animations. 

4. Select a File Name in the right section of the screen. 

- The selected image or animation displays below. 

5. Insert the desired media, and select the Archive Destination (USB, CD/DVD, network drive, or DICOM Server). 

6. Select the Identifier (name of the USB device or enter the name of the CD/DVD). 

7. Click [Archive]. 

- A progress bar displays “Store in Progress.” 
- The images and animations are archived on the selected media when the progress bar finishes. 

Importing Studies 
The user can import studies to the DWS from a USB device, a network drive, or CD/DVD. 
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1. Click Import from the Clinical Menu. 

2. Select a source from the Import From: pulldown menu. 

- If importing from USB or CD/DVD, make sure the media is present in the USB port or CD/DVD drive. 

3. Click the [Query] or [Browse] button. 

- For CD/DVD, only [Browse] is available. 
- The list of studies on the media displays: 

4. Select a study from the list and click the [Import Study] button. 

- A progress bar displays “Store in Progress.” 
- The study is imported to the DWS when the progress bar finishes. 

Troubleshooting 

Troubleshooting Tools 
Technical Support may ask that the user access one or more of the following software resources. 

EnSite Connect – Technical Support can electronically access your EnSite™ X EP System to perform troubleshooting. 

About the EnSite™ X EP System – This information provides your Abbott Technical Support representative with general information about your DWS 
and EnSite™ X Amplifier.To access during a study, from the menu bar, select Help > About. From the title screen, Select About EnSite™ X EP System. 

Amplifier Logs – This function displays messages from the EnSite™ X Amplifier during a study. From the menu bar, select Amplifier > Log. A window 
appears that displays all the collected logs. 

Collect Log Files – This function collects all the log files from the DWS and exports them to external media. From the title screen, select Services, then 
Collect Logs from the Services menu. Follow the on-screen prompts to complete the process. This operation can take several minutes to complete. 

Viewing recorded settings – Some settings used in Realtime environment can be viewed (but not changed) in Offline Review environment. Hardware 
settings can be viewed by selecting Amplifier > Settings from the menu bar. 

Catheter settings can be viewed in the Setup task. EnSite NavX™ settings can be viewed in the Setup task. 

Run external program – This function allows utilities to be accessed. Service utilities can be accessed from the Launcher's service page. 

Study Files – Record a segment that shows relevant information (if possible) and save the study using the option to remove personal patient 
information. The option will explain what information was removed and remain. 

Error Messages 
Error Message Problem 

DVD Drive Not Detected 
You will be able to conduct real-time studies but it will not be possible to 
review studies from or save data to CD or DVD 
Contact EnSite System technical support 
Press [Continue] when ready 

Indicates a hardware fault with the CD/DVD drive. 

Resource Checks 
Problems were found in checking system resources. 
Restart using normal procedures. 

Press [OK] when ready to shut down for a re-start. 

If the error persists after re-start contact technical support. 

Bad System Time Detected 

(A date and time will be displayed) 
Please correct the system time and date. 

If the trouble persists, Contact EnSite technical support. 
Press [Continue] when ready. 

The system administrator can check the system time setting to adjust to 
the correct time. 

Unexpected error occurred 
Application exited with (number) 

Restart the computer. A user with Service access may run collect logs and 
contact technical support. 

No Base License Detected 
The system does not have an EnSite X EP System base license. 
Contact EnSite technical support 

Press [Continue] when ready. 

The user should discontinue system usage and contact technical support 
for a license. 

Resource Checks 

Problems were found in checking system resources. 
SecurityLauncher program is already running. 

Re-start using normal procedures. 
Press [OK] when ready to shut down for a re-start. 

If the error persists, contact technical support. 

SecurityLauncher failed to execute Restart the computer. If the error persists, contact technical support. 

SecurityLauncher binary not present on the system. Restart the computer. If the error persists, contact technical support. 

Resource Checks 
Problems were found in checking system resources 

Courier program is already running. 
Re-start using normal procedures. 

Press [OK] when ready to shut down for a re-start. 

Restart the computer. If the error persists, contact technical support. 

 

Troubleshooting Common Problems 
System Hardware Problems 
Many hardware problems can be 
identified/resolved by checking 

Check all status lights 
The EnSite™ X Amplifier will perform a self-test. Both LEDs that comprise the status light are illuminated. Check the 
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status lights and cable 
connections. 

amplifier status lights. When the system is powered up, the amber light will stay lit for approximately two minutes 
while the system performs self-testing. After two minutes, the green light should come on and remain solid. See 
table below for amplifier status. 
The EnSite™ X Amplifier status and any fault information can be uploaded by the workstation after the 
EnSite™ X Amplifier connects to the workstation. 
Verify proper cable connections: 

- Turn the system power off. 

- Unplug the system components from power outlets. 
- Check all connections for damage (such as bent or broken pins). 

- Verify there are no loose connections. 

- Check the integrity of the wall power outlet. 
- EnSite™ X Display Workstation (DWS): The power LED on the front of the workstation should be on. 

 

Color  State Action 

Orange / 
Green 

 

Steady Restart or call technical service. 

Orange 

 

Steady Self-test running. 

Orange 

 

Flashing Restart or call technical service. 

Green 

 

Flashing Check fiber-optic cable between the EnSite™ X Amplifier and EnSite™ X DWS is connected; verify 
EnSite™ X DWS is powered on. 

Green 

 

Steady System ready. 

Off 

 

Off System Off. 

 
 
 
Power Failures: A power blackout will 
cause a total system shutdown. In the 
case of a brownout or (low power), the 
system may totally shutdown or may 
show signs of abnormal system behavior. 

If there is reason to believe that some type of power failure has occurred, turn the EnSite™ X Amplifier 
power switch to OFF immediately. Try to end the study and shutdown the workstation. If the normal 
shutdown procedure is unsuccessful: 

- Try Ctrl-Alt-Delete 
- Try Alt-F10 > [Exit EnSite X] > [Exit] 

- Try momentarily pressing the power button on the front of the DWS 
- As a last resort, press and hold the power button on the front of the DWS. 

When the power resumes and appears to be stable, power up the system. 
Monitor the automated system check during the power-up procedure. If any system problems occur, 
contact Abbott Technical Support immediately. 

There is a problem with the 
EnSite™ X Amplifier, indicated by an 
amber LED on the amplifier front panel 
after the two- minute power on self-test. 

- A solid amber LED indicates a self-test problem in the EnSite™ X Amplifier. 
- A flashing amber LED indicates an error in the EnSite™ X Amplifier. 

- Contact Abbott Technical Support. 

The EnSite™ X Amplifier is not 
communicating with the workstation. 

The EnSite™ X Amplifier is unresponsive or is not collecting data in Realtime mode or RealReview mode. 
Try to re- establish communication with the EnSite™ X Amplifier by selecting Amplifier > Reconnect. If 
communication is not reestablished, perform the following: 

- Check the fiber-optic cable connection at the EnSite™ X Amplifier and at the workstation. 

- Power off and on the EnSite™ X Amplifier and all peripherals. 
- Power off and on the workstation. 
- Verify that the lights are blinking on the fiber SFP modules at both the EnSite™ X Amplifier and the 

DWS. 

There is a problem with the 
EnSite™ X Amplifier indicated by the 
workstation. 

The workstation displays a yellow warning dialog: The user should contact Abbott Technical Support. 



 

132 
 
 

The workstation will not turn on, will not 
boot, or turns off unexpectedly. 

- Verify that the isolation transformer switch is on. 
- Verify that the power cable is properly connected between the workstation and the isolation 

transformer. 
- If the system should cease to function due to a power outage or other failure, turn off all power 

switches. Then restart the system. System recovery may take several minutes. 

- Try momentarily pressing the power button on the front of the DWS. 

- As a last step, press and hold the power button on the front of the DWS. 

Hard drive has run out of space. If there is insufficient space on the hard drive to load a study from the external media, delete studies from 
the hard drive, then load the study. 

There is a broken connector pin. Contact Abbott Technical Support or Customer Service to order a replacement cable. 

The printer does not print images. - Ensure the printer is enabled. To do this, go to the Services menu and select [Select Printer]. Select 
the desired printer and click "Apply." 

- Ensure that printer ink cartridges are not depleted; replace depleted cartridges. Ensure that there is 
paper in the printer. 

 

Patient Signal Problems 
Problem Possible Solutions 

Interference between devices is evident. This equipment has been tested and found to comply with the limits for medical devices to 
EN 60601-1-2: 2001. This testing shows the device provides reasonable protection against 
harmful interference in a typical medical installation. However, there is no guarantee that 
interference will not occur in an installation. If this equipment does cause harmful interference 
to other devices or is negatively impacted by other devices, try to correct the interference by 
one or more of the following measures: 

- Reorient or relocate the devices. 

- Increase the separation between the devices. 
- Connect the equipment to an outlet on a different circuit. 

- Contact Abbott Technical Support for further assistance. 

There is excessive waveform noise. If noise levels are excessive in general, check the following: 
- Under catheter setup / waveform controls, evaluate signals with noise filters enabled 

and disabled. 

- Adjust noise filter settings. 
- Ideally, the power source for the EnSite™ X Amplifier should be a properly grounded, 

dedicated 15-amp circuit. 
- Ensure the EnSite™ X Amplifier is connected to an Abbott supplied isolation 

transformer. 

An EnSite™ X electrode has become disconnected or 
loose, indicated by a warning message. 

- Verify that all cable connections between the electrodes and the SurfaceLink™ Module 
are secure. 

- Verify that none of the electrodes have come loose. If an electrode has come loose from 
the patient, re-apply the electrode in the same location and verify that navigation is 
accurate, compared to fluoroscopy and signals. It may be necessary to re-validate. 

ECG signals are not functioning properly. - Verify that the system reference patch is connected to the patient. 

- Verify that the ECG cables are connected properly. 

 

EnGuide Stability Problems 
An EnGuide electrode position seems to be incorrect: 
The EnGuide electrode intermittently displays jumps in location or changes 
in color. 
Displayed location of the roving catheter on the system differs from the 
displayed catheter location on fluoroscopy or another mapping system. 
The movement of the EnGuide is inconsistent with the movement of the 
roving catheter. 
The EnGuide “jitters.” 

- Verify to the Ampere Connect cable is connected between 
Ampere™ and the EnSite™ X Amplifier. 

- Verify that EnGuide is locating the intended electrode. 
- Verify that catheter cables and/or pin connectors are connected 

properly. 
- Verify that the electrodes are properly adhered to the patient and 

connected to the system. 
- Verify that the wires for the electrodes are positioned in a way that 

there is no tension on the wire. 
- Attempt to use a different catheter. Signal improvement may 

indicate a damaged EP catheter or connecting cable. 

- Select “Application Menu, then select Amplifier > Reset Amplifier. 

An EnGuide appears kinked or displays fewer electrodes than expected. - In an EnSite™ X EP System study, if the EnGuide appears kinked, 
there may be a problem with the catheter. A new catheter or 
extension cable may display better results. 

- If the EnGuide is displaying fewer electrodes than expected (based 
on EnGuide settings) the electrodes may be spaced too close to 
one another for EnGuide to display different electrodes, or there 
may be a problem with the roving catheter, such as a weak 
electrode or short. 
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Patient Irregular Respiration Patterns Patient – sleep 
apnea, coughs, snoring 

Follow these steps: 

1. Wait for the respiration pattern to stabilize. 
The EnGuide may return to its original 
expected location. 

2. Manually recollect respiration 
compensation data. 

3. Switch to manual to prevent additional 
collection (disable adaptive respiration 
compensation). 

4. If multiple shadows have been placed use 
EnGuide Alignment tool to adjust the 
visually realign the catheter to the model. 

5. Build a new model if steps above do not 
resolve the problem. 

Patient Rate or Rhythm change - Heart rate or rhythm changes have the 
potential to change the physical 
anatomical volume of the heart chamber. 
If the rate or rhythm changes occur after 
a model has been created, new model 
may need to be created for the new rate 
or rhythm. 

Patient Isoproterenol bolus - Wait for the respiration pattern to 
stabilize. The EnGuide may return to its 
original expected location. 

Patient Heart Motion - If the heart has physically moved from its 
original position, create a new model if 
necessary. 

Device Interaction Cardioversion Follow these steps: 

1. Wait for the EnGuide to return to its original 
expected location. 

2. If multiple shadows have been placed use 
EnGuide Alignment tool to adjust the 
visually realign the catheter to the model.  

3. Build a new model if steps above do not 
resolve the problem. 

Device Interaction Introduction of a guide wire - Remove the guide wire if it is not in use. 

Device Interaction Pacing – connection of a stimulation channel to 
electrodes 

- If there is no active pacing on the 
electrode pair, remove the connection of 
the stimulation channels. 

Electrode Changes Electrode Detachment Follow these steps: 

1. Replace the detached electrode with a new 
electrode. 

2. Build a new model. 

Electrode Changes Electrode movement relative to the location of 
the heart 

Follow these steps: 

1. Switch to an intracardiac reference if 
available to prevent additional instability 
due to electrode movement. 

2. If multiple shadows have been placed, use 
the EnGuide Alignment tool to visually 
realign the catheter to the model. 

3. Build a new model if use of the alignment 
tool is not successful. 

Electrode Changes Pushing on a patch - Inflation of a blood 
pressure cuff 

Try the following options: 
- Avoid pushing on the patch or remove 

the object pushing on the patch. 
- Switch to an intracardiac reference if 

available. 

Electrode Changes Adding or removing patient bedding materials - Avoid moving bedding materials such as 
a pillow that have the potential to disturb 
the electrode. 
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System Related Positional Reference Moves Try the following options: 

- Move catheter to original location as 
observed on Fluoroscopy images. If 
Positional Reference Tool is enabled use 
the tool to realign the reference. 

- Switch from the intracardiac Positional 
Reference to the System Reference. Then 
choose a different electrode for positional 
reference. 

- Build a new model if use of the Positional 
Reference Tool is not successful. 

 

Magnetic Tracking Problems 
System not recognizing PRS - Verify the EnSite™ X Field Frame cable is connected to the EnSite™ X Amplifier. 

- Ensure that the EnSite™ X Field Frame cable is not coiled. 
- Ensure a 12 coil Field Frame model ENSITE-FF-BRCKT-01 or ENSITE-FF-ABRKT-01 is connected to the 
system. 

- Ensure the Field Frame cable is model ENSITE-FF-3MC-01 or ENSITE-FF-4.5C-01. 
- Replace the PRS. 

PRS icons are gray - Ensure that the EnSite™ X Field Frame cable is not coiled. 
- Ensure the PRS sensors are connected to the EnSite™ X Amplifier. 
- Ensure that the PRS sensors are separated and are not being separated by a pillow or other piece of 
equipment. 

Valid PRS status is intermittent - Ensure that the EnSite™ X Field Frame cable is not coiled. 
- Ensure the PRS sensors are located within the motion field, adjust PRS placement or location of Field 
Frame on the patient table. 
- Replace the PRS. 

PRS-A is gray or red - Confirm position of PRS is within the PRS-A detection box as viewed on the PRS tab. 

- Adjust the EnSite™ X Field Frame or patient position on the table. 

- Confirm all PRS-A position criteria on the PRS tab are met. 
- Perform the Metal Baseline or return the Fluoroscopy detector to the Metal Baseline position. 

- Remove presence of metallic equipment in the presence of the magnetic field Example: patient warming 
equipment, monitor boom. 

System not collecting EnSite NavX™ SE 
points 

- Correct any Metal Distortion issues. 

- Confirm PRS and catheter status indicators are green. 
- Confirm a Sensor Enabled™ catheter selected as Active EnGuide for NavX Mode. 
- Verify the electrodes on the catheter are out of the sheath. 

- For ablation catheter, ensure Stabilize ABL is off. 
- Irregular respiration patterns may cause points to not be collected. Monitor the Respiration meter. 

 

Software Interface Problems 
Unable to enter Review Mode or end study. An action is incomplete. Verify that the model has been completed. Verify 

that recorded segments have been completed and annotated, verify 
patient information has been entered. 

Unable to access controls to export information to the external media. - Verify the system is in Offline Review; the external media is not intended 
to be used to export data or animations during a study. 

The study screen display freezes. If the system appears to be running but does not respond to keyboard or 
mouse input, press and hold the <Alt> key on your keyboard, then press 
the <Tab> key. The system should then return to normal operation. 
The study screen freezes after a manual reset of the EnSite™ X Amplifier 
or an inadvertent reset following a defibrillation.  
- Power cycle the EnSite™ X Amplifier by turning the EnSite™ X Amplifier 
power switch off and (after five seconds) then on. 

- Select Amplifier > Reconnect and wait up to 2 minutes for the 
EnSite™ X Amplifier to complete its self-test routines. 

- Select <Alt> + <Tab> to see if the study screen starts responding. 
- To force the system to shut down, select <Alt> + <F10>.   
- To end the current session, or to force the system to shut down or 

restart, select <Ctrl> + <Alt> + <Del>, and choose the desired 
option. 

- If the problem persists, contact Abbott Technical Support. 

An on-screen warning message has appeared. Follow any on screen instructions to resolve the issue. 

NOTE: Further details on problems related to the current 
version of the software can be viewed in the Software 
Anomalies Addendum. 

Other information may be displayed along with these messages indicating 
what caused the problem. Note this information for future reference 
should you wish to contact support personnel. 
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SJM™ Connect 
SJM™ Connect is a feature that is available on the EnSite™ X EP System. It allows an Abbott Technical Support representative to connect to your DWS 
through a broadband Internet connection. SJM™ Connect provides users with access to a secure remote connection to tech support to aid in remote 
servicing. All communications are encrypted with TLS. When connected to your DWS, the Abbott System Technical Support representative can see the 
interface. The user will also be able to chat with the Technical Support Representative through a chat window. 

NOTE: 

 SJM™ Connect is intended for troubleshooting purposes. SJM™ Connect is not intended to be used in lieu of an on-site system 
operator. 

 Personal patient information is automatically deleted from uploaded studies. The Technical Support representative uses these 
anonymous studies to research any technical issues. When possible, record and annotate segments of any unusual behavior for 
analysis. 

 The local user must launch the SJM™ Connect remote client and then call Abbott Technical Services to initiate the remote connection. 
The local user must accept the request for access which is sent by the remote user based on the level of access they require. The local 
user can end the session at any time. Select the Disable button when SJM™ Connect is not in use. 

Using SJM™ Connect 
Figure 163.  The SJM™ Connect Icon 

 

Call Abbott Technical Support. 

Abbott Technical Support will assess the issue over the phone and may 
need additional information from Collect Logs or remote access to the DWS. 
If Abbott Technical Support requires remote access to the DWS, select the 
SJM™ Connect icon on the EnSite™ X EP System’s tool bar. 

NOTE: 

An Ethernet cable with Internet access must be plugged into 
the hospital network port on the back of the DWS. This is an 
encrypted, secure connection used by Technical Support. 

Only enable SJM™ Connect if instructed to do so by Abbott 
Technical Support. 

 

Figure 164.  SJM™ Connect Window 

 

The SJM™ Connect window displays. Select the timeout from drop down 
list and select Enable. The SJM™ Connect icon will turn bronze. 

NOTE: SJM™ Connect will be enabled for the selected amount 
of time, ranging from 0.1 hour (6 minutes), 1 hour, 2 hours, 24 
hours, and 48 hours. The default timeout is 0.1 hour (6 
minutes). The timeout determines how long the session can 
remain idle before being terminated. The session will not 
timeout at any time during a study. 

If Technical Support initiates a remote connection to the DWS, a prompt 
displays requesting to view and control your computer. 

 

Figure 165.  SJM™ Technical Support Access Request Example 

 

Select Allow. If nothing is selected after 15 seconds, Technical Support will 
automatically connect. The SJM™ Connect icon will turn green. 
Technical Support will now have access to the system to troubleshoot the 
problem. A chat window will display if Technical Support initiates a chat 
session. 
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Figure 166.  Technical Support Chat Window 

 

If necessary, drag this window to the side of the monitor or select the 
SJM™ Connect icon. and select "Show / Hide Chat" in the SJM™ Connect 
dialog. The minimized chat window will pop up if Technical Support 
initiates a chat. Select Show Chat to bring screen back on the display. 
After the Technical Support session has ended, select the SJM™ Connect 
icon on the EnSite™ X EP System’s tool bar and select Disable button in 
the SJM™ Connect window. The SJM™ Connect icon will turn gray. 

NOTE: The default status of SJM™ Connect on system startup 
is disabled. SJM™ Connect should only be enabled when a 
Technical Support session is necessary. 

 

If not disabled manually, SJM™ Connect will stay enabled until the specified timeout irrespective of user logouts or system shutdown. It will disable 
automatically after the specified timeout if no Technical Support is connected at that time. If a Technical Support is connected and the timeout expires, 
the SJM™ Connect session will stay enabled until Technical Support terminates the connection. 

Whenever SJM™ Connect window is not active window on the screen, it will close itself. It can always be launched by selecting the SJM™ Connect icon 
on the EnSite™ X EP System’s tool bar. 

Sending Files 
The chat function allows the user to send files from the DWS to Technical Support. 

Figure 167.  SJM™ Connect Chat Window 

 

If Technical Support requests any logs, select Upload Logs from the SJM™ Connect 
window. 
After the Technical Support session has ended, select the SJM™ Connect icon on the 
EnSite™ X EP System’s tool bar and select Disable button in the SJM™ Connect 
window. The SJM™ Connect icon will turn gray. 

NOTE: The default status of SJM™ Connect on system startup is disabled. 
SJM™ Connect should only be enabled when a Technical Support session is 
necessary. 

 

Figure 168.  SJM™ Connect File Browser 

 

Browse the folders and select the desired file to send and select OK. 

 

Uploading Logs 
If Abbott Technical Support requests the user to upload logs: 

1. Select Upload Logs from the SJM™ Connect window. 

2. Select the logs to upload. 

NOTE: The logs will not be uploaded automatically. They will remain on the DWS until Abbott Technical Support connects to the DWS to 
collect them. 

Uploading Studies 
If Abbott Technical Support requests the user to upload patient studies: 

1. Select the Clinical button, then the Archive button from the EnSite™ X EP System main page. 
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2. Select the study or studies to upload. 

3. Select the SJM™ Connect checkbox and select Archive. 

4. Select Close. 

NOTE: The studies will not be uploaded automatically. They will remain on the DWS until Technical Support connects to the DWS to collect 
them. 

Proxy Configuration 
The hospital's IT department may request the user to configure the proxy server to establish a connection to the DWS. The SJM™ Connect Proxy 
Configuration Window. 

Figure 169.  SJM™ Connect File Browser 

 

1. Select Configure Proxy in the SJM™ Connect window. 

NOTE: The Configure Proxy button will be inactive if SJM™ Connect 
is enabled. 

2. Select the Enable Proxy checkbox and enter the proxy server and 
proxy port information. 

3. If the proxy server requires authentication, select the Authorization 
Required checkbox and enter the authorized user name and 
password. 

4. Select Save to save the proxy configuration. 

NOTE: Do not configure a proxy if the hospital network does not 
require a proxy for Internet access. By default, no proxy is configured 
and all the fields from the Proxy Configuration windows will be 
inactive. 

 

EnSite™ Courier™ PACS Module 
The EnSite™ Courier™ PACS Module v.3.0 allows the EnSite™ X EP System user to communicate with the hospital PACS server for the purposes of 
storing and retrieving patient data in DICOM format. Specifically, the EnSite™ Courier™ PACS Module can be used to perform the following: 
 Retrieve CT/MR/XA (rotational angiography) images to segment with EnSite™ Verismo™ Segmentation Tool and store the resulting segmented 3D 

model on a PACS (Picture Archiving and Communication System) server. 

 Retrieve pre-segmented 3D models from a PACS server or receive pre-segmented 3D models from a third-party advanced visualization 
workstation. Pre-segmented 3D models can be loaded directly into a realtime or review studies. 

 Store and retrieve studies on a PACS server and import the retrieved studies for review. 

 Store study screenshots for viewing on a standard DICOM viewer. 

NOTE: Refer to the EnSite™ Courier™ PACS Module DICOM Conformance Statement for information about compatible file types and 
vendors. 

Configuring the EnSite™ Courier™ PACS Module 
This chapter specifies the steps to configure the EnSite™ X EP System Display Workstation (DWS) for use with the EnSite™ Courier™ PACS Module. 

1. Configure DWS Network Settings. 

- Connect the DWS to the network. 
- Configure the IP Address. 

2. Configure the EnSite™ Courier™ PACS Module. 

- Configure PACS server settings. 
- Configure EnSite™ Courier™ PACS Module settings. 

3. Register the EnSite™ Courier™ PACS Module on the PACS server. 

Configure DWS Network Settings 
Connect the DWS to the Network 

Configure the IP Address 
The EnSite™ X EP System uses DHCP as the default setting for obtaining an IP address from the hospital network. If the user has received a new 
system and plans to use DHCP, the user does not need the DHCP configuration steps below. Simply connect the ethernet cable as described in 
"Connect the DWS to the Network". 

If the hospital does not allow use of a dynamic IP address, configure the EnSite™ X EP System with a static IP address. 

Configure a Dynamic IP Address 
Follow these instructions to verify DHCP settings or switch a system from a static IP configuration to DHCP. 

1. From the Launcher screen, select Services > Configure Network. 

2. The Network Configuration window will be displayed. 

a. Select the Devices tab. 

b. Select eth0. 

c. Select the Edit button and the Ethernet Device Window will be displayed. 
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Figure 170.  Network Configuration window 

 

 

Figure 171.  Ethernet Device window 

 

 

3. In the Ethernet Device window: 

a. Verify that Activate device when computer starts is not checked. 

b. With the Automatically obtain IP address settings with radio button selected, choose dhcp in the dropdown menu. 

c. Select OK. The Ethernet Device window will close. 

4. In the Network Configuration window's Devices tab: 

a. Verify that the Profile boxes are selected for all eth* interfaces within the Devices tab. 

b. Select File > Save. The following message will be displayed: "Changes are saved. The user may want to restart the network and network 
services or restart the computer." Select OK. 

c. Select File > Quit. 
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Figure 172.  Network Configuration, Devices tab 

 

 

Configure a Static IP Address 
NOTE: If the EnSite™ X EP System DWS is physically moved, make sure that the IP address, subnet mask, and default gateway address are 
valid for the new location. 

To configure the EnSite™ X EP System DWS with a static IP address: 

1. From the title screen, select Services > Configure Network. 

2. The Network Configuration window will be displayed. 

Figure 173.  Network Configuration window 

 

 

3. In the Network Configuration window: 

a. Select the Devices tab. 

b. Select eth0. 

c. Select Edit. The Ethernet Device window will be displayed. 
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Figure 174.  Ethernet Device window 

 

 

4. In the Ethernet Device window: 

a. Verify that the Activate device when computer starts option is selected. 

b. Select Statically set IP addresses. 

c. Specify the Address, Subnet mask, and Default gateway address. This information should be obtained from the hospital IT department. 

d. Select OK. 

5. In the Network Configuration window's Devices tab: 

a. Verify that the Profile boxes are selected for all eth* interfaces within the Devices tab. 

b. Select File > Save. The following message will be displayed: "Changes are saved. The user may want to restart the network and network 
services or restart the computer." Select OK. 

c. Select File > Quit. 

Configure PACS Server Settings 
The PACS Server Settings window is used to set the connection parameters for the PACS servers. At least one PACS server must be configured before 
the EnSite™ Courier™ PACS Module can be used. 

To configure the PACS server settings: 

1. From the clinical screen, select Archive or Import. 
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Figure 175.  EnSite™ X EP System Clinical Menu 

 

 

2. From the EnSite™ Courier™ PACS Module main window, select the Settings icon in the upper right corner of the screen, open the PACS Servers 
tab. 

3. Select the Edit button. 

Select within a data field to enter information. Each line represents one PACS server. Input all required information, items 1-8 in "Description of 
PACS Server Settings", to setup the PACS server. 

4. Select the Test Connection button to test the connection to the PACS server. 

If the connection does not work, check that the information entered in each field is correct. If the IP Address, AE Title, or Port Number are 
incorrect, the system will not be able to communicate with the PACS server. 

Once a connection has been established select Save to save the settings. 
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Description of PACS Server Settings 
Figure 176.  PACS Servers Tab 

 

1. Descriptive Name – The Descriptive Name cannot be blank. 
Input a name for the PACS server. This will be the name used to 
identify the PACS server in the software when archiving or 
importing files. To remove a PACS server from the list, delete 
the Descriptive Name and select Save. 

2. AE Title – Enter the Application Entity (AE) Title of the PACS 
server. The AE Title is case sensitive. 

3. IP Address – Enter the IP address of the PACS server. 

4. Port Number – Enter the port number of the PACS server. 

5. Query Level – Select the tier of information to be returned when 
performing a query (STUDY, SERIES or IMAGES). 

6. Q/R (Query/Retrieve) – Select the checkbox if this PACS server 
can be used for Query/Retrieve. 

7. Storage – Select the checkbox if this server can be used for 
storage. 

8. Storage Commitment – Select from ASYNCHRONOUS, 
SYNCHRONOUS, or NOT SUPPORTED. 

- When ASYNCHRONOUS is selected, the system will attempt a Storage 
Commitment request to the PACS server and will continue to wait for a 
response. The system will complete the storage operation only when 
the Storage Commitment status notification is received from the PACS 
server. 

- When SYNCHRONOUS is selected, the system will attempt a Storage 
Commitment request to the PACS server and will wait for a specified 
timeout period for the response. The system will complete the storage 
operation either when the Storage Commitment status notification is 
received from the PACS server or when the timeout period expires. 

- When NOT SUPPORTED is selected, the system will not attempt a 
Storage Commitment request to the PACS server and the storage 
operation will complete as soon as transmission is complete. 

9. Test Connection – Select this button to test the connection to the 
PACS server. 

10. Edit – Select to edit PACS server settings. 

11. Save – Select to save the changes. 

12. Close – Select the Close button to cancel any changes made and 
close the windows. 

 

Configure the EnSite™ Courier™ PACS Module Application Entity Settings 
NOTE: If multiple EnSite™ X EP Systems are in use on the same network, make sure that each DWS has a unique AE Title and is registered 
properly by the PACS Administrator. 

To configure the EnSite™ Courier™ PACS Module Settings: 

1. From the EnSite™ Courier™ PACS Module main window, select the Settings icon in the upper right corner of the screen. 

The Courier Settings window is displayed. Default settings are shown and should be changed only when necessary—for example, when there are 
hospital-specific rules regarding AE Title and/or Port Number. 

2. Click the Edit button. 

3. Click within a field to enter information. 

4. After all information has been entered, select the Save then Close button to save the settings. 

Description of EnSite™ Courier™ PACS Module Settings 
Image Receiver Settings 
These settings are used when receiving images. 

AE Title – The AE title. The user can change the AE title, which can be up to 16 characters. 

Port Number – The port number used by the to receive images. This field should not be changed by the user. 

Timeout – The amount of time, in seconds, that the EnSite™ Courier™ PACS Module will allow for a single image to be transmitted from the PACS 
server or advanced visualization workstation. This field should not be changed by the user. 

Network Path 
The Network Path tab allows the user to define the destination for archiving. Archived data can be stored on a USB drive, a DVD, or a network drive. 
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Figure 177.  Network Path Tab 

 

 

Application Entity 

Storage Attributes 
The Storage Attributes tab defines the size and amount of data that can be stored on a local network drive. This is a user-defined parameter, and the 
default setting is the secondary selection. 

Figure 178.  Storage Attributes Tab 
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History Management 
The History Management tab allows the user to manage locally the number of studies to retain on the EnSite™ X EP System network. Once stored, the 
data can be retrieved from the Retrieval History function. 

Figure 179.  History Management Tab 

 

 

Query Configuration 
The Query Configuration tab allows the user to define the desired tier of data (study/series/image). 

Figure 180.  Query Configuration  
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Register the EnSite™ Courier™ PACS Module on the PACS Server 
To exchange information between the EnSite™ Courier™ PACS Module and the PACS server, configure the PACS server with the information contained 
in the Courier Settings screen. 

1. From the EnSite™ Courier™ PACS Module main screen, select the Courier Settings icon. 

2. Talk with your PACS Administrator about entering these settings on the PACS server. 

3. After these settings have been entered on the PACS server, test the connection from PACS server to the EnSite™ Courier™ PACS Module, if 
possible. 

If the connection is successful, then the user is ready to begin using the EnSite™ Courier™ PACS Module. 

Using the EnSite™ Courier™ PACS Module 
After a patient has had a CT, MR, or XA scan, the user can import the images into the EnSite™ Verismo™ Segmentation Tool for segmentation and 
store the segmented 3D model to a PACS server, to the EnSite™ X EP System DWS hard drive, or to a CD/DVD. 

Launch the EnSite™ Courier™ PACS Module 
To launch the EnSite™ Courier™ PACS Module: 

1. From the EnSite™ X EP System title screen, select the Verismo icon to launch the EnSite™ Courier™ PACS Module. The 
EnSite™ Courier™ PACS Module main screen will be displayed. 

2. Use the next section, "Perform a Query", to locate the CT/MR/XA scan on the PACS server. Alternately, use the section "Receive Study or CT/MR 
Scans" to receive the images. 

Perform a Query 
To perform a query: 

1. Confirm that the Versimo task is selected. 

2. Specify the search criteria. 

NOTE: The asterisk (*) may be used as a wildcard, if supported by your PACS server. If a Chinese or Japanese keyboard is used, the 
asterisk must be entered in English input method. 

- At least one of the following must be entered: Patient ID, Patient Name, Accession Number, or Study Date (see yellow box highlighting these 
items in the figure below). 

- To specify Patient Name, type in the name with format "LastName^FirstName". If expected record is not returned, use wildcard search. Some 
example of wildcard search are LastName^FirstName*, LastName^*,Last Name*, *^FirstName. Similar wildcard searches can be used to 
specify the Referring Physician field. 

- To specify Study Date, select date, month and/or year in the format shown; the year also can be entered manually. Alternatively, select Today 
or Yesterday from the drop-down list to auto-populate the date, month, and year fields. 

3. Select the Modality. The modality determines the types of images (CT/MR/XA) contained in the study. More than one Modality type may be 
selected. If none are selected, all studies matching the search criteria will be displayed. 

NOTE: Use CT, MR, and XA to query for images to segment in the EnSite™ Verismo™ Segmentation Tool. 

4. Select the PACS server from the Import from drop-down menu. 

5. Select Query to launch Verismo. 

Figure 181.  Retrieving a study 

 

 

Import Study 
Single or multiple series or one study may be selected. 
 To select a single item, such as a CT/MR/XA scan, select the item. 

 To select multiple items, hold down the <Ctrl> key and select each item. 

 To select multiple consecutive items, hold down the <Shift> key, select an item and then select another item. Alternatively, select an item and 
drag to select additional consecutive items. 

NOTE: 

 Some PACS servers only support single item retrieval. 
 Only multiple studies for a single patient may be selected. 

There are two ways to retrieve images: 
 To retrieve a complete study, select the study and then select Launch Verismo button. 

 To retrieve a single series, select the study, select the series, and then select Launch Verismo button. 
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Figure 182.  Retrieving a study 

 

 

When the Import Study button is clicked, the Retrieve in Progress bar will show the percentage of the images retrieved. After the Retrieve is done, the 
EnSite™ Verismo™ Segmentation Tool is launched. 

NOTE: 

 When the Retrieve in Progress bar is displayed, the EnSite™ Courier™ PACS Module main screen cannot be repositioned. 
 If the user selects the Cancel button in the progress bar, image retrieval will be stopped; otherwise, image retrieval will continue until 

completed. 
 If the Retrieve operation fails, a message will be displayed. Refer to the Retrieve Failed instructions under the Troubleshooting section to 

determine the cause. 

Receive Study or CT/MR Scans 
To receive a study or CT/MR scans: 

1. From the EnSite™ X EP System title screen, select the Verismo icon to launch the EnSite™ Courier™ PACS Module. The 
EnSite™ Courier™ PACS Module main screen will be displayed. 

2. To enable Receive mode, select the Receive button in the lower left corner of the Courier PACS screen. When the Receive button is selected, it 
will change to Stop Receive. 

3. After all scans have been received, select Stop Receive. All received studies will be listed for selection. 

Archive Segmented 3D Model/Map to PACS Server 
This allows the user to store segmented 3D models generated by the EnSite™ Verismo™ Segmentation Tool. 
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Figure 183.  Archiving a study 

 

 

1. Return to the Clinical Menu and select Archive. 

2. If not already in the EnSite™ Courier™ PACS Module: From the EnSite™ X EP System title screen, select the Archive icon to launch the 
EnSite™ Courier™ PACS Module. 

3. Select the archive server PACS name associated with the server on which the user wants to archive the data. 

4. Select the Archive DIF Workflow Task, at top of the EnSite™ Courier™ PACS Module main screen. A screen will display a list of the DIF files 
created by the EnSite™ Verismo™ Segmentation Tool. 

5. Select the DIF file. 

- To select multiple items, hold down the <Ctrl> key and select each item. 
- To select multiple consecutive items, hold down the <Shift> key, select an item and then select another item. Alternatively, select an item and 

drag to select additional consecutive items. 

6. Select the destination PACS server from the drop-down menu at the lower right of the EnSite™ Courier™ PACS Module main screen. 

7. Select the Store button. 

The Store in Progress bar will show the percentage of the DIF models stored. 

NOTE: The user can overwrite a previously archived study by selecting the Overwrite previous archive option at the lower left of the Archive 
Study screen. 

If the user selects the Cancel button in the Store in Progress bar, any files that have already been transmitted or have started transmission will be 
stored; any files that have not started transmission will be canceled. 

8. An entry will be made in the Archive History when the transmission is completed. A second entry will be made in the Archive History when 
Storage Commitment is completed, if this has been configured for the receiving PACS server. 

A final storage status will be displayed for each study in the Archive History. 

Delete Study after Archiving 
To delete a study after it is archived, select the Delete the selected studies from the local drive after successful archiving option at the lower left of the 
Archive Study screen. 
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Figure 184.  Archiving Media 

 

 

Receive Pre-Segmented 3D Models 
The EnSite™ Courier™ PACS Module can accept pre-segmented 3D models from a third-party advanced visualization workstation. This capability, 
called Receive mode, must be enabled by the user. Any DICOM application entity that wants to send to the EnSite™ Courier™ PACS Module must use 
the correct the EnSite™ Courier™ PACS Module AE Title, IP Address, and Port Number. 

To receive pre-segmented 3D models from within an EnSite™ X EP System study: 

1. From an EnSite™ X EP System study, select the DIF icon at the top of the Model control panel. The DIF control panel will be displayed. From the 
DIF control panel, select Load DIF. The DIF window will be displayed. 

OR 

To launch the EnSite™ Courier™ PACS Module from the EnSite™ X EP System top bar, select File > Load DIF... The DIF window will be displayed. 

2. To enable Receive mode, select the Receive button. 

When the Receive button is clicked, it will change to Stop Receive. Receive mode will stay active until Stop Receive is selected. After Received mode is 
stopped, all received studies will be displayed. 

Figure 185.  Received Studies 

 

 

Select a Study 
1. Select the Retrieve button and preview the 3D model. 

2. Select the DIF file and select the Load DIF button to load the DIF file into the EnSite™ X EP System study. To receive pre-segmented 3D models 
from outside of an EnSite™ X EP System study: 

- From the EnSite™ X EP System Clinical Screen, select the Import icon to launch the EnSite™ Courier™ PACS Module. The 
EnSite™ Courier™ PACS Module main window will be displayed. 

- From the EnSite™ Courier™ PACS Module main window, select the Receive button in the lower left corner of the screen. 
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3. When complete, select the Stop Receive button. The received 3D models will be available in the retrieval history to be loaded into an 
EnSite™ X EP System study in the future. 

NOTE: 

 There is no limitation on the number of images received during a single connection. 
 If the EnSite™ Courier™ PACS Module is receiving images when the Stop Receive button is selected, the current transmission will 

continue; however, subsequent transmissions will be disabled. Receive mode must be re-enabled for subsequent transmissions. If the 
EnSite™ Courier™ PACS Module is not receiving images when the Stop Receive button is selected, Receive mode will immediately 
cease operation. Receive mode will remain active until stopped by the user. 

Store EnSite™ X EP System Studies on PACS Server 
1. If not already in the EnSite™ Courier™ PACS Module: From the EnSite™ X EP System Clinical Menu, select the Archive icon to launch the 

EnSite™ Courier™ PACS Module. 

2. Select the Archive Study Workflow Task. 

A list of the EnSite™ X EP System studies on the DWS will be displayed. 

3. Select one or more studies from the list to store. 

- If one study is selected, the notebook information and archive history of the study will be displayed on the righthand side of the screen. 
- To select multiple studies, hold down the <Ctrl> key and select each study. 
- To select multiple consecutive studies, hold down the <Shift> key, select a study and then select another item. Alternatively, select an item 

and drag to select additional consecutive items. 

4. Select the PACS server to use for storing the studies. 

5. Select the Archive button. 

The Store in Progress bar will show the percentage of the studies stored. 

6. If the user selects the Cancel button in the Store in Progress bar, any files that have already been transmitted or have started transmission will be 
stored; any files that have not started transmission will be canceled. 

A final storage status will be displayed for each study in the Archive History. 

NOTE: The result of viewing the EnSite™ X EP System study on a standard DICOM viewer depends on the PACS server configuration and 
may be displayed as a blank screen. This behavior is expected and does not indicate an error in storage. 

Import EnSite™ X EP System Studies from a PACS Server 
1. From the EnSite™ X EP System Clinical Menu, select the Import icon to launch the EnSite™ Courier™ PACS Module. 

2. From the EnSite Courier PACS Module Retrieve Workflow Task Window, make sure that EPS modality is selected (check mark displayed) and use 
the PACS Server drop-down menu to select the PACS server to query. 

NOTE: Some PACS servers may not support EPS modality type and may modify that field when an EnSite™ X EP System study is stored. If 
a query with EPS modality type checked does not return the expected EnSite™ X EP System study in the query result, clear all modality 
checkboxes and try the query again. 

3. Enter the search criteria to locate the study. 

4. Select the study and select Import Study. 

NOTE: If the PACS server supports Series level retrieval, select the series with Series Description "Study Data". 

Figure 186.  Importing an EnSite™ X EP System study from a PACS server 
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5. If only one study is retrieved, the study will be imported; If multiple studies or multiple version of the same study are retrieved, a study selection 
window will be displayed. Select the desired study, and then select the Continue... button to import the EnSite™ X EP System. 

NOTE: Only one study can be imported at a time. 

6. If the selected study already exists on the DWS, a warning will be displayed: This study already exists on the system. Overwrite? Select Yes to 
replace the existing study with the newly-imported study. 

7. When the import is complete, Courier exits. 

8. To view the imported study from the EnSite™ X EP System title screen, select Past Studies. 

Display EnSite™ X EP System Study Screenshots 
EnSite™ X EP System study screenshots are saved as a separate series within the study and can be retrieved independently from the 
EnSite™ X EP System study. These screenshots can be viewed using any standard DICOM viewer. 

View Screenshots from Standard DICOM Viewer 
EnSite™ X EP System study screenshots also can be retrieved by any standard DICOM Query and Retrieve application connected to the PACS server 
and then displayed by any standard DICOM viewer. To retrieve the screenshots, simply retrieve the series within an EnSite™ X EP System study with the 
Series Description, "Study Images". 

NOTE: If series level retrieval is not supported by the PACS server, retrieve the entire EnSite™ X EP System study, and select the proper 
screenshot series for display. 

Troubleshooting 
Courier Log 
The Courier Log is used to troubleshoot communication related issues. Select the Courier Log icon on the EnSite™ Courier™ PACS Module main 
window to display the Courier Log window. 

Figure 187.  Debug Log 

 

 

Log Level – The Log Level determines the type of information that is included in the Courier Log. The following levels are available: 
 INFO – (default) User Operation (Query, Retrieve, Criteria, Operation Status). 

 WARNING – General warning messages in addition to INFO. 

 DEBUG – General debug messages in addition to INFO, WARNING. 

 TRACE – Trace messages in addition to INFO, WARNING, DEBUG. 

The default Log Level is INFO. The Log Level may be set higher. However, in most cases DEBUG is enough to debug any communication related issues. 
The log level will stay in effect until the EnSite™ Courier™ PACS Module is closed, or until it is changed. 

NOTE: Log messages may be truncated. Select Log History to load the untruncated log entries. 

 MB – This text box may be used to specify the megabytes of log messages from the end of the file to load. 

 Log History – When the Courier Log window is displayed, only the tail of the log file is displayed. The user can load extra log history by selecting 
Log History. 
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 Clear Screen – Select this button to clear the entire log text window. Refresh- Select this button to load the newly added log entry to the log file. 
Close – Select the Close button to close the Courier Log window. 

Query Failed 
Follow these steps to troubleshoot a failed query: 

1. Check that the Ethernet cable is properly connected. If it is not properly connected, connect the cable as shown in "Connecting to the Hospital 
Network" (page 8). 

2. Open the PACS Server Settings window by selecting the Settings icon on the EnSite™ Courier™ PACS Module main window, and then select the 
PACS Servers tab. 

3. Check that the Query/Retrieve checkbox has a checkmark selected. 

4. Select Test Connection to verify the connection. If the connection is successful, skip steps 5 and 6. 

5. Check that the AE Title, IP Address, and Port Number are correctly typed. If they are not correct, correctly type the parameters and select Test 
Connection to verify the connection. 

6. If the PACS server was moved, check with the PACS Administrator to verify that the AE Title, IP Address, and Port Number are still valid. If they 
are not valid, correct the parameters and go to step 5. 

7. Do a simple test query. If the test query is not successful, go to step 9. 

8. Do the original query. If the original query is successful, stop here. 

9. Increase the Log Level to DEBUG and perform the original query. 

10. Call Technical Support to report the problem. Be sure to have logs available. 

Receive Failed 
1. Open the Courier Settings window by selecting the Courier Settings icon on the EnSite™ Courier™ PACS Module main window. 

2. Have the PACS Administrator verify that the EnSite™ X EP System DWS is properly registered and that the AE Title, Port Number, and IP Address 
are correct. If more than one EnSite™ X EP System DWS is in use, each must be properly registered and have a unique AE Title. 

3. Verify that the Timeout setting is enough and increase it if needed. 

4. Have the PACS Administrator perform an echo test from the server to the DWS. Make sure that this operation is successful before proceeding. 

5. Check the Courier Log for the presence of disk IO error messages. If the error is not present, skip step 6. 

6. Select the Courier Settings icon and then select History Management tab then select Edit button and then select Delete Retrieval History button. 
At the prompt, Delete Retrieval History? select Yes. 

7. Re-try the retrieve. If the retrieve is successful, stop here. 

8. Re-start the EnSite™ Courier™ PACS Module and re-try the retrieve. If the retrieve is successful, stop here. 

9. Re-boot the DWS and the PACS server and re-try the retrieve. If the retrieve is successful, stop here. 

10. Increase the Log Level to DEBUG and perform the original retrieve. 

11. Call Technical Support to report the problem. Be sure to have logs available. 

Image Incompatibility 
Follow these steps to troubleshoot an image incompatibility: 

1. Follow steps 1 through 6 for "Retrieve Failed". 

2. Try retrieving a simple image. If the retrieve is successful, stop here. 

3. Increase the Log Level to DEBUG and perform the retrieve tried in step 2. 

4. Call Technical Support to report the problem. Be sure to have logs available. 

Receive Failed 
Check that Receive mode is enabled. If it is enabled, then disable and re-enable Receive mode. If the receive still fails, follow the troubleshooting steps 
for "Retrieve Failed". 

Storage Failed 
1. Check that Storage mode is enabled on the PACS Server Settings. 

2. If a pre-processing error occurs, the disk space may be full. Follow step 6 of the "Retrieve Failed" (page 151) section to clean the disk and try 
storage again. 

3. If a transmission error occurs, follow steps 1 to 2 and steps 4 to 6 of the "Query Failed" (page 151) section. 

4. Repeat the original storage. If it is successful, stop here. 

5. Increase the Log Level to DEBUG and perform the original storage. 

6. Call Technical Support to report the problem. Be sure to have logs available. 

Storage Commitment Failed 
1. Open the PACS Server Settings window by selecting the Courier Settings icon on the EnSite™ Courier™ PACS Module main window. 

2. Confirm that the Storage Commitment setting (SYNCHRONOUS, ASYNCHRONOUS, NOT SUPPORTED) matches the setting on the PACS server. 

3. If ASYNCHRONOUS has been selected for Storage Commitment, confirm that the Port Number setting is registered correctly on the PACS server. 
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4. If ASYNCHRONOUS has been selected for Storage Commitment, the EnSite™ Courier™ PACS Module does not time out waiting for the PACS 
server response. Select the Cancel button on the Store in Progress bar to stop the storage operation. 

5. The message Storage Commitment not attempted occurs when the Storage Commitment option on the PACS Server Settings window is set to Not 
Supported. 

6. The message Storage Commitment request failed occurs when the Storage Commitment request is rejected by the PACS server or there is no 
response from the PACS server before timeout occurs. Try increasing the timeout. 

7. If a Committed Partial error is received, contact the PACS Administrator for assistance. 

8. If Storage Commitment continues to fail, collect log and call Technical Support to report the problem. 

EnSite™ X Verismo™ Segmentation Tool Description 

Indications for Use 
The EnSite™ Verismo™ Segmentation Tool is indicated for use in generating 3D models from CT, MR, or rotational angiography DICOM image data. 
Generated models are intended to be displayed on the EnSite™ X EP System. 

Description 
The EnSite™ Verismo™ Segmentation Tool is a software utility used to convert large volumes of sliced-based images into a manageable 3D model of 
cardiac structures. 

The EnSite™ Verismo™ Segmentation Tool accepts DICOM images from most CT and MRI scanners, including enhanced CT/MR images. Once image 
data are imported into the EnSite™ Verismo™ Segmentation Tool, a 3D model can be extracted from the images in a process called segmentation. 
Segmentation is the process of isolating an object of interest from a digital image using the greyscale intensity of slice-based data. This model can be 
easily viewed and manipulated during an electrophysiology procedure using the EnSite™ EP System software. 

Figure 188.  Example of a Segmented Model 

 

 

Overview of Segmentation 
The following list provides an overview of the common segmentation tasks. 

1. Power on the DWS and start the EnSite™ Verismo™ Segmentation Tool. 

2. Select an image series to segment. 

3. Subregion the series and begin segmentation. 

4. Grow a structure using either the Region Grow or Chamber tool. 

5. Edit the model: 

- Separate chambers or remove extraneous information using the Separator or Trace tool. 
- Grow tubular structures with the Vessel tool. 
- If necessary, use the Barrier tool to help the EnSite™ Verismo™ Segmentation Tool identify the edge of a structure. 

6. Perform any final cleanup: 

- Hide extraneous structures in the structure list. 
- Use the Reassign tool to remove any small debris surrounding the model. 
- If the surface of the model has distracting complexity, consider smoothing the surface. 

7. Save and review the model: 

- Save the model. 
- If the model will be used on a different workstation, export the DIF model to CD/DVD. 
- Review the model before exiting. 

System Requirements and Considerations 
The EnSite™ Verismo™ Segmentation Tool v.2.0.1 can only be installed on an EnSite™ X EP System workstation (DWS) with EnSite™ X v.1.0 Software 
or higher. 
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Verification – To ensure model accuracy, segmentation results should be compared to the original slice data by (or under the supervision of) a 
physician. 

DICOM conformance – the EnSite™ Verismo™ Segmentation Tool allows importation of slice-based images in DICOM 3.0 (2009) data sets from 
CD/DVD or a PACS network. 

The EnSite™ Verismo™ Segmentation Tool does not support direct connection to a PACS network. DICOM data sets located on a PACS network are 
retrieved by the EnSite™ Courier™ Module and written to the EnSite™ X EP System Display Workstation (DWS) hard drive. 

The EnSite™ Verismo™ Segmentation Tool does not support image export. 

The EnSite™ Verismo™ Segmentation Tool does not accept non-orthogonal enhanced CT/MR images. 

The EnSite™ Verismo™ Segmentation Tool does not accept non-orthogonal cine images with missing or inconsistent timing information within each 
volume. 

Refer to the EnSite™ Verismo™ Segmentation Tool v.2.0.1 DICOM Conformance Statement for details. 

Optimal Characteristics for the EnSite™ Verismo™ Segmentation Tool Image Files 
The following minimum requirements are provided to optimize the quality of the cardiac model generated through the EnSite™ Verismo™ Segmentation 
Tool segmentation process: 

- Missing 
Slices 

The EnSite™ Verismo™ Segmentation Tool cannot segment images with missing slices 

- Slice 
Orientation 

Do not use oblique slice orientations 

- Slice Spacing Must be uniform, .5 mm increments, such as .5 mm, 1.0 mm, and 1.5 mm. 

- DICOM 
Header 

Use only standard letters and numbers in the DICOM header. Do not use special characters, such as: ^ " & % $ # @ ! 

 

Loading Files for Segmentation 

Starting the EnSite™ Verismo™ Segmentation Tool 
The way DICOM files are loaded depends on whether the EnSite™ Courier™ Module is installed. If it is installed, DICOM files may be loaded from a 
PACS network or from CD/DVD. If it is not installed, DICOM files may be loaded only from CD/DVD. 

Verismo Cleanup 
Upon launching Verismo, the system allows you to perform a cleanup procedure before Verismo launches. Select the Clean Verismo button. This 
procedure removes all temporary files. Perform a Cleanup procedure if Verismo fails to launch. 

NOTE: Performing a Cleanup will remove any data currently in the Verismo workspace, such as work in progress files. DIF files will not be 
deleted. 

Loading DICOM Files 
1. Power on the EnSite™ X EP System and login as described in the EnSite™ X EP System Instructions for Use manual. 

2. From the EnSite™ X EP System launcher screen, Select Clinical, then Verismo. 

3. Select an Import From: source. 

4. Select Query to display a list of files. 

5. Select the desired file and Select Launch Verismo. 

Using DICOM Files from Saved Data 
To load DICOM files from data that you have previously saved: 

1. Power on the EnSite™ X EP System, as described in the previous section. A pop-up message window will be displayed. 

2. Select Use Saved Data Use Saved Data and press Continue. 

3. The previously saved patient will be displayed. 

Select on the patient to display and select a desired image series for new segmentation or select [File > Resume Previous Segmentation] File > Resume 
Previous Segmentation to resume the most recent segmentation series. 

Figure 189.  The Selection Window 

 

1. Read Data From CD/DVD 

2. Use Saved Data 

3. Continue 

4. Cancel 

 

Using the Wizard 
The Wizard is intended to guide the clinician through the segmentation process. The Wizard will describe how to load files and provides an overview of 
the segmentation tools. 
 Follow the suggested task at the top of the Wizard. 

 Below the task are several options. Selecting the option will provide additional details and describe how to access the controls. 

 When a step is complete, select Next. 

NOTE: 
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 Clicking Back will access the previous step. 
 The Wizard may be closed by selecting Close or Finish. To access the Wizard again, select [File > Resume Wizard] File > Resume 

Wizard. 

Figure 190.  Example of Wizard Window 

 
 

Introduction to the Patient Screen 
The patient screen is the interface for loading DICOM data. 

Figure 191.  The patient screen. 

 
1 Menu bar The menu bar provides access to commonly used tools. 

2 Wizard The Wizard guides the clinician through the process of segmentation. 
3 Progress bar The progress bar indicates when the workstation is processing data. If the progress bar is labeled Cancel Cancel, 

clicking the progress bar will cancel the current task. 
4 Series panels These panels provide an interface for selecting a data series. 

5 Patient panels These panels provide an interface for selecting a data series. 
6 Study panels These panels provide an interface for selecting a data series. 

7 Slice view The slice view contains images from the selected data set. Data in the slice view can be manipulated. 
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Selecting a Series for Segmentation 
A DICOM data disk may contain multiple patients, multiple radiology studies for each patient and multiple series per study. Use the panels on the lower 
half of the screen to select a series for segmentation. 

1. From the patient panel, select a patient name. 

2. From the study panel, select the study of interest. 

3. From the series panel, select the series of interest. 

NOTE: Series that can be loaded for segmentation appear in black. If a series cannot be used for segmentation, the information for that 
series appears in gray in the series panel, and an explanation of why the series may not be usable appears in the Usability column. 

Viewing Options 
The following options are available for sorting patient data: 
 To add or remove columns of information from the patient, study, or series panels, select List Options. A window will appear with display options. 

Select display options and select Close. 

 Selecting on the heading at the top of a column will sort the data by that column. 

Subregioning the Series 
Subregioning is a process of identifying a region of interest within the scan for segmentation. Subregioning can improve the performance of the 
segmentation tool by processing only the regions of interest. The goal of subregioning is to minimize the volume to maximize processing speed. 

1. In the slice view, drag the handles of the green bounding box to outline the region of interest. 

NOTE: During subregioning, the Zoom, Pan, and W/L controls may help visualize the slice data. 

2. Drag the Slice slider upward until the region of interest is no longer visible; then drag the upper Range slider to the same position. 

3. Drag the Slice slider downward until the region of interest is no longer visible; then drag the lower Range slider to the same position. 

NOTE: The number of recommended slices is greater than 10. 

Figure 192.  Using the bounding box to subregion the slice data. 

 

 

Loading the Series for Segmentation 
After subregioning the series, the data may need to be preprocessed, filtered and loaded into the segmentation interface. 

Filtering removes grainy artifacts and non-uniformities that may affect thresholding operations. By default, filters are applied to CT, but not to MR 
images. To adjust filter defaults, go to [Advanced > Settings] Advanced > Settings and select the desired filter settings before loading the series for 
segmentation. 

Loading a subregioned series – To load the subregioned data series, select Segment Series. A progress bar is shown while the subregioned volume is 
preprocessed, filtered, and then loaded. 

NOTE: If the size of the subregioned series is larger than 60Mb, a message will appear providing the following options: 
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Figure 193.  Message Indicating the Volume Size Exceeds 60.0 Mb 

 

The volume size 141.5 Mb exceeds the maximum recommended size of 
60.0 Mb and may cause poor performance. 
What would you like to do? 

1) Define a smaller subregion 
2) Continue with poor performance 

3) Resample to less than 60.0 Mb 

1. [Subregion] – Return to the subregioning tools and identify a 
smaller region of interest. 

2. [Continue] – Use the identified data set without further 
subregioning or resampling. Processing speed may not be 
optimal. 

3. [Resample] – Resampling will reduce the size of the data by 
adjusting the resolution of the images until the subregioned 
series is less than 60 MB. Resampling may decrease 
accuracy of measurement tools. 

 

NOTE: If the image to be loaded for segmentation is not a CT or MR image, the dialog box shown below will appear: 

Figure 194.  PreProcess Window 

 

Unable to automatically determine the modality. 

The modality is used to determine the type of filtering. 

Please manually select the modality or Skip to bypass the filtering 
operation. 

1. [CT] – Select CT to preprocess the image as a CT image. 

2. [MR] – Select MR to preprocess the image as an MR image. 

3. [Skip] – Select Skip to not preprocess the image. 

 

NOTE: For XA (rotational angiography) series, process the images as CT. 

Using the Segmentation Interface 
The segmentation screen is used to segment the scanned volume and render an output image for 3D visualization. 

Figure 195.  The segmentation screen. 

 

1 Menu bar The menu bar provides access to commonly used tools. 



 

157 
 
 

2 Control panel The control panel contains segmentation tools. The icons on the control panel indicate which tool is 
currently active. 

3 Structure list The structure list, featured in several tools, selects which structures are affected by segmentation. 

4 3D view The 3D view shows the result of the current segmentation. 
5 Slice views The slice views contain images from the selected data series in transverse, coronal, and sagittal planes. 
6 Slice views The slice views contain images from the selected data series in transverse, coronal, and sagittal planes. 

7 Slice views The slice views contain images from the selected data series in transverse, coronal, and sagittal planes. 

 

Table 10. Top bar Summary 

Menu Option  Function 

File [New Segmentation] New 
Segmentation 

Start a new segmentation session. 

 [Resume Wizard] Resume 
Wizard 

Continue the next step of the wizard. 

 [Import DICOM Files] Import 
DICOM Files 

Import currently saved DICOM files into the EnSite ™ Verismo ™ Segmentation Tool. 

 [Resume Previous 
Segmentation] Resume 
Previous Segmentation 

Resume the most recent segmentation session. 

 [Save As] Save As Save the displayed 3D model to the hard drive as a DIF file. 

 [Save Work in Progress] 
Save Work in Progress 

Save the segmentation results during a segmentation session, without creating a DIF file. 

 [Load Work in Progress] 
Load Work in Progress 

Reload a segmentation session from a previous Save Work in Progress. 

 [Save Template] Save 
Template 

Save the current settings as a template. 

 [Load Template] Load 
Template 

Load a previously saved template. 

 [Export to CD/DVD] Export to 
CD/DVD 

Save models to a CD/DVD. 

 [Print] Print Print the full segmentation screen, 3D heart model, or any of the slice views. 

 [Exit] Exit Exit the EnSite™ Verismo™ Segmentation Tool and return to the EnSite™ X EP System title screen. 

Edit [Modify Structure] Modify 
Structure 

Modify the current structure. 

 [Load Default Threshold] 
Load Default Threshold 

Restore the default threshold after manual adjustments have been made. 

 [Clear Segmentation Result] 
Clear Segmentation Result 

Clear all segmented results. 

Display [Info] Info Select preferences for displaying patient, study, and series information on the Slice views. Allows 
access to information from the DICOM header. 

 [Options] Options Set options for crosshairs display and the number of undo levels. 

 [View Segmentation Model] 
View Segmentation Model 

Show the 3D heart model. 

 [View Segmentation 
Contours] View 
Segmentation Contours 

Compare tiled model, rendered model, and slice contours. 

Advanced [Smooth All Structures] 
Smooth All Structures 

Refine all visible structures. 

 [Settings] Settings Set preferences for filters and the Growth Limit for the Vessel Tool. 

Help [About EnSite™ Verismo™] 
About EnSite™ Verismo™ 

Display the software version. 

 [Release Notes] Release 
Notes 

Display information about the software not contained in the IFU. 

 

Using Basic Interface Controls 
The EnSite™ X Verismo™ Segmentation Tool interface provides controls for navigating in slice views, zooming, panning, and adjusting the intensity of 
the image. These controls are in the lower left and lower right corners of the slice and 3D views. 

NOTE: After segmentation, if the Slice control is active, moving the mouse over the Zoom, Pan, or W/L controls will deactivate the Slice 
control. If the Zoom, Pan, or W/L control is active, moving the mouse over the Slice control will deactivate the Zoom, Pan, or W/L controls. 

Navigating in Slice Views 
Each slice view can be independently manipulated to find the slices and plane most suitable for segmentation. Use any of the following methods to 
select a slice in a single view: 
 Navigate slices from within a slice view. 

- Move the cursor up or down while pressing the wheel button within a slice view. 
- Press the Up or Down arrow keys with the cursor in a slice view. 
- Select the Slice control (in the lower left corner of a slice view) to activate the slice cursor. Move the slice cursor up or down while pressing the 

mouse button within a slice view. Select the Slice control again to disable the slice cursor. 
- Press and hold the right mouse button on the Slice control to open a menu and then select the First, Middle or Last slice. 
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 Use the crosshairs. The crosshairs facilitate navigation between slices and show the relationship between the slice view and the 3D model. In the 
slice view, the cursors indicate the position of the slice displayed in the other two views. 

- To move crosshairs in a slice view, drag a crosshair individually or drag from the intersection of two crosshairs to move both at once. 
- To move the crosshairs in the 3D view, drag from the intersection of the crosshairs. 

NOTE: When dragging the crosshairs in3D view, the crosshairs can only be positioned to a surface location on the model. 

- To disable the display of crosshairs in a one of the slice views, press and hold the right mouse button in the slice view and clear the Crosshairs 
checkbox. To disable the display of crosshairs in all the slice views, select [Display > Options] Display > Options, and clear the [Show Cross 
Hair] Show Cross Hair checkbox. 

Figure 196.  Transverse image with crosshairs indicating coronal (yellow) and sagittal (red) slice orientations 

 

 

Using the Zoom Control 
The Zoom control appears in the lower right corner of the slice and 3D views. By default, the Zoom control will be set to fit the image to the panel in 
each view. Use the following controls to adjust the zoom level: 
 Select Zoom to activate the zoom cursor. Move the cursor up or down while pressing the mouse button to zoom in or out. Select Zoom again to 

disable the zoom cursor. 

 Press and hold the right mouse button on Zoom to select preset zoom levels: 

- 0.25x – 4.00x – various magnifications. 
- Fit Window – fits to panel. 
- Fit Width – fits to panel width. 
- Fit Height – fits to panel height. 

Using the Pan Control 
The pan control appears in the lower right corner of the slice and 3D panels. By default, the image will be centered. Use the following controls to adjust 
the pan: 
 Left-select on [Pan] Pan to activate the pan cursor. Then, left-select and drag the mouse in any direction to pan the image. Left-select on Pan 

again to disable the pan cursor. 

 To center the image, hold down the right mouse button on Pan and select Reset. 

Using the Intensity (W/L) Controls 
The window Width/Level (W/L) control appears in the lower right corner of the slice panels. The W/L controls adjust the intensity of the displayed slice 
data. This adjustment allows visualization of structures in the data. By default, the W/L will be set to a range encompassing the minimum and maximum 
intensity values in the subregioned images. Adjusting W/L in any view will affect all three slice panels. 

NOTE: W/L adjustments do not affect the result of automated segmentation tools. To adjust intensities for automated segmentation, use the 
thresholding and boundary emphasis controls under the related tools. 

Use the following controls to adjust W/L: 
 To manually control W/L, left-Select on W/L to display the W/L cursor. Then left-Select and drag the mouse to adjust window (left to right) and 

level (up and down). Left- Select on W/L again to disable the intensity cursor. 

 To select a defined W/L, hold down the right mouse button on W/L and select a setting: 

- Intensity values that were saved as a part of the DICOM data set appear as numeric values. 
- Reset sets the W/L to a range encompassing the minimum and maximum intensity values in the subregioned images. 
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Rotating the 3D Model 
The 3D model can be rotated to view the heart from various angles. The torso-shaped Orientation Reference in the upper right corner shows the current 
rotation. Use the following controls to adjust the rotation angle: 
 To manually adjust the rotation, middle-Select on the 3D model, and drag to rotate. 

 To select a pre-defined angle, left-Select one of the rotation angles listed at the top of the panel: 

- AP: Anterior to posterior, correlates to the coronal slice view. 
- PA: Posterior to anterior. 
- LL: Left lateral, correlates to the sagittal slice view. 
- RL: Right lateral. 
- CRA: Cranial. 
- CAU: Caudal, correlates to the transverse slice view. 

Using Templates 
Interface preferences may be saved in templates. The following attributes can be saved in templates: 
 Structure names and colors. 

 Default structure. 

 Information displayed in the upper left corner of slice and 3D views. 

 Show crosshairs on/off. 

 Growth limit for the vessel tool. 

 Font size for labels and tape measures. 

 Number of undo levels. 

To create a template – Modify the above attributes and select [File > Save Template] File > Save Template. 

To load a template – Select [File > Load Template] File > Load Template. 

NOTE: Templates can only be saved or loaded from the segmentation screen. 

Performing Segmentation 

Overview of Segmentation Tools 
Segmentation is the process of isolating an object of interest using the gray-scale intensity of slice-based data. The EnSite™ Verismo™ Segmentation 
Tool uses two common segmentation techniques to create an accurate model for 3D visualization of cardiac structures. 
 Thresholding is a method of selecting any values within a range of intensities. 

 Boundary emphasis identifies sharp transitions in intensity. 

Each segmentation tool is represented by an icon in the control panel. Clicking the icon will display the tool. 

Figure 197.  Segmentation Tools. 

 

1 Region Grow tool Segment a region that consists of many connected structures, such as the blood pool. 

2 Chamber tool Segment a heart chamber. 
3 Vessel tool Segment a cardiac vessel. 
4 Separator tool Separate connected structures from one another. 

5 Trace tool Manually trace a region. 
6 Barrier tool Enhance boundaries between structures to improve the use of the Region Grow, Chamber, Vessel, and 

Separator tools. 
7 Reassign tool Reassign a structure that was previously defined. 

8 Label tool Label the heart model. 
9 Measure tool Measure linear distances and volumes. 

 

Additional Controls: Delete, Undo, Cancel 
The following controls appear at the bottom of the control panel and apply to multiple tools: 
 [Delete] Delete – Select Delete and the select the item to be deleted (seed point, barrier, trace, label or measurement) in the slice view or 3D view. 

 [Delete All] Delete All – Select to delete all seed points, traces, labels, measurements and barriers. 

 [Undo] Undo – Undoes the last segmentation process. 

 [Redo] Redo – Restores the last process reversed with Undo. 

 [Cancel] Cancel – Cancels all unapplied actions of the current segmentation tool and closes the tool. 

Using the Structure List 
The Structure list manages the display of up to 16 structures. It features a drop-down menu of 16 structures and an ***Undefined*** option. One 
structure may be selected from this list to be used by segmentation tools. 

The ***Undefined*** option is used to remove information from the segmented model. All other structures add information to the segmented model. 
Undefined cannot be locked, displayed, colored, or renamed. 
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Figure 198.  The Structure List 

 

1 Lock Locking a structure prevents modifications. To lock or unlock a structure, Select on the lock icon. The icon for an 
unlocked and modifiable structure appears in green (default), and the icon for a locked structure appears in red. 

2 Display Display controls whether the structure will be displayed in the 3D view. If the display is enabled (default), the display 
icon appears as a small monitor, and the structure is shown in 3D view. If the display is disabled, the icon appears as a 
monitor with a red slash, and the structure is hidden from 3D view. If a structure is not displayed, no part of that 
structure can be removed or assigned to a different structure; however, a structure that is not displayed can still have 
additional information added to it by other segmentation tools. 

NOTE: Structures that are not displayed when a model is saved will not be available when the model is 
displayed on the EnSite™ X EP System software. 

3 Color Color – The color controls the display color for the structure in the slice and 3D views. 

4 [Modify...] Modify 
button 

Select Structure attributes may be modified using the Modify Structure Window. 

 

Modifying Structures 
Structure attributes may be modified. 

Figure 199.  The Structure List and Modify Structure Window. 

 

1. Select a structure from the drop-down list to modify. 

2. Select the [Modify...] Modify button adjacent to the structure 
list or select [Edit > Modify Structure] Edit > Modify 
Structure. The Modify Structure window will appear. 

3. [Name] Name – Type a name using up to 16 characters or 
select a name from the list. 

4. [Color] Color – Type a color name (“red”) or select ... to 
display a color selection tool. 

5. [Lock] Lock – Lock or unlock the structure. 

6. [Display] Display – Display or hide the structure. 

7. Select [Apply] Apply to apply modifications. 

8. Select [OK] OK to apply modifications and close the Modify 
Structure window. 

9. Select [Cancel] Cancel to discard modifications and close 
Modify Structure window. 

10. […] – Color chart 

 

Using the Region Grow Tool 
The Region Grow tool is used to quickly isolate a larger region of the scanned volume such as the blood pool. Other segmentation tools can then be 
used to separate individual structures from the blood pool. The Region Grow tool requires the placement of one or more seed points and manual 
adjustment of the threshold range. 

1. Select a structure of interest from the list. 

2. In the desired Slice view, left-Select to place one or more seed points in the middle of the structure. 

NOTE: If seed points are placed incorrectly, use the Delete or Delete All buttons. 

3. Adjust the Minimum Threshold, Maximum Threshold, and Boundary Emphasis sliders: 

- Lower the Minimum Threshold until the structures of interest fill in with translucent color. If boundaries between structures begin to fill with 
color, the Min. Threshold may be too low. 

- The Maximum Threshold generally does not need to be adjusted unless a hard structure (bone, implanted metal) is present. 
- Drag the Boundary Emphasis slider to emphasize the boundaries between structures. Raise the slider until a thin boundary appears around 

the structures in the slice views. 

NOTE: If thresholding and boundary emphasis do not identify separations that can be visually identified, consider using the Barrier tool 
before proceeding. 

4. Adjust the slide to emphasize boundaries between structures. 

5. Optional: To limit the area affected by Region Grow, select Local Region and adjust the bounding box in the slice views. 

6. Select Apply to segment the defined structure. The segmented structure is shown in the 3D view. 

NOTE: If the effect of the segmentation is undesirable, use the Undo button to undo the last change to the 3D model 
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Figure 200.  The Region Grow Tool. 

 

1. [Select Structure to define.] Select Structure to define. 
Use the Modify button to make changes to the Structure. 

2. [Place a seed point in the middle of the structure in a slice view. Repeat step 
2 as desired.] Place a seed point in the middle of the structure in a slice 
view. Repeat step 2 as desired. 

3. [Manually adjust Threshold if necessary.] Manually adjust Threshold if 
necessary. 

Use the [Min. Threshold] minimum threshold and [Max. Threshold] maximum 
threshold sliders to adjust threshold. 

4. [Adjust the slide to emphasize boundaries between structures.] Adjust the 
slide to emphasize boundaries between structures. 

Use the Boundary Emphasis to adjust boundaries 

5. [Click this button to restrict the region grow to a adjustable Local Region.] 
Click this button to restrict the region grow to a adjustable Local Region. 

Select the Local Region button to adjust a region 

6. [Select Apply.] Select Apply. 
Select the Apply button to apply changes. 

 

Figure 201.  While the threshold sliders are adjusted, the affected portion of the model will be indicated with a translucent overlay of the structure color. 
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Figure 202.  While the Boundary Emphasis slider is adjusted, areas with a sharp change in intensity are indicated in translucent white. 

 

 

Figure 203.  Initial 3D model from Region Grow tool 

 

 

Using the Chamber Tool 
The Chamber tool is used to quickly isolate a heart chamber from the scanned volume. This tool requires the placement of a seed point in the middle of 
the chamber of interest and manual adjustment of the threshold range. The Chamber tool emphasizes the segmentation of a single chamber using an 
erosion algorithm. The erosion algorithm uses thresholding and boundary emphasis values to automatically break thin connections to other structures. 
The Chamber tool is often faster than the Region Grow tool for segmenting a single chamber, but generally has slightly less resolution. 

1. Select the chamber of interest from the list. 

2. In the desired slice view, left-Select to place a seed point in the middle of the chamber. 

NOTE: If seed points are placed incorrectly, use the Delete or Delete All Delete All buttons. 

- Adjust the Min. Threshold Min. Threshold, Max. Threshold Max. Threshold, and Boundary Emphasis Boundary Emphasis sliders: 
- Adjust the Min. Threshold Min. Threshold until a dotted line appears around the structure of interest. If the dotted line surrounds multiple 

structures, the Min. Threshold Min. Threshold may be too low. 
- The Max. Threshold Max. Threshold generally does not need to be adjusted unless a hard structure (bone, implanted metal) is present. 
- Drag the Boundary Emphasis Boundary Emphasis slider to emphasize the boundaries between structures. Raise the slider until a thin 

boundary appears around the structures in the slice views. 

NOTE: If thresholding and boundary emphasis do not identify separations that can be visually identified, consider using the barrier tool 
before proceeding. 

3. Adjust the slide to emphasize boundaries between structures. 

4. Select Apply to segment the defined chamber. The segmented structure is shown in the 3D view. 

NOTE: 

 The segmented structure will not precisely match the initial dotted line because of the erosion algorithm described above. 
 If the effect of the segmentation is undesirable, use the Undo button to undo the last change to the 3D model. 
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Figure 204.  The Chamber tool. 

 

1. [Select Structure to Define.] Select Structure to Define. 

2. [Place a seed point in the middle of the structure in a slice view.] Place a 
seed point in the middle of the structure in a slice view. 

3. [Manually adjust Threshold if necessary.] Manually adjust Threshold if 
necessary. 

[Min. Threshold] Minimum Threshold 
[Max. Threshold] Maximum Threshold 

4. [Adjust the slide to emphasize boundaries between structures.] Adjust the 
slide to emphasize boundaries between structures. 

[Boundary Emphasis] Bounday Emphasis 

5. [Select Apply.] Select Apply. 

 

Figure 205.  A model produced by the Chamber tool. 

 

 

Using the Vessel Tool 
The Vessel tool is used to quickly isolate a vessel from the scanned volume. This tool grows a vessel on adjacent slices, using a seed point and a 
threshold range. 

1. Select a structure from the list. In the desired slice view, left-Select to place a seed point in a vessel. The seed point should generally be placed in 
a plane perpendicular to the vessel, such as the sagittal view for pulmonary veins. 

NOTE: The growth of structures using the Vessel tool is controlled by the Growth Limit. The Growth Limit, available under Advanced > 
Settings Advanced > Settings, is user adjustable, but defaults to 1.5 times the size of the original slice. 

2. In the desired slice view, left-Select to place a seed point in the middle of the chamber. 

NOTE: If seed points are placed incorrectly, use the Delete or Delete All buttons. 

3. Adjust the minimum and maximum threshold sliders: 

- Adjust the minimum threshold until a dotted line appears around the structure of interest. If the dotted line surrounds multiple structures, the 
minimum threshold may be too low. 

- The maximum threshold generally does not need to be adjusted unless a hard structure (bone, implanted metal) is present. 

NOTE: If thresholding does not identify separations that can be visually identified, consider using the Barrier tool before proceeding. 
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4. Select one of the following directions to grow the vessel: 

- (Superior/Anterior/Left) (Superior/Anterior/Left) to grow the vessel in the specified direction. 
- Both directions to grow the vessel in both directions. 
- (Inferior/Posterior/Right) (Inferior/Posterior/Right) to grow the vessel in the specified direction. 
- Select Apply to segment the vessel. 

5. Select Apply to segment the defined chamber. The segmented structure is shown in the 3D view. 

NOTE: 

 The segmented structure will not precisely match the initial dotted line because of the erosion algorithm described above. 
 If the effect of the segmentation is undesirable, use the Undo button to undo the last change to the 3D model. 

Figure 206.  The Vessel tool. 

 

1. [Select Structure to define.] Select Structure to define. 

2. [Place a seed point in the middle of the structure in a slice view.] Place a 
seed point in the middle of the structure in a slice view. 

3. [Manually adjust Threshold if necessary.] Manually adjust Threshold if 
necessary. 

[Min. Threshold] Minimum Threshold 

[Max. Threshold] Maximum Threshold 

4. [Select dilation direction.] Select dilation direction. 

[Superior] Superior 

[Both directions] Both directions 

[Inferior] Inferior 

5. [Select Apply.] Select Apply. 

 

 

Figure 207.  A completed vessel model of the descending aorta. 
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Using the Separator Tool 
The Separator tool is used to separate structures for individual visualization, for example, separating the left ventricle from the left atrium. This tool can 
also be used to remove a portion of the 3D model if too much detail was segmented. Structures are separated between two or more seed points placed 
on the surrounding structures. 

1. Select a structure to separate (e.g. Left Atrium). 

NOTE: Selecting “Undefined” from the structure list allows the separator tool to delete portions of the segmented model. 

2. In the desired Slice or 3D view, left-Select to place one or more seed points on the appropriate structure (e.g. left atrium). 

NOTE: If seed points are placed incorrectly, use the Delete or Delete All buttons. 

3. Repeat steps 1 and 2 as needed to continue identifying surrounding structures. 

NOTE: To preserve the original structure, be sure to place at least one point in the original structure. For example, if the “Left Atrium” 
structure also contains portions of the left ventricle and aorta, place points not only in the left ventricle and aorta, but also in the left atrium. 

4. Drag the Boundary Emphasis slider to emphasize the boundaries between structures. 

5. Select Apply to separate the defined structures. 

Figure 208.  The Separator Tool. 

 

1. [Select Structure to define.] Select Structure to define. 

2. [Place a seed point on a structure in any view, the region surrounding it will 
be assigned to the structure selected above.] Place a seed point on a 
structure in any view, the region surrounding it will be assigned to the 
structure selected above. 

3. [Repeat steps 1 and 2 until at least two points are defined.] Repeat steps 1 
and 2 until at least two points are defined. 

4. [Adjust the slide to emphasize boundaries between structures.] Adjust the 
slide to emphasize boundaries between structures. 

[Boundary Emphasis] Boundary Emphasis 

5. [Select Apply.] Select Apply. 

 

Figure 209.  Before (left) and after (right) using the Separator tool. 

 

 

NOTE: 

 If separations do not occur at locations that can be visually identified, consider using the Barrier tool before proceeding. 
 If the effect of the segmentation is undesirable, use the Undo button to undo the last change to the 3D model. 
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Using the Trace Tool 
The Trace tool is used to manually outline a structure. It can be used to create structures from slice views or reassign portions of the segmented model 
to a different structure. 

Using the Trace Tool in a Slice View 
1. Select the structure to be traced, such as “Esophagus.” 

2. In the desired slice view, left-Select along an edge of the structure to be traced. Left-Select and drag around the edge of the contour to trace the 
structure. Release the mouse button to complete the trace and connect the starting point of the line to the ending point. The structure will be 
created on a single slice. 

NOTE: To remove a trace from a single slice, use the Delete or Delete All buttons. 

3. Advance to a parallel slice in the same view and trace the structure again. 

4. To grow the structure through adjacent slices, Select Propagate. 

NOTE: If the effect of the segmentation is undesirable, use the Undo button to undo the last change to the 3D model. 

5. Select Cancel to stop action. 

Figure 210.  The Trace Tool 

 

1. [Select Structure to define.] Select Structure to define. 

2. [Use the mouse to trace out a closed contour.] Use the mouse to trace out a 
closed contour. 

[In 3D view, propagation is completed automatically;] In 3D view, propagation is 
completed automatically; 
[In 2D slice views, continue following steps.] In 2D slice views, continue following 
steps. 

3. [If desired, advance to a new parallel slice and place a trace on it. Repeat 
steps 2-3 as desired.] If desired, advance to a new parallel slice and place 
a trace on it. Repeat steps 2-3 as desired. 

4. [If desired, click Propagate.] If desired, click Propagate. 
[Interpolated traces as automatically created on all intermediate slices.] 
Interpolated traces as automatically created on all intermediate slices. 
[Delete] [Delete All] Delete, Delete All 

5. [Cancel] [Redo] [Undo] Cancel, Redo, Undo 

 

Using the Trace tool in the 3D View 
1. Select the Trace icon. 

2. Select a structure. 

NOTE: Selecting “Undefined” from the structure list allows the Trace tool to delete portions of the segmented model. 

3. In the 3D view, left-Select and drag the cursor around the structure to be reassigned. 

4. Release the mouse button to complete the trace. 

NOTE: If the effect of the segmentation is undesirable, use the Undo button to undo the last change to the 3D model. 
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Figure 211.  Using the Trace tool. 

 

 

Using the Barrier Tool 
The Barrier tool is used to place divisions between structures that can be visually identified but may be difficult to automatically identify for a variety of 
reasons. The Barrier tool improves the use of the Region Grow, Chamber, Vessel, and Separator tools. 

1. In the desired Slice view, left-select and drag to draw a line. 

2. Advance to another slice in the same view and draw another line. Repeat this process until the barrier has progressed from one side of the 
structures to the other. 

- When drawing barriers, always draw in the same general direction (left- to-right, top-to-bottom, etc.) 
- Slices do not need to be consecutive. 
- The barrier tool will create an estimated line on all the slices between user-drawn lines. These estimated lines are displayed in purple; drawing 

a new line on this slice will remove the estimated line. 
- Drawing a new line on a slice that already contains a line will replace the previous line. 

3. Select Create Barrier Create Barrier to grow the barrier through adjacent slices. 

NOTE: 

 After creating a barrier, additional barriers may be drawn. 
 To remove barriers, use the Delete or Delete All Delete All buttons. 

4. Continue segmentation using the appropriate tools. 

NOTE: Barriers are not affected by Undo or Redo. Undo and Redo only affect changes to the segmented model; barriers only appear in the 
2D view. 
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Figure 212.  The Barrier tool. 

 

1. [To create barrier, use the mouse to trace out a curved line in any slice 
view.] To create barrier, use the mouse to trace out a curved line in any 
slice view. 

2. [If desired, advance to a new parallel slice and place a trace on it. Repeat 
step 2 as desired.] If desired, advance to a new parallel slice and place a 
trace on it. Repeat step 2 as desired. 

[Interpolated traces are automatically created on all intermediate slices. Any trace, 
including the interpolated trace, can be edited until the Create Barrier button is 
clicked.] Interpolated traces are automatically created on all intermediate slices. 
Any trace, including the interpolated trace, can be edited until the Create Barrier 
button is clicked. 

3. [Click Create Barrier] Click Create Barrier. 
[Delete] [Delete All] Delete, Delete All 

4. [Cancel] [Redo] [Undo] Cancel, Redo, Undo 

 

Figure 213.  A Drawn Barrier Line. 
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Figure 214.  A created barrier. 

 

 

Using the Reassign Tool 
The Reassign tool is used to reassign a structure that has already been defined. It is an efficient way to segment the remaining structures from the slice 
or 3D views. 

1. Select the structure to be reassigned. 

2. Select from the following assignment methods: 

- Entire Structure reassigns all components of one structure to a different structure. For example, if a model of the left atrium was inadvertently 
assigned to the Left Ventricle structure, use Entire Structure to reassign the entire model to the Left Atrium structure. 

- Contiguous 3D reassigns all connected 3D regions to the defined structure. For example, if a model in the Blood Pool structure contained the 
anatomy of the descending aorta and the rest of the heart, and the aortic anatomy was not connected to the posterior wall of the heart, this 
option would allow the descending aorta to be reassigned to the Aorta structure. 

- Components less than 125 mm reassigns connected 3D regions less than 125 mm. A new number can be typed if desired. For example, if the 
Left Atrium structure includes many small disconnected and undesirable pieces, this option can be used to reassign the small pieces to the 
Unassigned structure. 

3. In the desired slice or 3D view, left-Select to place a seed point on the structure to reassign. 

NOTE: If seed points are placed incorrectly, use the Delete or Delete All Delete All buttons. 

4. Select Apply to reassign the defined structure. 

Figure 215.  The Reassign tool. 

 

1. [Select Structure to define.] Select Structure to define. 

2. [Select method.] Select method. 
[Entire Structure] Entire Structure 
[Contiguous 3D] Contiguous 3D 
[Components less than _____mm3] Components less than _____mm3 

3. [Place a seed point on an object, the object will be assigned to the structure 
selected above.] Place a seed point on an object, the object will be 
assigned to the structure selected above. 

4. [Click Apply.] Click Apply. 

 

Using the Label Tool 
The Label tool is used to label the 3D heart model. All labels are saved with the 3D model and will be included on models imported into an EnSite™ X 
EP System study. 

1. Type a label (up to 16 characters), select a predefined label from the list, or select Location from the list. When Location is selected, a placed 
label will display Cartesian coordinates for the selected map location. 
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2. Select a font size for the label. 

- Small – 10 point 
- Medium – 12 point (default) 
- Large – 14 point 

3. Left-Select in a slice view or on the 3D model to place a label. 

NOTE: If labels are placed incorrectly, use the Delete or Delete All buttons. 

Figure 216.  The Label tool. 

 

1. [Type in or select label from the list.] Type in or select label from the list. 

2. [Select font size:] Select font size: 
[Small] [Medium] [Large] Small, Medium, Large 
[Place label on the desired location.] Place label on the desired location. 

3. [Delete] [Delete All] Delete, Delete All 

 

Figure 217.  Using the Label tool. 

 

 

Using the Measurement Tools 
The Measure tool is used to measure linear and screen distances between two user-selected points. Measurement accuracy is based on the original 
scan data +/- one slice space. 

1. Select a font size for displaying the measured distance. 

- Small – 10 point 
- Medium – 12 point (default) 
- Large – 14 point 

2. In any slice view or the 3D view, left-Select and drag on the area to be measured. 

- Straight (slice or 3D views) is the shortest distance across the structure. 
- Screen (3D view only) is the projected screen distance, which changes as the 3D model is rotated. The screen measurement may be useful for 

analyzing a distance at various angles. 

NOTE: 

 Measurements are shown on a model only when the Measure tool is selected. Measurements are not saved with the final DIF file. 
 To delete tape measures, use the Delete or Delete All buttons. When using the delete tool with tape measures, Select on the red ends of 

a tape measure. 
 Resampling may decrease the accuracy of measurement tools. 
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Figure 218.  The Measurement tool. 

 

[Measure Distances] Measure Distances 

1. [Click and drag on a view to measure distance. Use this font size:] Click and 
drag on a view to measure distance. Use this font size: 

[Small] [Medium] [Large] Small, Medium, Large 

[Measure Volumes] Measure Volumes 

2. [Select to display volume measures of all structures.] Select to display 
volume measures of all structures. 

[Measure Volumes…] Measure Volumes 
[Delete] [Delete All] Delete, Delete All 

 

Figure 219.  Using the Measurement Tool. 

 

 

Measuring Volumes 
Select Measure Volume to display the calculated volumes for all structures. 

Saving and Exporting Models 

Key Points About Saving Models 
The following points are important considerations in saving a model: 
 At the time that the model is saved, each visible structure is included in the final model. Disabling the view of a structure in the structure list will 

prevent that structure from being included. 

NOTE: When saving a model with more than one structure displayed in the structure list, the resolution of each individual structure will be 
slightly reduced. The greater the number of displayed structures, the lower the resolution on each individual structure. 

 When segmentation is complete, the model must be saved to the hard drive, regardless of whether the model will be used on a different 
workstation. The model may be exported after saving. 

 During the saving process, the final model is constructed by creating a thin shell around each visible structure in the 3D view. A viewer will appear 
to display the surface of this shell. A contour viewer is also available to compare the shape of this shell directly to the model in the 3D view and 
the original slice data. 

 To save partially completed segmentations select [File > Save Work in Progress] File > Save Work in Progress. To return to a previously saved 
segmentation, select [File > Load Work in Progress] File > Load Work in Progress. 

Saving the Model to the Hard Drive 
1. Select [File > Save As] File > Save As. 

2. Enter a File name. 

3. In the Operator field, type the name of the clinician who performed the segmentation. 

NOTE: The operator name may also be accessed from a list. Use the drop-down menu to access an operator from the list. To add new 
operator names to the list, type the new operator name, and from the drop-down menu, select Add. 
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4. Optionally, notes about the segmentation session may be saved with the model in the Comments section. Comments will be available during the 
EnSite™ X EP System study. 

5. Select Save to save the file on the EnSite™ X EP System. When a model is saved, the system creates a tiled surface of each displayed structure. 
The tiled model in DIF format is the version that will be accessed by the EnSite™ X EP System. After a model has been saved, it will be loaded 
and displayed in the DIF Viewer. 

NOTE: During saving, a message may appear stating that the complexity of the model may slow the EnSite™ X EP System application. If 
this occurs, consider performing the following action(s) to reduce the complexity of the model and then resaving: 

 Hide additional structures in the Structure List and save again. 
 Remove small debris from the model using either the Trace or Reassign tool and save again. 
 Reduce the surface complexity by selecting [Advanced > Smooth All Structures] Advanced > Smooth All Structures and save the model 

again. 

Exporting Models to CD or DVD 
To save the DIF file to a CD/DVD: 

1. Select [File > Export] File > Export to CD/DVD. A list of saved models will appear. 

2. Select saved files to back up on the CD/DVD. 

3. Click OK to copy the files to the disk. 

Saving Work in Progress 
Saving work in progress will help preserve the model in various stages of segmentation and allow the user to return to a previous point in the 
segmentation process. 

NOTE: Barriers, labels, and tape measures are not saved with work-in-progress files. 

1. Select [File > Save Work in Progress] File > Save Work in Progress. 

2. To recover this saved model at any time, select [File > Load Work in Progress] File > Load Work in Progress. 

Reviewing the Final Model 

Using the DIF Viewer 
The DIF Viewer displays the final 3D model surface as it will appear on the EnSite™ X EP System. 

Figure 220.  The DIF viewer. 

 

 

The viewer may be accessed by two methods: 
 After saving a model by selecting [File > Save As] File > Save As. The viewer will appear with the model loaded. 

 The viewer may also be accessed by selecting [Display > View Segmentation Model] Display > View Segmentation Model. A list of available 
models will appear. Select a model from the list. 

The following controls are available in the viewer: 
 Rotate – Hold down the middle mouse button and drag. 

 Zoom – Use the roller wheel on the mouse. 

 Wireframe – [Display > View Segmentation Model] Display > View Segmentation Model. 

 Bounding box display – [Options > Bounding Box] Options > Bounding Box. 

 Default views – [Views > AP/PA/LL/RL/CRA/CAU] Views > AP/PA/LL/RL/CRA/CAU. 
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 Close viewer – [File > Exit] File > Exit. 

Viewing Segmentation Contours 
The segmentation contour viewer allows the clinician to compare a DIF surface model to the current rendered model from the 3D view and the current 
slice data. 

To access the segmentation contour viewer, select [Display>View Segmentation Contour] Display>View Segmentation Contour. 
 The rendered model from the 3D view appears as shaded solid areas. 

 The surface of the DIF model appears as thick opaque lines. 

 The slice images appear in a single view, which may be navigated using the same controls as the other slice views. 

Figure 221.  The Segmentation Contour Viewer. 

 

 

Printing Images 
1. Select File > Print. 

2. Select from the following options: 

- Full Screen prints the entire segmentation screen. 
- 3D Rendering prints the 3D heart model. 
- Transverse (CAU) prints the transverse slice view. 
- Coronal (AP) prints the coronal slice view. 
- Sagittal (LL) prints the sagittal slice view. 

Troubleshooting Tools 
Technical Support may ask you to access one or more of the following software resources: 

About EnSite Verismo – This information will provide technical support with general information about your software version. From the EnSite™ 
Verismo™ Segmentation Tool menu bar, select [Help > About EnSite Verismo] Help > About EnSite Verismo. 

Collect Log Files – This function collects all the log files from the system and exports them to a disk. Place a blank disk in the DVD/CD writable drive. 
From the EnSite™ X EP System title screen, Select on the [About EnSite ...] About EnSite button. Select on the Utilities tab then Select on the [Collect 
Log Files] Collect Log Files button. Follow the on-screen prompts to complete the process. This operation can take several minutes to complete. 

Troubleshooting Common Problems 
When a problem occurs, perform the following steps: 

Series will not load – Verify that the data was created in accordance with the optimal characteristics. If the series information displays but the series will 
not load, check the Usability indicator. 
 [OK] OK – No problems were detected. 

 [Bad Dircos] Bad Dircos – Coordinate information is missing, or vectors are not at right angles. 

 [Rot###] Rot### – Volume is not orthogonal - direction cosines are reported. 

 [NOT_3D] NOT_3D – Only one section or no slice locations, missing coordinate information or all slices are at the same location. 

 [Unsupported orientation] Unsupported orientation – Volume is not a standard orthogonal. 

 [Gantry Tilt] Gantry Tilt – Gantry tilt field is nonzero. 

 [IRREGULAR_SPACING] IRREGULAR_SPACING – Spacing conflicts cannot be resolved. 

 [EnSite™ X Verismo™ Segmentation Tool is not responding] EnSite™ X Verismo™ Segmentation Tool is not responding – If the EnSite™ X 
Verismo™ Segmentation Tool is not responding, press Alt + F10. 
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Error Messages 
Error Window Error Message Additional Information 

 

Chamber tool Failed: Try another seed point or method. For best 
results pick a seed point near the 3D center of the structure to be 
extracted. 
OK 

 

 

All seeds must be within the volume boundaries. Seed 1 or 4 has 
a location of (353, 291, 230), which is not within the volume. 
OK 

The seed and location data are examples only. 

 

Seed placed outside any defined structure. 
OK 

 

 

The intensity value (1121) is outside the current threshold range 
(1136 and 4095). 
Would you like the range adjusted to include this value? 
Yes No Cancel 

The intensity value and threshold range are 
examples only. 

 

One of the seed points is on a locked or Off structure which 
cannot be changed. 
OK 

 

 

Must enter Operator Name. 
OK 

 

 

The selected structure is locked and cannot be changed. 

OK 

 

 
2 out of 5 objects failed to generate geometry surface(s) from 
object map file:/var/STJ/Training/dicom/SJM_Surf/ 
DIF_20200302_205705.obj. 

OK 

Error generated from file in training directory. 

 

Are you sure you want to exit EnSite Verismo? 

Yes No 

 

 

CD/DVD not available 
OK 

 

 

Cannot reassign the ***Undefined*** structure 
OK 

***Undefined*** is the structure name. 

 

There is no usable DICOM data on this disk or the disk in empty. 

OK 

 

 

No saved data available 
OK 

 

 

Cannot establish connection with “server name” 
OK 

 

 

Connection with “client name” has been established. 
OK 

 

 

Retrieve failed. 
OK 

 

 

The seed point is on a locked or Off structure which cannot be 
changed. 
OK 

 

 

EnSite™ Verismo™ Segmentation Tool Cleanup 
 EnSite™ Verismo™ Segmentation Tool Cleanup – If the EnSite™ Verismo™ Segmentation Tool fails to start, consider clearing out all temporary 

files. 
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 Open the Application menu at the bottom left corner of screen, select Help. Select About. The About window will open. Select the Utilities tab. 
Select the type of files to delete, and then select Delete. 

- Database – Delete the currently loaded DICOM files and all Work In Progress files. 
- Templates – Delete the user-defined templates. 
- Work in Progress Work in Progress – Delete all Work in Progress files. 

NOTE: The cleanup tool will not delete created DIF files. These models may be deleted from within the Load DIF window in the EnSite™ X 
EP System software. 

Figure 222.  Use the Utilities Tab to Delete Temporary Files. 

 

 

Keyboard and Screen Languages 

 

Set the language for the Graphical User Interface from this dialog box. 

Languages can be selected for the keyboard and the screens. The default keyboard language and screen language is U.S. English. If a different 
keyboard language is to be used, follow the steps in “Selecting a Keyboard Language” to select the keyboard language. If a different screen language is 
to be used, follow the steps in “Selecting a Screen Language” to select the screen language. 

Selecting a Keyboard Language 
NOTE: The keyboard language applies to all users of the system. 

To select a keyboard language, click the keyboard icon in the upper-right corner of the Login screen, and select the language from the displayed list 
that matches the keyboard to be used. 

Selecting a Screen Language 
NOTE: 

 The screen language is associated with the login name. 
 If the screen language selected is Chinese or Japanese, the user can toggle between English characters and Chinese characters, or 

between English characters and Japanese characters, by holding down the Ctrl key and pressing the spacebar. 

1. Log in to the system. 

2. Click on the Language icon in the lower right corner of the screen. 

3. Select a language from the displayed list, and then click the Change Language button. During login, the system will ask if the screen language 
selection is to be used for only the current session or for all sessions. 

NOTE: The user must log out and log back in to the system for the change to take effect. 

Change Password 

 

The current user may change their password from this dialog box. 
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Figure 223.  Change Password dialog box. 

 

1. Old Password field – Enter old password 

2. New Password field – Enter new password 

3. Confirm New Password field – Confirm by typing new 
password again 

4. Cancel button – Cancel changes to password 

5. Accept button – Accept the new password 

 

About the System 

 

Displays a variety of system information, including the software release notes, controls for setting the system clock, controls for 
establishing the hospital name, utilities for advanced technical support, and notices. 

 

About the System - About tab 
Figure 224.  About the System – About tab 
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About the System - Hospital tab 
Figure 225.  About the System – Hospital tab 

 

 

About the System - TactiSys Quartz tab 
Figure 226.  About the System – TactiSys Quartz tab 
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Services Menu 
Services Menu Description 

 

 

Figure 227.  The Services Menu 

 

 

1. Collect Logs: export logs to CD/DVD or USB device. 

2. Verismo Cleanup: cleanup unneeded files. 

3. Check Network Settings. 

4. Configure Remote Monitor. 

To Setup the Remote Monitor 
1. Select the About EnSite™ X EP System button and then select the Utilities tab. 

2. Select the Run External Program button. 

3. Select the Remote_Monitor_Config tool and click Run. 

4. Select the connected monitor from the drop-down box and click OK. 

5. Select Reboot Now to complete the setup. 

Setting the Site Information 
Setting the System Clock 
1. Login as the Service user. 

2. From the title screen, click Services and select Set System Time. 

3. Adjust the Set System Time section on the left side of the screen using the arrow buttons to set the current time. 

NOTE: 

 This is a 24-hour clock. The clock can only be set to a time that is at least 18 hours later than the time that the last study ended. 
 After the user sets the system clock, the system prompts the user to confirm system shutdown. 

Setting the Powerline Frequency 
The powerline frequency can be set to either 50 Hz or 60 Hz. For North American locations, 60 Hz is generally appropriate. For European locations, 
50 Hz is generally appropriate. 

1. During a study, select the Application Menu icon at the bottom left of the screen >Amplifier > Amplifier Settings > Power Line. 

2. Use the Powerline Frequency checkboxes to select a powerline frequency. 
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Figure 228.  Setting the Powerline Frequency 

 

 

Setting the Owner Information 
Information about the hospital can be entered into the software. The saved hospital name is displayed on the title screen and saved with studies on the 
external media. From the title screen, select Services and then click the Hospital tab. Complete the available fields and select Apply. 

The owner information is used to administer support tools such as SJM™ Connect. 

NOTE: If multiple EnSite™ X EP Systems are present at the same location, enter an identifier such as “LAB A.” 

Figure 229.  The owner information helps Abbott Technical Support organize information. 

 

 

Error Messages 
Error Window Error Message Additional Information 

 

DVD Drive Not Detected 
You will be able to conduct real-time studies but it will not be 
possible to review studies or save data to CD or DVD. 
Contact EnSite System technical support 

Press [Continue] when ready 

Indicates a hardware fault with the CD/DVD 
drive 

 

Resource Checks 
Problems were found in checking system resources. 
Restart using normal procedures. 

Press [OK] when ready to shut down for a re-start. 

If the error persists after re-start contact 
technical support. 

 

Bad System Time Detected 

(A date and time will be displayed) 
Please correct the system time and date. 

If the trouble persists, Contact EnSite technical support. 
Press [Continue] when ready. 

The system administrator can check the 
system time setting to adjust to the correct 
time. 

 

Unexpected error occurred 

Application exited with (number) 
Press [Continue] when ready. 

Restart the computer. A user with Service 
access may run collect logs and contact 
technical support. 
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Error Window Error Message Additional Information 

 

No Base License Detected 
The system does not have an EnSite X EP System base license. 
Contact EnSite technical support 

Press [Continue] when ready. 

The user should discontinue system usage 
and contact technical support for a license. 

 

Resource Checks 
Problems were found in checking system resources. 

SecurityLauncher program is already running. 
Re-start using normal procedures. 

Press [OK] when ready to shut down for a re-start. 

If the error persists, contact technical 
support. 

 

SecurityLauncher failed to execute 
Press [Continue] when ready. 

Restart the computer. If the error persists, 
contact technical support. 

 

SecurityLauncher binary not present on the system. 

Press [Continue] when ready. 

Restart the computer. If the error persists, 
contact technical support. 

 

Resource Checks 
Problems were found in checking system resources 

Courier program is already running. 
Re-start using normal procedures. 

Press [OK] when ready to shut down for a re-start. 

Restart the computer. If the error persists, 
contact technical support. 

 

System Icons 
Table 11. System Icons 

Icon Description Function 

 
Back Button Returning to previous screen 

 

Power Button Powering off the system 

 
Login Button Logging into system 

 

New Study User can begin a new study within the system 

 

Past Study User can access a previously-recorded study in Off line Review environment 

 

Last Study User can retrieve and access the most recent study completed in the system 

 

Import User can import a study or information to the system 

 

Archive User can archive files and studies 

 

Verismo User can access the EnSite™ Verismo™ Segmentation tool 
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Table 11. System Icons 

Icon Description Function 

 

Clinical Grants permission to perform studies on cardiac mapping system 

 

Services Grants permission to perform service on cardiac mapping system and provides 
access to functions required to maintain the DWS 

 
Training Grants permission to access studies in training mode 

 

Administrator Grants only the administrator permission to perform certain tasks 

 

Grant Credentials Grant Credentials 

 

Research Grants permission to access research information 

 

Access User Internal access user 

 

CD Icon found on past study studies review screens 

 

Tools List Properties used to control the filter settings for the waveforms and the settings used 
for manipulating the displayed waveforms 

 

Auto-Record Settings Allows a user to set-up a certain auto-record setting preference 

 

Presets Provides access to the list of presets available for the current panel. 

 

Center Model Centers the model back into view, if it is beyond the borders of the screen. 

 

Clean-Up Display Cleans up items/elements from the screen 

 

Split View / Standard View Switches between single and split screen views 

 

Full Screen Hides the Work Panel and displays the Model/Map area in full screen view 

 

Mobile Panel Allows the user access to Detection Sources and AutoMap Thresholds to support 
simultaneous workflow of mapping, therapy tasks, and full screen view. 

 

Access To Set-Up Link Provides access to study setup screens (patient/study details, hardware map, etc.) 

 

Meters & Display Options Settings Panel Display options for meters, filters, model & map display settings 

 

Catheters & Waveforms Settings Panel Specifications, attributes, setup, signal settings, waveform attributes 

 

Model, Dif & Fusion Settings Panel Model surface properties, DIF & fusion options 

 

Map Settings & Signals Settings Panel AutoMap thresholds, CFE settings, detection settings, map appearance, map 
display, points/labels, settings 

 

Automark & Contact Force Settings Panel Metrics, placements settings, visible thresholds, CF display, CF stability 

 

Navigation Settings Panel Provides quick access to setup functions and parameters. It contains functions 
related to the catheter navigation, respiration compensation, PRS setup, and Metal 
setup. 

 

Active EnGuide Icon Icon selector for Active EnGuide tools such as creating surfaces, placing labels, 
placing lesions, and collecting points for maps 

 

Waveform Display Used to select the waveform type in the panels when changing the layout of the 
workspace- also used as links to the fly out options 
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Table 11. System Icons 

Icon Description Function 

 

Detection Settings / Acquisition Waveforms Used to select the waveform type in the panels when changing the layout of the 
workspace- also used as links to the fly out options 

 

Generator Waveforms Used to select the waveform type in the panels when changing the layout of the 
workspace 

 

Color Controls the color 

 
D/Dt Sharpness of slope, regardless of positive or negative value 

 

Caution Shown when there is a condition that might cause a problem in the future or if the 
user proceeds, but the user is still able to proceed 

 

Problem/Issue Shown when a problem has already occurred, and the issue must be corrected to 
proceed 

 

Approved Detectable components have been detected and approved by the system 

 

Notice Informs and notify users of points and recommendations for efficient and accurate 
set up 

 

Help Tool Tip Icon Displays additional help text when hovered over with the mouse cursor 

 

Question Mark Pop- Up Configure signal detection settings 

 

No Button Appears on "No" buttons on pop-up messages 

 

Yes Button Appears on "Yes" buttons on pop-up messages 

 

Check Mark Icon used for checking boxes 

 

"Stop Automap" Button Icon Appears on "Stop AutoMap" button 

 

Rotate/Pan Tool Used to rotate the model or map 

 

Pointer Tool Used for selection 

 

Label Tool Used to annotate a model or map 

 

Marker Tool Used to create anatomic markers 

 

Tape Measure Tool Used to create tape measures 

 

Lesion Tool Used to create lesions 

 
Shadow Tool Used to place a shadow on the selected EnGuide 

 
Caliper Tool Add a timing caliper 

 

Double Arrow Tool Used for dragging the appearance window in the workspace 

 

Chart With Gear Displays the Courier Settings Window 
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Hot Keys 
Shift+ Alt+ Ctrl+ CHR Action 

   A Rotate around vertical axis 

  X A Select All Points 

   B Enable Label Tool 

  X B Save Bookmark 

   C Enable Caliper Tool 

   D Rotate around vertical axis 

  X E Save Event 

  X G Select all points in the group 

X  X G Add all points in the group to existing selection 

   H Enable EnGuide Shadow Tool 

   L Enable Lesion Tool 

  X L Locate selected point in the Map Display 

   M Enable Marker Tool 

   O Open (Show) Tool Tag List 

   P Enable Pointer (Arrow) Tool 

  X Q End Study 

   R Enable Rand (Rotate/Pan) Tool 

 X  R Collect Respiration Data 

   S Rotate around horizontal axis 

   T Enable Tape Measure Tool 

   W Rotate around horizontal axis 

   F1 Display Help Dialog 

   F2 Not used 

   F3 Synch display between split-screen views 

   F4 Record a Segment 

   F5 Enable/Disable EnGuide 

   F6 Add Lesion at EnGuide 

X   F6 Add 3D Lesion at EnGuide 

   F7 Not used 

   F8 Saturation Recovery 

   F9 Stop All Collection (Model and AutoMap) 

   F10 Not used 

   F11 Freeze/Save a Mapping Point 

X   F11 AutoMap Start/Stop 

   F12 Cancel/Discard the Current Mapping Point 

  X PrtScr Save Image 

   Delete Delete selected points 

   Delete Delete point group 

   Right Arrow Step Forward 

   Left Arrow Step Backward 

F1 Quick Help 

 

Right Arrow Step Forward 

F2  Left Arrow Stop Backward 

F3 
Synchronize 
Split Screen 

 
 

F4 Record On/Off   

F5  Ctrl+F5 Impedance/NavX Current 

F6 
Add Lesion at 

EnGuide 
Shift+F6 

Add 3D Lesion at EnGuide 

F7  Ctrl+B Save Bookmark 

F8 
Saturation 
Recovery 

Ctrl+Print 
Save Image 

F9 Stop All 
Collection 

Ctrl+E Save Event 

F10 Force Exit Ctrl+Q End Study 

F11 Freeze Shift+F11 AutoMap Start/Stop 

F12 Cancel   

  Alt+R Collect Respiration Data 
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Glossary 
Table 12. Glossary 

Term Defintion 

3D Three-dimensional. 

ABL Ablation. 

Accession Number Sequential numbers assigned by imaging vendors as unique identifiers of an examination. 

Active EnGuide The catheter that is used for creating surfaces, placing labels, placing lesions, and collecting points for 
maps. 

Active EnGuide Silhouette A silhouette outline of the Active EnGuide where it resides inside the chamber of interest. The outline takes 
on the color of the assigned Active EnGuide color. 

Anatomic marker A tool that is used to connect points on the surface of the model with lines. 

Animations Recorded video segments from a study. 

AP Anterior Posterior. 

Application Context The specification of the type of communication used between Application Entities. Example: DICOM 
network protocol. 

Application Entity (AE) An end point of a DICOM information exchange, including the DICOM network or media interface software; 
i.e., the software that sends or receives DICOM information objects or messages. A single device may have 
multiple Application Entities. 

Asynchronous Asynchronous Storage Commitment is returned to the requestor in a different DICOM association than the 
one by which the request was sent (see Synchronous). 

Auto Segment The system automatically records segments to periodically store study information. These automatically 
recorded segments are added to the Notebook where they are identified as type Auto Segment. 

Bio Impedance Scaling A feature that corrects for the slow drift of the EnSite NavX™ positions caused by a change in the saline 
concentration within body fluids over the course of a study. 

Bookmark A feature that allows the system to return to a specific time in review environment. 

Boundary emphasis Segmentation technique used to sharpen the edges of a structure so that the computer can identify what 
the user sees as boundaries. 

Calipers A tool that is used to measure and adjust timing between signal features in the waveform display. 

Cardiac Triggered Maps Maps that use a surface electrocardiogram or an intra-cardiac electrogram as the reference to which 
collected points are measured. 

Catheter Catalog A collection of predefined catheters that can be used in a study. 

CFE Complex Fractionated Electrogram. 

CFE Mean maps Maps that provide a fractionation index based on the cycle length between multiple, discrete, local 
activations in an electrogram. 

CFE Standard Deviation map A map that provides a fractionation index based on the cycle length between multiple, discrete, local 
activations in an electrogram. 

CIFS Common Internet File System. 

CIM Catheter input module. 

CL Cycle Length. Cardiac Cycle Length. 

Clipping Plane Clipping planes allow for a view of the interior and rear of the closed map by cutting a plane away from the 
viewing space. 

Color High A specific map value to be displayed as purple. 

Color Low A specific map value to be displayed as white. 

Coronal plane Image plane that divides the body vertically into a front and back. Also called the frontal plane. 

CT Computed Tomography. 

CT scan Imaging technique that provides a 3D computer model of a patient’s anatomy. CT (computed tomography) 
scanners use detectors rather than film to collect and digitize x-ray images. CT images are used to examine 
cross-sections (slices) of the heart from all angles. 

D3D DIF three-dimensional. 

DHCP see Dynamic Host Configuration Protocol. 

DICOM Digital Imaging and Communications in Medicine; an industry standard that facilitates interoperability of 
medical imaging equipment. 

DICOM Header A text-based portion of a DICOM file that describes the image dimensions and other information about the 
scan. 

DIF Digital Image Fusion (DIF) Three-dimensional models created from digital images collected from Spiral CT 
or MRI scans. 

Distal Length The length of the distal electrode, which is located at the tip of the catheter. 

DWS Display Workstation. 

Dynamic Host Configuration Protocol 
(DHCP)  

Used to automatically assign IP addresses, deliver TCP/IP configuration parameters (such as the subnet 
mask and default router) and provide other configuration information such as the addresses of time 
servers. DICOM requires fixed IP addresses and the configuration of AE Titles at each individual device. 

ECG Electrocardiogram. 

ECG electrodes Patch electrodes on the patient's skin, used to collect extra-thoracic cardiac signals. 

Electrode A conductor which collects voltage signals from a patient. 

Electrode Spacing The distance from the edges of the electrodes on a catheter (not the distance from the centers of the 
electrodes). 

Electrogram A waveform which represents a voltage signal generated from a patient. 
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EnGuide Alignment A tool used to manually adjust the alignment of EnGuides relative to the model. 

EnGuide Shadows A three-dimensional historic image of an EnGuide position a three-dimensional historic image of an 
EnGuide position. 

EnGuide The display of an EP catheter in the map display. 

Enhanced CT and MR images This refers to the multi-frame image objects defined by the DICOM standard for CT and MR. The new 
multi-frame image objects collect frames into a single file with a standard structured header. This reduces 
the data size and file transfer overhead. 

Enhanced DICOM Object The new enhanced objects for MR, CT, XA and RF (radiography/fluoroscopy) accommodate new 
developments and acquisition techniques. As an example, for MR, the image data will be exchanged not 
only as individual images, but as multiframe objects. Multiframe objects are a convenient way to package 
all the pixel data of a complete acquisition in one message (or envelope). The differences between the 
individual frames of the multiframe object, such as the frame-rate, are described in the multiframe header. 

EnSite™ Courier™ A software application that enables the EnSite™ X EP System user to communicate with the hospital PACS 
server for the purposes of storing and retrieving patient data in DICOM format. 

EnSite NavX™ Mode A navigation mode where EP Catheter locations from sensed potential on each axis of an orthogonal electric 
field generated by body surface electrodes. 

EnSite™ Verismo™ Segmentation Tool a software utility used to convert large volumes of slice-based images into a manageable 3D model of 
cardiac structures. 

EnSite™ VoXel™ A navigation mode where the catheter locations are mainly based on the magnetic signals generated by 
Sensor Enabled™ catheters in conjunction with the Field Frame. 

EnSite™ X Amplifier The EnSite™ Amplifier accepts signals from the accessory modules and converts these signals to digital 
format, and sends them to the DWS for processing. The EnSite™ Amplifier is connected to the DWS 
through a fiber optic cable. 

EP catheter electrodes The tip or ring electrodes on the shaft of an EP catheter which must be in contact with the endocardial wall 
to collect electrical signals. 

EPS a DICOM modality type for basic cardiac electrophysiology, the specification for digitalized electrical signals 
from the patient cardiac conduction system collected in the heart. EPS is the modality type used to store 
EnSite X™ Velocity™ Cardiac Mapping System studies. 

Field Scaling A feature that provides patient-specific scaling of EnSite™ NavX™ dimensions to allow for distance 
measurements in EnSite™ NavX™ mode studies. 

Highpass Filter A filter that reduces low-frequency signals (i.e., repolarization signals) and baseline drift. 

IOD Information Object Definition: the specified set of Attributes that comprise a type of data object; does not 
represent a specific instance of the data object, but rather a class of similar data objects that have the 
same properties. The Attributes may be specified as Mandatory (Type 1), Required but possibly unknown 
(Type 2), or Optional (Type 3), and there may be conditions associated with the use of an Attribute (Types 
1C and 2C). Examples: MR Image IOD, CT Image IOD, Print Job IOD. 

Intra-Cardiac Electrogram (IEGM) An electrogram produced using catheters placed within the heart. 

IP Address a numerical label that is assigned to devices participating in a computer network that uses the Internet 
Protocol for communication between its nodes. An IP address serves two principal functions: host or 
network interface identification and location addressing. An IP Address can either be fixed or dynamic (see 
DHCP). 

Isochronal Map A map that shows the progression of activation through the first surface. 

Isopotential Map A map of voltages on the endocardial surface where similar voltages are represented by similar colors. 

Labels Markers that are used to identify points on the model. 

LAO Left Anterior Oblique. 

LAT Local Activation Time. 

LED Light Emitting Diode. 

Lesion Markers that are used to identify ablation points on the model. 

Local Activation Time (LAT) Isochronal 
Map 

A map that shows color-coded activation times for each collected location (or nearest surface). 

Lowpass Filter A filter that reduces high-frequency signals commonly caused by electronic interference. 

Low-V ID An adjustable low voltage identification option (Low -V ID) allows low-voltage potentials to appear in gray 
instead of affecting the color pattern. Low-V ID is available for Local Activation Time (LAT) isochronal maps 
and Complex Fractionated Electrogram (CFE) maps. 

Model The geometric surface model which describes the size, shape, and orientation of a heart chamber(s). 

MRI Magnetic Resonance Imaging. 

MRI Scan Imaging technique that uses magnetic signals rather than x-rays to provide a 3D model of the patient’s 
anatomy. MRI (magnetic resonance imaging) is based on the absorption and emission of radio wave pulses 
of energy. MRI images are used to examine cross-sections (slices) of the heart from all angles. 

Navigation Accuracy The error in navigating a catheter back to a defined location. 

NFS Network File System. 

Noise Filter A notch filter that reduces powerline noise. 

Non-Cardiac Triggered Maps Maps that are created by collecting points at one second intervals. 

Notebook A feature that allows recorded data and study information to be filed and annotated for future access. 

Offline Review An operating mode in which data from a previous study is viewed and edited. The EnSite™ Amplifier does 
not need to be connected or powered on. 

OneModel Tool Default type for model creation. The OneModel tool wraps the model surface tightly around collected points 
without tying back to a center point and may provide enhanced anatomic detail of the cardiac model. 
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Orientation Reference A torso-shaped icon in the upper right of a map that indicates the current orientation of the map by rotating 
as the map rotates. 

Orthogonal Intersecting or lying at right angles. The axes of scanned orthogonal images are perpendicular to each 
other and to the coronal (frontal), transverse (horizontal), and sagittal (medial) planes of the body. 

PACS Picture Archiving and Communication Systems: An electronic information system for acquiring, sorting, 
transporting, storing, and electronically displaying medical images. 

Peak-Negative (P-Neg) Voltage Map A map that displays color-coded voltage values for each collected location (or nearest surface). 

Peak-to-Peak (P-P) Voltage Map A map that displays color-coded voltage values for each collected location (or nearest surface). 

Perspective View A feature that allows the field of view, or perspective of the model, to be changed to increase the 
understanding of the model, the position of the catheters and/or the identification of points of interest. 

Pixel Smallest distinguishable element of a digital image. 

Polarity A voltage is the difference between positive and negative poles. The polarity defines these poles. 

Port Number a numerical identifier for the data structures of the endpoints for host-to-host communications. 

Positional Reference An electrode that will remain stable during an EnSite™ NavX™ study. The displayed position of all 
electrodes is relative to the location of the positional reference. 

Proximal Electrode Any catheter electrode other than the distal electrode. 

RAO Right Anterior Oblique. 

RealReview A task in which recorded segments can be viewed. 

Realtime mode An operating mode in which data is gathered, displayed, and recorded simultaneously while a patient is 
being studied. Patient connections to the EnSite™ Amplifier are required, and the EnSite™ Amplifier must 
be powered on. 

Reference Signal The reference signal monitors a specific voltage point, based on the detection algorithm, of a specific 
waveform to aid in the collection of activation data. 

Render To translate and regenerate an image. In the EnSite™ Verismo™ Segmentation Tool, heart structures are 
isolated from a volume of scanned images and rendered for 3D visualization. 

Resolution Minimum distance at which two adjacent objects can be distinguished as separate. 

RespComp X A feature that is used to compensate for catheter movement caused by a patient's breathing. 

Respiration Meter A meter that shows the current level of respiration, as computed by the relative impedance on the EnSite™ 
surface electrodes. 

Irregular Respiration A feature that is used to suspend model point collection and labeling functions when the patient's 
respiration falls outside of a percentage of the Respiration Compensation range. 

RF Radio Frequency. 

Rotational Angiography (RA) A type of X-ray angiography where a series of images is acquired while the RA modality C-arm performs a 
continuous rotation around the region of interest. 

Roving Activation Interval A timing parameter that is used in the detection of roving catheter activation. 

Roving Signal The roving signal is used for sampling local activation times (relative to the timing reference signal) and 
voltages from various locations in the heart. 

Sagittal plane Image plane that divides the body into a right and left half. Also called medial plane. 

Saturated Waveform When a signal amplitude has reached its maximum value. 

Saturation Recovery A feature that allows for the quick recovery of signals to facilitate identification of post-therapy complexes. 

Seed point Reference point used by the EnSite™ Verismo™ Segmentation Tool to identify the heart structure of 
interest. 

Segment A recorded part of a study. 

Segmentation In digital image analysis, segmentation is the process of isolating the object of interest (foreground) from 
the rest of the objects in the image (background). 

Service Class Provider (SCP) Role of an Application Entity that provides a DICOM network service; typically, a server that performs 
operations requested by another Application Entity (Service Class User). Examples: Picture Archiving and 
Communication System (image storage SCP, and image query/retrieve SCP), Radiology Information System 
(modality worklist SCP). 

Service Class User (SCU) Role of an Application Entity that uses a DICOM network service; typically, a client. Examples: imaging 
modality (image storage SCU, and modality worklist SCU), imaging workstation (image query/retrieve SCU). 

Service/Object Pair (SOP) Class The specification of the network or media transfer (service) of a particular type of data (object); the 
fundamental unit of DICOM interoperability specification. Examples: Ultrasound Image Storage Service, 
Basic Grayscale Print Management. 

Service/Object Pair (SOP) Instance An information object; a specific occurrence of information exchanged in a SOP Class. Examples: a specific 
x-ray image. 

SJM™ Connect A feature that enables an AbbottTechnical Support representative to connect to the DWS through a 
broadband Internet connection to perform remote technical support. 

Stabilize ABL Stabilize ABL corrects the location of the distal electrode based on the properties of the catheter. ABL 
electrodes 2, 3, and 4 need to be displayed for Stabilize ABL to be enabled. 

WARNING: Do not use Stabilize ABL in situations where electrodes 2, 3, or 4, on the 
ablation catheter, are covered by a sheath. 

Std Dev Standard Deviation. 

Storage Commitment The DICOM storage commitment service is used by the modality or workstation to confirm that an image 
has been permanently stored by a device, usually a server and/or archive station, and it is safe to delete the 
images locally. 

Surface Proximity Distance The distance from the Active Electrode to the model or DIF surface. 

Sweep Speed The number of mm/secs in the waveform display (time scale). 
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Synchronous Synchronous Storage Commitment is returned using the same DICOM association (a DICOM 
communication session) as the one by which the Storage Commitment request was sent (see 
Asynchronous). 

System Reference Surface Electrode A surface electrode that is required for proper system operation for EnSite™ X EP System studies. The 
system reference surface electrode connects to the SurfaceLink™ Module. 

Tape Measure A tool that is used to measure the distance between points on the model of the endocardial surface. 

Threshold A voltage level at which an event is detected. 

Thresholding Segmentation technique that uses intensity values to distinguish between the foreground and background 
objects of a digital image. The intensity threshold is chosen from a histogram of intensity values for the 
image. 

Time Cursor A vertical yellow line in the waveform display that indicates the time represented by the map display. 

Traces Waveforms. 

Tracking Accuracy The error between an induced catheter displacement and the corresponding measured displacement. 

Transfer Syntax the encoding used for exchange of DICOM information objects and messages. Examples: JPEG 
compressed (images), Little Endian explicit value representation. 

Transverse Plane Image plane that divides the body into upper and lower portions. The transverse plane is perpendicular to 
the coronal and sagittal planes. Also called horizontal plane, axial plane, or transaxial plane. 

Trigger Event The detection event plus a user selectable time offset. 

Triggering To 'phase lock' both the waveform and the map displays, providing a view of the data which is 
synchronized with each triggering event. Thus, when the triggering event is a heartbeat the waveforms and 
maps shall be repeatedly displayed, frozen at the same point in time of each heart cycle. 

Unipolar Reference The signal return path for unipolar diagnostic catheter signals. 

Unique Identifier (UID) a globally unique “dotted decimal” string that identifies a specific object or a class of objects; an ISO-8824 
Object Identifier. Examples: Study Instance UID, SOP Class UID, SOP Instance UID. 

Velocity Filter A feature that prevents model point collection during rapid catheter movements. 

Velocity meter A meter that shows the relative velocity of the fastest unsheathed enabled electrode of the Active EnGuide. 

Voltage Caliper A tool that displays the measured potential at the distal signal of the Active Electrode. 

Volume Set of cross-sectional images obtained when scanned slices are stacked in computer memory. A volume or 
volumetric data set is based on inter-pixel and inter-slice distances that represent a real-world volume. 

Waveform A representation on the screen of all the data from a signal within a defined timeframe where time moves 
from left to right and the height of the waveform represents the amplitude of the signal. 

Waveform Display The area on the screen in which waveforms are displayed. 

XA X-ray angiography images. 

 

Service and Technical Support 
The troubleshooting guide in this document is intended to help resolve problems with the system. If problems cannot be resolved by using the 
suggestions presented here, contact your EnSite™ X EP System field representative or distributor. 

Local Number: 651-756-6985 

Toll Free: 855-478-5833 

Email: USDTechSupport@abbott.com 

Technical Specifications 
Environmental Specifications 
Component Operating 

Temperature 
Operating 
Humidity 

Operating Altitude Storage and 
Transport Temp 

Storage and 
Transport 
Humidity 

Storage and 
Transport Altitude 

DWS Ambient 
Temperature: 
+18° C to +27° C, 
inclusive 

Relative Humidity, 
non-condensing: 
30% to 75% 

Altitude: 0 m to 
3000 m 

Ambient 
Temperature: -
10° C to +50° C, 
inclusive 

Relative Humidity, 
non-condensing: 
20% to 90% 

Altitude: 0 m to 
5574 m 

The EnSite™ X EP System has a Class I safety classification. 

Standards of Compliance 

 

Conforms to EN 60601-1, EN 60601-1-1, EN 60601-1-2, EN 60601-1-4, EN 60601-1-6, EN 62304, EN 62366-1; Certified to 
CAN/CSA 22.2 No.60601-1. 
All configurations should comply with the system standard EN 60601-1-1. Everybody who connects additional equipment to the signal 
input part or signal output part configures a medical system and is, therefore, responsible that the system complies with the 
requirements of the system standard EN 60601-1-1. If in doubt, consult the technical services department or your local 
representative. 

 

Isolation Transformer 
EN 60601-1, Ed. 3.1 approved Isolation Transformer models ISB-1462 (US), ISB-1499 (JPN), or ISB-1520 (EU) to be used for connection of the 
EnSite™ X Amplifier and Medical Electrical (ME) System equipment installed on the Amplifier and DWS carts. A total of two (2) Isolation Transformers 
are used for a complete EnSite™ X EP System. 

NOTE: Do not position the isolation transformer so that it is difficult to disconnect from power. 

EN 60601-1, Ed. 3.1 approved Isolation Transformer models ABC600-11MED (US, JPN) or ABC750-22MED (EU) to be used for connection of the 
optional remote monitor stand. 
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NOTE: Do not position the isolation transformer so that it is difficult to disconnect from power. 

Recording System Input Impedance 
External recording equipment must meet the safety requirements of BS EN 60601-1 "Medical electrical equipment Part 1: General requirements for 
basic safety and essential performance". 

Input impedance should be greater than 2.5 megohms when measured at 40Hz. Additionally, to optimize EnSite NavX™ performance, input 
impedance should be greater than 25k ohms channel-to-channel when measured at 8kHz. 

Patient Environment Information 
Non-Patient Environment 
EnSite™ X EP System Display Workstation (DWS) Cart including: EnSite™ X EP System DWS, Keyboard, Mouse, Printer, Local Monitor, Isolation 
Transformer, Fiber Optic Video Extender and associated cabling. 

NOTE: The EnSite™ X EP System DWS Cart is an optional component. Components are considered to be a part of the non-patient 
environment regardless of if they are on a cart. 

Patient Environment 
EnSite™ X EP System Amplifier Cart including: EnSite™ X EP System Amplifier, EnSite™ X EP System Field Frame, EnSite™ X EP System SurfaceLink 
Module, EnSite™ X EP System Patient Reference Sensors, and associated cabling. 

NOTE: The EnSite™ X EP System Amplifier Cart is an optional component. Components are considered to be a part of the patient 
environment regardless of if they are on a cart. 

EnSite™ X EP System Remote Monitor Stand including: Remote Monitor, Isolation Transformer, and Fiber Optic Video Extender, and associated 
cabling. 

NOTE: The EnSite™ X EP System Remote Monitor Stand is an optional component. Components are considered to be a part of the patient 
environment regardless of if they are on a cart. 
NOTE: The Remote Monitor is an optional component. If included, it can reside on the EnSite™ X EP System Remote Monitor Stand or the 
EnSite™ X EP System Amplifier Cart. 

Disposal 
 The IFU is recyclable. 

 After use, device(s) and packaging should be appropriately classified for disposal, e.g. electrical equipment, non-hazardous waste, etc. and 
carefully disposed of in compliance with facility procedures and applicable laws and regulations. Discard any unused components after the 
procedure. 

Reporting Device Incidents 
If, in the course of use of this device, you have reason to believe that a serious incident occurred, please report it to the manufacturer. For customers in 
the European Union, report the serious incident to your national authority as well as to the manufacturer. 

Cybersecurity 
 The site controlling the device should have policies in place prescribing the physical safety and security of the devices in the electrophysiology 

laboratory. For example, physically securing devices and information should include policies that limit physical access, securing equipment in 
locked rooms, managing access to secured rooms, and restricting the ability to remove devices from a secure area. 

 Inspect the device; discontinue use if there is visible evidence of tampering. 

 In the event of a suspected cybersecurity issue, discontinue use of the EnSite™ X EP System and contact Abbott Technical Support. 

Limited Warranty 
Abbott Medical warrants that its products shall be free from defects in materials and workmanship under normal use. This warranty does not exceed the 
"Expiration" date stated on any product labeling. The authorized uses and approved methods of use of each of our products is set forth in the related 
"Instructions for Use" that accompany each product. Abbott Medical disclaims any responsibility and liability for the use of its products in a manner that 
has not been authorized or approved. Abbott Medical’s liability under this warranty is limited to replacing its products. The foregoing warranty excludes 
and is in lieu of all other warranties whether expressed or implied including, but not limited to, any implied warranties of merchantability or fitness for a 
particular purpose. Abbott Medical disclaims any liability for any incidental or consequential loss, damage, or expense directly or indirectly arising from 
the use of this product, other than as expressly provided by specific law. Abbott Medical neither assumes nor authorizes any other person to assume for 
it any other or additional liability for loss, damage, or expense in connection with this product. For more details please review complete Abbott Medical 
warranty policy available from Abbott Medical or on the back of an Abbott Medical invoice. 

Symbols 
The symbols below and harmonized symbols may be found on the product or product label. For harmonized symbols, refer to the Universal Symbols 
Glossary at medical.abbott/manuals. 

Symbol Definition 

 

Medical Device 

 
Unique device identification number 

 

Importer 

 

Consult instructions for use on this website 

 

Affixed to this device in accordance with European Council Directive 2012/19/EU. 
This directive calls for separate collection and disposal of electrical and electronic equipment. 
Sorting such waste and removing it from other forms of waste lessens the contribution of potentially 
toxic substances into municipal disposal systems and into the larger ecosystem. 
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The symbols below and harmonized symbols may be found on the product or product label. For harmonized symbols, refer to the Universal Symbols 
Glossary at medical.abbott/manuals. 

 

Intertek Safety Agency Certification Mark 

 

Conformité Européenne (European Conformity). Affixed in accordance with European Council 
Directive 93/42/EEC (NB 2797) and 2011/65/EU. Hereby, St. Jude Medical declares that this 
device is in compliance with the essential requirements and other relevant provisions of this 
directive. 

 

USA only: Federal law restricts this device to sale by or on the order of a Physician 
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